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Vista Manager EX™ is a graphical network monitoring and management tool for Allied Telesis
Autonomous Management Framework™ (AMF) networks. Vista Manager EX automatically creates a
complete topology map from an AMF network of switches, firewalls and wireless access points
(APs). Vista Manager EX facilitates simple management of many, or all, network devices from a
dashboard that gives you a central overview of your network. From the dashboard you can monitor
up-to-date network status, and take action to resolve any network problems.

About this Guide

This Guide describes how to use Vista Manager EX running the base Vista Manager EX license. It is
intended for computer system administrators and network engineers using Vista Manager EX.

You can obtain Vista Manager EX either on a hardware platform:

m  VST-APL: An application running on Vista Manager Network Appliance (VST-APL) hardware. This
Guide also describes setting up Vista Manager on a VST-APL. For information about the VST-APL,
see the Vista Manager Network Appliance (VST-APL) Technical Documents.

or as one of the following software deployments:

m VST-VRT: An application in Vista Manager Virtual (VST-VRT) deployed on VirtualBox 6.1. This
Guide describes how to set up Vista Manager EX on VST-VRT. For information about using
VST-VRT, including deploying it on VirtualBox, see the Vista Manager Virtual (VST-VRT) User
Guide.

®  Windows software: Software installed directly on a device running Microsoft Windows OS

From version 3.17.1 onwards, we will no longer support the Windows version of Vista Manager EX.
To get ongoing new features and enhancements, you need to update your Vista Manager installation
to the VST-VRT version. Migration to VST-VRT is easy; for step-by-step instructions see the
Windows to VST-VRT Vista Manager Migration User Guide. Periodic maintenance releases for
version 3.16.x, along with select earlier versions, may be issued.

For more information, see the Vista Manager Virtual (VST-VRT) Technical Documents.
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Virtual Appliance: A stand-alone Vista Manager virtual appliance deployed on Windows Server
2012 R2 Hyper-V or VMware vSphere Hypervisor (ESXi) 6.0, 6.5, 6.7, 7.0, and 8.0. For installation,
see the Vista Manager EX Virtual Appliance Installation Guide. Note that this virtual appliance
does not support Vista Manager plugins. If you need the plugins, use VST-VRT as the virtualized
deployment of Vista Manager.

Where there are differences in this Guide, they are indicated by APL, VRT, WIN and VA.

Related documents

For more information, see:

QAPL =

GEVRT =

VA [OWIN

The Vista Manager web page

The Vista Manager Network Appliance (VST-APL) Technical Documents—for information about
how to install and use the VST-APL and the applications supported on it.

Vista Manager Virtual (VST-VRT) Technical Documents—for information about how to deploy and
use the VST-VRT and the applications supported on it.

The Vista Manager EX Technical Documents—for information about how to install Vista Manager
EX as Windows software on Windows Server 2012 R2 Hyper-V or VMware vSphere Hypervisor
(ESXi) 6.0, 6.5, 6.7, 7.0, and 8.0. This page also shows how to use Vista Manager EX and its
optional features.

Planning an AMF Plus network is beyond the scope of this installation guide. The following
documents give more information about AMF Plus:

AMF Plus Feature Overview and Configuration Guide

AMF Plus Introduction and videos

These documents are available from the links above or on our website at alliedtelesis.com
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What’s in Vista Manager EX?

You can perform Network operations directly by navigating to the following tools available from the
central dashboard:
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Dashboard
Displays your network details and network map including all devices connected to each area.
Also shows a 24-hour event history at a glance and a list of color-coded recent events.

Network Map

Displays a graphical topology map of your network. From here you can view pop up details of an
area that displays the number of AMF devices, guest devices, device name and IP address.
STOAT plugins for third-party tools, including Forescout, and Nozomi. can also be used for device
discovery. You can carry out actions such as backup master, SSH to master, and backup device
directly from the network map. The AWC plugin also enables management and monitoring of
Allied Telesis APs.

Health Monitoring
Displays a customisable dashboard to monitor the health of devices in your network.

Events
Displays a list of events that are color-coded red for critical, orange for abnormal and green for
normal. Events can be filtered by status.

Asset Management

Displays a complete list of all devices on the network and allows you to search for specific
devices. You can filter this list by categories or export it. To manage devices, you can create
groups, assign icons or view licenses.

Network Services

Allows an administrator to learn the status of services running on devices on the network.
Configure a monitoring task to run periodically, or to monitor services on demand. You can also
view the Access Control List Matrix and RADIUS information.

Intent Networks
Provides network optimization, automation, management, and visualization. Also offers
automation of branch security and WAN bandwidth management.

WAN

Enables you to set acceptable performance metrics for any application, and load-balance traffic
to meet requirements. By monitoring VPN link quality, time-sensitive or critical traffic is
automatically switched over to the optimal link as required.

Bookmarks
Allows you to quickly bookmark useful websites for easy access.

User Management
Administrator access allows you to add, change or delete Vista Manager EX users.

System Management
Displays various system details such as the current version, serial number, and license
information. It also allows you to manage the system configuration, such as SMTP settings.
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Vista Manager plugins

Optional Vista Manager EX plugins are available on:
@ APL = Vista Manager Network Appliance (VST-APL).
G)VRT = Vista Manager Virtual (VST-VRT).

EWIN = Windows-based installations.

VA Plugins are not available on a standalone Vista Manager virtual appliance.

Vista Manager EX works with a variety of plugins, including:
m  AWC (Wireless Controller) plugin

m  SNMP plugin

m  Trap Receiver plugin

m  Forescout plugin

®  Nozomi plugin

B Microsoft Intune

For more information about these plugins, see "Plugins" on page 188.
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What’s new in Vista Manager version 3.17.x?

Vista Manager version 3.17.x includes both new features and significant enhancements to some
existing features, as listed below.

For more information about specific changes, including instructions on how to update your

software, see the Vista Manager EX Release Notes.

C613-10634-00-REV B

"Updating passwords for AMF Plus devices" on page 18
"Check speed of AMF guest links" on page 91

"AWC Wireless Monitoring Dashboard" on page 183
"RADIUS login for Vista Manager" on page 206

"Sites and Groups Permissions" on page 317

"HCNET integration support" on page 344

"Al Network Assistant" on page 348

B ‘"License Details" on page 349
m "Checking network information" on page 349
m  "Upgrading Firmware" on page 351

"OsecT Support" on page 356

"Disable http check-api-content-type-header before using Vista Manager" on page 359
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Preparing your AMF Network for
Vista Manager EX

B APL

VRT

Vista Manager EX is an application that allows you to monitor and manage your AMF Plus network.
Before you can use Vista Manager EX, you need to configure your AMF network. This chapter does
not describe how to set up an AMF network.

AMF Plus is available on AlliedWare Plus devices running software version 5.5.2-2.3 and later. The
following guide describes both AMF Plus and AMF on 5.5.2-2.3 and later: For step-by step
instructions, see the AMF Plus Feature Overview and Configuration Guide.

This section describes how to prepare your existing AMF network for use with Vista Manager EX.

On VST-APL and VST-VRT, the AMF Master may be the AMF Cloud application on the same
VST-APL that the Vista Manager EX application is running on, or it may be a remote device.

AMEF software version compatibility with Vista Manager
EXv3.17.x

Ensuring compatibility within your AMF network requires specific version considerations. We
recommend that AMF devices must operate on version 5.5.5-1.x or later.

Dependencies outlined based on the status of controller and master devices. For example:

m If any of your AMF Controller or Master devices are running 5.5.5-1.x, then all other devices
must run 5.5.5-1.x or later.

m If your AMF Master device is running 5.5.5-0.x, then all other devices must also run 5.5.5-1.x
(not a later version such as 5.5.5-2.x or 5.5.5-3.x).

m |f your AMF Master device is running 5.5.5-2.x, then member devices can run 5.5.5-0.x or
5.5.5-1.x.
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Server requirement

Vista Manager EX needs to be installed on a server or appliance that has connectivity to your AMF
Plus master or controller.

Enable the HTTP service on your devices

To use Vista Manager EX, you must enable the HTTP service on all AMF Plus devices, including all
AMF masters and controllers. Some AlliedWare Plus devices are shipped with the HTTP service
disabled by default. Ensure that it is enabled on all devices that you want to manage with Vista
Manager EX.

To enable the HTTP service, use the commands:

configure terminal

service http

You can use an AMF working set command to configure this option on all your devices:

atmf working-set group all
configure terminal

service http

Allow Vista Manager EX to discover the AMF network

Run the following commands on your AMF controller (if you have one in your network) and all AMF
masters to allow Vista Manager EX to discovery your AMF network:

configure terminal

atmf topology-gui enable

Configure the AMF log event host

If the AMF Plus controller or AMF Plus master you intend to register with Vista Manager EX is
configured to send event notifications to Vista Manager EX, then Vista Manager EX will display them
on its dashboard and event log page.

Run this command only on the registered AMF Plus controller/master with Vista Manager EX:
configure terminal

log event-host <vista-manager-ip-addr> atmf-topology-event

Note: The IP address is the address of the server that Vista Manager EX is running on.

where <vista-manager-ip-addr> is the IP address of the Vista Manager EX instance.

Note: To register with Vista Manager EX, ensure that the AMF Plus controller/master has layer 3
connectivity to the Vista Manager EX server.
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Configure certificate for device authentication

You can configure Vista Manager EX to use a certificate to authenticate communication within your
AMF Plus network. After configuration, the certificate allows the AMF Plus controller/master to
automatically authenticate and connect to any device in the network without requiring a username
and password.

Note: We recommend you configure a certificate for authentication. If you do not configure this
option, you need to ensure that all devices in the AMF Plus network to be managed by Vista
Manager EX have the same username and password as the AMF Plus controller/master.

To configure your AMF Plus network to use certificate authentication, enter the following commands
on your AMF controller/master:
configure terminal
crypto pki trustpoint <trustpoint-name>
enrollment selfsigned
rsakeypair <key-name>
exit
exit
crypto pki authenticate <trustpoint-name>
crypto pki enroll <trustpoint-name>
configure terminal
atmf trustpoint <trustpoint-name>

Note: Save this configuration and reboot your AMF Plus controller/master after running the atmf
trustpoint command for this change to take affect.

Note: In an AMF Plus network with multiple areas, this process only needs to be carried out on the
controller/master. It does not need to be repeated on each individual area’s master.

This functionality is disabled by default, but it is recommended that it is enabled. If you need to turn
this feature on or off, this can be done from Vista Manager EX configuration settings:

Use certificates {recommended):

Use password if certificate fails:

The Use password if certificate fails option can also be enabled. When it is turned On, if the
certificate authentication fails, it will revert to using the username and password to authenticate.
This will only work if all devices have been configured with the same username and password as the
controller/master, as mentioned above.
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Connection timeout on masters and controllers

We recommend not changing the session timeout on your Vista Manager EX master or controller
using the line vty exec-timeout command. If you do decide to change it, it should not be set to 0,
as this may result in sessions that can’t be reached and never time out.

Updating passwords for AMF Plus devices

This section applies to customers using passwords across their AMF Plus and Vista Manager network.

If you update your AMF device passwords, you must follow this procedure to ensure Vista Manager can still
access the AMF devices after the update.

In summary, this procedure has five steps:

1. Create a temporary account, e.g. ‘vista-temp’

2. Switch Vista Manager’s credentials to use the new account
3. Change the password on the 'main' account

4. Switch Vista Manager back to the 'main' account.

5. Delete the temporary account.

The rest of this section describes this procedure in detail.

Step 1: Create the temporary account
First you must create a new user on the AMF Master and Member nodes. To do this:

1. Open a terminal session on the AMF Master node.

2. Enter the global configuration mode on the AMF Master:
configure terminal
3. Use the atmf working-set group all command to target all nodes in the group:
atmf working-set group all
4. Enter the configuration mode for the working set:
configure terminal
5. Create a new user named ‘vista-temp’ with a specified password:
username vista-temp password your_password
6. Exit the configuration mode:
exit
7. Save the configuration
write

The above process creates the user ‘vista-temp’ on all nodes within the specified working set group. Make
sure to replace your_password with a secure password of your choice.

C613-10634-00-REV B | Page 18



Step 2: Switch Vista Manager’s credentials to use the new account
1. Go to System Management > Network Configuration from the side menu in Vista Manager.

2. Add the previously created ‘vista-temp’ username and password:

Network Configuration
About Network
Network Display Name: Network
AMF Network Configuration
Network Name:
Network
Network IP;
1037181240 Change Network IP
Change Username
vista-temp Save
Change Password
————————————— Change Password
Use certificates (recommended):
= -
3. Click Save.

Step 3: Change the password on the 'main' account

1. Open a terminal session on the AMF Master node.

2. Enter the global configuration mode on the AMF Master:
awplus# configure terminal
3. Use the atmf working-set group all command to target all nodes in the group:
awplus (config)# atmf working-set group all
4. Enter the configuration mode for the working set:
AMF[alll]l# configure terminal
5. Update the password for ‘manager’:
AMF[all] (config)# username manager password new_password
6. Exit the configuration mode:
AMF [all] (config)# exit
7. Save the configuration

AMF[alll# write
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Step 4: Change Vista Manager back to the 'main' account.

1.

Add the manager user details back to Vista Manager:

Network Configuration

About Network

Network Display Name: Network

AMF Network Configuration
Network Mame:

Networl

Network IP:

10.37.141.240 Change Network IP

manager Change Username

Change Password

Use certificates (recommended)

-

2.

Click Save.

Step 5: Delete the temporary account.

1.

2.
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Open a terminal session on the AMF Master node.

Enter the global configuration mode on the AMF Master:

awplus# configure terminal

Use the atmf working-set group all command to target all nodes in the group:

awplus (config)# atmf working-set group all
Enter the configuration mode for the working set:
AMF[all]l# configure terminal
Delete the ‘vista-temp’ user
AMF[all] (config)# no username vista-temp
Exit the configuration mode:
AMF [all] (config)# exit
Save the configuration

AMF[alll# write
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Logging into Vista Manager EX

ava

B APL

VRT

G WIN

Initial login and setup

This section describes logging in and initial setup for Vista Manager EX.

Before setting up Vista Manager EX on the VST-APL, you must activate and start the Vista Manager
application on the VST-APL. For information about using the VST-APL, including activating
applications, see the Vista Manager Network Appliance (VST-APL) User Guide.

Before setting up Vista Manager EX on VST-VRT, you need to deploy the VST-VRT. For deployment
and configuration information for VST-VRT, see the Vista Manager Virtual (VST-VRT) User Guide.

For installation instructions, see the Vista Manager EX™ Installation Guides.

This section describes:
B "lLogging into Vista Manager EX after setup" on page 25
m  "Registering/Installing plugins" on page 28

Note that dialog boxes in this section are from a VST-APL. In most cases, the dialog boxes are the
same for all Vista Manager platforms.

Initial login to Vista Manager

Initially you can log into Vista Manager by using the default username and password combination
(manager and friend).You can change this once you have logged in. After you log in, there is a
sequence of steps to go through to set up your Vista Manager EX account.

Note: Vista Manager requires JavaScript to be enabled in your web browser.

From the Vista Manager Login dialog:

AVZ Allied Telesis | Vista Manager

m Enter the Username: manager

® Enter the Password: friend

- Username: manager
@ Pesswod: | s | m Click Login
Remember me Forgot Password?
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To connect remotely, use your browser to go to the URL:

http://<ip-address>

where <ip-address> is the address of the Vista Manager application. This is the IP address you
assigned statically to Vista Manager or that you set it to obtain by DHCP when configuring the
application. You can find this IP address by hovering over the instance information icon for the Vista
Manager application in the VST-APL or VST-VRT GUI.

To connect locally, you can use the URL:

http://localhost:5000

To connect remotely, use the URL:

http://<ip-address>:5000
where <ip-address> is the address you assigned on the Registration Server IP Address dialog.
To connect remotely, use the URL:

http://<ip-address>

where <ip-address> is the address displayed on the Vista Manager EX appliance console screen
after it boots.

Step 1: Setting up your Vista Manager account

The Set Up Your Vista Manager account dialog displays after you log in. You can change the
default login information from this window.

m Enter your new Username

Create your Vista Manager account details: m Enter your new Password

2  Username: manager
B Re-enter your Password to
a Password: Confirm
8 confirm m Enter your Email
Password:
m Click Next.
E Email: user({@company.com

If you want to use a backup to restore
a previous database, click upload
existing profile backup.

upload existing profile backup NG
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Step 2: License registration

VRT EJWIN If this is the first time you are using Vista Manager EX, you have the option to apply the 90 day trial
0O va license for other licensed features, such as the AWC plugin and the AlO feature, by clicking Use 90
day trial license.

EAPL Note: Onthe VST-APL, you can click Skip this step. No license is required on the VST-APL for Vista
Manager EX, or the Trap Receiver plugin.

The Optionally Use Trial Licenses dialog displays:

AV Allied Telesis Vista Manager™ EX

mSelect the 90-day trial.
Step 2: Optionally Use Trial Licenses
m|f you wish to upload a licence instead,

The trial license will provide full access to all Vista Manager EX plugins for 90 days. click Sklp this step.
Would you like to enable the 90 day trial license? Note:lIf you select the 90-day trial, you
need to install your licenses before the
end of that trial. For more information,

Skip this step Upload backupile | Se€ "About Vista Manager EX
Licenses" on page 38.

Otherwise, the Upload License File dialog displays:

AVL: Allied Telesis | Vista Manager™ EX

mInstall your licenses now by uploading
the license file.

Please upload your Vista Manager EX licenses file.
The licenses file you provided should be associated with the following Vista Manager m Click Next.
EX serial number.

Note:lf your license file is not associated
with the Serial Number listed in your
Select License File: Choose File | No file chosen dialog, or you do not have a license file,
then contact Allied Telesis support to

obtain a license.

Serial Number 610b416b-1d86-4f68-a30c-29cd130de567

If you do not have a license file, please contact Allied Telesis.
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Step 3: Set Up Your Network

The Set Up Your Network dialog displays:

B APL

VRT

On a VST-APL or VST-VRT deployment, the AMF Master may be the AMF

Cloud application, or it may be any other AMF Master or Controller.

AV Allied Telesis Vista Manager™ EX

Step 3: Set Up Your Network

Enter AMF Network Master or Controller IPv4 or IPv6 Address or Domain Name:

Enter AMF Network Master or Controller Username and Password:

2 Username:

& Password:

skip network setup

Upload backup file m

Step 4: Set Up Your SMTP settings
The Set Up SMTP settings dialog displays:

AV Allied Telesis Vista Manager™ EX

Step 4: Set Up Your SMTP settings

Enter the address of SMTF server, which will be used by Vista Manager EX to send
notifications to users.

SMTP server IP address:

SMTP Server Port

25 o

Enter your SMTP server's username and password:

2 Username:

@ Password:

= Send mail as:

do this later
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m Enter the IP Address for
the AMF Master or
Controller

® Enter the AMF Controller
or Master Username

® Enter the AMF Controller
or Master Password

m Enter the IP Address of your
SMTP server

You may also enter:
m the SMTP Server Port

m the SMTP Server Username
m the SMTP Server

Password

® the Send mail as email address.

You will receive a message saying that the
set up is successful.
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Logging into Vista Manager EX after setup

VRT [E)APL To connect remotely, use your browser to go to the URL:

http://<ip-address>

where <ip-address> is the address of the Vista Manager application. This is the IP address you
assigned statically to the Vista Manager application or that you set it to obtain by DHCP when
configuring the application. You can find this IP address by hovering over the instance information
icon for the Vista Manager application in the VST-APL or VST-VRT GUIL.

EAWIN To connect locally, you can use the URL:

http://localhost:5000

To connect remotely, use the URL:

http://<ip-address>:5000

where <ip-address> is the address you picked on the Registration Server IP Address dialog.

VA To connect remotely, use the URL:

http://<ip-address>

where <ip-address> is the address displayed on the Vista Manager EX appliance console screen after it
boots.

The Vista Manager Login dialog displays:

AL Allied Telesis Vista Manager™ EX mEnter your

, . Username.
Vista Manager EX Login

mEnter your
Password.

& Usermname:

mClick Login.

B Password:

7| Remember me ﬂ

Note: To enable/disable auto-logout for different users, you can change the Timeout in the User
Management menu.
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Logout

On any Vista Manager screen, click on your username in the top right-hand corner and select
Logout.

After logging out, the login window will appear.

Changing your password

1. Go to User Management and select your user name

2. Click Edit

3. Click Change Password

4. Enter your new password and then re-enter your new password to confirm

5. Click Save

Enabling Two-Factor Authentication (2FA)

As an Admin user, you can enable 2FA for your own account, other admin accounts, or general
users.

1. To enable 2FA, click the toggle on the User Management page.

Note: 2FA requires SMTP to be configured before it can be enabled.
If you are using a VST-APL device, 2FA requires an NTP server to be set up for accurate time service.

2. After enabling 2FA from Vista Manager, when you next log in you will be shown a QR code to scan
on your authentication app of choice.
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2FA is supported with any mobile authenticator that supports TOTP (such as Google Authenticator,
Microsoft Authenticator, Authy, LastPass Authenticator, and many more).

AL Allied Telesis ~ Vista Manager™ EX
Scan QR Code

@ Please scan this QR code with your authenticator app. Once scanned, enter
the generated code below to verify your account.

Enter the code manually if you cannot scan the QR code

[n]

Authenticator App Code

Back

® User level accounts cannot enable or disable 2FA.
m  Authenticator codes appear under the title ‘VistaManager: Your Username’

m Enter a valid code from your authenticator app into the Authenticator App Code field. Click
Submit and you will log in as normal.

B After 5 incorrect code attempts, you must wait 5 minutes before you can try again

m  Clicking Remember me on the login screen skips 2FA, even if it is enabled. Remember me lasts
for 14 days.

Reissuing the QR code
You can re-issue the 2FA QR in different ways, depending on the status of your account.

®  As a normal user, click the reset link sent to your registered email.

B Admin users can enable and disable 2FA for that specific account.
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Registering/Installing plugins

Vista Manager EX supports a number of plugins. This section outlines their subscription
requirements and setup instructions.

GEIVRT E)APL ®m The AWC plugin requires a separate subscription license from Vista Manager. See "Initial login
B WIN and setup" on page 21 and "About Vista Manager EX Licenses" on page 38 for details.

m  The SNMP plugin is enabled by default in an AMF Plus environment from Vista Manager version
3.11.0 onwards. This means that if you have a current active and enabled AMF Plus license on
your AMF masters and controllers, then the functionality of the SNMP plugin is available to you.
There is no setup required for you to use this.

m  The Forescout plugin is included as part of the Vista Manager EX software package. You do not
need to download it separately; just download Vista Manager EX 3.9.1 or later from our Software
Download site.

B The Nozomi plugin is supported from version 3.12.0 of Vista Manager EX.
To set up the plugins after you have successfully logged in to Vista Manager EX, go to:

System Management > Plugins:

System Management
About
Plugins
Configuration
Vista Manager's Certificate Fingerprints Regenerate Certificate
Network Configuration
SHA1
Resource Management
Database Management SHAZ56
Licenses
o
Plugins q.‘ ----____.-- - --“"*A
"""'---__..-———-’""_-
Plugins + Add Plugin
Forescout Plugin
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Registering the AWC plugin
1. Scroll down to System Management from the side menu.

2. Click on the Plugins tab. Click + Add Plugin on the Plugins table

AV Allied Telesis  vista Manager X docnet Q @ manager -
System Management
About

Plugins
Configuration
Vista Manager's Certificate Fingerprints Regenerate Certificate
Network Configuration
SHAT
Resource Management
Database Management SHA256

Licenses

! 4 -
2 Optional Features Plugins

Vista Labs Forescout Plugin
Nozomi

Intune

3. The Register Plugin side menu will appear.

Enter the plugin server url by replacing ip-address with the IP assigned in the Wireless Control-
ler section of the VST-VRT GUI at
https://ip-address:5443/wireless_plugin

Register Plugin X

@ |If you are installing Vista Manager EX and its plugin on the same host,
specify "localhost” in the plugin server URL.

For Appliance box or virtual appliance installations, replace "localhost"
with the IP address of the plugin application in the plugin server URL.

Please see Vista Manager EX User Guide for detailed documentation.

Server URL

hitps://ip-address:5443/wireless_plugin| I Register Plugin

Format: hitps:/fip-address:port/plugin

4. Click Register Plugin.
5. The fingerprints for the application will appear. Click Confirm fingerprints.

6. A green notification will appear in the bottom right corner of Vista Manager and the plugin is
added.
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The AWC Plugin displays a Wireless icon on the Vista Manager EX menu. When you click on this
i [ i i i
([l icon it will display the AWC menu items.

= AWC Plug-in

Wireless Monitoring

Wireless Configuration

Wireless Maintenance

Device Search

System Setting

Registering the SNMP plugin

As of update 3.11.0, the SNMP plugin is enabled by default in an AMF Plus environment. This means
that if you have a current active and enabled AMF Plus license on your AMF masters and controllers,
then the functionality of the SNMP plugin is available to you. There is no setup required for you to
use this. In order to enable the SNMP plugin manually, you can do so with the following steps:

1. Scroll down to System Management from the side menu.
2. Click on the Plugins tab.

3. Click + Add Plugin on the Plugins table

AV Allied Telesis  vista Manager X docnet Q @ manager -

System Management

About
Plugins
Configuration

Vista Manager's Certificate Fingerprints Regenerate Certificate
Network Configuration

SHAT
Resource Management

Database Management SHA256

Licenses

Optional Features Plugins + AP\ugin

Vista Labs Forescout Plugin
Nozomi

Intune

4. The Register Plugin side menu will appear.
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Enter the plugin server url by replacing ip-address with the IP assigned in the SNMP Plug-in
section of the VST-VRT GUI at
https://ip-address:6443/NetManager

Register Plugin X

@ If you are installing Vista Manager EX and its plugin on the same host,
specify "localhost" in the plugin server URL.

For Appliance box or virtual appliance installations, replace "localhost"
with the IP address of the plugin application in the plugin server URL.

Please see Vista Manager EX User Guide for detailed documentation.

Server URL

https.//ip-address:6443/NetManager| Register Plugin

P Format: https:/fip-address:port/plugin

5. Click Register Plugin.
6. The fingerprints for the application will appear. Click Confirm fingerprints.

7. A green notification will appear in the bottom right corner of Vista Manager and the plugin is
added.

Registering the Forescout plugin

The Forescout plugin is included as part of the Vista Manager EX software package. You do not
need to download it separately; just download Vista Manager EX 3.9.1 or later from our Software
Download site.

You must first configure the Forescout console prior to adding the plugin to Vista Manager EX. For
information about configuring the web APl module in the Forescout console, see "Prerequisites for
installing Forescout" on page 187.

After upgrading to version 3.9.1 or later, you need to register the plugin. To do this:

1. Go to System Management > Plugins.

2. Click + Add Plugin on the Plugin table.

Plugins + Add Plugin I

AWC Plug-in

SNMP Plug-in

3. Register the plugin in the textbox with the server URL of https://localhost:11443

4. Click Register Plugin and Vista Manager will generate the certificate’s fingerprints.
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5. Confirm that the fingerprints match the Forescout program, then click Confirm Fingerprints.

Register Plugin

© fyou are installing Vista Manager EX and its plugin on the same
host, specify "localhost” in the plugin server URL.

For Appliance box or virtual appliance installations, replace
“localhost” with the IP address of the plugin application in the plugin
server URL.

Please see Vista Manager EX User Guide for detailed documentation.

Server URL
https://localhost:11443 Register Plugin

Format: https://ip-address:port/plugin

© confirm fingerprints match

Please verify these certificate fingerprints match the ones the plugin
is reporting. See Vista Manager EX Installation Guide for more
information.

SHA1

8CET:FA14:2C:EA94:7A6A59:AB:71:85:1C:AD:53:41:A7:31
AF 0

SHA256

AB315F17:CATCBC 24 7F6A33: 5F 5A70i3E:37:71:49:24;
D447 4E:97AEFC:07:9B:73:69:FF2E:6C 0

x

Confirm Fingerprints

Y

6. Scroll down and enter the additional Forescout setup settings:

B Username
m Password

® |P address

Setup

-
= Username

Password

IP Address
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7. Click Save.
The Plugin will be added to your plugin list.
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Registering the Nozomi plugin
From version 3.12.0 onwards, Vista Manager supports the Nozomi plugin.
You must first configure the Nozomi Guardian sensor prior to registering it in Vista Manager EX. To

see information about the initial configuration of Nozomi Guardian, see the Nozomi Plugin User
Guide.

1. Go to System Management > Plugins.

2. Click + Add Plugin on the Plugin table.

Plugins + Add Plugin I

AWC Plug-in

SNMP Plug-in

3. Register the plugin in the textbox with the server URL of https://localhost:15443
4. Click Register Plugin and Vista Manager will generate the certificate’s fingerprints.

5. Confirm that the fingerprints match the Nozomi program, then click Confirm Fingerprints.

Register Plugin X

Server URL
https://localhost: 15443 Register Plugin

Format: https://ip-address:pert/plugin

© confirm fingerprints match

Please verify these certificate fingerprints match the ones the plugin
is reporting. See Vista Manager EX Installation Guide for more
information.

SHA1

FD:60:DAF2:94.EB:3C:FB:99:B3:2B:F2:D4:8F.E9:AB:74:9DED
16D n|

SHA256

17:29:0A:CABD95:4B:42:7C:DA64:CE1DIAS:ICBI6E:E2:2B:3F
(C674:67:38ENCT TR CAAAATAFDT.CB 0

Confirm Fingerprints

Y

6. Scroll down and enter the additional Nozomi setup settings:

m  Key Name

m  Key Token
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m [P address

Setup

O= Key Name

Key Token

IP Address

7. Click Save.
The Plugin will be added to your plugin list.
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Registering the Microsoft Intune plugin

From version 3.13.1 onwards, you can view alert information that is gathered by Microsoft Intune in
Vista Manager. For more information, see "Microsoft Intune Plugin alerts" on page 193.

Do not enable the Automatic Blocking feature from the Endpoints table while using the Intune
plugin. If you have previously enabled Automatic Blocking, disable it.

1. Go to System Management > Plugins.

2. Click + Add Plugin on the Plugin table.

Plugins

AWC Plug-in

SNMP Plug-in

+ Add Plugin I

3. Register the plugin in the textbox with the server URL of https://localhost: 19443/

4. Click Register Plugin and Vista Manager will generate the certificate’s fingerprints.

5. Confirm that the fingerprints match the Intune program, then click Confirm Fingerprints.

Server URL
https://localhost: 19443/

Format: https://ip-address:port/plugin

© confirm fingerprints match

Please verify these certificate fingerprints match the ones the plugin
is reporting. See Vista Manager EX Installation Guide for more

information.

SHA1

19

SHA256

17:09:80:9E:7F:E4:2C:DE:D2:6F80:5B:74:21:66:08:27:83:F9:

SF:6D:0EB5:F2:CA:EC:BF:C8:90:0F:60:FB:67:03:7C:69:30:94:
8D:13:EBTAFZ:AB9A77.CD:88:12.BF:9D

Register Plugin

D

D

Confirm Fingerprints

Y

6. Scroll down and enter the additional Intune setup settings:

m ClientID

m Client Secret
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®m Tenant ID

Setup

2 cliem D

Client Secret

Tenant ID

7. Click Save.
The Plugin will be added to your plugin list.
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About Vista Manager EX Licenses

B APL

EVRT WIN

ava

Licensed features

Vista Manager EX base license is enabled by default on the VST-APL. Licenses for optional features
and plugins are applied during the Vista Manager EX software installation procedure. Download the
license file from the Allied Telesis download center. Subscription licenses are tied to the Vista
Manager database and are maintained across backups and restores.

You can install multiple plugin licenses (for the same feature) each with their own license period. This
allows you to manage a total number of devices equal to the sum of the devices of the active
licenses. For example, if you have two licenses installed for one plugin that is device-restrictive,
each for 10 devices, you will be able to manage a total of 20 devices through that same plugin.

After clearing the Vista Manager database:
m  Trial licenses are retained.

m  Non-trial licenses are lost. (Licenses are tied to a serial number; initialization loses the old serial
number and generates a new one.)

If you import a backup, the serial number and any licenses are tied to the backup.

Vista Manager EX licensing is subscription based. Download the license file from the Allied Telesis
download center. The base license file is applied during the Vista Manager software installation
procedure. Subscription licenses are tied to the Vista Manager database and are maintained across
backups and restores. If, however, you reinitialize the database you will need to get a new license
file.

The base license and optional plugin licenses have separate license periods. If the base license
expires, the optional features will not be available, even if they are still licensed.

You can install multiple plugin licenses (for the same feature) each with their own license period. This
allows you to manage a total number of devices equal to the sum of the devices of the active
licenses. For example, if you have two licenses installed for one plugin that is device-restrictive,
each for 10 devices, you will be able to manage a total of 20 devices through that same plugin.

Vista Manager EX licensing is subscription based. Download the license file from the Allied Telesis
download center. The base license file is applied during the Vista Manager software installation
procedure. Subscription licenses are tied to the Vista Manager database and are maintained across
backups and restores. If, however, you reinitialize the database you will need to get a new license
file.
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B APL

B APL

GEVRT CWIN

Managing your licenses

The initial login procedure includes installation of licenses or the option to select the 90-day trial
license. For more detail, see "Logging into Vista Manager EX after setup" on page 25.

1. To add a new license to Vista Manager EX, or view existing licenses, navigate to System
Management.

2. Then go to the Licenses tab.

3. To add a new license click Update License and select the required license file to upload.

AVZ Allied Telesis  Vista Manager EX a o
System Management
About .

Licenses

Configuration
'90 day trial license started on 1 June Update Licenses

Network Configuration
2023 2024

Apr Jul Oct Jan
Resource Management

Vista Manager EX Vis|a Manager E

Database Management
Allied Intent-based Orchestrator Allied Intent-bas

Licenses e AWC Plugin AWE Plugin - Act
Plugins AWC Smart Connect AWE Smart Cont
AWC Channel Blanket AW Channel Bl

SNMP Plugin SNRP Plugin Lic

On the VST-APL, the Vista Manager EX base license is enabled by default. It is not shown in the
graph. A note on the page indicates this. For more information on licensing options and plugins see
the Vista Manager EX Datasheet.

90-day trial license

As long as you are using Vista Manager EX for the first time, you can use a 90 day trial license. A trial
license is only available on new installations. It is not available on systems that have been previously
licensed, or systems restored from backups that have been previously licensed.

On the VST-APL, the base Vista Manager EX license is enabled by default, and does not give access
to additional features including plugins. If you choose the 90-day trial license during login, this gives
full access to additional features available for Vista Manager EX, including AMF Plus (Allied Intent-
based Orchestrator), and the plugins. There is no grace period after the license expires, but you will
receive expiry notifications at 28, 21, 14, 7, and 1 day/s before expiry. You can add a purchased
license on the license management page at any time before the trial has finished.

The 90-day trial license gives full access to Vista Manager EX, AMF Plus or the Allied Intent-based

Orchestrator, and the plugins. There is no grace period after the license expires, but you will receive
expiry notifications at 28, 21, 14, 7, and 1 day/s before expiry. You can add a purchased license on
the license management page at any time before the trial has finished.
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Ed Dashboard

Vista Manager Dashboard

The Dashboard is the default screen displayed after you have logged in to Vista Manager EX:

AV Allied Telesis  vista Manager Ex Q | 2demo~
Netwaork Details Network Map @, Search name or IP address
e
= -
@ 17 Nodes 17 Up
= =
/
S
o/
- -
24 Hour Event History ?'— —
/
S
45 /
e
28 Lo
" -
eaduarter|
N [ T
(1] ]
- s - = =
0 B
10 1112 13 14 15 16 17 18 19 20 21 22 23 00 01 02 03 04 05 06 O7 08 09 Branchi Branch?
Recent Events ~ View Event Log
Seveity Visiility
Al Alarmo Critical  Abnormal | Normal ANl Visible  Hidden 304 60d  90d  AlTime (3
Showing 1001430 &y Al
O Timestamp = Message Dovice Mates Action
I O !ff_{,‘l Successfully Enabled Allie @ ’
I ] !1‘.17.,5?[ Successfully Disabled Alie @ 7
08:3715
(] S 0128 Startup config has been backed up : defoultefy @ ¥930-master 7
08:04:41
I O B ‘Startup config has been backed up : defaultcfy @ x530+master rd
L

The dashboard displays the following information about your network:

Network Details Shows the number of devices and status (up, down, abnormal or unmanaged).
24 Hour Event History Shows a graph of the last 24 hours of log events history.
Recent Events Displays time, device and any notes or messages relating to each event.

Network Map Displays the network topology in graphical form.

Recent Events
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The recent event logs are displayed. Visible Logs are displayed by default.
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Left-hand menu navigation

On the left-hand side of every Vista Manager screen is an expandable menu. The menu enables you
to navigate to and from the Dashboard, Network Map, Health Monitoring features, Events, Asset
Management, Network Services, Intent Networks features, WAN, User Management, and System

Management. Any optional plugins you have installed will also appear in this menu.

For easy navigation from any window in Vista Manager EX you can expand or collapse the sidebar

menu as follows. A tool-tip will appear when you hover over the menu:

m  Click the hamburger menu icon to expand the menu.
The expanded menu displays the name of each menu option.

m  Click the hamburger menu icon with the small white arrow to collapse the menu.

Expand Menu
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Dashboard

Network Map

Health Monitoring AMF+

Events

Asset Management

Network Services

Intent Networks

WAN

AWC Plug-in

SNMP Plug-in

Bookmarks

User Management

System Management

Collapse Menu
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Network Map

Overview

The dashboard includes an integrated map showing all devices known to Vista Manager EX on the
network. This makes it easier for users to see and visualize what is happening on their network. You
can change the network map’s function by selecting a different map layer. This will be explained

further on in this guide.

You can use the left hand menu to access the integrated map on its own screen by using the
Network Map from on the left-hand menu. From the Network Map you can display details about
sites and groups in the network hierarchy and identify the devices in each site or group.

Network Hierarchy ~ Groups

Network Hierarchy

Branch1

Branch2

HeadQuarter

16Devices 11Up 3Down 0 Abnormal | 2Unmanaged

B Network ~ /7 Q, Search name ol
° g
Create Child Site
Edit Site o
Remove Site b1-sw-x32i

(]

HeadQuarter

O

The header on the network map shows the health of your network and devices at a glance.The
colored labels correspond to devices on your network, where the color displayed on the header
matches the label under the device.

16 Devices 11Up 3 Down 0 Abnormal

Wireless client count

From version 3.16.0 onwards, device counters display the total managed device count and count of
wireless client devices separately.
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You can view the total number of connected wireless clients from the Network Map screen. This
helps you to check the status of both wireless client devices and total managed devices quickly.

The wireless client count updates dynamically whenever the count changes in the AWC plugin.

5Devices 2 Wireless Clients W

5 Devices 2 Wireless Clients  5Up

Network Map buttons

The network map has a variety of different tools for network organization. The following section
explains the buttons that appear on the Network Map page and their functions. These buttons also
appear on other map layers.

Network Hierarchy

"=

The Network Hierarchy button brings up the network hierarchy side menu.

Network Hierarchy Groups
<
e
N

Network Hierarchy

. Add Site
) Sitel

Auto Generate Sites

) Site2
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From this menu, you can see sites and groups that are created on your network. If you click on the
cog icon, you can add or generate sites. The Groups tab displays a list of the groups in your
network, and you can edit them if you wish.

You can collapse this menu by clicking the arrow button on the side of the panel.

When you select a single device, the side menu displays device settings. To see more about device
settings, see "Devices on the Network Map" on page 53.

Map layer drop-down

€ Network

The Map layer drop-down defaults to the Network Map. You can expand the Map layer drop-down
by clicking on it, where you can view different layers of the map.

Depending on the map layer you select, the sidebar offers a variety of different customizable
settings and statistics about your network. For information on the different map layers in more detail,
see "Map Layer" on page 48.

= #& Network [£] DocNet 1 g X
Network
Traffic
VLAN m
P

Edit

You can select any of the following layers: Network, Traffic, VLAN, IP, Edit

Lock topology layout
&

You can use the lock topology layout button to lock the position of all devices on the map.
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Auto generate topology layout

X

You can use the auto generate topology layout button to generate a new map layout. Clicking on
this button creates a confirmation box before you continue. The current positioning and any
floormap image used is overridden when generated. Note that it cannot be selected if the topology
has been locked, or multi-select is enabled. This process cannot be reversed.

Multi-select devices

®  The multi-select devices button enables you to select multiple devices on the map.
m  Once you click this button, you can click any device on the map to select it.

m If you select more than one device, they will be displayed on the left-hand menu.

B You can select the X to remove them from the selection.

m  Select the lock topology button with the multi select button to pan around your map and select
multiple devices without moving them.

With the multi-select button enabled, the side panel appears showing a list of selected devices
when more than one device is selected.

Selected Devices [ ]

g "= ® Network - [E£] DocNet1 ~ s a8 X B=E
Gmmm x2303 X >
G x230-1 X

Comue) (o)

x230-3 il x230-1 N

B On the selected devices list, click the X to remove the device from the selection.

m Click a selected device again to deselect it.

m  Click anywhere on the map to de-select devices.
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When only one device is selected, the side panel shows details of that specific device.

%230-3

Reboot

Device

Status

Backup SSH Delete Device

Basic Information

MNormal

IP Addresses

MAC Address

DocMet1

[ ]
s/ B8 X Q=

Refresh Topology

)

The Refresh Topology button refreshes the network topology.

m  Click this at the bottom left of the map screen to trigger polling.

m  After polling is complete, the web browser will update the status of the equipment and new
devices will appear. The icon turns gray and spins if it is currently processing.

Information icon

The information icon button displays a legend for the links used on the map. Its function changes
depending on what layer you are on. It displays the following on the Network Map:

Network Legend

Physical link

Physical link disconnected
Wireless link

Wireless link disconnected
Virtual link

Virtual disconnected
Tunnel link

Tunnel link disconnected
Network Events

Device Blocked
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Export PDF

=

Click the Export PDF icon to export a .pdf file of your network. A map file will download locally, that
retains any zoom properties that your current map view has. The exported PDF prints the name of
your network and its IP Address in the header.

Backwards navigation

—

Backwards navigation is supported on specific pages. This button lets you move efficiently between
pages during a single task flow on multiple devices, like updating release files or deploying policies.

For example, you could navigate to the Device Info tab from Asset Management, and then browse
through several different tabs from there. Clicking on the browser back button would only return you
to the previous tab, but the backwards button takes you straight back to Asset Management.

Zoom functionality

You can zoom in and out by clicking the (+/-) buttons or dragging the zoom slider. The top cross-hair
button is the reset topology button, which re-centers and resets the zoom of the network map in the
map window.

®

+

Select topology layout

DocNet 1

You can click the Select topology layout button to change between different network topology
layouts.
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You can design different network map layouts, and switch the network map layouts easily. You can
also set a designed network map layout as the default map layout for everyone, or for a specific
user. This means each user will see a well-organized network map when they log in for the first time.

If you save your current layout with the name of an existing layout, it will overwrite it. You can only
overwrite map layouts you create.

Selecting a layout

The Select topology layout button has a drop-down list to show the current layout, and all available
layouts. All the layouts created by the current user will be visible in the drop-down list. Additionally, if
the current user is an administrator user, the layouts created by other administrators are also visible
in the drop-down list.

If a specific network layout has been set as the default layout for this user or everyone, the default
layout is also visible in the drop-down list. For map layouts created by other users, the author's

name is displayed as part of the map name to help identify it.

For more information, see "Changing the Network Map Layouts" on page 74

Map Layer

® Network ~ € Network
“ Network %
Select Map Layer
Traffic

VLAN

IP

Edit

Network map Layer

The majority of the network layer functions have been previously explained in the button section.
This section explains extra information about features in the network layer.

Device status

From the network map, you can check the status of a device at a glance. The status of a device is
indicated by the device’s title background color. The key is located in the header of the Network map

page.

I

@ 16 Devices 11Up 3 Down 0 Abnormal
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Devices will not display a Status if the device does not provide one.

Map Type

From version 3.13.1 onwards, a Map Type column has been added to the Asset Management

page.

To add this column, click the Manage Columns icon, and check the Map Type column.

#= Asset Management

Asset Management

[] serial Number

D Software Version

[[] Notes

MAC Addresses

D Vendor

W4 License Status

b Map Type
& L

|_| Discovery Source

Devices (12) Endpoints (0) offline Devices (1) Groups (5) Provision (0) Firmware Report
Groups Sites
s & 0 ¢
= Q ® All Groups - All sSites -
Manage Columns

Asset Management

Devices (23)  Endpoints (11)  Offline Devices (0) ~ Groups (6) P
Groups Sit
= & @  AllGroups - 4
Device Name IP Addresses MapType =~
~ Cluster

Max Zoom

Max Zoom

The Map Type column aims to differentiate nodes that are:
m  Cluster nodes (Stacked devices),

m Device nodes (Devices seen on the map at all zoom levels),

® or Max-Zoom (Devices that are only seen on maximum zoom).
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Device Links

S )
badicy

s Max-zoom

When you click on a link between two devices on the Network Map, you can view information about
the link, such as the ports connecting each device.

From a glance, you can verify what type of connection and connective status the link has (either
disconnected or connected).

Devices that are physically attached to another device are
indicated by gray links. Hovering over a gray link displays the
port number.

Note that you can create custom links in the edit map layer, see
"Edit map layer" on page 104 for more information.

Click the information icon to see all of the different network link types.
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Network Legend

_— Physical link

------- Physical link disconnected
Wireless link

Wireless link disconnected
Virtual link

------- Virtual disconnected

—_ Tunnel link

------- Tunnel link disconnected

Network Events

@ Device Blocked

From version 3.15.0 onwards, when you click on a link between two devices on the Network Map, it

displays two tabs that represent the two port directions of the link.

@ ) 12Devices 12Up

port1.0.1 port1.0.1 ‘ \
x230-1

e ="

x530I-master

Basic Information
Status Up

Rate 1 Gbps

port1.0.1  port1.03
x230-3
>

x230-1

Basic Information

Status up g

Rate 1Gbps

=

3 x230-3
s bk

[\
A
PRNE

o

Note that the following types of links will not display two tabs:

®  Tunnel links

m  STOAT links where one link is a non-STOAT device and is not learned via any other plugin.

Device status: Down vs. removal from Vista Manager EX

Devices may be put into a Down state instead of being removed from Vista Manager EX entirely.

For example, when an AMF device goes down, the device will no longer be in the AMF topology, but
Vista Manager EX will move the device to a Down state and keep it on the map. For more
information on network map display when a device goes down or is removed, see "Device status:

Down vs. removal from Vista Manager EX" on page 51.
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When a device goes down or leaves the network, is it still displayed on the network map, or is it
removed? The table below describes how Vista Manager EX and the network map behave when a
device goes down or is removed:

Table 1: Device status and discovery method behaviour

DISCOVERY METHOD BEHAVIOUR

STOAT (LLDP) When a STOAT LLDP devices goes down, the device is removed from
the STOAT API and removed from Vista Manager EX. There is no Down
status for STOAT nodes, they are just removed from the map.

STOAT (DHCP-Snooping) There are two scenarios:

m If a STOAT DHCP-Snooping device goes down gracefully and a
DHCP release is sent, it will behave the same as STOAT (LLDP),
i.e. the node will be removed from Vista Manager EX and the map.

m If a STOAT DHCP-Snooping device goes down disgracefully and
no release is sent, the device is displayed until the DHCP-
Snooping entry times out, then it is removed entirely.

STOAT (wireless) If a wireless device leaves the network, the node stays as
'unassociated' for a 5 minute period, when that 5 minute period
expires, the wireless device is removed from STOAT and disappears
from the network map, there is no Down state.

AMF When an AMF device goes down, the device will no longer be in the
AMF topology API, but Vista Manager EX will move the device to a
Down state and keep it on the map.

Nozomi Nozomi doesn't return a state for nodes, also Nozomi won’t remove
down devices from its inventory. What this means is that when a
Nozomi node is learnt, it will display on the network map as Up, even
if the device is physically Down. If a user manually removed the client
from Nozomi, Vista Manager EX will then remove the node from the
map (it will have no Down state).

Forescout Forescout does return a state, this state can be Up or Down.

m If the client state returned from Forescout equals Up, then Vista
Manager EX displays the node in an Up state.

m If the client state returned from Forescout equals Down, then Vista
Manager EX displays the node in a Down state.

m |f Forescout doesn't return any data for the client (the client is
missing in Forescout), Vista Manager EX removes the client from
the map, the client will not go into a Down state.
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Devices on the Network Map

You can interact with devices on the map by:
m Clicking on a selected device.
®  Double clicking on a device, which will show all the device information on the sidebar.

m  Clicking and dragging a device’s icon, to re-position it on the map.

You can change the name and icon of a device learned by Vista Manager by clicking on the device,
and clicking Edit from the three dots menu that appears next to its icon from the side menu.

sl'ﬂ

Reboot

Backup
Backup Area
Fpy SSH

ml Edt fin

01 Delete Device

m Inthe event that Vista Manager has not discovered a device, you can create a custom device and
configure the MAC and IP addresses for the device.

B You cannot customize IP or MAC addresses of devices that are automatically discovered. You can
only customize addresses of devices that you add manually.

The Edit Device popup shows the customizable properties of the device you are currently editing.

Custom Device GUI support

From version 3.16.0 onwards, Vista Manager supports access to devices with third-party GUIs. This
means you can set a custom Management URI to redirect you to a device’s GUI.
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To add a Management URI from the Network map:
1. Click on the device’s icon.

2. Click on the three-dot menu in the device information side panel.

3. Select Edit.

To add a Management URI from the Asset Management page:

1. Click on the three-dot menu next to the device in the table.

2. Select Edit.

After you add a Management URI:

B You can right click on a device on the network map and select the Manage Device option to visit
the GUI. This shows if this device has a supported GUI detected by Vista Manager, regardless of
if it has been set up from the Edit page. We recommend you add the redirect manually in the URI
field.

®m [nthe event that your device does not have a GUI, you will be returned to the previous Edit Device
window on the network map.

If a device is discovered by a plugin, or by AMF Plus Device Discovery, an extra category will appear
under the Basic Information of the device. This shows relevant information about the device,
including how it was discovered and how it may relate to other parts of your network.

Forescout Plugin Information

Operating System Linux

Function IP Camera
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AMF Plus Device Discovery Information

Port Authentication Attributes

Role Supplicant
Authentication Unauthenticated
Authentication Method Mac

RADIUS Username
NAS IP Address
RADIUS Server IP Address

RADIUS Server Group radius

The STOAT feature displays discovered nodes and devices on the network map. For more
information on STOAT see "STOAT Device Discovery" on page 152.

=2

50:8e:49:ea:37:95

hg-access-IE210L-1.0.5

hg-access-IE210L-1.0.5j"d-access-IE210L-1.0.6

The following sections discuss various device functions available from the side menu:
m  "Rebooting a device" on page 57
B "Backing up a device" on page 58

B "SSH (Secure Shell) to a device" on page 59

You can click the button next to the side menu to collapse the menu:

From version 3.12.0 onwards, two changes have been added to Device icons on the Network Map:

m  All devices now display an icon next to the device name on the Device Information side-panel on
the Network Map.

B The edit device feature has now moved from a badge on the icon image, to the three dots next
to the device name. Click the three dots to edit a device.
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New devices appear automatically via polling, or you can click the Refresh icon on a map screen for
an immediate result.

From version 3.13.1 onwards, Vista Manager displays a Discovery Source badge under a device’s
Basic Information, about how the device was discovered.

Device Members

Basic Information

Discovery Source AMF  AMFP-DD

In the Device information side-panel, new tabs including information gathered from plugins are

Identity, Functional and Network Access.

MAC Address

Model AT-TQ6602 GEN2

AMF Information
Area site3
Host Device %530

Role Guest

port

Identity

Port1.0.13

Identity information

discovered from

plugin(s)

Guest Badge

An Guest badge has been added next to AMF Guest devices on the Network Map.

The badges M, C, C/M and G appear on Network layer of the Map and the Asset Management
pages. These stand for:

® M - Master

m C - Client

®m  C/M - Client/Master

B G- Guest
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Rebooting a device

To reboot a device, first select the device that you want to reboot:

x610-link-sw

Reboot Backup

Device Stack

Basic Information

Status
IP Addresses
MAC Address
Mode

Version

AMF Information

Area
Role

Last Backup

55H

MNormal

%610-48Ts-POE+

areal
Member

Dec 9, 2021

Click the Reboot button. A confirmation dialog will appear.

Reboot Devices

Are you sure you want to reboot this device?

m  Check that you have the correct device selected and click the Reboot button if you are sure that
you want to reboot the device.

®  Aninformation message is displayed showing that the selected device has rebooted:

o 07-x908 rebooted

If the reboot fails, you will see an error message as follows:

v Error
06-ar2050 reboot failed
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Backing up a device

To backup a device, first select the device that you want to back up:

x610-link-sw

Reboot Backup S5H

Device Stack

Basic Information

Status

IP Addresses
MAC Address
Model

Version

AMF Information
Area

Role

Last Backup

Normal

x610-48Ts-POE+

areal
Member

Dec 9, 2021

m  Click on the Backup button.

®  Aninformation message is displayed showing that the backup has occurred:

€© x610-link-sw backup requested
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SSH (Secure Shell) to a device

From Vista Manager EX you can open a Secure Shell connection to a device. From this session you
can connect to the device and issue CLI commands as if you were directly logged into the device
itself.

To SSH to a device, first select the device that you want to connect to:

x610-link-sw

Reboot Backup SSH@

Device Stack

Basic Information

Status MNormal

IP Addresses

MAC Address

Mode x610-48Ts-POE+

Version

AMF Information

Area areal
Role Member
Last Backup Dec 9, 2021

® Click the SSH button to start a CLI session.

m  The following window will open in your browser:

AlliedWare Plus (TM) 5.4.6 12/12/16 11:38:39

aster:
Working set join

aster#l]

®  From this session you can carry out any CLI commands in your browser as if you were directly
logged on to the device.
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Changing a Device’s name

From version 3.12.0 onwards, you can rename devices from the Network Map and Asset
Management page in Vista Manager. Two new options have been added to nodes on the Network
Map, where you can edit and reset the names of devices

To edit a device’s name, click on the Edit option of the action tab on the Asset Management page.

Note that the custom name does not overwrite the device’s hostname.

Device Name Priority

You can name a device through different plugin and AMF node menus. The device’s name on the
map will be determined by Vista Manager’s internal hierarchy. The hierarchy of names is as follows:

1. User-Defined name (from Network map)
2. AMF (non-guest node)

3. AWC plugin

4. SNMP plugin

5. AMF (guest node)

For example, a device which has separate names set in the SNMP plugin and AWC plugin will have
its AWC name display as it is above the SNMP name in the hierarchy. It is important to note that
devices receive their name on the network map via polling, and will be updated after polling. If the
name is an IP Address or MAC Address, it will be used according to the hierarchy.

From version 3.12 onwards, the user-defined name (the name that you give a device from the
Network map) will display as it takes priority over how the device was discovered.

Critical Events

Critical events are displayed on the network map as a red number on the alert icon of the device
they occur on. Click on the device to display a pop-up with device information and a list of critical
events. Dismiss events by clicking on the red-cross next to the event description.

b2-gw = €  Network
De

ete Device

Device Members Rules

Basic Information

Status Critical

Last Backup Mov 29, 2021

Network Events

Tunnel Down (3)
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Tunnel Monitoring

When you click on a device link, the left-hand side displays information about tunnel monitoring on
the map.

You can see the speed rate of the link in gigabits per second (Gbps) under the status column. This
speed will scale based on the speed of the link.

Tunnel monitoring automatically detects supported tunnels between an AlliedWare Plus device and
a remote device that is not part of the network. The map is automatically updated if there are any
changes to an existing tunnel or when a new tunnel is configured. For information on creating
custom links see "Creating custom links" on page 104.

@ 9 Devices 9 Up

C_AR4050S <= C_Spokel - ™, . ;B .:‘}f i
AMF Information

Status Forwarding

Type AMF /N
C_AR40508 C_Spokei
Device Type Router

Interface VlIink201

C_Spoke1 ST —

Device Type Router g
Interface Vlink200

The map detects IPv4 PPPoE configuration and display these links and devices on the map similar
to the tunnels. You are able to configure interfaces and bandwidth on a custom link so that the link
utilization data is available. Click on any link on the map to view the link utilization. For information
about how to view link utilization see"Creating link utilization rules" on page 89.
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571-bd1-dist-sw1
€«
s1-core

Basic Information

Status

Rate

The Link Utilization graph also shows the link Bandwidth. This label will change depending on the
speed of the link (such as Kbps, Mbps, or Gbps).

Link Utilization

100
75
50
25

0

Last Updated 4:22:20 PM

site1_building2_ring_sw1

Bandwidth 1 Gbps site1_building2_ring_sw4

25

Link Utilization %

50

75

100

port1.0.2

16:14:00

16:16:00 16:18:00

Tx from site1_building2_ring_sw1  Tx from site1_building2_ring_sw4

port1.0.1

16:20:00

16:22:00
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Monitoring non-AMF devices

= A
central-gateway-viw

To add a non-AMF device to the map, see "Detecting non-AMF devices on the Network Map
Layer" on page 65. After manually adding non-AMF devices, you can view them on the map.

Merging network nodes

You are able to merge nodes on the network map, which is useful if there are duplicate nodes on the
map. In most cases Vista Manager EX is able to merge topology information including duplicate
nodes. Device nodes are discovered by STOAT, for more information about STOAT see "STOAT
Device Discovery" on page 152. However, when Vista Manager EX can’t automatically merge nodes
together, you can:

®  manually merge duplicated nodes and have them appear as a single node
B un-merge nodes that have been manually merged

B see what nodes have been merged and where their information was obtained (source).

To merge devices:
1. Go to the Network Map, and select the devices you want to merge.

2. Right click to see the context menu.

Selected Devices Merge Devices < Network v [7] Layout1 v S b X o6
0 wkimaser — souee x
[ tokimaster source. X

3. In the Merge Devices dialog, click Merge.
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Merge Devices

@ Listed devices will be merged into a single device managed by AMF.
The resulting device can be un-merged at any time.
Device histary for non-AMF devices will be lost.

Primary Device MAC Address Source
Loki-Master AMF Plus
Device 1 AMF Plus
Device 2 AMF Plus

Device 3 e AMF Plus
canml |m

4. The nodes are merged into one. You will see more details in the left side panel.

Loki-Master

5. In Asset Management you can see which nodes are merged at a glance with the ‘Merged’
badge.

Loki-Master m Merged

To un-merge devices:

6. Go to the Network Map, select the merged device and right click to see the context menu. A
similar merge dialog will appear showing the duplicates.
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AV Allied Telesi

O Lok

Basic information

Stetus
1P Addresses

MAC Address

Model

Serlal
Vendor

AMF

Ares
Role

Last Backup

S Vista Manager EX | Loki

Loki-Master Bl vewed 3 Reboot ok

gackup
Backup Area
S5H
Undo Merge Device
Primay MAC  Delete Device
AMF Plus MAC
STOAT MAC

7-AT-x530L-18GHXm-Loki-Area-2

SNMP MAC

Sites

Groups

Backup Device

S5H to Device

Undo Merge Device

7. If you click Continue, then the nodes will be un-merged into their previous state.

. 2 Network

v B v S L X8 ®

Undo Merge Devices

© Final copy TBC
Listed devices will be un-merged
Device history for merged (non AMF) devices will be lost.

Device
6 Loki-Master [

Loki-Master
sw3-x3

Loki-Master

s300-SBx908NG

Discovery Source
AMF
AMF Plus

SNMP

coneel

Detecting non-AMF devices on the Network Map Layer

The network map can detect non-AMF devices that have an AlliedWare Plus device connected to
them by a tunnel. The non-AMF device is represented as a cloud icon. The hostname is the IP
address of the tunnel destination.
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Enabling RADIUS on devices from the Network map

You can enable RADIUS on devices in order to configure them in the RADIUS Network Services
section. You are able to enable RADIUS for devices on the network map.

Step 1. Navigate to the Network Map
Step 2. Right click one device you want to check. A context menu will be displayed
Step 3. Select Enable RADIUS server

Step 4. Repeat step 2 and 3 until all the devices you want to check have been done

For more information on how to configure RADIUS in the Network Services section, see "Local
RADIUS Server" on page 218.

Sites and Groups on the Network Map

From version 3.13.1 onwards, the network maps are made simpler. Vista Manager now offers the
ability to focus on one site at a time, with improved flexibility to the Auto Sites Generator.

The existing Auto Generate Sites feature has been redesigned:
m  The Network Hierarchy side panel has two tabs: Sites and Groups.

m  The Configure Sites button is only available for Admin users. This menu includes three sub-menu
items: Add Site, Auto Generate Sites, and Remove Auto Generated Sites.

C613-10634-00-REV B Enabling RADIUS on devices from the Network map | Page 66



- € Network No lay:

Sites & Groups:

Sites Groups
P " ® Network ~

Conﬁgur@%\les -3

Test

[ m—

See the following sections for more information:

m  "Groups" on page 67

m "Auto-Generating sites" on page 68

m  "Manually creating a site" on page 71

m  "Regex format separator support for auto-site generation" on page 73

m "Sites and Groups Permissions" on page 317

Groups

Groups are collections of network devices chosen by a user. Groups may include devices from
multiple sites and can easily be created on the Network Map. AMF areas are automatically
converted into groups. When a new device is added to a group, assigned users automatically have
access to the device. For more information on how to configure groups in the Asset Management
menu, see "Creating Groups in the Asset Management menu" on page 172.

1. To create a group, click on the Network Hierarchy icon.
2. Then, click on the Groups tab in the newly opened sidebar.

3. Right click on the icon of a device you would like to add to a group to bring up the settings.

4. Mouse over the Groups tab, and select Add Group.
2\
E Si’[esd 4
Groups b Add Group
Manage Device Add Device To Group 2
a Backup Device imove Device From Group »

Enable RADIUS Server

F SSH to Device -master

If you would like multiple devices to be grouped together, you can select multiple by either:
® holding Ctrl and clicking on multiple device icons before adding to the group, or

B clicking the multi-select button, and then selecting multiple devices
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When Multiple devices are selected, they will appear with a blue circle around them, and appear in
the Selected Devices left-hand menu.

L
o=

— femm)
AR1050V R

An Add Group window will appear, where you can name the group.

Auto-Generating sites

You can manually or automatically assign a device to a site. A site is a location, building, or floor
where devices are stationed. Create sites on the network map by clicking the Network Hierarchy
button and accessing the left-hand menu that appears.

Vista Manager can create auto-generated sites. Note that auto-generated sites are read-only, and
cannot be edited after they are generated.

1. To auto-generate a site setup, click Auto Generate Sites from the Sites & Groups tab on the
Network Map.

'u:

Configure Sites £

Add Site

Auto Generate Sites

Remove Auto Generated Site{b q
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2. The Auto Generate Sites window will appear, where you can customize the regex pattern.

3. You can either enter a regex string, or choose to use an individual separator. For more information
about regex strings, see "Regex format separator support for auto-site generation" on page 73.

Auto Generate Sites

© Auto-generate sites based on hostname
Organize your devices into sites based on location or department to simplify
visualization and config management. For best results, ensure all devices use
a consistent naming convention.

Re-generating auto sites will remove existing auto sites and auto layouts for
all users. User Network Topology Layout must be re-assigned.

Re-organize existing user dsit
Devices assigned to user created sites will be assigned to auto generated sites where
appropriate

Pattern

Separator String

7]*) for hostname Location_BuildingFloorHost the

String Regex

Cancel

4.

If a device fails to be auto-assigned, it will remain in its original manually created site if it existed

prior.

When a new device joins the network after you auto-generate a site, Vista Manager will try to
classify the hostname with the existing sites hierarchy automatically. If no existing sites exist,

Vista Manager will create new sites for it.

If the hostname matches the parent site but not child sites, Vista Manger will create sites under

the same parent site.

Click Preview Sites to get an example to confirm the generated setup.

Preview Sites

» vaa Auto
» x5300 Auto
» X230 Auto

» AR4050S Auto

-

Note:
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Removing a site in the preview window only stops the automatic assignment. It does not
remove the site from Vista Manager EX.
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You can decide whether the existing manually created sites should be re-organized after the new
auto-generated sites are confirmed.

m If you choose to re-organize the existing manually created sites, Vista Manager will try again to
auto-assign a new generated site for all the managed devices. This includes the previously
assigned devices.

m If you choose not to re-organize the existing manually created sites, the managed devices that do
not belong to any manually created sites will attempt to auto-assign to the new auto-generated
sites. The manually assigned devices will remain in the manually created sites.

Removing Auto Generated sites

When you click the Remove Auto Generated Sites button, all Auto-generated sites and their
corresponding layouts will be deleted. All devices assigned to Auto-generated sites will be reset.

Configure Sites £3

Add site
Auto Generate Sites

Remove Auto Gen erati%Sites

Auto-generated sites also generate Layouts with the same names as the sites. This allows you to
easily switch between site layouts. See "Changing the Network Map Layouts" on page 74 for more
info about Layouts.

Filtering the sites in the Asset Management menu

You can filter by Sites in the Asset Management > Devices tab. This filter can be used in
combination with the pre-existing Groups filter on the Devices tab.

Asset Management

Devices (12)  Endpoints(0)  Offline Devices (1) Groups(5)  Provision (0)  Firmware  Report

Groups Sites

T Q ® | AllGroups = Allsites & -

Device Name = 1P Addresses All sites

Site 1

Test

Note: Guest and 802.1x nodes won't appear when filtering devices by a specific site even if they
are connected to a device located in that site, because those devices do not explicitly
belong to that site.
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Take note of the following limitations:
B Automatic generation of sites supports up to 3 levels of network.

B Automatic generation of sites overwrites existing sites if they have the same name. Renaming or
removing auto-generated sites stops the automatic assignment.

m  When the sites are overwritten, the devices will be moved to the new auto-generated site. If the
overwritten site is also an auto-generated one, it loses its auto-assignment functionality and gets
overwritten by the new, auto-generated one.

m If asite has a duplicate name with an existing one in the preview stage, a confirmation dialog pops

up, indicating the site will be overwritten.

When a new device join a network after sites have been automatically generated, Vista Manager will
try to classify the device’s hostname using the existing hierarchy automatically. If no sites exist then
Vista Manager will create a new site for it.

You can configure access to read/write permissions for specific sites for each user. For information
about configuring permissions for sites see "Sites and Groups Permissions" on page 317.

Manually creating a site

To manually create a new site yourself, click on the Network Hierarchy icon to bring up the side-

menu.

You can manually create sites via the Sites & Groups side panel by clicking the Configure Sites
button and selecting the Add Site button.

Configure Sites €2

Add Site
Auto Generate Sites

Remove Auto Generated Sites

Similarly to automatically generated sites, once a site is created, an automatically generated layout
with the same name will be created for each user who has access to this site.
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This change applies to all layouts, including Auto-sites layouts, user-created layouts, and the entire
network.

For non-admin users, the layouts they are given will depend on which auto-generated sites they
are given permission for. Any auto-generated site that the user has permission for will have a
corresponding layout for that user.

Each user has their own layouts based on the auto-generated sites. Layouts are not shared
between users, so each user can make their own changes to a layout and it will not affect the
layouts for other users.

Likewise, if permission is removed from some auto-generated sites, the layouts for those sites will
be removed. If a user saved their own copy of an auto-generated layout, that copy will not be
affected.

Layouts that were originally created from auto-generated sites will appear in a nested format.

After running the Auto Site Generator again, the selected or default layout of all users may
change.

A non-admin user will only be able to see dot1x supplicants if the user has permission for a group
and the group contains the dot1x supplicant.

When sites are collapsed, a blue circle icon next to the site shows how many devices are in this
collapsed site.

When migrating from an older release of Vista Manager any device that is a 802.1x supplicant and
belongs to a site will be removed from the site during the database migration. It is very unlikely that
a dot1x supplicant will have been explicitly added to a site. The device will now implicitly belong to
whatever site the device is attached to.

To add a device to an existing site, right click on the device you would like to add to a site, then
mouse over the sites tab. Mouse over Add Device to Site, and then select a site to add the device

to.
i
EEEEE  Sites Y Addshe
N/ Groves " AddDevice ToSite »
i o 5518200 et
15,16 laoz ineo ne
[ Site 3
i
== |
You can also create a site from the Network Map by right-clicking on device(s) and selecting Add

Device(s) to New Site. Note that a device cannot be assigned to multiple sites.
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Regex format separator support for auto-site generation

You can select Regex as a sites separator for auto site generation. This feature allows you to define
a custom separator pattern inside square brackets, where it will be read, and split into sites, child
sites, and devices based on hostnames.

Vista Manager reads this data in a Site > Child Site > Device order.

For example, you can use an underscore inside square brackets as a Regex pattern for the following
output:

Hostname format: CHCH_ITO1SWO1
Regex pattern: [_]

Results:

® One site named: CHCH
B  One Device named: ITO1SWO01

Another example is:

Hostname format: CHCH_IT01-SW.01
Regex pattern: [_-.]

Results:

B One site named: CHCH,

B One child site named: ITO1

B One child site nested in the ITO1 site named: SW

® One device named: 01

Click Save after importing the regex string to store it.

If a site called Office has a child site named Building1, and a new device classified as “Office,
Building2” joins, then Vista Manager will create a new child site for Building2 with the parent as
Office.

Note: If the hostname fits any of the following examples it will be seen as an invalid hostname.
Automatic site generation will not be performed on the below hostnames.

m  starts with a separator (such as '_CHCH_Building'),
B ends with a separator (such as 'CHCH_Building_"),

B or has consecutive separators (such as 'CHCH__Building')
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Regex Hostname matcher support for auto site generation

You can select Regex as a site hostname matcher for auto site generation as well. This feature
allows you to define a custom regex string pattern to extract and create sites based on hostnames.

The following examples show example patterns:

Hostname format: CHCH_IT0O1SWO01
Regex pattern: ([A-Za-z]+)_(\w{2})(\d{2})

Results:

® One site named: CHCH
B  One child site named: ITO1

Hostname format: aklvaa01, aklswi02
Regex pattern: (\w{3})(\w{3})(\d{2})

Results:

B One site named: akl

B One child site named: vaa

B One device named: 01

B A second child site named: swi

B A second device in that site named: 02

The input regex string will be stored after clicking Save.

Changing the Network Map Layouts
On the Network Map, double click on a site to switch to the corresponding Layout.

Click the top left button group of the integrated map to collapse all visible parent sites. Note that
child sites will not be collapsed.

When viewing layouts for auto-generated sites, sites (including child sites) are expanded by default.
When expanding or collapsing sites, they will be saved like this automatically.
Note: The default layout for all users is the Entire Network. The Entire Network layout cannot be

deleted. The Entire Network layout is read-only; it is not possible for the user to delete this
layout.
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Layouts of auto-generated sites and manually created sites have an Auto badge displayed next to
their names in the layouts dropdown menu. Layouts are displayed in alphabetical order.

- € Network v Entire Ne... ~ /s @& - X
o3 Save As New Layout

Entire Network

AR4050S5 Auto

AS40505 Auto @

When you make changes to the Network Map, they will be automatically saved, including:
m  Changing the position of devices/sites,

m  Expanding/collapsing sites on the map,

m Changing the background image,

B and changing the zoom level of the map.

In the User Management menu, you can set default layouts to your admin user account, as well as
other users.

Network Topology Layout None bl

@ Cancel ﬂ

Layouts can be created from the
map None

®  When an Admin user edits their details, the user can see all accessible layouts in the Network
Topology Layout drop-down list. This includes the entire network, all Auto-Generated Layouts, all
manually-created site layouts, and all user-created layouts.

m  When an Admin user is editing another user’s details or creating a new user, the Network Topology
Layout drop-down list only includes layouts that are allowed to be shared between users.

Adding a new layout

You can create new custom layouts by clicking and dragging devices around. You can save them as
a new layout from this menu by clicking the ‘Save as new layout’ text.

1. Click on the Select topology layout drop-down.

m If this is your first layout, the default will display as Entire Network.

m  Otherwise, it will be the name of the currently selected layout.

® Network Entire Ne...

Select topology layout
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2. Click Save as New Layout.

B You can duplicate an existing layout by saving the current layout with a new name.

Entire Ne...

Entire Network

&

’

&

Save As New Layout

Y

3. Enter a name for your new layout and click on the save icon to save the layout.

Entire Ne... ~

Cancel

&

’

&

Layout 3

Entire Network

4. The new layout will become the currently selected layout. You can make any changes to the zoom

level or layout of devices on the map.

m  Changes will be saved to the new layout automatically.

5. Click the trash icon next to the layout you would like to delete to delete the layout.

hd Layout 3 b

Entire Network
a
b

Layout 3

&)

&

Save As New Layout

/s

&

]

(8
1

m  Users can only delete map layouts that they created.

B You cannot delete the Entire Network layout.
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6. On the confirmation dialog, click Continue to delete the layout.

Delete Layout *

Cancel m

Note: Hidden devices are specific to the layout. You can hide devices on a per-layout basis, and
they will be hidden for any user using that layout. For information on hiding devices see
"Show/Hide devices" on page 105.

Layout 3 will be permanently deleted

Syslog Rule alarms
On the Network map a bell icon will appear next to a device that has a syslog event that matches a
rule. Click on the bell icon to open up the side panel displaying its syslog details. Here, you may also

choose to dismiss the alarm.

For information on setting up syslog rules and information on events, see "Events" on page 127.

"%  Network

Basic Information

Status Normal
IP Addresses 10.36.200.130
Type Terminal
Metwork Events

peer_TB130

R TRwE - g
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View Details of Stacked Devices

You can click on the View Detail ( 5) section of
the stack member side-menu to monitor the
state of stacked devices in your network.

Click the + icon by your stack to expand it.
This lets you view all stack members and
associated stacking links. If a stack is fully-
formed, you will also see an outer link
completing the stacking loop.

my510Stack

The Stack tab displays some basic stack-wide
information such as:

B a list of stack members
B current status of each stack member

® which stack member is the master

@ ) 23 Devices 20Up 3 Unmanaged

my510Stack

Reboot SSH

Backup

Device Stack

Stack Information

Stack Master ID

Stack MAC Address

Virtual MAC

Disabled Master Monitoring
Resiliency Link
Management Subnat

Management VLAN

Stack Members (4)

D Device Type Status

,

2 x510-52GPX

x510L-52GP Ready

Ready

J PoakB0L 3G . Rt g

Enabled

Enabled

vlan1000

4085

View Detail

*3 Network v

9%47;

[

g

Each stack member has an icon showing its stack member ID. Click on the stack on the map (blue
highlighted area) to see its information. When a stack is expanded:

m  All stack members and associated stacking links will be displayed.

B The stack master has an ‘SM’ badge indicating that it is the stack master.

m  Click on each link to see which device type and interface is on each end of the link.

When a stack master leaves the stack, the stack master badge will update to show next to the new

stack master.

An event bell icon indicating any network events will still be displayed on the stack master.

The stack remains expanded when you leave and navigate back to the map later.

Note:

If a stack member goes down, its position will move to the bottom of the stack to indicate its

current down status. The hostname/member ID will stay green and not change to red.
Individual stack members cannot be moved.
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Click View Detail to see detailed information about the stack. This opens up the device details page

showing:
< [ < | my510Stack SSHto Device  Backup Device
Device Info Stack Notes Guest Devices Configs Licenses File System

Stack Information Stack Members L
1 Status Ready
Stack Master ID 2 Backup Member
Role Backup Member
Stack MAC Address 2 m
Active Master d
Priority 1
Virtual MAC Enabled 3
Backup Member MAC Address
Disabled Master Monitoring Enabled
4 Model x510L-526P
Resiliency Link vlan1000 Backup Member
Board Revision B-0
Management Subnet
Serial Number
Management VLAN 4085
Resiliency Link Up Yes
Resiliency Link  Successfully receiving health checks from the
State Active Master.
Stack Ports
port1.0.51
Neighbor ID Z
et e A N e s rF SO . . ot

m  Stack Information: Stack Master ID, stack MAC Address, virtual MAC, disabled master
monitoring, resiliency link, management subnet, management VLAN

m Stack Members: Stack ID, status, role, priority, MAC address, product type, revision, serial
number, resiliency links, state, stack ports

For more information about the device details page, see "Accessing device details" on page 152.
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Active Fiber Monitoring with stacked devices

With enhanced information display possible for stacked devices, support has been added to display
Active Fiber Monitoring Plus (AFM Plus) links. You can see links between members and fiber tamper
alarms (red bell icons) when a link has been tampered with.

As an administrator, you can use this information to check on the physical links, dismiss the fiber
tamper alarms and/or change AFM settings on specific links.

1.ldentify a stack with an event bell icon.
This means there has been an event on the stack, for example,

e 9 tampered links.

2.Hover over a stack to see the ‘+’ symbol. Click on ‘+’ to expand it.
You will see the stack master showing the yellow and black event bell

my51 0}Sirz18ilq | icon, and fiber tamper alarms on stacking links (red bell icons) that

have been tampered with.

3. Click on the stack (blue highlighted area) to enable the side panel. Fiber tamper alarms are shown
at the bottom of the side panel, under Network Events.

my510Stack " Netwek LV s @ X © Qs

Reboot  Backup  SSH

Device Stack e

Basic Information

i)
7

-

arch nam

Status Normal

IP Addresses

MAC Address

Model ¥510-52GPX o
Version 5.56.0-2.3

AMF Information

Area local

Role Member

[
my510Stack

Network Events

Environment Alarm (2)

Fiber tamper alarm set (2) 6 X

Note: Fiber tamper alarms will remain until you have dismissed them. This removes the red bell
icon and reduces the event bell count on the device stack

Enabling Active Fiber Monitoring on a stack

To change settings for AFM on a stack, expand the stack.
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With the stack still expanded, click on a link inside the stack that you wish to enable/disable AFM
for. This highlights the link.

On the side panel, click on the AFM settings icon to enable/disable AFM.

1

1652

Active Fiber Monitoring
Enabled

i H Network -
—~

Device Type M
Interface Stackportneighbor2 \
: \
Device Type \ \v
Interface Stackportneighbor1

4«  Active Fiber Monitoring !

ﬂ Once enabled these settings will override any
existing device settings. Vista will not display the
current settings from the device.

—

Debug Disabled
Sensitivity medium
Interval (seconds) 5
Baseline Interval (seconds) 5
Baseline (readings) 12
Trap Enabled
Note: Only links inside a Virtual Chassis Stack are supported for viewing and editing AFM settings

Note:

in Vista Manager EX.

If AFM has already been enabled from the CLI, the AFM settings icon will not be visible on
the side panel of Vista Manager EX.

B This feature requires AlliedWare Plus version 5.5.0-0.3 or later.

m Detecting tampered link events requires AlliedWare Plus version 5.4.8-1 or later.
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Dismissing Fiber tamper alarms

You can dismiss a fiber tamper alarm in 3 ways:

m  Click on the stack, like in Step 4. Dismiss the Fiber tamper alarm set event under Network
Events on the side panel.

m Click on the red bell icon. Dismiss the Fiber tamper alarm set event under Network Events
on the side panel.

m Dismiss either the stack event or stack member event in the Event Log.

Loop protection

The loop protection feature helps prevent loops in your network. Network loops are also known as
Layer 2 switching loops or bridge loops because they occur at Layer 2. Put simply, a loop occurs
when a network is cabled in a way that allows traffic to get to a destination by multiple paths.

Loop Protection

Loop detect  Thrash limiting

Enable LDF Port profiles + Create profile

site1_building?2._ring_sw3
LOFinterval Fast block
Default Profile

o 10
Action Types Action Timeout

(O siockalltraffic, ake down the link(Link down) L]

(O petailsare logged, no action is applied(Log only)

(O Blockallraffic, keap the lik up(Fort disable) ActionDeteyTime,

(@ Blockallaffic for Vian(Vian disable) 0

2310

(O Avlias no protective action(Action none)
Enable LDF

site1_building?2_ring_sw2

LDFinterval Fast block

1357 9 mmis W nzm
MRS EEEE e 25 26 M
NNFE U NNN NEEN || [
24 6 8

10 12 14 16 18 20 22 24

Enable LDF
site1_building2_ring_swa

LDFinterval Fast block

® 10

230106

The loop protection feature helps you manage loop protection settings of your AlliedWare Plus
devices in the Vista Manager GUI. You can use Vista Manager to manage both the loop detection
and thrash limiting of your network. This feature is supported when devices are running firmware
version AlliedWare Plus v5.5.0-0.1 or later.
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Select a device, or select multiple devices with the multi-select button, then right click and select
Loop Protection to open the menu. You can select one or multiple (up to 10) devices from the
network map layer for loop protection configuration.

o

s B X o

site1_building2_ring_sw3

| Sites [ m

Groups »

Backup Mode

SSH to Node

é Loop Protection
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Loop Detection

When you land on the Loop Protection page, the Loop detect tab will be selected. On the Loop
detect tab you can configure loop detection for the selected devices. The Enable LDF button lets
you enable or disable loop-detect frames (LDF) for each device. The LDF interval slider lets you set
the loop-detect frame interval. The Fast block button lets you enable or disable fast block.

Loop Protection

Loop detect Thrash limiting

x230-3 Enable LOF @
LDF interval Fast block
® - -9
1 3 §5 7
g EEEE s
i — L L L1 I B
2 4 6 B8

For loop detection port profiles, you can choose the action type, the action timeout, and the action
delay time for the profile. By default the settings of the Default Profile apply to all ports on the

device.
Port profiles + Create profile
Default Profile
Action Types Action Timeout
® 7
O Block all traffic, take down the link{Link down)
. L A Action Delay Time
Details are logged, no action is applied(Log only)
® 0

Block all traffic, keep the link up(Port disable)

Block all traffic for Vian(Vian disable)

Applies no protective action(Action none)

O ® O O
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To create a new profile, click on the + Create profile button.

Port profiles + Create profile

Add Profile

Action Types Action Timeout

[ ] 0

O Block all traffic, take down the link(Link down)
) N ) Action Delay Time
O Details are logged, no actien is applied(Log only)
® 0
O Block all traffic, keep the link up{Port disable)

O Block all traffic for Vian{Vlan disable)

O Applies no protective action{Action none}

Cancel Save profile

You can select multiple ports across one or multiple devices, and apply the profile to all of them at
the same time. Click on Save profile to save the changes.

Thrash Limiting

Thrash limiting, also known as rapid MAC movement, detects the rapid changes in MAC address
table entries that a loop causes, and takes action to deal with the loop. It is highly user-
configurable—from the rate that indicates a loop to the action for the switch to take.

On the Thrash Limiting tab, you can configure thrash limiting for the selected devices. The Thrash
Limit slider lets you set the thrash limit.

Loop Protection

Loop detect Thrash limiting

X230-3

Thrash Limit

[ ) 10
1 3 5 7
e HEEE 2
§ — FENNE B
2 4 & 8
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For thrash limiting port profiles, you can choose the action type and action timeout. You can then
assign the profile to device ports. By default, the settings of the Default Profile apply to all ports on

the device.

Port profiles

O

+ Create profile

Default Profile

Action Types Action Timeout
© Disable mac address learning(Learn disable) .
O Block all traffic, take down the link(Link down)
O Block all traffic, keep the link up(Port disable)

Block all traffic for Vlan(Vlan disable)

O Applies no protective action(Action none)

To create a new profile, click on the + Create profile button.

Port profile

S

=+ Create profile

Action Ty,

O OO0O0O0

Add Profile

pes Action Timeout

Disable mac address learning(Learn disable)
Block all traffic, take down the link(Link down)
Block all traffic, keep the link up(Port disable)
Block all traffic for Vlan(Vlan disable)

Applies no protective action(Action none)

Cancel

Save profile

You can select multiple ports across one or multiple devices, and apply the profile to all of them at
the same time. Click on Save profile to save the changes.
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Traffic map Layer

When selecting the Traffic map layer, the map switches
modes and displays the traffic menu on the left-hand side.
The links between devices will change to colored arrows
based on the link utilization key, that indicate the utilization
percentage of that link.

As a user, you are:

able to create a rule which generates an action on a link
that no longer has high utilization

notified when any links have a high utilization (consistently
oversubscribed)

able to create a rule which generates an action on any link
having high utilization over a period of time (consistently
oversubscribed)

Traffic Protocol
Network Traffic
10m 1h 12h  24h Custom~
Link Utilization
0-25% 25-50% 50-75% 75-100%
I I

Top 5 Interfaces by Utilization

able to see an event when a link that previously had high utilization no longer has high utilization

(recovered)

able to configure the percentage/time period for defining high/recovered link utilization

Link utilization is color coded so you can view which areas of your network carry different levels of
traffic. If you click on a device, you can monitor the traffic going to and from that device. If you click
on a link on the map, then you can monitor the traffic between the two devices.

%230-1

Link Utilization

100

50

50

100

Average Utilization

x230-3

0

4.29 Kbps 4.34 Kbps
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The ‘i’ icon now shows the Link Capacity when clicked. This shows in the links between devices, as
o well as the meaning for icons that may appear beside devices.

Link Capacity

Rounded to closest size

100MB
16
2.5G
56
106G —
406G —
100G —
Capacity
unknown
Advanced Features
@ Application Priority
Events
Q DP1 or sFlow enabled

° Vista Manager is not
receiving sFlow data

Traffic Protocol

Protocol Traffic

10m 1h  12h  24h Customw

]

The protocol tab displays the protocol traffic. You can select a time or a custom date to view
network traffic. You can monitor any link by clicking, to show bi-directional traffic on all aggregated
ports over the last 24 hours. You can replay network traffic from up to 24 hours by clicking the play
button on the left-hand menu.

Custom link monitoring

You can view custom link information from the Traffic map layer. However, in order to view link
utilization information, you must first configure the interfaces through the Edit map layer. For
information about how to create a custom link see "Edit map layer" on page 104.
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Creating link utilization rules

" ® Traffic No layout B X @

P

Set expected link capacity

Create link utilization ruleo

Right-click on the link

to display the menu

Create Rule

Rule Name *

A

Enter Mame

Match Criteria
Link
%230-1 (port1.0.3), x230-3 (port1.0.1) i

High Utilization Percent *

Recovered Utilization Percent *

Time Period in Minutes *

Enter Minutes

Action 1

No Action v

Add action4
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If you would like to create a link utilization rule, you can
do so by right-clicking on the link you want to monitor,
then selecting Create link utilization rule.

On the left, the Create Rule panel will appear. Here you
can create a rule to monitor link utilization on the Traffic
map and see related information.

Click on the Save button to save your rule.

Click on the tunnel link to view its link utilization
information. The side panel pops out showing the link
utilization and its related information.

Note: There are some limitations to take note of:

m This feature is unable to detect the up/down status of a
remote device.

m If two WAN tunnels are connecting to the same device,
two cloud icons will show instead of one. Vista Manager
is unable to discover if two IPs are on the same device.

® Removing or configuring interfaces on automatically
discovered tunnels are not possible. You can only hide a
remote device and its associated links.

m Link utilization data of a port connected to a server is
not supported unless the connection is via a tunnel.
Manually adding a remote device and a custom link, and
specifying the associated interface will display its link
utilization data.
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You can see all created rules on the Events page. Select Rules to see all created rules and enable/
disable or edit/delete them. For more information about the Events page, see "Events" on page 127.

Eventlog  EventArchive  Syslog  Reports  Rules

Rules ©
Rule Name Rule Type Criteria Actions Status Action
Link Utilization Test Link Utilization High Utilization Percent: 75 Recovered Utilization Percent: 50 Time Period i No Action @) Enabled

Edit

to1of Page| Doiete

Set expected link capacity

You can set the expected capacity for a custom link
you are monitoring on the Traffic map layer. To set the
capacity, right-click on a custom link and click Set

expected link capacity.
Set expected link capacity

wojsno

Create link utilization rule

This will open the Set expected link capacity dialog
box, where you can input the expected capacity for

your custom link.

Set expected link capacity custom € 2 custom

© The Mbits/sec value entered will affect the visual appearance of a link in the map
Link width represents bandwidth capacity

Expected Capacity (Mbits/sec)
x230-2 ¥ x230-3

x230-3 7 x230-2

Cancel Save

]4_01 [).0.? i_i C_AR4050S g = & Traffic Mo layout g X
Link Utilization
30/11/21,1:22 PM - 30/11/21,1:32 PM #

100 T .

- S\

- C_Spoke2 B

: C_Spoket

25

50

75

100

A
Average Utilization 15.1.1.2 Eittia 14.0.100.2
441Kbps | . 4229 Kbps C_AR4050S
0
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Check speed of AMF guest links

From version 3.17.1 onwards, when selecting an AMF Guest Link on the Network map’s Traffic map,
you can see the link speed on the left side panel from the amf-guest-link tab.

When selecting an AMF Guest Link on the Network > Traffic map, the link thickness indicates the
speed.

You can find the link capacity scale by clicking the info icon near the bottom left of the Network map.

v e 3

Advanced Traffic Monitoring with sFlow

You can monitor network traffic using Vista Manager’s sFlow (sampled flow) feature on the Traffic
map layer. After configuring sFlow on your network devices, you can use the Advanced Traffic
Monitoring section to view information about network traffic, protocols, and applications.When
sFlow is active, a green icon will appear next to the device you have decided to monitor.

With sFlow configured, the Advanced Traffic Monitoring section will appear at the bottom of the
sidebar when you select a device. When you first click on a device without sFlow configured, there
will be no data.

From version 3.13.1 onwards, support has been added to change the IP Address of the sFlow
server.

This IP is used by devices with sFlow enabled for its Collector IP, and for SMTP when sending
license expiration email alerts. Note that If this Server IP is changed, you will need to re-configure
sFlow on the AlliedWare Plus devices that are configured to use it.

System Management
About
Configuration

Configuration

Network Configuration

HTTPS

'TPS, you will need to generate a Certificate Signing Request in Vista Manager, arrange for it to be signed by your local Certificate Authority, then upload the

etails.
Plugins @

Server Configuration

Vista Manager Server IP

0B

To change the IP Address for sFlow, go to System Management > Configuration.
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Under Server Configuration, click Edit to change the Vista Manager IP address. Vista Manager will
display a list of IPv4 addresses that you can select from.

Server Configuration

Vista Manager Server [P

Ganod] ﬁ

The IP address of the interface on the Vista Manager server that is connected to the network.

The default is set to the first public IPv4 address in the list.

Configuring devices for sFlow using Vista Manager requires the device to be running Alliedware Plus
version 5.4.8-2 or later. Devices running older releases are still compatible with this feature; however,
the sFlow configuration will have to be done manually through the CLI. To see how to configure a
device for sFlow using the CLI, see "Configuring sFlow through the CLI" on page 95.

To configure a device with sFlow:

Step 1. Select the device from your map to configure

Step 2. Click on the settings cogwheel on the newly opened information panel to configure it.

x510-Master

On-
sFlow Monitoring @ o

Top 5 Protocols @
x510-Master

* Traffic

Utilization

The side panel will show a list of the ports on the device. Select a

<« Configure sFlow port via the check-box to enable or disable sFlow on the port.

Cancel Apply Changes Click Apply Changes to save.
port1.0.1 The side panel will then show monitoring output from the selected
switch, including the protocols,
port1.0.2
pori1.0.3
port1.0.4 proe
F -

If you would like to change the server IP for sFlow and SMTP, see "Advanced Traffic Monitoring with
sFlow" on page 91.

C613-10634-00-REV B Advanced Traffic Monitoring with sFlow | Page 92



Displaying protocol traffic from non-AMF links with sFlow

From version 3.16.0 onwards, Vista Manager supports the display of protocol traffic from non-AMF
links with sFlow. Previously, only AMF links were supported.

B You can manually create a link in Vista Manager to see protocol traffic from devices even if the
devices are not connected by AMF links.

B You will need to configure sFlow on the AMF device at one end of the link, and set up traffic
forwarding from that device to Vista Manager.

Enabling DPI for advanced traffic monitoring

Routers do not support sFlow by themselves. However, by enabling DPI (deep packet inspection) on
a router, you can carry out features of traffic monitoring. DPI Enabled devices have a green icon next
to them.

Advanced Features
@ Application Priority
Events
@ DPI or sFlow enabled

° Vista Manager is not
receiving sFlow data

O%I@

DPI traffic statistics
From version 3.13.1 onwards, you can select multiple devices when viewing DPI traffic.

This means that you can click on multiple DPI-enabled devices to display an aggregated view of
traffic statistics across the selected devices.
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Statistics and visuals of applications from the selected devices are shown on the left side-panel. DPI

Enabled devices have a green icon next to them.

1. To view DPI traffic, navigate to the Network Map.

2. Click the dropdown to turn the Network Map into the Traffic Map.

® Network - | hH € Traffic -~
- —
Select Map Layer ,I [ Sl Select Map Layer
o -—

3. To enable DPI on a device, click on the device to bring up its information on the side panel.

4. Click the Cog icon to open the DPI settings.

AR40505-master

Advanced Traffic Menitoring

Device DPI Running: Standalone

©® Aggregated View
Select more DPI enabled devices for
aggregated application stats

5. Enable the DPI toggle.

AR40505-master
DPI Configuration

NAT rules, SD-WAN rules.

Device DPI

Pravider built-in

DPI Learning

DPI per Entity

Cancel

© Changes to DPI configuration may affect features that use
applications including Internet Breakout, Firewall rules,

<

6. Click Apply Changes.
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Selected Devices ] & Tafic - Nolayout a

AS4050S2 )  AR4D50S-master €3

Clear All

Top 5 Aggregated Applications
During last hour

m ss| m targusgetdata = eth atmf system

/ 4

Top 10 Aggregated Applications
During last hour

ssl 6MB

AS4050S-2

targusgetdata 3IMB
otn 2m8 AR2050V

atmf 209KB

Once enabled, the DPI application information and DPI icon will display on the Network map.

To select multiple devices, Ctrl + Click or use the Multi Select Devices button to select multiple
devices to include in them in the chart on the left panel.

The side panel will show the protocols being used by the router in a chart, along with other charts.
You can click on the diagrams in the side panel to open the associated chart widget.

Information from the widgets can also be exported to a CSV file. To do so, click on the Export as
CSV button.

Configuring sFlow through the CLI

Configuring devices for sFlow using Vista Manager requires the device to be running Alliedware
Plus. Devices running releases older than version 5.4.8-2 are still compatible with sFlow; however,
the sFlow configuration will have to be done manually through the CLI.

Sample sFlow CLI configuration:

sflow agent ip 172.31.1.245
sflow collector ip 192.168.1.1

sflow enable

!

interface portl.1l.1

sflow sampling-rate 8192
sflow polling-interval 60

Vista Manager uses the sFlow agent IP address to match the data received with the correct AMF
device. The agent IP address must be the same as the AMF Management IP address. You can find
the IP address by using the show atmf detail command.
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AlliedWare Plus configuration can support multiple collectors. However, only the first collector will
allow Vista Manager sFlow to connect to the device correctly. If there are multiple collectors, please
ensure that the first collector is the IP address of Vista Manager. For example, the following sFlow
configuration is correct if Vista Manager is using the IP of 10.33.25.48:

sflow agent ip 172.31.1.102

sflow collector id 1 ip 10.33.25.48
sflow collector id 2 ip 10.36.150.103
sflow collector id 3 ip 10.33.25.92
sflow enable

VLAN map layer

The VLAN map layer shows all VLANs in the network on the left side-bar, which are color coded by a
strip on the left side of the name. When a VLAN on the sidebar is clicked, devices that are part of
that VLAN are highlighted on the map and displayed with a background that corresponds to the
color on the list.

The color-coded Vista Manager VLAN Map lets you manage VLANs across multiple devices,
including support for aggregators and stacking.

Using the VLAN configuration tool, you can:

B create new VLANs

m  destroy existing VLANs

m configure VLAN Names, VLAN Types, and VLAN IDs
B add and delete ports to VLANs

m  set VLAN ports as tagged or untagged

To see more about how to use the VLAN management functionality, refer to the VLAN Management
video on the Allied Telesis website.
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VLAN search

When searching by VLAN ID, the filter performs an exact match to narrow down search results and
ensure higher accuracy.

When searching for VLAN names, the filter is not case-sensitive and performs partial matching only.

For example, in the screenshot below, a user tries to search for VLAN 10 in a network that also has
VLAN 50 named ‘Building 100’.

Typing ‘10’ will return results of VLAN 10 being top of the list, because it is a direct match on the

VLAN ID typed. Other VLANs containing 10 in their names will appear after, such as VLAN 100,
1000, 1034, etc.

VLANs
= ® VIAN ~

Q 10

VLANs
VLAN 10
VLAMNOOT0

Q. ATMHA
VLAN 100
VLAMNOT00 VLAN 4090

tmf 3

— atmf_node_recovery_safe_vlan
VLAMNT000
VLAN 1034 VLAN
VLANT034 s
VLAN 1037
VLANT037 2 2001

VLAN 200

VLANO200
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Create VLAN

To create a VLAN, select the device or devices
2 ] you want to add the VLAN to. Click to select one
() [ device, or click the multi-select button to select

x230-2 x930-Master more devices.

A Create VLAN button will appear on the left side menu, which you can use to create a new VLAN.

Selected Devices l:reite VLAN

VLANS on device:

x230-3

Clicking Create VLAN brings up the Create VLAN page.

You can customize the color, ID and name of the VLAN which appears on the map, as well as select
ports from the visual GUL.

« Create VLAN L\\, cancel

VLAN ID VLAN Name Color

Enter VLAN ID Enter VLAN Name ..-. ..

%x230-3 VLANSs on device:
%2303
1 3 5 7
2 [T Jufu]T] 9 10 VLAN1 .
i —_m DOS@ O
£ 4 6 8 VLAN 179 .
VLAND179

Once a VLAN is created, it will display on the VLAN list back on the map.

Creating a Native VLAN configuration

When a port has a native VLAN, any packets received on the switchport without a VLAN tag are
placed into that native VLAN. Packets then leaving a switchport on the native VLAN will not be
tagged. You can assign different native VLANSs to different switchports on a device. Note that only
one native VLAN can exist per switchport.

Note: Native VLANs only apply to switchports in trunk mode.

C613-10634-00-REV B Creating a Native VLAN configuration | Page 98



The following procedure first uses the VLAN map to put the switchport into trunk mode, then sets
the correct native VLAN:

1. Select the device or devices you want to add the VLAN to. Click to select one device, or use the
multi-select button to select more devices.

(2]
G

x930-Master

2. Click Create VLAN to create a new VLAN.

Selected Devices 2 Create VLAN

VLANs on device:

Xx230-2

N ENER N
[ 100 ] 200 [ 1034

x930-Master

(2 [0 oo [
Coor

3. Enter the VLAN ID and name, and select a display color for it.

4. Click on the switchport you want to add the VLAN to, until it changes to the VLAN’s color and
shows a T (for “trunk”).
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« Create VLAN

VLAN D o WLAN Name Color

900 VLANI0D ] .. . -.
x230-2
Select Ports
1 3 5 7 9
a
g IENENED - B
g —
2 4 6 8 10

x930-Master
Select Ports

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31 33 35 37 43 45 47 49 51
jufufolrfulufululululufufululvTulw]ulul (rJufullo]o i
fulololrulullvivivivlolofululululululs]

X526

port1.0.43 Untagged VLAN
2 4 6 8 10 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40 42
| viaN 1 untagged O]
default
VLAN 500 (@]
VLANSOD

5. A pop-up will appear, showing the current native VLAN (probably VLAN 1) and the port’s other

VLANS, including the new VLAN. In the pop-up, select the VLAN that you want to make the native
VLAN.

43 45 47 49 51

[ Jujullc]u il B
port1.0.43 Untagged VLAN
f VLAN1 @)
default

VLAN 900 Untagged @®
VLANSOO
6. Click Save to save the configuration.
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VLAN 1 port reconfiguration

If a port is assigned to VLAN 1 in Access mode, you can reassign a different VLAN without having to
remove VLAN 1 first. The VLAN 1 states of ports are treated the same as all other VLANs. Every port
will have a ‘U’ (Access) or a ‘T’ (Trunk) displayed. When VLAN 1 is selected, ports with VLAN 1
assigned can only be changed between Access and Trunk modes. There is no ‘blank’ state.

37 39 41 43 45 47 49 51

[ufulrjufullofol |

un port1.0.43

38 40 42

VLAN 1 Untagged
default

VLAN 900
VLANSOO

Untagged VLAN

®

Edit VLAN
Clicking on the pencil icon on the right of an already created VLAN brings you to the edit VLAN
page.
< Edit VLAN cancel [
VLAN ID WLAMN Name Color
179 VLAND179 .
x230-3 VLANSs on device:
1 3 5§ 7
g BERnn 9 10 VLAN1 .
g — B [ U [N default
2 VLAN 179
VLAN 1 Untagged VLAND179
default

On the edit VLAN page, you can edit the ports added to the VLAN selected. Ethernet Protection
Switching Ring (EPSR) ports are disabled on the VLAN editing page. You can easily identify EPSR
ports when editing VLANs, and avoid misconfiguration.
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IP map layer

The IP map layer shows the hops that data packets take between two selected devices. The devices
you select, as well as the path between, are marked in green. From the IP map layer, you can access
the Tracepath and Walk path features on the side menu.

The information icon changes to show the Tracepath or Walk path legend, depending on what you

© have selected in the side menu.

Tracepath Legend
. Device selected

_— Hop successful

_— Hop failed

You can manually enter the source and destination from the search list on the left, or click on the

devices on the map to select them.

P ®
< B IP ~ DocNet1 ~
Tracepath
x230-3
¥230-1
- |
x230-3 [ A— il A—
x230-3] x230-1
x230-1
30l-maste
Tracepath

Tracepath allows you to determine where traffic is flowing. You can click on two devices in the Vista
Manager network map, the source and destination. Vista Manager will display the path between

them and show round trip time (RTT) information.
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I® { "l: $ IP e
Tracepath Walk Path
hg-core-stk
hg-server-sw| Q,
hg-core-stk
8.18m=s
hg-server-sw
Walk path

Walk path lets you determine if there are any configured routing paths from one device to a
destination IP within the network known to Vista Manager. This is usually performed for installation

or diagnostic purposes.

1P

Tracepath Walk Path

Source *

hg-server-sw a

Destination *

hg-gw|1.1.1.1 a

Details -

hg-server-sw

Via 0.0.0.0/0
hg-core-stk
10.10.10.1

Viz 0.0.0.0/0
hg-gw
10.50.50.1
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Edit map layer

On the Edit map layer, you can edit the layout of the devices on the network map and create custom
links.

= —femees
2303

© The information icon changes to display the custom links legend:

Custom Links
— Physical link
= Wireless link

Mon-custom link

0o &

Ll The Upload Background Image button is visible on the edit layer. You can apply a background
image to the map of your network such as a floor map or other image.

Creating custom links

You can create custom links between devices on the Edit map layer. In order to create a link
between devices, select the first device you would like to create the link on, and then select the
second device to connect the link to. The link will appear in a few seconds after Vista Manager
processes the change. To see information on how to manage the traffic of custom links, see "Traffic
map Layer" on page 87.

When a link is created, a notification will appear in the
v Thelinkis created. It will show on the bottom left of the map which indicates that Vista Manager
is creating the link.

map shorly. s

You can set or unset a custom link as a wireless link, and set link interfaces by right clicking on the
link.
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Setting custom link interfaces

When you right click on a custom link, you can select Set link interfaces to bring up a menu where
you are able to set the interfaces for each end of the custom link.

Set the interfaces for each end of the link

® Specifying the interfaces for the link will add support for link utilization

s1-core

port1.1.1

central-core

custom

port1.0.2

port1.0.3 Cancel

port1.0.4

port1.0.5

port1.0.6

port1.0.7

Show/Hide devices

From the Edit map layer, you can hide devices, and they will remain hidden on any

Sites
Groups

Hide

3

3

R

layer of the map. You can hide devices on the map by right-clicking the device you
would like to hide, and selecting Hide.
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Hidden devices will appear on the left-hand menu and you can show them again on the map by
dragging them out of this menu and back onto the map.

Q < B $Edito

*Illlllllllllll"

Sites ¥

Groups b

Hide e

Importing a background image

L3 You can import a background image to a map screen on the Edit map layer by clicking on the
Upload Background Image button. This is useful to show the physical location of devices that may

be on a building level or floor map.

Click Select file to browse for your floor plan and select the file. Then click Open. You can set the
opacity of the image by adjusting the slider below the image. Click the Save button to upload the
image to your network map.

The image will appear as the background of your network.

To delete an image, click on the image icon and click Delete. Confirm that you are sure you want to
delete the image, and if you are sure, click the Delete button again.
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] Health Monitoring

You can use the Health Monitoring menu to view a summary of the state of your network’s health as
part of AMF Plus. Understanding network health indicators enables you to investigate, analyze, and
improve the overall health of your network quickly. Such indicators include CPU utilization, storage,
temperature, and memory usage.

There are three key indicators (tabs):

m  Network Health: the default tab - shows your entire network’s health

m Device Health: shows utilization statistics of devices in your network (CPU, memory, storage,
temperature).

m  Traffic Health: shows the health of the traffic flow of your network (including interface counter
metrics, when toggled).

Checking the network health
To check your network health and customize the dashboard, from the Network Health tab.

1. Make sure the Network Health tab is selected

A/

Health Monitoring © “ Network Health  Device Health  Traffic Health ] & Download POF  + Add 88

November 162024, 1:43 pm-November 192024, 143pm 1h  12h  2ah  7d ()

Total Network Health i AllGroups: Traffic Health i All Groups: Health Score History
01:27 PMNov 19
= ore m Threshold Ghange
4 3 3 % 4712 devices healthy 50
&
40
35
Devices (12) Snm— — 20
Interfaces (12) SO ——————— 25

20
15
-~ 10
5
0

~ Down 17% from 24 Hour(s) ago ~ Down 17% from 24 Hour(s) a... Average 33 Now 18 12:00 Nov 18 21:00 Now 19500 Nov 191200
All Groups: CPU Utilization t  Interface Counters t Al Groups: Memory Utilization :  Storage Usage for Office Site
01:27 PM Nov 19 0127 PM Nov 19 0127 PM Nov 19 0127 PM Nov 19
® 2303 g %2301 — 7%
® 2301 ga ART050V — 51%
® x530-master Go vaa-controller — 3%
8 6Good ® AR1050V Goo 2303 - 0% @ 3 Good
Devices oFar ® vaa-controller Gor AR4050S-master - 28% Devices i Far
12 ® 0Bad 4 ® 0Bad
P— & AR4050S-master Go X530kmaster - 27% P—
¥930-master Unreachable x930-master Unreachable
AS40505-2 Unreachable ASA0508-2 Unreachable
@302 Unreachable 2302 Unreachable
550 Unreachable X550 Unreachable
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2. Optionally, add widgets, probes, or rules by clicking the + Add button in the top right of the Health
Monitoring page.

& Download PDF  + Add £

Add Widget
1h 12h 2
Add Probe
29 2025,11:07 am - M
Add Rule

When creating a widget, you can also add a custom name to display as the title of the widget.

New Widget X

Health Score

NYC_Site1: Network Health Score

Health Score History
Problem Devices 5 6 0/
0
Statistic Trend (Device Group)
Statistic Latest Donut (Device Group) Devices (8)

Probes (5)

Statistic History Bar (Device Group)
Interfaces (8)

Statistic History Line
Statistic Gauge

Advanced Monitoring - Individual Value
No change from 1 Hour(s) ago
Advanced Monitoring - Process List

TopkList - Statstic Displays the overall health percentage for a selected device group. Based on configured thresholds for Hardware
. Health, probes, and interface counters.
Top List - System Sensor

T
Top List - Probes yoe
Health Score bd
Top List - Interface Counters
Data set
Data source
Select data source v
Widget Title

Network Health Score

Cancel

3. Once you’ve created the widget, use the Settings icon in the top right of the Health Monitoring
page to configure the threshold values for the states (i.e. good, fair, bad) of each metric. These
thresholds apply to the entire network and are used to determine the health status of devices and
interfaces.

4. Check the Total Network Health score (located on the top left widget by default), which is a
percentage based on how many devices are healthy in the network. The state of each device is
selected based on the worst state of any of the gathered statistics.
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Health Monitoring Categories

The health monitoring widget for the monitored item is color-coded to indicate its health status. The
color key as of version 3.14.0 is as follows:

. Good: The data is under the warning thresholds specified in settings
Warning: The data meets or exceeds warning thresholds specified in settings

. Bad: The data meets or exceeds bad thresholds specified in settings

. Unreachable: The device could not be reached during the last polling period

Unknown: The upper limit of the temperature sensor was not reported

Categories include ‘Good', 'Warning' (previously 'Fair'), '‘Bad', and 'Unreachable’.

When there is no high limit on a sensor, that sensor will be classed as '‘Unknown’, and it will not
count towards a Health Score rating.

Temperature sensors include an ID number at the end of their name.

For example: ‘Temp: System 8’ would indicate that sensor has an ID of 8. When multiple sensors
share the same name on a device, this ID helps you match each sensor in Vista Manager to its
corresponding sensor on the device.

From version 3.14.0 onwards, when you create a new widget from the Health Monitoring menu, a
preview of the widget will be displayed. To move a widget, hover over the widget heading and click
and drag the widget to the desired location.

All Groups: Network Health S

You can also resize widgets, such as the Health Score History graph, for a bigger or smaller view.

All Groups: Health Score History

W Health Score Threshold Change

Nov 18 13:00 Nov 18 21:00 Nov 18 5:00 Nov 19 13:00

)

i |To delete a widget, click the Action button (the 3 dots) in the corner of the widget.
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To see a device’s live CPU statistics, click on a device from the Device list on the Health
Monitoring page.

CPU Utilization: Device List

04:57 PM Nov 19

%2301 | 15%
AR1050V @ | 15%
AR40505-master | | 9%
x230-3 1 3%
vaa-controller 0%
x530l-master 0%
x930-master Unreachable
AS40508-2 Unreachable
x230-2 Unreachable
x550 Unreachable

m CPU usage data matches data shown in the CLI command show cpu

m CPU charts update in real-time.

CPU charts include:
m  CPU load history per second (over the last 60 seconds)
m  CPU load history per minute (over the last 60 minutes)

m  CPU load per 30 minutes (the last 60 load values over 30 hours)

Scroll to the bottom of the Device’s Health Monitoring page and you will see the Live CPU graphs.

Nov 19 16:00 Novia 170 Nov 19040 Noviosz0 Novio 1600 Novia 1700 Nov 19040 Novioe20 Nov 19 16:00

Live CPU Utilization Per Second Live CPU Utilization Per Minute Live CPU Utilization Per 30 Minutes

Fair Treshold 1 Bad Threshold [ Average Fair Treshold 1 Bad Threshold W Average  Maximum Fair Thresnold - Bad Thveshold Il Average  Maximum
0 w0 o

Checking a Device’s Health

Use the Device Group selector on the Device Health and Traffic Health

Health Monitoring ® . g .
tabs to display a specific group. The default is All Groups. For

":'IT”"’"” information about creating groups in the Asset Management menu, see
Groups -
A D "Groups" on page 172.
All Groups

nd

e
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Note that this example uses screenshots from a previous version of Vista Manager. The process
looks different in current versions, but still retains most of the same step by step procedure.

In the example below, you can see a Health Score of 88%. There are 8 devices in this network, but
there’s a CPU issue with one of them. The bad device is highlighted in red.

AVE Allied Telesis  VistaManager EX | AMFPLUS Demo

"“""‘:" Health Monitoring ©
88% [N h Iy

rend: CPU

7/8 devices healthy

100%

Up 8% fom 23 Hour(s) og0

Network Health Trend: Memory.
Overall Network Summary

8/8 devices healthy
Average 13

= Up 100% from 23 Hous) a0

0% o

~ Up100% rom 23 Hour(s) ag0

aQ [

™ 1h 120 24h 7d 0 d Download POF

100% Zm

~ Up100% from 23 Hous) ag0

0939 AMDeco2

7 6o0d
oFair

o 1830
0 Unreachable

CPU Utilzation: Device List
0539 AMDec02

T

ROUTER AMFPL w0 ACCESS1 AEP.
ACCESSZ_AM. BN ACCESS2AWFP.
ACCESSI_AMEP. ROUTER AMFPL
DISTI_AMFPLU.. 03 DIST2AMFPLU..
AcCESS1AMF?.. o DISTIAMFPLU..

Memory Utiization: Latest

‘Memory Utiization: Device List
0939 AM Dec02

o Utilization: Latest

i Good
oF
@081
0 Unreachable
Flash Storage Utlizatin: Device List
0939 AMDect2
- ACCESS2 AMFP. =
- ns ACCESSTAMFP. =
m OISTLAMFPLU.. =1
m s DIST2 AMFPLU.. ]
n wa accessiawer. [

» 86000
ofaie
® 080

0 Unreachable

s
2

1. Click on the ‘bad’ device name to investigate further.

AV Allied Telesis  Vista Manager EX  AMFPLUS-Demo

WSl Health Monitoring @
8Devices 7Good 1Bad

Network Health Trend: CPU

verall Network Summary

/8 devices healthy
Average 13%

Up 8% from 23 Hour(s) ago

CPU Utilization: Latest
09:39 2

® 7 Good
0 Fair

® 1Bad
0 Unreachable

©PU Utilization: Device List
09:39 2

ROUTER AMEPL.

ROUTER AMFPLUS_DEMO
e e

DIST1_AMFPLU...
'ACCESS1_AMFP-..
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Network Heaq

Overall Network

‘IOO“1

{

= Up 100% fr

Memory Utiliz
09:39 AM Dec

 760f
G oFa
7 oes

ourl

Temperature: Device List
05:39 AW Dec 02
ACCESS2AMFP.
ACCESS3_AMFP.
ACCESS1_AMFP.
DISTIAMFPLU..
DISTZAMFPLY...
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2. Dirilling down confirms that around 9am CPU utilization rose above the configured band
threshold.

AVZ: Allied Telesis  Vista Manager EX | AMFPLUS Demo 19211681022

~ ROUTER AMFPLUS_DEMO ¢,

CPU utilization has
gone above the
configured bad

threshold

-
o [ prevem=— i s G rm— I
o
® W ¥
21% I~ 5% . P
86% 26881268 18511873568 ) .
35°C
Ko — e e = = i

3. To further diagnose the issue, click on Manage Device to open the Device GUL.

Q

th 12h 24h 7d B

O manager v

Mana le Device SSH to Device

~ O

CPU Utilization

Fair Threshold

| Bad Threshold i Average

hMaximum

From the Device GUI of the AR4050S device, the system information section indicates a very high
CPU usage, and the Applications section shows bittorrent traffic increasing quite rapidly. This is
likely to be the cause of the high CPU utilization.

AL Allied Telesis
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AR4050S

o

ROUTER AMFPLUS_DEMO

Up time:

1212022, 940:47 am

Top 10 Applications Rosat

Appcation Tl acdre
o w7

- o B &

y n2s Pt

> ™ 5w

" 5 A &

o W

- £

it H E
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4. At this point you may decide to disallow the bittorrent traffic by adding a firewall rule.

Top 10 Applications

Application Total MB Add Rule
bittorrent 9526.82 F T
— Y
unknown 48.49 F T
ssl 21.26 F T
arp 1.57 F T
atmt 0.85 F T
icmpvi 0.64 F T
sflow 0.19 F T
mdns 0.08 F T
websocket 0.07 F T
ospl 0.07 F i} 1

| |
5. Configure the firewall rules.

New Firewall Rule

Action 5 Deny P

Application bittorrent

From ANY e

e ——

9 wan »
O »
o ANY |

6. Turn on the firewall.

AR4050S ROUTER AMFPLUS DEMO  Up time: 2 manager B save

Firewall

2Rules

irewall Rules

Action Application From T Eror
Deny bittorrent Oy 0,y sE g ek
permit any Oy Oy FEit W Delete
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7. Go back to the Dashboard and check the CPU percentage.

System Information 7

Environment

System Time ®2/12/2022, 9:42:07 am

Top 10 Applications Reset

Application Total MB Add Rule

bittorrent 062824 § B T
unknown 49.06 F T
puy A s
e, e

FAQs

1. What devices are monitored, and can you select the devices that will be monitored?

m  All AlliedWare Plus devices are automatically added to Health Monitoring. Devices cannot be
added or deleted manually.

2. How often is a device polled?
m  Polling occurs every 5 minutes.
3. How much historical data is stored?

B 7 days.

Note: You can export a PDF of the selected tab from the Health Monitoring page by clicking the
Download PDF button. The PDF scales to match what you see in Vista Manager when you
zoom in or out in your browser window.

How to add a Windows Server to Vista Manager

From version 3.13.1 onwards, you can view Windows Server Monitoring charts and metric data from
the Health Monitoring page. This means you can monitor Windows Server information in Vista
Manager.

Step 1. Enable Advanced Monitoring from System Management.

Go to System Management > Configuration and enable the Advanced Monitoring feature.

About

Configuration

Advanced Monitoring (@ Enabled @HEH

Next add the windows server as a device in the Asset Management menu. Note that you do not
have to perform this if it has already been discovered from another source.
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Step 2. Go to the Asset Management page and click + Add Device

Asset Management

Devices (12)  Endpoints (0)  Offline Devices (1) Groups (5)  Provision (0)  Firmware  Report

= q @  AllGroups ~ | Allsites - =l

Enter the Name, MAC Address, IP Address, Device Type, and optionally a custom icon.

Create Device
Name

ExampleDevice

MAC Address

00:00:00:00:00:00

IP Address

192.168.1.1

Device Type

terminal hd

Select Custom Icons

EoEae e—~Ea
=) f B

Gancel E

Click Save.
Step 3. (Optional) Enable Encryption settings and enter the zabbix agent information.

Go back to the System Management > Configuration page.

About

Configuration

Scroll down to Optional Features, and toggle the Advanced Monitoring Encryption Settings toggle.
Using the information from the previous step, select this device from the dropdown for encryption.
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Encryption Settings
Enable encryption to zabbix agent

Add the Windows device’s information from the dropdown into the Encryption Settings fields.

Enabled Q
MAC address IP address Issuer

Subject
Select MAC address

<+ Add Encryption Config

Visualize data sourced from third-party monitoring agents in Health Monitoring dashboards. Advanced monitoring must
also be enabled per device via the map or Asset Management. - View advanced configuration guide.

A This feature may impact system performance. Each device with Advanced Monitering enabled will increase the system’s
storage requirements and the time required for data retrieval.

B You can optionally click the Action button and select Generate to get the Issuer and Subject
information.

uer

m  Click the Action button again to download a local zip file of the configuration.

Subject

n| [n|

Generate
~+ Add Encryption Cc¢

Download
Monitoring dashboards. Advanced monitoring must also be enabled per device via the map o

Delete

§ agent_

Outside of Vista Manager, log onto your remote server and extract the zip file

o ———
-
-
~

‘\~\
~
» ThisPC » Downloads » agent_example_export A Y
o Name ‘v Date modified Type
| | zabbix_agentd.cert CERT File
| | zabbix_agentd.key KEY File
| ] zabbix_ca_file File

Navigate to your Zabbix Agent 2 installation folder and open the Zabbix_Agent2.CONF file in a text
editor of your choice.

€ =

I« Local Disk (C) > Program Files > Zabbix Agent2 I

Search Zabbix Agent 2 pe
Name
s Quick access

Date modified

Type Size
zabbix_agent2.d File folde
B Desktop T ) i
| zabbix_agent2 CONF File
4 Downloads [&] zabbix_agent2 Applicatior
| Documents | zabbix_agent2 Text Document
&) Pictures ] zabbix_agent2.log.old
[ zabbix_get
(=] zabbix_sender
[ This PC
¥ Network

The default path for the installation folder is C:\Program Files\Zabbix Agent 2

Follow the documentation from the Official Zabbix Agent 2 Documentation to see how to edit the
configuration file.
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Step 4. Restart the Zabbix_agent2 service from Task Manager on your remote server to apply the

updated configuration.

Step 5. In Vista Manager, refresh the Network Map topology by clicking the Refresh button.

@ Network Map

The Windows Server will appear as a device on the Network Map.

How to add the widget to the Health Monitoring Page

Step 1. Click on Health Monitoring from the side menu.

Dashboard

Network Map

Health Monitoring AMF+

Events

Asset Management

This opens the Health Monitoring page:

Health Monitoring ®

All Groups: Network Heal... All Groups: Device Health

03:32 PM Nov 14

9 20/0 11/12 devices h

Devices (12) mmm—

Network Health

All Groups: Health Score History i All Groups: Traffic Health

W Health Score m Threshold Change
100 1 OO% 12/12 devic
90 W

Device Health Traffic Health & Download POF  [TGENERTENE £

1h 12h 24h  7d ]

November 13 2024, 3:42 pm - November 14 2024, 3:42 pm

03:32 PM Nov 14
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[ Add Widget

Step 2. Click Add Widget to add a widget, and click on the Type.

New Widget

Type

Health Score

Data set

Data source

area3

Widget Title

area3: Network Health Score

cancel Q’w

x New Widget

Type

- Statistic Latest Aggregated (Donut)

Data set

CPU Utilization

Data source

~ area3

Widget Title

area3: CPU Utilization

For the windows server specifically, you can select from:

m  Advanced Monitoring - Individual Value (CPU, RAM)

m or Advanced Monitoring - Process List (CPU, RAM)

Step 3. Select the Windows Server as the Data Source.

Step 4. Wait a moment for polling and the data will appear on the Network Health dashboard.

Creating Link Monitoring Probes

The Health Monitoring feature allows you to create Link Monitoring (Linkmon) Probes and will report
statistics (latency, jitter and packet loss) on these probes, representing the health of the traffic.

For example, you could use the probes to monitor links:

m from a company's router to the Internet, to ensure it is operating and at an acceptable level.

® inside a company's LAN from the core switch to a highly used backup server to check latency.

m to a remote office used for video broadcast to check the jitter.

B Dbetween the core switches of two remote offices.

To use this feature:
1. Go to Health Monitoring
2. Click +Add and select Add Probe

3. The sidebar will open.

Dashboard

Health Monitoring ©

) Network Map

Device Group

Health Monitoring AMF+

All Groups ~
Events

CPU Utilization: Health Trend
Overall Network Summary

0, )
5 0 /D 6/12 devices healthy

Asset Management

Network Services
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docnet

Network Health

Memory Utilization: Health Trend
Overall Network Summary

0, .
5 0 /D 6/12 devices healthy

Device Health

Q vnager ~

) Download PDF ~ + Add %

1h 1 2¢
Add Probe
June 2 2025,1 i

Add Rule
Temperature: Health .._.__
Overall Network Summary

0, ’
4 0 /D 4/10 devices healthy

Traffic Health

Storage Utilization: Health Trend
Overall Network Summary

0
50 /O 6/12 devices healthy
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4. The Add Traffic Health Probe side-window opens.
® Enter a name and select the Probe Type - ICMP Echo or HTTP GET.
m  Select a Source device - the drop down box lists all linkmon capable devices in the network.

m Typein aDestination - for ICMP echo probes, this is either an IP address or FQDN. For HTTP
GET probes, this can only be an FQDN.

® Enter an Interval in seconds. for ICMP probes the default is 1 and for HTTP GET probes the
default is 30.

m  Set the Thresholds for packet loss, jitter, and latency.

New Traffic Health Probe o

Name

Prabe Type

ICMP Echo{ping)  HTTP GE

Source Device

Destination

Interval(s)

Link Health Thresholds
Threshalds define probe heakh in dashboard{Good. Fair. B

oA, w o L
Latency 150 . 300 .

Cancel

Adding Health Monitoring Rules

From version 3.12.0 onwards, you can create custom rules for Health Monitoring from the Health
Monitoring Dashboard. This feature allows you to set up actions, such as email notifications or
alarms, when Health Trend widgets from the Health Monitoring dashboard go red (or bad).

Note that you must enable Health Monitoring Polling for all rules to work.

For rules that use Interface Counters as a metric, you must enable both Health Monitoring Polling,
and Interface Counters.

Click + Add and select Add Rule to add a new custom rule.
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& Download PDF  + Add £

Add Widget
1h 12h 2
e Add Probe
¥y 292025, 11:07 am-M
Add Rule

You can then input a name, select a metric, and select an action. You can add an additional action
by clicking Add action + below the first Action (with a maximum of 2 total actions).

An action or event will be triggered if:
B The metric you specified has its Health Trend change from good to bad,

m or, if a device within that metric becomes bad from fair or good, and if it has not already been
triggered for a given period of the metric being red.

When a metric goes green again, then devices fitting that metric have the ability to be triggered once
the metric goes red again.

If you do not select an action, then no notification will be sent even if the conditions are met.

Add Rule X

Rule Name

health_menitoring_rule

Metric

CPU Utilization -

Action 1
Mo Action -
Add action +
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Metrics that you can select from are:
m  CPU Utilization

®  Memory Utilization

B Storage Utilization

m  Temperature

m  Traffic Health

m Interface Counters - Note that this must be enabled first in the Settings

The Actions you can set from include:
®  Email Notification
B Dismissable Alarm

® No Action

You can dismiss the alarms manually.

Created rules are displayed on the Event page in Vista Manager EX, and you can edit existing rules
from the Rules tab on the Events page.

AV Allied Telesis  vista Manager £ Testing Q@ EditRule

Event Log Event Archive Syslog Reports Rules Rude Nome
health_monitoring_sule

Rules ©

Rule Name Rule Type Criteria Actiong Match Criteria

health_monitoring_rule Health Monitoring Metric: CPU Utilization Email  Alarm
Action 1

Email Netification -

Recipient group

Admin {1 user) -

Trigger Intervel

30 mins -

Action 2

Dismissible Alarm -

e £

You cannot edit the Metric Criteria section from this page, so if you require a new metric to be
tracked then create another rule.
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Health Monitoring Polling and Interface Counters Polling

To view updated information on Interface Counters in the Network Health tab, you must first enable
both Health Monitoring Polling and Interface Counters Health Monitoring Polling in the settings.
This is because Interface Counters Health Monitoring Polling only affects the interface counters (not
the entire network health tab, just the right column).

To access the Health Monitoring settings, click the Settings icon on the top right corner of the

Health Monitoring page:

& Download PDF + Add %

1h 12h 24h 7d

B

Health Monitoring Settings

Health Monitoring Polling

Enable polling for all hardware monitoring metrics.

Interface Counters Health Monitoring Polling
Enable polling for interface counter metrics.

Enabled Q

Enabled Q

You must first enable Health Monitoring Polling before you can enable Interface Counters Health

Monitoring Polling.

Interface Counter Polling is a subset of Health Monitoring Polling and cannot be enabled otherwise.

A warning will appear on the Network Health tab of Health Monitoring if Interface Counters Health
Monitoring Polling is disabled, but Health Monitor polling is enabled:

Health Monitoring Settings

Health Monitoring Polling
n

Enable polling for all hardware monitoring metics.

Interface Counters Health Monitoring Polling
Enable polling for interface counter metics.

Device Group

Device Health Network Health

Health Monitoring ©

Al Groups

Health Monitoring Interface Counters Polling Is currently disabled
Interface Counters Polling can be enabled in Health Monitoring Settings
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The Interface Counters dashboard includes the following widgets:
m  Health Trend

m Latest

m Device List

m  History

Use the Interface Counters dashboard to easily monitor:
m [nterface errors occurring across the entire network or on a particular device.
m  Overall health status and specific health metrics of interfaces.

m Detailed explanations of the errors, enabling you to effectively diagnose and resolve any issues
that arise.

You can configure the threshold values for each interface error type in the main settings panel of the
dashboard. These thresholds apply to the entire network and are used to determine the health
status of devices and interfaces.

Monitoring third-party devices

From version 3.10.3 onwards, the Health Monitoring page incorporates information on third-party
devices (i.e., non-AMF devices). Prior to this, only network devices belonging to AMF were subject
to monitoring. Using the SNMP Plugin, the Health Monitoring dashboard displays the latest stats for
all devices with an IP address.

The SNMP plugin collects detailed information and statistics from network devices, and utilizes a
Standard MIB compiler to generate charts based on MIB values. See Table 2 on page 123 for the
supported MIB information.

If the SNMP device can provide such information, the Health Monitoring dashboard will display
CPU, RAM, Storage, and Temperature statistics.

Table 2: Supported MIB information

SNMP AGENT MEMORY SIZE STORAGE SIZE CPU LOAD SENSOR

NAME

Standard SNMP Service HOST-RESOURCE- HOST-RESOURCE- HOST- ENTITY-

MIB (Windows) MIB::hrStorageTable MIB::hrStorageTable RESOURCE- SENSOR-
Net-SNMP package (hrStotageType=hrStorag (hrStorageType=hrStora MIB::hrProcessor MIB::entPhySens
(Linux) eRam) geFixedDisk or Load orTableENTITY-

hrStorageRamDisk) MIB::entPhysical
Table
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Activating Health Monitoring statistics for non-AMF devices
First you need to add the SNMP Plugin, then add and configure an SNMP network.

1. To add the SNMP plugin:
m  Go to System Management > Plugins
m Click + Add Plugin
B Enter the Server URL - https://<ip-address>:6443/NetManager
m Verify the connection and Save.

m  For more details on registering plugins, see "Registering/Installing plugins" on page 28

2. To add an SNMP network.
®  Go to SNMP Plugin > Network Tree
m Create a subnet.

m After a few minutes the SNMP Plugin automatically discovers available devices under the
specified subnet.

m  After auto discovery is complete, a list of devices is shown on the Network Tree.

Il AL Allied Telesis  Vista Manager EX  apollo Q v © manager v

Dashboard
e Network Tree Displayma

Network Map

Health Monitoring AlF+

TB315

5,8 ©
2

v B & network Subnet Name : 75315‘/
>mé Laptop_Lenovo Network Address : 10.38.60.32/28
v ®O® s e Number of discovered ... 7
Number of managed no... 7
SNMP Parameter Name : public
Status : Responded

N Pee

Non-AMF

o device
Noe_anr

A

SNMP Plug-in

Dashboard

Network Tree
Device List
System

SNMP Parameter

Event Filter

3. Check the Network Map to find the devices that were discovered by the SNMP plugin.

m  Go to Network Map
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m  Click on a device to see its SNMP Plugin information.

AVE Allied Telesis  Vista Manager £ zpollo

Dashboard

Network Map

Health Monitoring 4047+ (]
& Network v @ Nolayout v, @ X @
(G GS9740EMX_NONE_AMF . x

Events
Asset Management Delete Device

Network Services

Device el
et Networks —
wan
Basic Information
= awcPlugin Stows Normal ——T
T—— P Addresses ) a @ -
] ] |
Sockmarks WAC Address promy— ) &
-
User Management Type Switch @& ] ] e )
— C B
‘System Management Vendors Allied Telesis R&D Center K.K. <~} [~ <> —
= = — . -
SNMP Plug-in Information o o & &
SNME Plag i nformation @ @ @ EEE— —
vesdl cieseToma [ — ]
- i L [® o
[ — ]

4. To obtain the latest statistics for third-party or non-AMF devices discovered by the SNMP
plugin, check the Health Monitoring dashboard or the Device Specific dashboard.

m  Go to Health Monitoring

m  The Health Monitoring page includes all valid third-party or non-AMF devices in the summary

charts.

AYE Allied Telesis  VistaManager EX | apollo | 1037.141.1 Q Search network © manager v

Healh core itori

FiiAl Health Monitoring © o e s amenror [

o 11Devices 10 Good 1 Bad
w 7Go0d & 11 Good ® 10Good u 7Good
oFair Devices oFair Devicss OFair Devices oFir
® 18ad 11 ®08ad 10 ® 08 7 # 08
0Unreachable 0 Unvreachable 0 Unreachable 0Unreachable

CPU Utilization: Device List Memory Utilization: Device List ‘Storage Utilization: Device List Temperature: Device List

1031 AM May 0 031 AM May 01 1 AN May 01 031 Av

1036150160 - 1036.150.160 [ 1036.150.160 [ R 50-950-cloud

1036.150.165 ] s 10322887 - 2% s14050-m - s 6S9740EMX_NO.

530-3050 | 5% 1036150165 [ EN 540916 [ ] s 1038.60.36

5203050 1 o [sss7a0emxvo. [ 3| 10322887 [} 248 s1-4050m

s-4050m 1 5303050 [ ] « [Fosesose ] | 540916

50-950-cloud | 5203050 - e 5203050 [] ET 5303050

540916 0% [r038.60:36 [ 24 | 10.36.150.165 [ 95 520-3050 e
10322887 0% s1-4050-m [] 0% ‘GS9740EMX.NO. 5

50.950-cloud ] I 50-950-cloud T
Memory Utilization: History Storage Utilization: Histor Temperature: Hmcr‘y

m  Click on a specific device to see its details.
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m  For example, the image below shows the details for ‘GS970EMX_NONE_AMF.

AVE Allied Telesis  Vista Manager £ apollo | 10.37.141 Q  Search network © manager v
« GS9740EMX_NONE_AMF Th 12h 24h 7d M
e
1036 A May 01 1036 AM May 01 Tomp: Switch 10:36 AM May 01 Temp: Intermal 10:36 AM Ma Temp: Cansole 10:36 AM May 01
33% 5%
4088168 si98 ve [ ol
Memory Uilization Temp: Switch
Fair Threshold -1 Bad Threshold [l Average  Maxi W Averag

w
w o
@ o

» o

0
sor x M n A A0 M May 110 ” tor " M

Temp: Console: Temp: Internal
M Average (! High Bad Limit - High Warning Limit M Average 1 High Bad Limit - High Warning Limit

“© w

—_—_— - R e ——

@ w0

0 )

0 0

A Hor o May e Ao May "

Please note that you can only find third-party devices on the Health Monitoring dashboard if the

correct MIB is supported on the third party device.
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Events

Event Log

From the left-hand menu select Events to display all events in the Event log, as follows:

AVL Allied Telesis  vista Manager X docnet Q

= © manager ~
L
Events
o Event Log Event Archive Syslog Reports Rules Notifications
Py
. docnet m
D) m
# 13539 Critical ® 1 Abnormal % 3663 Normal
e 24 Hour Event History
L s
4
= 3
2
1
0
1 12 13 14 15 18 17 13 19 20 21 2 23 ] 01 02 03 04 05 06 07 03 09 10
Q All Alarm  Critical Abnormal ~ Normal 30 days 60 days 90days  All Events =)
&l
D Timestamp ~ Message Device Notes Action
O 1534 Starty fig has been backed up : AR4050s-mastercfy @ AR4050S mast 4
0980820 artup config has been backed up : s-master.cfg -master Fd
|| 111856 AMF Plus License Forced has been enabled @ ARAD50S-master Vd

The event log shows you the history of events in your network, and currently uncleared events.
Critical events have a red background, abnormal events are yellow, and normal events are green. As
an administrator, you can manage events in your network.You can enter notes on any event, clear
events, and filter on different fields in the event display.

You can search the event log based on details of the event such as the time period in which it
occurred. The graph at the top of the image shows the event history of your network over a 24 hour

period.

As a user, you can view and search through all event logs.
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Vista Manager Event severity levels

Events in Vista Manager are categorized by the following severity levels. The alert level depends on
how important an event is:

m 0 EMERGENCY
m 1 ALERT

m 2 CRITICAL

® 3 ERROR

® 4 WARNING

m 5 NOTICE

® 6 INFORMATION

m 7 DEBUG

EMERGENCY and ALERT level events create an alarm on the Network map (if device-related), and
also appear as a count in the Endpoints table until the alarm is dismissed.

Hiding Event logs

From version 3.16.0 onwards, you can hide unnecessary Event logs. This feature is available to
Administrator users.

You can use this feature to create a rule to hide any logs that you don’t need to see, and
automatically hide further logs that fit that rule.

Once a log message is hidden you cannot return it to the main Event log list.

To hide event logs:

1. Navigate to the Events tab and open the Event Log.

2. Click the three-dots next to the event you would like to hide and select Create Rule.

3. Enter the rule name, rule match criteria, and set the Action dropdown to Hide Event Log.

4. Click Save. Rules will be hidden from now on if they fit that criteria.
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Create Rule

Rule Name *

Example

Match Criteria
Title

Device site is manual-assigned hd

Networks

docnet-snmp hd

Device

10.37.179.14 hd

Message

Device 10.37.179.14 is assigned to site SNMP Devices man...

Action 1

Hide Event Log v
+ Add action
Cancel E

You can see hidden log messages from the Event Log page by selecting the Hidden tab.

Severity Visibility —

Q, All Alarm Critical Abnormal Normal All Visible Hidden

B Hidden logs are still included in the total Event log count.
® Logs generated prior to creating a rule enabling the ‘Hide’ feature will not be hidden.

m Using the Hide action does not prevent other actions on a rule from being triggered. For example,
if you add an Email action in addition to the Hide action, you will still receive an email and the log
will be hidden.

B You can archive hidden logs.

m  Hidden logs are still included in backups.
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Adding notes to events

Click on the pencil icon to add a note. The following dialog box displays and enables you to add or
edit the note. Click on the Save button to save the note to the event.

MNotes

Add Note x

Polling service restarted after device reboot.

(o
Add Note
Cancel m

Event language

When you change the event language, the general Ul will retain the main language, however event
messages will be translated into the new language you have set. By upgrading to Vista Manager EX
version 3.7.0 and later, you can translate events into Japanese (H A& z8).

Q Keyword Al Alarm  Critical  Abnormal Normal 30 days 60days 90days  All Evenis ™
Archive selected events B Delete selected events

&
O Timestamp ™ Device Notes Message Action
O &2 - /s BEOAAL b2 English 05 BFE CHRUEUE. 503 1AL buERensLE. 0
[ - ’ R NEES Engish 15 B CRESNELL. BEOAY OBRERSEL. O

Navigate to the Language tab of the System Management page’s About section to change the
language of events.

You are able to search for terms in Japanese, and the search function will search for key words
matching that language. This language support functionality is only applicable to the Event Log, SD-
WAN table of events, and Event Rules. Plugin events will not be translated.

Changing the event language initiates the
€@ Event Language changed from English background process of translating past
to H#55. Initiating translation of past events. Once past events have been
events. If there are many events, this translated, event rule messages will then be
may take several minutes to complete translated to the new language.

An event log is also created and added to the list when the translation completes.

Note that this feature has been designed to support more languages in the future.
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Event Archive

As an administrator, you can archive events on the Event Log section of the Events tab in Vista
Manager. Archiving an event moves the log entry to the Event Archive tab and decreases the alarm
icon’s event count on the side bar.

AL Allied Telesis | vista ManagerEx  docnet Q © manager v

Events

Event Log Event Archive Syslog Reports. Rules Notifications

Q 2 Al Alarm  Critical Abnormal  Normal 30 days 60 days 90 days All Events ]

B Delete selected events & e
D Timestamp ~ Message Device Notes Action
;;21&8055?9 AMF Plus License Forced hasbeenenabled @ AR4050S-master Vs
;;2‘;.8055?9 AMF Plus License Forced hasbeenenabled @ x530-master Vs
D ;;2;_5055?; AMF Plus License Forced has beenenabled @ x930-master Va
D ;;21?355?; AMF Plus License Forced hasbeenenabled @ vaa-controller ra
|:| ;E?éi—%gjs Plugin snmp did not provide the correct certificate. Communication ab.. @ - ra

You can also:
B export a selection of event logs (with applied filters) as a CSV file.
m delete a selection or all event logs from the Event Log.

m filter event logs and delete selected or matching logs from the Event Log.

Archiving event notifications
To archive old or cleared events, select the events by checking the box on the left-hand side, and
then click the Archive selected events button. You can also select all events by clicking the check

box at the top of the list.

You can view archived events by clicking on the Event Archive tab.
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AV Allied Telesis | vista Manager Ex  docnet aQ 6 manager ~

Events

Event Log Event Archive Syslog Reports Rules Notifications

Q Al Alarm  Critical ~ Abnormal ~ Normal 30days 60days 90days  All Events =)
&
D Timestamp ~ Message Device Notes Action
15:33:48 .
D 20550520 Startup config has been backed up : AR4050s-mastercfg @ ARA4050S-master ’
11:18:56 .
I D AMF Plus License Forced has been enabled @ AR40508-master ra
20250519
D 11:18:54 AMF Plus License Forced has been enabled @@ x530l-master ra
20250519
1to30f3 Page 10of1

You can restore archived logs back to the Event Log, or permanently delete them from the Event
Archive. A confirmation dialog appears when try to delete events.

Confirm delete events

This action will permanently delete 1 events

A server log message is displayed after a successful restore or delete operation.
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Syslog

The Syslog tab shows syslog messages from the network or for a specific device on the network.
Messages older than the default or configured length of time are automatically deleted.

As an administrator, you can configure how long Vista Manager stores syslog messages.The syslog
storage is limited to 5 million entries, and the default configuration is 365 days.

Events
Event Log Event Archive Syslog Reports Rules Notifications
Syslog Last3Month(s) v [
Facility Severity App Name Hostname Source IP Process ID
Select facility Select Severity Enter app name Enter hostname Enter source IP Enter process ID
Message
Q [OB Create Rule
Case sensitive. Supports wildcard query operators * and 7. Special characters(3, /) can be included in search by prefixing with \
Q (0] 463075000000 0 & ok AR
Timestamp ~ Facility Severity App Name Hostname Source IP Process ID Message
Lk User Level w dated AR40505-mast Failed to retrieve latest version il
e e ser Leve arning update -master - ailed to retrieve latest version file
1414062 User Level w dated AR40S0S-mast Failed to retrieve latest il
i ser Level arning update -master - ailed to retrieve latest version file

Note: For the syslog server to display accurate timestamps and valid messages, it is highly
recommended for the device to be running Alliedware Plus version 5.4.8 or later

Setting up Syslog messages in Vista Manager

To set up Syslog messages from a device to Vista Manager, you must configure the following
commands in the device’s CLI, as an administrator.

In this example, we send logs with the severity level of ‘Notice’ or above to the Syslog tab.

configure terminal
log date-format iso
log host <ipv4-addr>

log host <ipv4d-addr> level notices

Use <ipv4-addr> or <ipv6-addr> for the IP address of the remote syslog server. In this case, we
use Vista Manager’s IP address.
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There are some limitations to take note of:
B As syslog messages are based on UDP protocol, this functionality may be unreliable.

® |nthe event that the Vista Manager EX syslog server goes down, syslog messages lost during the
downtime will not be recoverable.

m [f the AMF-Sec server changes its syslog format, this feature will fail to work as there is no way
to detect such failures.

®  AMF-Sec alarms that depend on the DISCONNECT action will not be removed when the parent
device reboots or leaves the network. This is because the AMF-Sec server does not send a
corresponding disconnect message with a device reboot, therefore causing the alarms to remain
on the map.

m  AMF-Sec will not send syslog messages for the IP-FILTER action. If sourced from a non-AMF
device, Vista Manager EX will not be able to detect this action.

m  Some changes have been applied to the event messages from the original blacklist feature.
Therefore for any event filtering relying on event messages, the existing event filter may appear
broken after upgrading to version 3.7.0.

Syslog forwarding

As an admin user, you can relay syslog messages to an external server. This functionality forwards
all received syslog messages to a specified syslog server, regardless of any rules configured. Note
that only one external syslog server is supported.

Note: The source address of a syslog cannot be retained to its external server.
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To add a relay server address and enable syslog forwarding:

1. Navigate to the Syslog tab page from the Events menu.

Events

Event Log Event Archive Syslog Reports

Rules

Notifications

681 0f 5000000 @ &

Create Rule

e £

2. Click on the Syslog settings gear icon. This will open the Syslog settings window.

3. Check the Relay syslogs to external server checkbox to enable the Relay server address text

field.

4. Enter the relay server address and port number.

Syslog settings

Maximum syslog storage time

365

Relay server address *

1111

a o

=
- S

Relay syslogs to external server - .

Port *

\ A

514

@ Syslog storage limit is 5,000,000 messages. Logs will be deleted in historical order once limit is
exceeded. To reduce logs select a maximum storage time below.

X

5. Click Save.
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Syslog message filtering using wildcard characters

You can filter syslog events by whole or partial message content, by using multiple wildcards.

Message
Q, Search exact message 0]
Case itive. Supports wil query * and ?. Special characters(?,* /) can be included in search by prefixing with \.

Details of supported wildcard query operators and special characters are as follows:
m A question mark (?) is used for a single character.

B An asterisk (*) is used for multiple characters.

m A backslash (\) is used to escape any special characters (2, *, /) after it.

B When a backslash is expected to be part of the message to be matched on, escape it with an
additional (preceding) backslash.

B When an asterisk is expected to be part of the message to be matched on, escape it with a
preceding backslash.

Q, *port1.0.7 a

Create Rul

‘Case sensitive. Supports wildcard query cperators * and ?. Special characters(?* /) can be included in search by prefixing with \.

Message -

[manager@ interface ...

[manager@ = Winterface ...

[manager@ interface ...

Port up notification received for p...

Message

Q, 110.37.1/* a

Case sensitive. Supports wildcard query operators * and 2. Special characters(?,* /) can be included in search by prefixing with \.

Message -

vlan179 installed address 10.37.1...

C613-10634-00-REV B Syslog message filtering using wildcard characters | Page 136



R

eports

From the Reports tab, you can generate reports that provide detailed statistics of actions performed

by the AMF networks. Reports are presented in easy-to-understand charts and tables. You are able
to export these charts and tables to a PDF.
Events
Event Log Event Archive Syslog Reports Rules Notifications
Reporting Generate PDF report i~ Last7 Day(s) ~ 9
Dashboard Areas Groups Sites
Auto Configuration total Auto Recovery total

0

Device Count

0

May 21, 2025 12:00 AM ~ May 22, 202512:00 AM  May 23, 2025 12:00 AM  May 24, 2025 12:00 AM  May 25, 2025 12.00 AM  May 26, 2025 12:00 AM

Data for reports is compiled daily at midnight UTC time.

You can specify a range between 7 days to 6 years for the reports tab to display, and can see how
the size of your network has changed over time.

You can click on the graph buttons to change the graph type, and click the Areas, Groups, or Sites
tabs for specific statistical reports about your network.

As an administrator, you will be able to justify why and when you have to renew your AMF
subscription license.

Events

Event Log

Reporting

Event Archive Syslog Reports Rules Notifications

Generate PDF report ih ~ Last 7 Day(s)

&
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Rules

The Rules tab shows the assortment of rules you have deployed. These include Event log rules,
Syslog Rules, and Link Utilization rules.

Events

Event Log Event Archive Syslog

Rules ©
Rule Name Rule Type
example rule Event Log
Rule no action Syslog
Test Syslog

Reports

Rules Notifications

Criteria

Title: AMF Plus Forced Networks: ar...

Severity: Information, Emergency Fa...

Source IP:

Actions

No Action

No Action

No Action

Status Action

m Enabled
Q Enabled
Q Enabled

m Event Rules - Created from the event action menu in the event log table.

m  Syslog Rules - Created from the syslog filter panel. Syslog Rules accept a combination of column

filters and message to generate match criteria.

B Link Utilization Rules - Created from the traffic map layer by right-clicking a link that supports
utilization and selecting Create link utilization rule.

To read more about the differentiation in rules, click the information icon by the Rules tab.

How to create Event log rules

Admin users can view and create event rules to notify you whenever certain events occur, such as
when a port goes up/down, configuration on a device is changed, or a fan or power supply failure

OcCcurs.

Note: We recommend using the title field instead of the message field when creating event rules
SO you can receive broader search results when searching for events.
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To create an event log rule:

1.

2.

From the left-hand menu, navigate to Events.

Select Create Rule.

From the Event Log tab, scroll down and choose an existing event you wish to create a rule for.

In the Action column, click on the three vertical dots for more options.

Events

Event Archive Syslog Reports Rules Notifications

15:33:48

! O 60 Startup config has been backed up : AR4050s-master.cfg @ AR4050S-master 7’ i
Delete
Archive
| O 1341&554{ AMF Plus License Forced has been enabled @ X530l-master 4 Create Ryle
J M AiIE18:5a AMF Plus License Forced has been enabled @ X930-master P

5. The Create Rule side-panel opens.
The criteria will be pre-filled based on the event that has been selected. Configure as required.
Events Create Rule
Rule Name *
Event Log Event Archive Syslog Reports Rules Notifications Example Alarm Rule
docnet
[cm] Match Criteria
‘% 13539 Critical ‘& 1 Abnormal ‘& 3663 Normal Title
Config Backup Event v
24 Hour Event History
Networks
5 areal v
4
3 Device
2
: AR4050S-master -
0 :
16 17 18 19 20 21 2 23 00 01 02 Message
Startup config has been backed up : AR4050s-master.cfg v
Q Al Alarm  Critical  Abnormal  Normal ~ 30¢ A°ten?
Dismissible Alarm -
+ Addaction
CI Timestamp ~ Message
Cancel m
15:33:48 E
I |:| e Startup config has been backed up : AR4050s-master.cfg
11:18:56

| =

AMF Plus License Forced has been enabled @

20250510

® Enter arule name.

m  Select any criteria to match on anything.

m  Select an Action: Email Notification, Dismissible Alarm, or No Action.

6. Click Save. You can use the Rules tab to view, edit, or delete existing rules.

An SMTP server is required for email notifications to be sent. You can configure users’ email

addresses in the User Management window.
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You can create rules from the Events > Syslog page, main Event Log page, or from the Health
Monitoring page. To create a new rule on the:

m  Events page - click the three dots next to an event log entry.

m  Syslog page - click the Create Rule button.

m  Health Monitoring page - click the + Add button and add a new Rule.

Events
al 30days 60 days days (]
Event Log EventArchive  Syslog  Reports  Rules  Notifications
&
"=, Testing
Device Notes Action
[ ]
® 3Cical % 14 Abnormal % 60 Normal

Event Log Event Archive

Syslog

Syslog

Facllity

Fd
’ Delete
Archive
AR /
Create Rule
el ABANENC.EA tn ADUNENE in arddad i the brnninms  #R »
Reports Rules Notifications

Last3Month(s) v [

Severity

AVL Allied Telesis  vista Manager EX

Health Monitoring ©®

| +Add &

Add Widget
Add Probe

Add Rule

You can place an alarm on an event rule to identify it as a critical event.

m  Critical events have a dismissible red alarm icon showing next to them in the Event Log window.

B You can decide if the alarmed event requires immediate action or dismiss it as a normal alert.

You can also create a link utilization rule from the Traffic layer of the Network map by right clicking a

blue link.

@ ) 15Devices 15Up

Traffic Protocol
Network Traffic
10m 1h | 12h  24h  Custom v
5/5/25,7:28 AM - 5/5/25, 7:38 AM
- @
Link Utilization
0-25% 25-50% 50-75% 75-100%

Top 5 Interfaces by Utilization
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@ Application Priority #“ Auto Traffic Shaping

"= @ Taffic - Entire Ne... éd + X @
x230_Middle [x230_B|

L

"= ARX200S-Gateway

ARA050S-5G

U
6‘ Create link utilization rule
P
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How to create Syslog rules

Syslog rules work similarly as the existing event rules. Any received syslog that matches a rule will
trigger the action associated with the rule. Create a syslog rule based on the syslog message filter
from the syslog tab page. When creating a single rule, configure up to two of the following actions:

B email notification
B dismissible alarm

® no action

To create a syslog rule:
1. Use the syslog message filtering to search for messages of your choice.
2. Next, select a hostname.

3. Click Create Rule. This opens up a side panel.

&

Hostname

Q port* Create Rule

Case sensitive. Supports wildcard query cperator
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4 .Enter a rule name.
Create Rule

5.Configure a first action for email notification.

Rule Name *

peerTB130

o 6.Select a recipient group.
7.Select a trigger interval time.
8.Configure a second action for dismissible alarm.

Match Criteria *

@ Usefilters and message to generate match 9.Click Save.

criteria. Keyword search is excluded.

Message

Hostname

tb130

Action 1

Email Notification

Recipient group

All (1 user)

Trigger Interval

5 mins

Action 2

Dismissible Alarm

— Remove action

Cancel

%@O@@

To view a list of syslog rules, navigate to the Rules tab page. Here, you can also disable a rule, edit
it, or delete it.

Events

Event Log Event Archive Syslog Reports Rules Notifications

Rules ®
Edit
Rule Name Rule Type Criteria Actions Status Delete
example rule Event Log Title: AMF Plus Forced Networks: ar... No Action Q Enabled
Rule no action Syslog Severity: Information, Emergency Fa... No Action Q Enabled

How to create Link Utilization rules

You can configure link utilization rules from the Traffic map. For more information on how to
configure this, see "Creating link utilization rules" on page 89.
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Setting up third-party notifications

From version 3.14.0 onwards, you can configure Vista Manager to send you notifications about your
network to third-party communication applications including Microsoft Teams and Slack, with the
introduction of recipient groups.

You can select a recipient group from the recipient group section of the event rules drop down. You
can create a recipient group with a name and a set of email addresses from the Events > Notification

page.

A recipient group is treated as a user that has permissions for all events. It is up to the admin
creating the event rule to decide which notifications the group receives.

To get an email for a Teams channel:

1. Click the three dots next to the channel you wish to send notifications to.

2. Click Get email address. Teams will generate an email address.

3. Copy the email address in the middle of the generated string between the <>

* EV [Example Vista Manager notifi...

Notifications More options
[ Channel notifications
£7 Pin
R Hide

83 Manage channel

Get email addrrz\sﬁi.J o

&2 Get link to channel

Events

Eventlog  EventArchive  Syslog  Reports  Rules  Noifications

Notifications

The Notifications tab on the Events page has been added to support sending notifications from Vista
Manager to other applications. Click the + New Notification button to add a new entry.

1. Enter a name.
2. Enter the email address from the communication channel.
3. Click the + button to confirm and add the email address.

4. Click save.

The new notification entry will be added to the Notifications page.
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New Notification ped
® Notifications allow you to connect external teams to
Event Rule notifications by automating alerts to
individuals or platforms like Slack and Microsoft
Teams for real-time updates.
Mame
o Example Notification
Email Address
.onmicrosoft.com@au.teams... €3
Notifications
Name Email Address Action
Example Notification _onmicrosoft com@au teams.ms

You must also set up SMTP Server settings to get notifications. The SMTP config handles encrypted
SMTPS on port 465 and port 587. An SMTP Auth User and Password is required for the SMTP
Server to forward information.

To change the SMTP settings, navigate to System Management > About and scroll down to the
About SMTP section and click the ‘Edit details’ button.

Edit details

About SMTP

SMTP Server Address. *

smtp.domain.com

SMTP Server Port *

587

Username

SMTPuser

Password

Send mail as:

email@example.com

cancel E
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In version 3.14.0 onwards, the recipient group option has been extended. When you create a rule,
you can choose to send notifications to specific notification groups.

Create Rule

Rule Name *

Match Criteria

Titie

Sending mail failure

Networks

Any

Recipient group

Error SMTP has n.

Admin (1 user)

Create Rule

Rule Name *

Enter Name

Match Criteria

Title

Network Added

Action 1

Email Notification

Reclplent Group *

Network Network-57 for sul

by

nets

Select recipients

' All Admin Users

All Non-Admin Users

notification_group_1

AMF Security (AMF-Sec) support

’ ’ notificaiton_group_2

The alarm notification supports both AlliedWare Plus devices and wireless devices by leveraging on
syslog messages from the AMF-Sec server. Vista Manager EX shows alarms on the integrated map
for both blacklist and whitelist security events on AlliedWare Plus devices.

You can configure all your AMF-Sec servers to send syslog messages to Vista Manager EX. All
syslog messages from the AMF-Sec servers will then appear on the Event > Syslog page.

Note: In order to process syslog messages from the AMF-Sec server, Vista Manager EX will have
some built-in event rules not visible to users. Because of this, if a user creates a rule with the
same name in the event log or syslog table, an error message will display: “Duplicate rule
name used. Note may be a duplicate of a hidden system rule name.”

AMF-Sec Alarms

Vista Manager EX will convert specific actions that match AMF-Sec syslog messages into alarms
(high severity event logs) and display them on the map. These specific blacklist and whitelist actions

are.

m Blacklist

m  Security Block

® LinkDown

B Quarantine VLAN

B Security Logging (no-action, reporting only)

®  Whitelist

m  Auth Failed (deny)
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Any other syslog messages from the AMF-Sec server not mentioned above will not be converted.
This means the user will not be able to see successful notification events in the Vista Manager event
log table, but those events are present in the Syslog tab page.

The alarms will be associated with devices based on IP addresses and hosthames from the AMF-
Sec syslog message. If you associate one AMF-Sec syslog message with multiple devices, then all
devices will have their own alarm. If an alarm cannot be associated with any device on the map, it
will not be visible on the map.

Note: Unmanaged devices are not always visible on the map, such as TQ devices without the AWC
plugin. In this case, alarms will still be associated to the TQ device, but can only be viewed
by zooming into the map. Alternatively, add the AWC plugin to manage the TQ which then
makes it visible by default.

The alarms will keep showing on the map until either
B a2 user dismisses them proactively, or

m arecovery AMF-Sec syslog message dismisses them automatically.

Users with read/write permissions to the associated device can dismiss the alarms in 2 ways:
m from the event log table, or

® from the side panel of the map.

Auto-dismissed Alarms

When a user performs an action in the AMF-Sec server, the AMF-Sec server will send syslog
messages to Vista Manager EX to indicate a status change on the alarm.

Vista Manager EX automatically dismisses an alarm and removes it from the map, if they are event
recovery types such as:

m DISCONNECT

m  ACCEPT

A “recovered” event log will then be generated with detailed information.

AMF-Sec block actions

AMF Security (AMF-Sec) blocking actions, configured using AMF application proxy, are displayed as
high priority events. AMF-Sec blocking actions configured using OpenFlow are not yet supported.

The following AMF-Sec blocks will be shown on the Area Map and in the Event Log:

m  Drop
B Quarantine

® Link Down
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In addition, the following action will appear in the Event Log only:

m |P Filter

See the AMF Security (AMF-Sec) Technical Documents for more information on configuring
AMF-Sec and the AMF application proxy.

SNMP Trap Events

SNMP trap events require the SNMP plugin. If they are configured, the following SNMP traps will
appear as high priority events:

m  SNMP loop detection traps

m  SNMP active fiber monitoring traps.
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EAsset Management

You can use the Asset Management screen to manage the assets in your network. It is made up of
several components. You can view devices and groups from this screen.

m  Device discovery - devices on the network are discovered via AMF and plugins.

m Device classification - during discovery, a best effort is made to categorize what type of device
has been discovered. However, this may be incorrect, so it allows you to specify what type of
device has actually been discovered.

m  Device management - once discovery is complete, the asset information should be available to
you.

You can use Asset Management to:

B get a complete list of all assets on your network, including those that have connected to the
network and subsequently left in the last 1.5 years.

m display the assets on the network map, and select the most relevant icon for each device.
m view the license information for all Allied Ware Plus devices.
B be notified when a license is about to expire or has recently expired.

m create a group defined by either IP/MAC address range or Vendor, and assign an icon to this
group.

m filter the list of assets, and print/export this list.
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Asset Management is accessed from the sidebar menu.

Dashboard

Network Map

Health Monitoring AMF+
Events

Asset Management
Network Services

Intent Networks

WAN

AWC Plug-in

SNMP Plug-in

Bookmarks

User Management

System Management

Devices

Device list

The Asset Management screen shows you the devices in your network, including their details. It
also allows you to search for particular devices. You can re-order any of these columns by clicking
and dragging the column title. The changes are saved and reset after login/logout.

Asset Management
Devices (19) Endpoints offline Devices Groups (7) Provision (0) Firmware  Report
& aloowps v T Q ® & o c
Device Name IP Addresses Status Device Type License St. =~  MAC Addresses Discovery Source lcon Action
Area-A-Master [ ~ Normal ATx950-52XSQ Active AMF -
Area-B-Master [ v Normal AT-x530L-28GPX Active AMF [y
Area-C-Master &l Normal AR40508 Active AMF  AMFP-DD fammY
Area-D-Master @ ~ Normal AT-VAR Active AMF @
‘Management-Switch b Normal AT-x550-18XTQ Active AMF —
office Nozomi 48 ~ Critical ATx330-28GTX Active AMF =Y
Office-1 . Normal AT-x530L-52GTX Active AMF =Y
Office-2 ~ Normal ATx530L-28GTX Active AMF -
Office-3 > Normal AT-x530L-526TX Active AMF [y
Office-4 ~ Nermal AT-%530-10GHXm Active AMF [em]

m  Click on the Export as CSV icon at the top right corner to download a CSV file list of assets.
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Click on the Manage Columns icon to change the column display.

N < < I < W <

<N <N <NEN< NN

oy e
Devig i
IP Addresses
Parent Device
Parent Port
Status
Device Type
Fault
Serial Mumber
Software Version
Motes
MAC Address
Vendor
License Status
lcon

Action

anage Columns
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Updating the device list

B You can add a new device by clicking on the + Add Device button.

When you add a new device, you will be prompted to name
the device, as well as specify the MAC address and IP
address. You can also select an icon to represent the device.

Create Device

Mame

Click on the ‘+’ button, to upload a custom icon for the
device. The custom icon dialog supports PNG, JPG, and MAC Address
SVG image files.

Note: Only administrators have the permission to upload IP Address
and change custom icons. An AMF device cannot
have its default icon changed.

Add Custom Icon
Select Custom lcons

Em@ +

Cancel Select file

B You can update a device’s GUI by clicking the Update Device GUI button.

Update Device GUI

m Click on the Discover Devices icon to discover devices from the Asset Management screen.

oy e C

.

Discover Devices

Vista Manager uses address resolution protocol (ARP) to discover any new devices, and return a list
to you. A message appears indicating the number of new devices found. Detected devices that fall
into a user defined inventory group inherit the assigned custom icon.

Note: Discover devices will only discover IPv4 neighbours.
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Any detected devices will not automatically appear on the map or show link information and will
require you to add devices and links to the map manually once they have been discovered. See
"Edit map layer" on page 104 for more information on how to display the devices on the map and
create links.

STOAT Device Discovery

STOAT (Standardized Topology Organizer and Transport) is a feature that is responsible for
discovering devices and network topology. AMF Plus Device Discovery supports STOAT as a
topology data source. Devices and links discovered by STOAT will be added to Vista Manager EX's
database, allowing them to be displayed on the Network Map and included in the Asset
Management table.

It organizes device and topology information into a standardized format. Devices that are a part of
the STOAT process are configured as collectors or sources using LLDP protocol.

The following titles are referred to during the STOAT process:
m Device - a network node that has no STOAT role but is LLDP capable.

m  Source - compiles data about itself and the nodes it can discover with LLPD and streams it to
the collector.

B Collector - collects and stores data about itself and discovered devices.

For more information about how to configure STOAT devices, see the Device Discovery using
STOAT Feature Overview Guide.

Accessing device details

You can click on the device name to access the device’s information page.

Asset Management

Devices (19) Endpoints Offline Devices Groups (7) Provision (0) Firmware Report

= Filterdata v @& All Groups v Q, Search by keyword G o C Update Device GUI + Add Device

Device Name ~ IP Addresses Status Device Type MAC Address License Stat. Icon Action

x930-ma¥fr M) Normal AT-x930-52GPX Active [
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This will bring up the Device Info page for the specific device you have selected. You can see
information and configure a variety of settings relating to your device from this page.

Device Info Stack

Basic Information

Model

Device IPv4 Address
Device IPv6 Address
Serial Number

MAC Address
Vendor

Environment Status
RAM Usage

CPU Usage

Flash Memory Usage
S/W Version

Current Running Release

Configured Release

« @ @ x930-master

Notes

Guest Devices

SSH to Device Backup Device Backup Area Reboot Device Delete Device

Backups Configs

AT-x930-52GPX

A04880A143100007

Allied Telesis Inc.
Normal

17.5%

7%

61%

55.3-01
%930-5.5.3-0.1.rel

x930-5.5.3-0.1.rel

Licenses File System

AMF Status Information

AMF Network

AMF Status

AMF Area

Backup Status

Last Backup

Depth

Recovery State

docnet

Normal

areal

Good

2023-07-24 03:00:01

Device is not in a recovery state
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Stack Information

The Stack tab shows stack information for the device.

« @ A x930-master SSH to Device Backup Device Backup Area

Device Info Stack Notes Guest Devices Backups Configs Licenses File System

Stack Information Stack Members 1

Stack Master ID 1 1 Eﬂ Status Ready

Active Master

Stack MAC Address Role Active Master

Virtual MAC Disabled Priority 128

Disabled Master Monitoring Enabled MAC Address

Resiliency Link Model AT-x930-52GPX

Management Subnet Board Revision X3-0

Management VLAN Serial Number A04880A143100007
Resiliency Link Up No
Resiliency Link State The resili link is not confi d.
Stack Ports

Guest Devices

Guest Devices that are connected to your device are shown here.

Device Info Stack Notes Guest Devices Backups Configs Licenses File System

Q, Find guest device..
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Backups

The Backups tab is shown when you select an AMF Plus Master or Controller device. This section
specifically controls the AMF backups. Note that using Vista Manager, you cannot initiate a backup
from a member node, this is only for AMF Master or Controller devices.

Backups
Backup Devices to Master:
A~ ~
Select Time: 03 00
v v
Choose Frequency: Daily

For more information about AMF Plus, "Using AMF Plus Features" on page 227, as well as the AMF
Plus Feature Overview and Configuration Guide.

Configs

Clicking on Configs leads you to the Configuration Backups menu. In this menu, you can back up
both running and startup configurations.

< (< 3 x930-master ° SSHtoDevice  BackupDevice  BackupArea [EEELEMDTVIEN WOEEELETES

Devicelnfo ~ Stack  Notes  GuestDevices  Backups  Configs  Licenses File System

Last 5 Year(s) ¥ m

Q search by ke ® Delete selected  Compare selected Backup Running Backup Startup

Source BackedUp ~ Description Created by ° Favourite g Action

Running 01/08/2023,13:52:29 manager

Configuration Backups

Startup 31/07/2023,11:00:09 manager

This feature provides you with the ability to manage startup configuration files, including backing up,
restoring, and comparing configuration files.

You can:
a. SSH to a device
b. delete a selected configuration
c. compare two selected configuration files
d. back-up a running configuration file

e. back-up a startup configuration file
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f. set favorite configuration files

Action
g. perform actions from the Action menu

You can perform specific actions on one file from the Action menu:

B delete a configuration

Delete
m set a configuration as start-up

m  download a configuration Setas startup

m favourite a configuration Download

Note: Favourite config files cannot be accidentally deleted, unless Favourite

unfavourited first.

)

How to backup a device configuration and set at startup

Backing up your configurations is an important procedure that helps to prevent issues in your
network. This is helpful if you would like to go back to a previous configuration.

© < ) @ x930-master SSH to Device Backup Device Backup Area Reboot Device

Device Info Stack Notes Guest Devices Backups Configs Licenses File System
Configuration Backups Last 5 Year(s) v )
Q_ search by ki i ® Backup Running Backup Startup
Source D BackedUp ~ Description Created by Favourite Action
Running D 01/08/2023, 13:52:29 manager
Startup O 31/07/2023,11:00:09 manager Delete
Set as startup
Download
Favourite
1to20f2 Page

On the Configs tab of the device you wish to update, click the Backup Configuration button.
1. A notification on successful backup will appear.
2. Type a brief description in the Description textbox. Click outside the textbox to save.

3. You can click on the Action drop-down to set a config backup that you wish to set as startup.

A reboot is required to load the new config. A bell icon will appear on the Reboot Device indicating
further action is required. Click the Reboot Device button immediately, or schedule a time for it.

Restoring a config overwrites the contents of the current startup-config only. The original file-name
and location of the backup config will not be used during the restore.

Note: When a device config is saved using the CLI, Vista Manager detects this and automatically
runs a backup without requiring any user action.
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Comparing configuration files

You are able to compare device configuration files if you wish through the device’s configs tab. This
helps you make a more informed decision about the changes being written to your device. You can
also compare running config and start-up config. To do this:

1.
current running config.
2.
Select up to two files.
3. Click on the Compare selected button.

Compare selected @

& ) @ VAA
Device Info Notes Guest Devices Backups Configs Licenses
Configuration Backups
Q Delete selected
BackedUp ™ Description Created by
12/01/2022, 13:19:25 Jan2022-Backup manager
02/08/2021, 11:37:43 manager
s BT Py = =W >~

If you want to compare the current running config with another config file, make a backup of the

Click on the check box on the left-hand side of each configuration file you wish to compare.

SSH to Device Backup Device Backup Area Reboot Device

File System

Last 5 Year(s) v

m]

Backup Configuration

Favourite Action

Y

PP

N WO

When comparing two configuration files, the tool displays differences in full, or just five lines of either
side, highlighting differences in bold and in color. Toggle between settings using the Minimal and

Full buttons.

Configuration Backups / Config Comparison

Config Comparison VAA

18/11/2020,10:09:20 Minimal Context

1
- ! Startup-config saved on Tue Nov 17 21:88:54 282@ 10880 b
!
service password-encryption
!
hostname VAA
1

1
@aa suthentication enable default locsl

@aa authentication login default local

atmf master

atmf area AREA® id 182 local

atmf topology-gui enable

- atmf backup server id 1 1@.32.192.15 username manager path

it

FaP P o e T A el ™

L e
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Full Context

3

+

PRS-

12/01/2022,13119:25 w

!

! Startup-config saved on Sun Aug 1 23:37:33 2821 10000 b
!

service password-encryption

1

hostname VAA

enable default local
login default local

authentication
authentication

atmf controller
atmf ares AREA2 id 182 local
atmf topology-gui enable

!
F

- - cream ot W
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Licenses

The Licenses tab displays all device licenses and their duration in a graph. You can add and
examine licenses on an AMF device from the Licenses tab.

“« ::-c:' 3 x930-master

Device Info Stack Notes Guest Devices

Licenses

2024

AMFPLUS Master

Base License

@ click license bar to configure expiry notification settings (applies to non-permanent licenses only)

SSH to Device Backup Device Backup Area Reboot Device Delete Device

Backups Configs Licenses File System

Enter Licenses Upload Licenses

Dates on graph represent system time on device

2025 2026 2027 2028

AMFPLUS Master

Base License

Note that this is different to the System Management Licenses tab, which shows all of the licenses
on Vista Manager. For information about the System Management Licenses page see "System

Management" on page 319.

The Enter Licenses button allows you to add a license by copy-and-pasting the license enable
command. The Upload Licenses button allows you to select either a system license certificate
(.csv) file or a flexera license capability response (.bin) file.

More license information and notifications

Duration
May 2, 2023 12:00 PM - May 2, 2028 12:00 PM

Expiry Notifications Q

AMF nodes
10

AMFPLUS Master X

Click on a license bar to display a pop-up panel on the left
with additional information about that license.

You can turn off expiry notifications. By default, all license
expiry notifications are set to enabled. Click on a license
bar that you wish to disable notifications for. A side panel
will appear. A success message will pop up at the bottom
of the side panel. A crossed-out bell will appear on the
license bar if you disable notifications.

Note:
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This feature applies to non-permanent licenses only.
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File System

The File System page provides a file directory with the software files that are stored on the selected
device. This page allows your to upload software files to your device and browse folders stored on
your device.

File System Upload Files

File System

Q se

Name = Size Date Modified Action

10:55:41
flash 2023-07-25
12:00:00

1970-01-01

ush

You can click on a folder name to view items in that folder.

flash

571 You can to upload software by clicking the
Upload Files button on the top right. This will
show the Upload Files dialog, where you can
upload software files from either a direct URL or
from your device.

Upload Files

Latest software is available from the Allied
Telesis Download Center

From URL

From local storage

To delete afile:
1. Click Delete in the action column for the file(s) that you wish to delete.

2. A confirmation message appears. Click Delete to proceed. A success notification then appears
on the bottom right.

Delete File %

File will be deleted from all stack members. Are you sure you want to delete docnet-base.cfg?

Note: File(s) selected for deletion on a stacked device will be deleted from all stack members.
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There are some limitations to take note of:
B Protected files cannot be deleted, this includes:

B boot firmware release files

®  backup boot firmware release files
B boot configuration files

m  backup boot configuration files

® Directories cannot be deleted.

m  Wildcard characters (*) are not supported in the file search.

DPI per Entity

To view the DPI statistics, navigate to Asset Management and click on a device.

To enable DPI per Entity on devices, click the cog
icon in the top right of the DPI per Entity screen. This
will bring up the DPI Configuration window where you
can toggle it on.

DPI Counter per entity Disabled l:l

DPI Configuration

ﬂ Changes to DPI configuration may affect features that use applications
including Internet Breakout, Firewall rules, NAT rules, SD-WAN rules.

Device DPI e
Provider

DPI Learning
DPI per Entity

Application Sharing (requires DPI Learning)

Cancel
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If no entities are configured on your device, then Vista Manager will show you a warning that none
are configured. They can either be configured via the CLI or Device GUI. If Device DPI and Per Entity
aren't already toggled on, click each of them to toggle them on.

0 Entities configured on device

Configure entities via the CLI or Device GUI

Device DPI and DPI per Entity must be enabled to view application statistics per Zone/Network/Host,

AYE Allicd Telesis  Vista Manager e

-
< I hg-gw
Device Info Notes Guest Devices Configs Licenses DFI per Entity File System
Device DPI Per Entity procera

Entity Application

Entity Zone: PRIVATE
> PRIVATE 1 Network Application Traffic % = TX Pack
> PUBLIC 1 Network
udp 86.33 17260
» VM_Zane 1 MNetwork
icp 10.29 18726
http 2.68 0

Clicking on each entity on the left will show the stats, sorted by the highest percent of traffic at the
top under the Traffic % heading. Clicking on a column sorts by that field. If there's an arrow to the
left of the network name, you can drill down to see each host.

By clicking the Application tab, you can click on a particular application to see their stats. In the

table, you can click on the zone to see the stats for networks, and drill down into a network and into
hosts.
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Application reconfiguration support

Because enabling DPI may affect existing firewall/NAT/PBR rules, Vista Manager EX automatically
redirects you to the Applications tab for a detailed reconfiguration of applications if required.
Alternatively, you can navigate directly to this page to adjust the list of applications before enabling
DPI, to ensure the router functions normally.

To enable DPI:

1. Click on the DPI per Entity tab.

2. Click on the Settings cog icon.

3. This opens the DPI Configuration dialog box.

b1-gw %
DPI Configuration

o Changes to DPI configuration may affect features that use applications
including Internet Breakout, Firewall rules, NAT rules, SD-WAN rules.

Device DPI

Provider Built-in

DPI Learning

DPI per Entity

Cancel Apply Changes

C613-10634-00-REV B DPI per Entity | Page 162



- < 1890 SSH to Device Backup Device Reboot Device
Device Info Notes Guest Devices configs Licenses DPI per Entity File System Applications —

Application Management ©® Device DPI DPI Learning DP1 per Entity Provider: builtin ~ +
Type Name Protocol Source Ports. Destination Ports Action
Custom (7) Custom applications will affect features that use DP| applications. e.g. firewall/MAT/PER rules
Custom applications take priority over DPI
Promated aim TCP 1024-65535 9898-9898 ]
Promated awe TCP 1024-65535 65437-65438 [ ]
- | . ——a P & gy L Fa Membaciiam, 2 A bt
Promated http TCP 1024-65535 80-80 ]
Promaoted https TCP 1024-65535 443-443 |

DPI provider built-in (252) Running

DPI applications will affect any features that use predefined applications. e.g. firewall/MAT/PER rules
DPI applications take priority aver predefined

Predefined (35)

Prigritize to override DPI application

Predefined icq TGP 1024-65535 5190-5190 ™
Predefined ident TCP 1024-65535 113-113 ™
Predefined imap TCP 1024-65535 143-143 ™

Here, you will see custom applications and predefined applications of your selected device. If DPI is
enabled, you will also see the DPI running status, providers and the number of DPI applications on
the device.

Custom applications and predefined applications will appear in two groups, separated by the DPI
group, which indicates priority:
1. Custom

2. DPI

3. Predefined

When DPI is enabled, a warning icon will appear beside the predefined applications. This indicates
that:

m they may not work due to their lower priority, prompting you to promote them to custom

m if they overlap with DPI applications, they should be considered for promotion if any rules are
using them
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As a user with write permission, you will be able to:

B enable/disable various DPI settings

m change the DPI provider

m  promote predefined applications to the custom category

B remove promoted applications from the custom category

Applications

You can click on the Applications tab to open the Application Management page.

The Applications tab is closely related to the SD-WAN feature. For more information see "WAN" on
page 283. For further information, see the SD-WAN Feature Overview and Configuration Guide.

Branch office routers (clients) can gain access to applications on a head office router (server) by
using this functionality. Applications learned on the servers can be distributed to the clients, thus
allowing features like Internet Breakout to be enabled on a client.

®  ARS3050S, AR4050S, and ARX200 devices can be used as server devices that have advanced
DPI engines available. This means that they can share their applications with other devices.

m  AR2010V, AR2050V, and TQ-R Series Routers can be client devices. A server device sends
these client devices the application data.

Note: This functionality requires AR-series devices to run AlliedWare Plus 5.5.1-1 or later.

You can enable Application sharing in three different ways, see the following pages for more
information on each method:

m "1: Enabling Application sharing via the Traffic map" on page 165
B "2: Enabling Application sharing via the Traffic map side panel" on page 167

m "3: Enabling Application sharing via the Device’s Applications Tab" on page 168
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1: Enabling Application sharing via the Traffic map

24 Devices 22Up 2 Unmanaged @ Application Priority A+ Auto Traffic Shaping
1 Device 1 Hub Interface

Selected Devices *§  Traffic o & X Q
x

) 2-531-2050-CLIENT

ez 3-511-2010-CLIENT X

Sltes »

Groups »

Auto Traffic Shaping »

Application Sharing e

1. Navigate to the traffic map.
2. Select at least one client router.

3. Right-click on the selected router(s) and select Application Sharing from the menu.

24 Devices 22 Up 2 Unmanaged

"L Traffic v & x e

Application Sharing %

Changes to DPI configuration may affect fi that use

including Internet Breakout, Firewall rules, NAT rules, SD-WAN rules.
Server and client devices must share AMF area.

Select Server Device *
elect Server Device

Supported devices AR50, AR3050, AT-VFW

Client Devices (2) o

@ Client Device Server Action
2_531-2050-CLIENT 2_§31-2050-... Nk i
3.511-2010-... Remote; 1_s50-3050-SERVER [}

Cancel Save
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This opens up the Application Sharing side panel. You may remove or add more client devices
here.

5. Next, select a server device from the drop-down list. Take note of the current DPI state of the

server.

"8 Traffic v i x . Application Sharing 5

@ Changes to DPI configuration may affect features that use applications
including Internet Breakout, Firewall rules, NAT rules, SD-WAN rules.
Server and client devices must share AMF area.

Select Server Device *

1_850-3050-SERVER e a |
Server application publishing |s disabled

Device DPI Disabled: Standalone

Configure Device DPI

Cllent Devices (1)

o o

2_s31-2050-CLIENT I3 s11-2010- et Surver Action

2_5831-2050-... None [}

Cancel

6. Click on the Configure Device DPI gear icon button if device DPI is disabled or to configure its

settings.

© Chenges to DPI configuration may affect features that use applications

1_s50-3050-SERVER

including Internet Breakout, Firewall rules, NAT rules, SD-WAN rules.

Device DPI
Provider Bullt-in v

DPI Learning o
DPI per Entity (v @]

Application Sharing (requires DPI Learning)

N
1 client device

Cancel Apply chane

7.

8.

9.
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Turn on all settings to ensure a successful application sharing setup.
Click Apply Changes. This will close the DPI Configuration window.

Finally, click Save to confirm the changes on the side panel.
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2: Enabling Application sharing via the Traffic map side panel

24 Devices 21 Up 1 2 Ursanaged Q Application Priority  ;A# Auto Traffic Shaping
1 Device 1 Hub Interface

1_s50-3050-SERVER
Advanced Traffic Monitoring @ Traffic & x i

Device DPI

e
Running: Server e

Top 5 Protocols

1_s50-3050-SERVER

2_531-2050-CLIENT 3_511-2010-CLIENT

Top 10 Applications

Application

udp 169 MB
facebo... 75 MB
quora 43 MB
gre 28 MB

1. Navigate to the traffic map.
2. Select a supported server/client device. This opens up the Traffic side panel.
3. Click on the Device DPI gear icon button if device DPI is disabled or to configure its settings.

4. If a server device was selected, carry out Steps 7-8 in Option 1.
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5. If aclient device was selected, fewer DPI settings will be displayed. Select a Remote provider to
choose a server next.

2_s31-2050-CLIENT

© Changes to DPI configuration may affect features that use applications
including Internet Breakout, Firewall rules, NAT rules, SD-WAN rules.

Device DPI O

Provider Remote e =

Select Server Device *

1_s50-3050-SERVER o a
Cancel ) ii

6. Select a server from the drop-down list.

7. Click Apply Changes.

3: Enabling Application sharing via the Device’s Applications Tab

AVZ Alied Telesis  Vista Wanager & Q search network © manager
— @ 1_550-3050-SERVER/ SSH to Device Backup Device Reboot Device
1 4
Device Info Notes Guest Devices Applications
«
Application Management © Device DPI | Running: Server

3 Configure Device L. |
Type Name f Destination Ports A
Custom (0)
Custom applications take priority over DPI p

DPI provider built-in (256) Running: Semf) 1y features that use predefined applications. e.g. firewall/NAT/PBR rules

DP1 applications take priority over predefined

F g
Predefined (42) -

Prioritize to overnide DPI application

4

1. Navigate to Asset Management. Select a supported device from the list.
2. Next, go to the Applications tab of that device.

3. Click on the Configure Device DPI gear icon button if device DPI is disabled or to configure its
settings.

4. |If a server device was selected, carry out Steps 7-8 in Option 1.
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5.

If a client device was selected, fewer DPI settings will be displayed. Carry out Steps 5-7 in Option

2.

With DPI learning and application sharing configured and running successfully, you can then enable
Internet Breakout for specific applications on clients from the Traffic side panel. Here, you can also
see what applications have been learned from the server.

1.

Navigate

to the network map.

2. Select Traffic map mode.

3. Select a client device that you wish to enable Internet Breakout for.

4. On the Traffic side panel that launches, enable Internet Breakout accordingly.

Note:
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AV

@

Allied Telesis  Vista Manager EX

24 Devices 22Up 2 Unmanaged

2_s31-2050-CLIENT

Device DPI
Running: Client Connected

Top 5 Protocols

2_531-2050-CLIENT 3_511-2010-CLIENT
Top 10 Applications
Application Internet Breakout
facebo... 496 MB (v @)
quora 39 MB ow ﬁ
p a8 ) B <55-4050
ssl 12MB
google 6 MB a:}
o 0 @

@ Application Priority .~ Auto Traffic Shaping

1 Device 1 Hub Interface

'l= Traffic e o) x (%
fe

1_s50-3050-SERVER

©

e o

Application sharing (between a server and clients) will only be functional within an AMF area.

It is possible to have multiple servers in different areas, but the clients of each server must
be located in the same area as the server.
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Offline Devices

From version 3.13.1 onwards, the Offline Devices tab has been added to the Asset Management
page. Note that this feature is disabled by default.

Asset Management

Devices (133) Endpoints (219) Offline Devices ®) Groups (3) Provision (0) Firmware Report

= Q 0] All Time (No filter applied) () & v Recording: Enabled %

T Delete All

MAC Address Device Name Vendor Status LastDisconnect Time  ~ Latest Authentication (D Action

21:32:01

O
O oits
O
O

21:32:01

20250116

17:11:04

20250116

Critical

The Offline Devices tab lets you see all devices that have connected to the network and then left
within the last 1.5 years. This feature helps you keep track of all assets that are or have been in your
network, making it a useful audit tool. You can also generate a CSV file with this information. It is
sorted with the most recently left device at the top.

B You can search devices by typing a MAC Address, Device Name, Vendor, or Device Type in the
search field.

B You can change the table display using the Manage Columns, Filter Data, and Delete options. The
table is sorted with the most recently left device at the top.

m  Filter the Offline Devices tab by the last disconnect time by using the new Asset Management >
Offline Devices > Time Range Picker.

Configure the Maximum offline device storage time within the range of 1 day to 2 years (731 days)
by clicking the Settings Cog.

Offline Devices Recording: Enabled ¢

L

Offline Devices Settings X

o Devices will be deleted in historical order once the maximum storage time is exceeded.
Maximum storage time

550 a Day(s)

Record offline devices Enabled Q
When disabled, offline devices will no longer be tracked, except for critical devices

Cancel

m  Download a CSV file with all devices listed within the specified maximum storage time range.
Click on the Download CSV button on the Offline Devices table.
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m To see all devices that are currently part of my network, use the existing Asset Management >
Devices table.

B You can export a PDF of the list by clicking the Download button.

Note: When the feature is disabled, all existing data remains, but new data is not collected. Once
the feature is enabled again, data collection resumes. However, devices that go offline while
the feature is disabled will not be shown in the table.
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Groups

The Asset Management page allows you to create groups to organize your network. The groups list
shows created groups in your network, how many devices are in that group, the source, network ID
Criteria, a group icon, and further edit actions.

Asset Management

Devices (13) Endpoints (0) Offline Devices (1) Groups (5) Provision (0) Firmware Report
= Q oyl Load Presets [EETEY TN
Group Name Devices Total Source Criteria Custom Icon Action
areal 8 Devices Auto-Generated (Network) networkld = areal.docn [“ i, ]
area3 4 Devices Auto-Generated (Network) networkld = area3.docn... )

Creating Groups in the Asset Management menu

You can assign multiple devices to a group. Groups can also be created in the Network map; for
information about this see "Groups" on page 67.

A user can create Network groups with read/write permissions in the User Settings page for each
separate user. You can change permissions for different users for both sites and groups on the User
Management page. For more information about sites and groups permissions see "User
Management" on page 314.

To create a group in the Asset Management menu, select the
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You can click the Load Presets button to load a ZIP or GZ file with
groups from a previous version of Vista Manager.

You can customize the groups in the side menu. You can specify a

MAC address range, an IP address range, a vendor, or a combination

of these. You can also select an icon to represent the group.

Once the group has been created, you can use it to view the details of
the members of that group, as well as export that information to CSV.

New devices that are discovered and meet the group’s criteria will
automatically be added to the group.

To
1.

2.

add a group:

Go to Asset Mangement > Groups

Click +Add Group

Edit Group
Name

Example group

1P Range Start:
1P Range End.
Vendor

Add MAC Address

E.g. 0000

Device Family

Switch

Operating System

Device Search

Search Devices

Static Devices
%2302 )

%550 @

Select Custom lcons

+

+ Upload File

Cancel m

Devices (13)

Asset Management

Endpoints (0)

= Q

Group Name Devices Total
1-2F Group 1 Device
areal

8 Devices

aread 4 Devices

offline Devices (1)

Groups (5) Provision (0)

Source

Auto-Generated (Metw...

Auto-Generated (Netw...

Auto-Generated (Netw...

Firmware Report

&l Load Presets |[RESEFG NN

Criteria

networkld = group_5_a..

networkld = areal.doc...

networkld = area3.doc...

2

Custom Icon

)

~

B

Action

3.

4.
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Enter a group Name

In the Device Search field, start typing a device name. A drop-down list appears.
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Add Group

Name
—

TestGROUP e

IP Range Start

)
@

]
=]

Vendor

Search Vendors hd

Add MAC Address

E.Q. D000, * ok + Upload File

|| Device Family

Device Search

- | < ¢

Add 23 devices

s1-bd1-dist-sw1 | site1 | 172.31.8.160
s1-bd1-dist-sw2 | site [ 172.31.0.207
51-bd1-fl1-sw1 | site1 ] 172.31.0.121
51-bd1-fl1-sw1-1.0.10 | site1 [ 172.16.111.5
51-bd1-fl1-sw1-1.0.12 | site1 [ 172.16.111.4
e1-hd1fllew1-1 N 2l eital 117214111 R

5. Select the devices you want for the group. Each device is added as a label one-by-one to Static
Devices.

Device Search

[search Devi

Static Devices e

s1-bd1-dist-swl €3  s1-bdl1-distsw2 €
s1-bd1-fll-sw1 €

Select Custom Icons

6. Click Save.

7. The Vista Group that you have created is now visible in the Asset Management window.
sies 1 vevices AULD-LENETALEU [NELWOTK) NEIWUIKIU = SIES.VISIE-TTEx [ ™ H
sited 2 Devices Auto-Generated (Network) networkld = site4.vista-max [~ =Y
TestGROUP 3 Devices User Created - ==Y

o Tto50f 5 Page 1of 1

Note: From version 3.11.0, RADIUS batch support has been added. You can set-up device groups
for this as above, before you continue configuring the RADIUS groups from the RADIUS
page. For information on RADIUS groups, see "Groups" on page 67.
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Adding a MAC address list

You can add multiple MAC addresses to a group by uploading a .txt or .csv file containing a list of
MAC addresses to the Groups tab of the Asset Management menu. Vista Manager EX then extracts
the MAC addresses from the uploaded file and registers them with the group.

To do this click on the + Add Group button.

The Add Group sidebar will appear where you can type a single MAC address and click the + to add
it, or upload a file with multiple MAC addresses in it.

Add MAC Address

+ Upload File

You can use commas, spaces, and new lines to separate the MAC addresses.

Supported MAC address formats are:
® 000000000000
m 0000.0000.0000
® 0000:0000:0000
m 0000-0000-0000
m  (00:00:00:00:00:00
m 00-00-00-00-00-00
m  wildcard with asterisk (*)
B Any unrecognisable MAC address formats will be ignored, no errors will show to indicate this.

®  While there is no limitation to the file size, the recommended number of MAC addresses should
not exceed 10,000.

You may select a custom icon for the group. Devices that match the MAC addresses of the group
will automatically use the customized icon as their device icon.
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Provisioning

Provisioning is the process of equipping a new AMF Plus node (device) with everything it will need to

operate in an AMF Plus network as needed.

For example, when a new device is connected to the network it can receive the required firmware,
configuration, and licensing files from a nearby device.

You can organize these files in advance through the asset management provisioning system.

During provisioning, you must also define the location of the new device (port it connects to). The
new device must be plugged into the specified port to receive the files.

For more information on AMF node provisioning, including how to configure this through the
device’s CLlI, see the AMF Plus and AMF Feature Overview and Configuration Guide.

You can provision a device through the Asset Management menu.

Asset Management

Devices (13)  Endpoints (0)  Offline Devices (1)~ Groups (5)  Provision (0)  Firmware  Report

= Filter data v Q

Device Name Network License Release Config

s970_test sited - - dutl3.cfg

9s970_test site3 - - dutL3.cfg

Backup Release Backup Config Provision Status Adjacent Info Action
Not Deployed

Not Deployed
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Provisioning a new device

When you click the + Provision Device button, the sidebar will open a dialog where you are able to
provision a new device. You can set up network provisioning between devices that you wish to
connect.

1. Name Device

o . Provision new device
m  Name the new provisioning setting

m  Select the neighbouring device o Name .. e Select file
m  Select the port from the diagram of the device that
appears Name
2. Select files and deploy
B Add a config file (.cfg), you can add a backup Select neighbouring device *
config file as well
B Add a release file (.rel), you can add a backup
release file as well Select port

B Add a Device License file (.txt)

B Add a Device Gui file (.gui)

Once you have completed the provisioning, the
provisioned device node will appear on the
Provisioning tab.

The number next to the title Provisioning (0) will Cancel
change to reflect how many devices have been

provisioned.

Firmware

Device firmware management
The asset management page provides you with the ability to update firmware across a device or

family of devices on a network/AMF area, and then schedule a time when the devices will reboot to
install the firmware release.
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Asset Management
Devices (13) Endpoints (0) Offline Devices (1) Groups (5) Provision (0) Firmware Report
e
areal
Device Family Using Release(s) Firmware Status Action
area3
AR2050V (1)
ARAD50S (2) Update
TQ6702GEN2.. Update

Reboot Updated Devices

If a device needs a firmware upgrade, then an orange triangle icon paired with orange text will show
in the Firmware Status section. The Reboot Updated Devices button on the top left with the orange
bell icon will become clickable.

Note: You cannot upgrade the TQ-R Series access point firmware through Vista Manager EX.
Use the device's CLI or GUI instead.

A Reboot Updated Devices

Mew firmware is present on
devices. Devices must be

Rebooted for firmware to be
activated.

If you hover over this button, it will tell you the devices must be rebooted. Click this button to update
these devices.

Click the blue Update Firmware button to update all device families in the selected AMF area.

Click on any of the blue Update action buttons to update a specific device family. The side panel
opens, showing 4 steps. For this process, you will need a firmware release file for that family.

Reboot Updated Device Update Firmware

Action

Reboot Update

Note: This file is not the same release as the current file running on the devices.
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When firmware distributions are in progress, navigating away from the distribution tab will cancel
any remaining distributions that have not started yet.

X

Firmware update for Network central, Family x930 is already in
progress. Do you want to cancel that update?

No Yes

Updating a device family

This section covers the process of updating firmware via the Update Firmware menu. The steps are
broken up into different sections.

You can exclude selected devices from a given family when you perform a firmware upgrade. This
feature is especially helpful if you need to upgrade only specific devices in a critical network, such as
a hospital ICU network.

If you use firmware distribution to copy a firmware file to devices, and that file already exists on a
device, then firmware distribution will overwrite the existing file. This makes it possible to use
firmware distribution to repair a corrupted firmware file on a device

Update Firmware
OSe\ecl e Upload o erify o::: bute

Select release files

Select release files from local storage Accepted file extension .re )
Select release from URL http Add file(s)
Select release(s) from VAA Add file(s)

Select distribution point source drive

vailab ce ®3632.49 M
Flash Available space ®3632.49 MB

Device Family Target Release Source Release size

AR2010V

AR40508

IE210

IE300

IE340
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Step 1. Select

Select the release files for the Area Master. The permitted file types are .zip and .rel files. Vista
Manager EX first extracts the zip file onto a temporary directory. The release file will then be
distributed to the device family if there is a match. Otherwise, you will be notified of any invalid
extract files.

The source options are:
m from local storage

® from a direct URL

B existing file on the AMF Master (firmware distribution)

To select specific devices, click the Update Firmware button.

1. Select the release files from your desired location. Then click on the Edit Devices button or the
pencil Edit icon in the Action column.

m Edit Devices - to select devices per family

m Edit action - to select

devices for specific Update Firmware x
families in the same '
area

° Select release 2 upload to dist 3 Verlfy Devices 4 Distribute to devices

2. A pop-up then appears
listing all devices under the Select Release Files
device family. This allows
you to deselect specific SEIesan,e from UR,L S— https//awpbuild atinz.|c/releases...  Select Files
devices before upgrading
the firmware.

3. Click Save when you have Select Devices x

finished. The number of
target devices are updated
after you save the changes. | osiceramiy Targer AR05051
eﬂ30505—2

Device Family dit Devices

/]

AR30508

m Users also have the AR3050S (4) 2021
option to copy the file to
a USB drive if their flash

drive is full on the %950 (4) 2021 8 A |
firmware distribution

. Cancel “
point.

Note: If updating multiple families, target release files will appear in each row at the bottom.
Click the Add file(s) button and select the release file you wish to add. Then click Next.

AR30505-3

AR40505 (4) 2021 AR3DS0S-4 u

Note: This file is not the same release as the current file running on the devices.
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When firmware distributions are in progress, navigating away from the distribution tab will cancel
any remaining distributions that have not started yet.

X

Firmware update for Network central, Family x930 is already in
progress. Do you want to cancel that update?

No Yes

Step 2. Upload

The progress bar advances as the file uploads. Click Next once it completes.

Step 3. Verify

The status of the firmware update will show as "Verifying...", and then either notify you of success
or that a number of devices failed. If any failed, click More info to see exactly which devices failed
and why. Assuming that they succeeded, click Update Device to distribute the firmware.

Step 4. Distribute

The status then shows as "Distributing to...". Click Done once distribution finishes.

Click Reboot Updated Devices, then select the date and time for the reboot. After the reboot, those
devices will be running the release file provided.

Note: AlliedWare Plus software versions require a release license for SBx908 GEN2 and SBx8100
switches. If you are using either of these switches, make sure that each switch has a suitable
license certificate. For details, see the “Licensing this Version...” sections of the relevant
AlliedWare Plus release note.
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Report

The Report section of the Asset Management menu displays various device data discovered by
plugins. By looking at the various donut charts, you can see how different assets in your network
compare to each other.

Assets by Operating System Assets by Function Assets by Vendor

In the example above, data from the Forescout plugin is displayed.

The header displays information of assets in your network at a glance, so you can quickly view the
status and comparative information of devices in your network.

The following information is displayed in a donut chart format:
B Assets by Operating System
m  Assets by Function

m Assets by Vendor

Note: If there is no plugin data then the Reports section will appear blank.

C613-10634-00-REV B Device firmware management | Page 182




Plugins

AWC (Wireless Controller) plugin

Allied Telesis Autonomous Wave Control (AWC) is an advanced network technology that utilizes
game theory to deliver significant improvements in wireless network connectivity and performance.
AWC can automatically minimize coverage gaps and reduce Access Point (AP) interference and
respond to network configuration changes and bandwidth demands from user devices.

AWC is closely integrated with Allied Telesis Autonomous Management Framework (AMF) and is
managed by Allied Telesis Vista Manager EX. AWC is available as an optional plugin to Vista
Manager.

To see how to install the AWC plugin, see "Registering/Installing plugins" on page 28.

For documentation on how to use the AWC Plugin, including AWC Plugin User Guides, see the AWC
Technical Documents page.

AWC Wireless Monitoring Dashboard

From version 3.17.1 onwards, you can access the Wireless Monitoring Dashboard to see
summarized information of the Wireless APs and client devices in your network.

®
9
e

&

AVE Allied Telesis  vista Manager Ex

All Management Groups v Al Floor Maps v

AP Status: Latest  2026-04-02 15:44:11

All Management Group...

Floor Map s not selected
APs

24

24APs 85 Clients
19Managed 5 Searching

Associated Clients (per SSID): Latest  2026-04-03 15:44:11

AllManagement Group...

Associated Clients
B hogehoge 84

85 u kg2l 1

24Hours

Associated Clients: History
300

Q
7d | 30d

20260402 15:44

Associated Clients (per frequency): Latest

All Management Group...
Associated Clients

85

Associated Clients (per AP): Latest 2026

AllManagement Group...
Associated Clients

85

© manager -

P

202604 03 1544 m w

2026-04-03 15:42:11

24GHz 48
® 5GHz 31
6GHz 0

04-0315:44:11

B ohta-apsim2-0002
B ohta-apsim2-0001
B ohta-apsim2-0004
ohta-apsim2-0005
B ohta-apsim2-0003
B ohta-apsim2-0007
B ohta-apsim2-0006
B ohta-apsim2-0010
B ohta-apsim2-0012
ohta-apsim2-0011
Others 15

>>View Client Status Page

Click on the Dashboard menu item from the AWC Plug-in menu to access the Dashboard.
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Dashboard

The AWC Wireless Monitoring Dashboard has customizable widgets including:

B AP Status donut charts
B Floor Map status charts

B Associated Client History charts

Recent AP alert log history

By clicking the Cog Icon in the top right of the Dashboard page, you will be redirected to the Dashboard

Settings section of the AWC Plugin’s System Settings page.

: Latest  2026-02-04 15:18:42

You can manually choose to change charts displayed on the dashboard to monitor your network organized

per SSID, per frequency, or per AP.

Dashboard Setting

Widgets to display

Latest
AP Status: Latest
Associated nts (per frequency): Latest
MAssociated (per SSID): Latest
Associated Clients (per AP): Latest

O Detected Rogue APs (per AP): Latest
(] High WLAN Utilization APs Top 10: Latest

' High Traffic Clients Top 10: Latest

History

Associated Clients: History
Log

[0 Recent Events History

Recent AP Log Alerts: History

Vista Manager automatically updates the charts based on the AWC Dashboard refresh rates. You can change

this from the User Management page.

AWC Dashboard

B Loading times of widgets will vary with your network environment’s hardware specifications.
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SNMP plugin

The Vista Manager SNMP plugin can acquire detailed information and statistics from a broad range
of networking devices. Different views enable users to manage devices the way they prefer. It
supports management of up to 2000 devices, and in large networks it automatically searches for
SNMP agents and displays each device found in tree form, for an easy view of the overall network
topology. The SNMP plugin is a powerful addition to Vista Manager EX, adding management
flexibility by also supporting non-AMF devices. To see how to install the SNMP plugin, see
"Registering/Installing plugins" on page 28.

As of update 3.11.0, the SNMP plugin can used as a part of your AMF network without the need for
a license. The SNMP plugin is enabled automatically provided that all AMF masters and controllers
have a valid AMF Plus license that is current and non expired.

@ AMF Plus functionality is only available when all AMF Controllers and Masters in the network have an active
AMF Plus license without any active AMF licenses, or the AMF licenses have been negated by enabling AMF
Plus Forced.

When an SNMP device goes down and is no longer reachable, the plugin will report it as down and
Vista Manager EX will display it on the network map with a Down status.

For documentation on how to use the SNMP plugin, see the SNMP Plug-in and Trap Receiver
Technical Documents.

Trap Receiver plugin

The Vista Manager Trap Receiver plugin captures information about your network. It allows you to
see a wide range of third-party devices and traps received for them. See the SNMP Plug-in and Trap
Receiver Technical Documents for more information.

Forescout plugin

The Forescout plugin automatically discovers non-Allied Telesis devices and displays them as
dynamic icons on the network map. It also displays information about those devices in the side
panel summary. Vista Manager polls Forescout every 5 minutes to retrieve the latest information.

Additionally, Forescout classifies each device by device type. Vista Manager then uses this
information to automatically select an appropriate icon specific to each discovered device.
Examples of such devices could be printers, phones, cameras or personal computers connected to
your network. As a result, you see a more complete view of your network.
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For example, the following figure shows a Honeywell IP camera that has been discovered through
the Forescout plugin.

-
@ 25 Devices 22 Up 3 Down
= ‘? P i ¢ Network No layout P - R
Device
Basic Information
Status Normal
IP Addresses
MAC Address
Vendors Honeywell Security (China) Ltd ‘
Sl S 192.168.12.10
Forescout Plugin Information
Operating System Linux
Function IP Camera
192.168.11.13
192.168.12.13
10.38.29.40
You can also:

m create a group of Forescout-discovered devices from the map or Asset Management page. For
example, you can make a group of all your printers.

B change the default icon for different discovered devices.

B  manually add custom links between a discovered device and an Allied Telesis device via the Edit
layer of the map.

Note that Vista Manager EX only displays the information that Forescout has discovered. Forescout
only finds links to edge devices, so the complete topology with links may not display. To resolve this,
you can manually add custom links to the Vista Manager EX map.

Forescout provides the status of a client, which can either be Up or Down:
m If Forescout returns an Up status for the client, Vista Manager EX will display the node as Up.
m If Forescout returns a Down status for the client, Vista Manager EX will display the node as Down.

m If Forescout does not return any data for the client (i.e., the client is not found in Forescout), Vista
Manager EX will remove the client from the map instead of showing it as Down.

Also, when Vista Manager EX polls Forescout, it receives the information that Forescout has at that
time. If device changes do not display in Vista Manager after polling, check the update interval in

Forescout.

To see a demo of the Forescout plugin, watch our video on Vimeo.
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Prerequisites for installing Forescout

Vista Manager polls Forescout’s Enterprise Manager API to get a list of endpoints along with
information about these end points that a CounterACT device has collected from the device. If the
customer has multiple CounterACT devices, you must first register them with Forescout’s Enterprise
Manager. To see how to install the Forescout plugin, see "Registering/Installing plugins" on page 28.

The Enterprise Manager is the controller that manages CounterACT appliance activity, policies, and
collects information about endpoint activity. You can see the information retrieved from the
Enterprise Manager from the Forescout Console program.

In order to run the Forescout plugin, you need to configure three things in the Forescout console
application:

Step 1. Install eyeExtend Connect
Step 2. Start the web API module

Step 3. Configure the web APl module

Note that this guide does not cover step 1, and instead covers the web API that connects with Vista
Manager. When using this guide, we assume that you have all of your CounterACT devices
registered with the Forescout console. For information about installing eyeExtend Connect, as well
as documentation for the full installation of Forescout CounterACT, refer to the official Forescout
documentation portal.
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First, install eyeExtend Connect. Once eyeExtend is installed, proceed with installing the Connect
web API from the Forescout Console.

Step 1. In the Forescout Console, go to Options > Modules.
Step 2. Click on the Install button, which will open your file browser.

Step 3. Select the Forescout Connect FPI File to install the web API.

The web API will now appear in the Modules list under the Connect heading.

@ Options 10.37.105.210 - m] X
Options
Search Q. Modules
3 B2 CounterACT Devices Modules extend CounterACT's capabilities by enabling integration with other tools, allowing deeper inspection, additional enforcement actions and
~ _‘ Modules :nonr‘\: modules, such as Base Modules, contain plugins that provide added functionality
Mew and updated Base Modules, Extended Modules and ContentModules are available from the product downloads portal
DS Query Extension
Flow Analyzer search O\
Channels MName Type Version m
2 Web API s> @ Endpoint Base 122
% Connact > © Network Base 122
&5 Data Exchange (DEX) > @Authenhcatiun Base 122
« Switch > @ Core Extensions Base 1.22
& GuestManagement > @ Hybrid Cloud Base 212
& Usar Directory ¥ Device Profile Library Content 20112
10€ Seanner ¥ 1oT Posture Assessment Library Content 19012
& HPS Inspecton Engine o MIC Vendor DB Content 20012
IoT Posture Assesament Eng ¥ Network Controller Contsnt Content 107
¢ Flaw Collector ¥ Security Policy Templates Content 20013
A Azure F Switch Content Content 111
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Note that you may have to start the web API after installing. If it is already active, the Start button will
be grayed-out.

1. To start the module, go to Options > Modules in the Forescout console and scroll down to the
Connect module.

2. Expand the connect module accordion menu and select Web API.

3. Click the Start button on the right side of the window to start the web API

@ Options 10.37.105.210 — O ®
Options
Search Q. Modules
3 == CounteraCT Devices Modules extend CounterACTs capabilities by enabling intzgration with other tools, allowing deeper inspection, additional enforcement actions and
more.
£V _,Modules Some modules, such as Base Modules, contain plugins that provide added functionality
Mew and updated Base Modules, Extended Modules and ContentModules are available from the product downloads portal.
DS Query Extension
Flow Analyzer Seareh Q
Channels Name Type Version m
5 \Wab API 7 L UIE CRIENSIUNS vass BT m
2. Connect > @ Hybrid Cloud Base 212
Data Exchange (DEX) * Device Profile Library Content 20112
5
Switch ¥ loT Posture Assessment Library Content 19.012
-
2 GuestManagament © niC vendorDB Content 20,012
3 Gues
2 User Directory ¥ Metwork Controller Content Content 1.0 Appliances
e Us
10C Seanner ¥ Security Policy Templates Content 20,013 m
2 HPS Inspection Engine ¥ Switch Content Content 111
3 s
|oT Posture Assessment Eng F Windows Applications Content 20,012 m
2 Elow Collector ¥ Windows Vulnerability DB Content 20,012 m
A Azure ~ @ Connect Extended 201
Wireless © connect Extended 161
Advanced Tools o Data Exchange (DEX) Extended 385
H
@ Microsofl SMS/SCCM D web AFI Extended 156
17 items (1 selected)

Creating a Web API User

For Vista Manager to access CounterACT devices for polling, we will create a web API user.
® In the Options menu, select Web API

m  On the Web API module click the User Settings tab

B Then, click Add to add a User.

@ Options 10.37.105.210 - [m] 4

Options
Search Q. Web API

> B CounterACT Devices
User Settings lient IP
~ g Modules
= Manage user credentials and authentication settings of CounterACT Weh APls.
DS Query Extension
User Credentials

Flow Analyzer Manage the cradential of users that ars allowsd fo access CountarACT Wab APl

Channels Search Q
sers
S Connect
vista

&~ Data Exchange (DEX)
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Next, we will allow all IP addresses to access the Web API:
®  On the web API module click the client IPs tab

® Then, click Add

@ Options 172.100.1.33

Options
Search Q. Web API

> = Appliance
ClientIPs

> W Modules
© Manage the list of client IP ranges that are allowed 1o access CounterACT Web APIS.
Channels

2, Web AP

IP Address Range
% Connect

Data Exchangs (DEX)

% Switch
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Nozomi plugin

From version 3.12.0 onwards, the Nozomi plugin (Nozomi Networks) is now supported on Vista
Manager. This means you can use the Nozomi plugin to discover and classify devices on your
network. If you run an AMF network with AMF Device Discovery enabled, you can use Nozomi to
add more information about devices into Vista Manager.

EL WS-GUI : ! - € Network ~ No layout ~ ra -1 J'!) [N

Device

Basic Information

[P Consan )
Status i AT-x530L-10GHXm Jill AT-XS916MXS

Management Addresses

MAC Address

Vendors

Nozomi Information
Names WS-GUI

Browser, Igmp, Mdns, Netbios-Ns,

Pratocols
Ssdp

|- == 1]
We au! WSO

After you register the plugin, the Vista Manager will poll for devices and discover them using the
plugin. The devices will then be displayed on the Network Map and Asset Management pages, and
you can change any desired custom details.

Nozomi doesn't return a state for nodes. Also, Nozomi won’t remove down devices from its
inventory. When a Nozomi node is learned it will display on the network map as Up, even if the
device is physically down.

When you manually remove or unregister the Nozomi plugin, the devices discovered by Nozomi will
be removed from the map.

You must first configure the Nozomi Guardian sensor prior to registering it in Vista Manager. To see
information about the initial configuration of Nozomi Guardian, see the Nozomi Plugin User Guide.

To see how to register the Nozomi plugin with Vista Manager, see "Registering/Installing plugins" on
page 28.
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How to setup Nozomi endpoint notifications in Vista Manager

From version 3.13.1 onwards, support for third party security features from the Nozomi plugin have
been implemented into Vista Manager.

You can create alarms in Vista Manager when it picks up alerts from Nozomi above a certain severity
level. You can also enable automatic blocking of endpoint devices above a certain severity level
based on gathered Nozomi information. These changes implement additional security features from
the Nozomi plugin.

To generate syslog event messages in Vista Manager when it receives a security related syslog from
Nozomi, enable the Convert Syslog Security Messages feature in System Management >
Configuration.

System Management

Configuration Optional Features

Record Randomized MAC Addresses (D Enabled @Y

Display devices with randomized MAG addresses such as mbile phones in Network Map.

Licenses A This feature willincrease the number of visible devices i the Network Map and may reduce performance

Convert Syslog Security Messages Enabled @Y
Convert syslog security messages from third party applications into dismissable alarms/events on the event log @

When Vista Manager receives a syslog message from Nozomi matching a security rule, it will create
a event in the event log with a severity level of ALERT.

This creates a alarm visible on the Network map and the Event Log. This is also shown in the alarms
count on the Endpoints table. These alarms can be dismissed to remove the alarm.

Nozomi alert-level based automatic blocking

You can also automatically block devices discovered by Nozomi, based on security severity levels.
When you enable Automatic Blocking from the Asset Management page, you can choose the
severity level that triggers the automatic blocking from Alert, or Emergency levels.

Depending on the source of Security Alerts, additional features may need to be enabled in System
Management > Optional Features.

To enable Automatic Blocking, click the Cog icon on the Endpoints tab of the Asset Management
page.

Asset Management

Devices (12) Endpoints (0) Offline Devices (1) Groups (5) Provision (0) Firmware Report

Table settings

Toggle to enable Automatic Blocking, and select the minimum security severity level for the alarm to
trigger from the dropdown.
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Automatic Endpoints Blocking X

© Tuming on the "Auto-block Unsafe Endpoints’ feature will automatically block any unsafe
RADIUS-enabled endpoints when security alerts are received. These alerts are generated
by our security event rules, and can also be received externally, helping keep your
network secure. Depending on the source of Security Alerts, additional features may
need to be enabled in System Management Optional Features

Auto-Block Unsafe Endpoints Disabled e
Send Email Notification when Endpoints are autematically blocked Disabled

Minimum Alarm Severity
Choose the minimum security alert severity needed to block an unsafe endpoint.

®  When you enable Automatic Blocking, endpoints will be automatically blocked if a security
alarm above the chosen severity occurs.

B You can enable email notifications for security related alarms.

If an Endpoint has been automatically blocked you can manually unblock the device from the Asset
Management table. See "Blocking or Allowing Endpoints" on page 204 for more information.

Microsoft Intune Plugin alerts

From version 3.13.1 onwards, you can view alert information that is gathered by Microsoft Intune in
Vista Manager. Vista Manager integrates information from Microsoft Intune for its Intune plugin to
obtain a full picture of the monitored devices and security alerts.

Devices enrolled in Intune are shown on the Network Map and Asset Management pages in Vista
Manager.

Note that you must have Microsoft Intune and associated applications, such as Microsoft Defender
and Azure Event Hubs, already configured. This includes endpoint devices synced with Intune. To

see how to configure Microsoft Intune, see Microsoft Intune’s Official Documentation.

Security alerts are shown in the Event log. These are linked to the device that the alert occurred on.
If the device has been removed from Intune, then no device information will be included in the Event.

On the Network Map, an alarm badge will be shown on devices that have security alerts.

Do not enable the Automatic Blocking feature from the Endpoints table while using the Intune
plugin. If you have previously enabled Automatic Blocking, disable it.
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Intelligent Edge Security (IES)

Intelligent Edge Security (IES) allows you to manage endpoint communication with MAC-based
authentication supported by AMF Plus devices.

You can use the Endpoints tab to enhance the security of your network by either allowing or
blocking selected MAC authenticated devices that are connected to your Local RADIUS server. You
can also configure this to automatically block endpoints that do not meet a set criteria.

You can set up the authentication server device to forward syslog output of permission or rejection
logs to Vista Manager.

Authentication RADIUS Client Endpoint
Server (Authenticator)

port1.0.2 port1.0.2 /\ port1.0.3

N

(@]
RADIUS Server NAS Device .
10.37.141.20 10.37.141.21 Supplicant/dox1x Node

In order for the Endpoints feature to work, you must have a Local RADIUS server and a Network
Access Server (NAS) device for authentication. This feature frequently polls the network and visually
reloads the list to keep the endpoint list up to date.

You must also configure STOAT on the NAS device to collect endpoint information.

Configuring the RADIUS Authentication Server

First, we will configure the RADIUS Authentication Server. The device running the RADIUS Server is
also running AlliedWare Plus version 5.5.3-2 or later. Alternatively, go to Network Services>
RADIUS> NAS from the Device GUI.

From the CLI, configure the RADIUS Authentication Server with the following commands:

radius-server local
auth-mac-promiscuous

nas 10.37.141.21 key secretkeyl
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We register the NAS device as a RADIUS client to the RADIUS Authentication Server.

Enabling auth-mac-promiscuous mode enables client devices to access the network immediately
when they first connect. You might want to enable promiscuous mode where access is initially
allowed for all endpoint devices, so you can block endpoint devices exhibiting suspicious behavior
individually.

®  When you enable promiscuous mode, the server responds with an authentication success to
MAC-based authentication requests from endpoints not registered with the RADIUS server. You
can set to manually accept or deny unregistered endpoints later.

Instead, if you would like to implement strict operation where communication is initially denied for all
endpoint devices that do not have permission, remove the auth-mac-promiscuous command from

the example above.

Note: If you don’t enter auth-mac promiscuous mode on the RADIUS server, then client devices
will be unable to connect until you manually set them to ‘allowed’.
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Full RADIUS Server Configuration Example

Below is an example configuration for a device acting as a RADIUS Server for the Endpoints feature.
We use the IP of the NAS device with a Shared Secret key, and enable STOAT on the device. We
then connect the server to the network with VLANSs.

radius-server local
server enable
auth-mac-promiscuous
nas 10.37.141.21 key secretkeyl
1
atmf network-name My-Network
atmf master
!
!
service stoat
1
stoat collector enable
stoat collector key secretkey2
!
!
vlan database
vlan 4080 name AMF
vlan 4080 state enable
1
interface portl.0.2
description Link R21-3050
switchport
switchport mode trunk
switchport trunk allowed vlan add 4080
switchport trunk native vlan none
switchport atmf-link
!
!
interface v1an4080
ip address 10.37.141.20/25
1
1
ip route 0.0.0.0/0 10.37.141.120

Configuring a switch to be an Authenticator device
(NAS)
Next, we will configure the Authenticator device (NAS). If you would like to use multiple switches as

NAS clients, repeat this process.

STOAT must be enabled on the Authenticator device (NAS). The NAS device is running AlliedWare
Plus version 5.5.3-2 or later. For more information about STOAT, see the Device Discovery using
STOAT Feature Overview and Configuration Guide.

1. Enable the STOAT service and enable dot1x as the discovery protocol.

We also create a destination to the IP address of the RADIUS Server.
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service stoat
stoat discovery dotlx
stoat destination 10.37.141.20
key secretkey2
2. Connect the NAS device to the RADIUS server:

radius-server host 10.37.141.20 key secretkeyl

3. Define the list of authentication servers to use for MAC authentication. In this case, we only have
one RADIUS Server, so we use the default group.

aaa authentication auth-mac default group radius
4. Enable MAC-based authentication on the port(s) to be monitored:

interface portl.0.1-1.0.3
auth-mac enable
auth host-mode single-host

auth timeout quiet-period 60

Note: Host mode should not be set to multi-host. This can result in multiple endpoints being
authenticated incorrectly.

You can set host-mode to single-host or host-plus-voice.

You may wish to limit the maximum allowed clients using the auth max-supplicant x command.
(Replace x with the maximum number of client devices).

We also recommend you set the authentication timeout to default with the auth timeout quiet-
period 60 command.

5. Connect to Vista Manager to allow dynamic authorization

auth radius send service-type

radius dynamic-authorization-client 10.38.60.20 key
secretkey3

Enabling this allows you to disconnect suspicious client devices from Vista Manager.

6. Optionally, to enable Vista Manager to send Syslog messages to the NAS device, use the
following commands:

Log date-format iso
log host 10.38.60.20

log host 10.38.60.20 level informational program 802.1x
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Full NAS Switch Configuration Example

radius-server host 10.37.141.20 key secretkeyl
1
aaa authentication auth-mac default group radius
1
atmf network-name MyNetwork
1
service stoat
1
stoat discovery dotlx
stoat destination 10.37.141.20
key secretkey?2
1
!
!
auth radius send service-type
radius dynamic-authorization-client 10.38.60.20 key secretkey3
1
vlan database
vlan 4080 name AMF
vlan 4080 state enable
1
interface portl.0.1
description Link_ R20-3050
switchport
switchport mode trunk
switchport trunk allowed vlan add 4080
switchport trunk native wvlan none
switchport atmf-link
1
interface portl.0.3
description ###Supplicant###
switchport
switchport mode access
switchport access vlan 4080
auth-mac enable
1
interface v1an4080
ip address 10.37.141.21/25

1

ip route 0.0.0.0/0 10.37.141.120
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Configuring a TQR Series Wireless AP as a NAS device

This section is specifically for configuring a TQR Series device as a NAS Client device for the
Authentication Server.

If you would like to use multiple TQR Series devices as NAS clients, repeat this process.
In this example, the TQR series device is already set up. If you have not yet configured the device,

please see the Quick Tour section of the AWC Plugin User Guide.

Note: When using IES with TQR series devices, we enable both MAC-based authentication (dot1x)
and the TQR device’s wireless discovery together for STOAT detection. This means that the
Network Map shows both of the connection links.

TQR series devices support device detection via wireless only.
1. Connect the NAS device to the RADIUS server:
awplus (config) #radius-server host 10.37.141.20 key secretkeyl
You can also do this from the TQR’s Device GUI.
m  Go to Network Services > AAA
B Click the + New Host button

m  Enter the RADIUS Server Host IP address, and specify the secret key (secretkey1)

New Host

Radius Server Host

Hosts 10.37.141.20

Key (Optional)

secretkey1

No Data

Authentication Port (Optional)

Accounting Port (Optional)

2. Enable the STOAT service and enable dot1x as the discovery protocol:

awplus (config) #service stoat

awplus (config) #stoat discovery dotlx

awplus (config) #stoat discovery wireless
awplus (config) #stoat destination 10.37.141.20
awplus (config-stoat-dest)key secretkey?2

Above, we also create a destination to the IP address of the RADIUS Server.

For TQR devices, we enable both MAC-based discovery (dot1x) and TQR series wireless dis-
covery for STOAT collection.

3. Configure MAC-based authentication for the wireless network configuration.

if you would like to detect devices on multiple networks, you must add settings to each wireless
network. In this example, we use network 1 and network 17.

awplus (config) fwireless
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network 1
mac-auth radius auth group radius
mac-auth radius send service-type

mac-auth radius dynamic-authorization-client 10.0.0.254
key secretkey3

unassociated-client-list acquire
exit
®  Above we specify the authentication group to use. In this case we only use one RADIUS server.

m  We also configure RADIUS to send dynamic authorization messages to Vista Manager
(10.0.0.254).

We repeat this for network 17:

network 17
mac-auth radius auth group radius
mac-auth radius send service-type

mac-auth radius dynamic-authorization-client 10.0.0.254
key secretkey3

unassociated-client-list acquire
exit
exit
4. Specify the interface to use as the starting point when communicating with the RADIUS server.

This interface is the interface with the IP address specified in the nas command on the RADIUS
server.

ip radius source-interface brl

In this case, the bridge interface (br1) is the bridge interface connected to the RADIUS server. If
you would like to use MAC-based authentication on multiple wireless networks, add a bridge
interface for each network.

5. Define the list of authentication servers to use for MAC authentication. In this case, we only have
one RADIUS Server, so we use the default group.

aaa authentication auth-mac default group radius
6. Enable MAC-based authentication on the port(s) to be monitored
interface portl1.0.1-1.0.3
auth-mac enable
auth host-mode single-host
auth timeout quiet-period 60

7. Optionally, to enable Vista Manager to send Syslog messages to the NAS device, use the
following commands:

Log date-format iso
log host 10.38.60.20

log host 10.38.60.20 level informational program 802.1x
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Endpoint Syslog Messages

The syslog messages that are output when an endpoint connects or disconnects differ depending
on whether the client device is a switch or a TQR series wireless AP.

In the case of a switch, the following three types of syslog messages are output:

1. MAC-based authentication success log

MAC Authentication successful for [RADIUS user
name] @ [endpoint MAC address] on [switch port number]

MAC Authentication successful for 00-00-53-00-5e-
00@0000.5300.5e00 on portl.0.2

2. MAC-based authentication failure log

MAC Authentication failed for [RADIUS user name]@[endpoint
MAC address] on [switch port number]

MAC Authentication failed for 00-00-53-00-5e-
00@0000.5300.5e00 on portl.0.2

3. Device Disconnection Event Log

Supplicant [RADIUS user name] has been disconnected by DM
from [AVM EX IP address]

Supplicant 00-00-53-00-5e-00 has been disconnected by DM
from 192.198.1.250

In the above examples, the RADIUS username is the same MAC address as the endpoint MAC
address. The format may differ depending on your configuration.

For TQR series wireless APs, the following two types of syslog messages are output:

1. Connection log

vap[connected wireless band]. [VAP number]: STA [endpoint
MAC address] associated with BSSID [BSSID of connected
wireless AP] ([SSID of connected wireless AP]) RSSI [RSSI

value]
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vapl.0: STA 00:00:53:00:5e:80 associated with BSSID
00:00:53:00:5e:20 (FreeForAll) RSSI -28

2. Disconnection log

vap [connected wireless band].[VAP number]: STA [endpoint
MAC address] disassociated from BSSID [BSSID of connected
wireless AP] ([SSID of connected wireless AP]) reason
[reason value]

vapl.0: STA 00:00:53:00:5e:80 disassociated from BSSID
00:00:53:00:5e:20 (FreeForAll) reason 1

Connecting to Vista Manager

Configure Vista Manager to send RADIUS Dynamic Authorization messages (Disconnect clients,
CoA (Change of Authorization)).

1. Go to the Network Services > RADIUS page.

2. Click the Shared Secret button in the top right.

@ Shared Secret

Once the Authentication RADIUS server, NAS, and Vista Manager are configured, you will see the
connected endpoints on the Asset Management page under the Endpoints tab.
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Configuring endpoint permissions from Vista Manager

The Endpoint tab helps you to manage supplicants/endpoints by displaying their status and
providing options to allow or block them.

Asset Management
Devices (32) ~ Groups(3)  Provision (0)  Endpoints  Firmware  Report
= Q o] Ak
a MAGC Address ~ RADIUS Username RADIUS Server Hostname  NAS Hostname NAS Port Status O Authentication (O Icon Action
[0 edlaea7lBel2 e0-laea71-5e-12 R20-3050 R21-3050_NAS port1.0.3 Blocked &
[ 00laebesefn - R20-3050 SW31-x530_NAS port1.0.9 Undecided Authenticated =Y
D 001a.ebcb.2eed i R20-3050 SW31-x530_NAS port1.0.4 Undecided Authenticated = x)
D 0011.0100.0014 00-11-01-00-00-14 R20-3050 R21-3050_NAS port1.0.5 Allowed Authenticated = x)
D 0011.0100.0013 # R20-3050 R21-3050_NAS port1.0.5 Undecided [ %3
D 0011.0100.0012 # R20-3050 R21-3050_NAS port1.0.5 Undecided [ %3
D 0011.0100.0011 # R20-3050 R21-3050_NAS port1.0.5 Undecided Authenticated =2}
D 0011.0100.0010 # R20-3050 R21-3050_NAS port1.0.5 Undecided =2}
D 0011.0100.000f # R20-3050 R21-3050_NAS port1.0.5 Undecided Authenticated [ X3
D 0011.0100.000e = R20-3050 R21-3050_NAS port1.0.5 Undecided = =)
to1 > M

There are two major columns that help determine the status of endpoints: the Status column and the
Authentication column.

The current status of the device is displayed in the Status column:

mUndecided - a RADIUS user does not exist on the RADIUS server, and no

Status © decision has been made yet on whether to block or allow it. See "Default
_— authentication in promiscuous mode" on page 204 for more information.

_ mBlocked - a RADIUS user exists to block this endpoint on the network and is
— set to reject on the RADIUS user page
Lifle=isi mAllowed - a RADIUS user exists to allow this endpoint on the network, and is
— not set to reject on the RADIUS user page

owel

The Authentication column shows the authentication status as it is learned through AlliedWare Plus
Device Discovery.

A blank or empty column indicates that the endpoint is unauthenticated
Authentication (® and unable to connect to the network.

BA column containing the ‘Authenticated’ keyword indicates that the

endpoint is authenticated and able to connect to the network.
Authenticated
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Blocking or Allowing Endpoints

Select one or multiple devices you wish to configure by selecting the checkbox next to a device. The
Block Selected and Allow Selected buttons will become selectable once you select a device.

) Block Selected + Allow Selected

When you click the Block Selected button:

B The selected RADIUS users will be added to the RADIUS server if they do not already exist, or
updated with the "Reject" keyword based on the selected endpoints' MAC addresses.

m  Once the RADIUS users are created or updated, the Status column will display Blocked for the
selected devices.

m A Change of Authorization (CoA) request will be sent from Vista Manager to the NAS device to
disconnect the selected devices as part of the blocking process.

m [f the CoA request is successful, the Authentication column will be cleared for these devices.
m  The Network Map includes a ‘Blocked’ icon next to the client devices that you have blocked.
B You can see a "blocked" badge on the blocked and unauthenticated devices icon in the Network

Map.

Note: The table may take several minutes to reflect these changes, as it depends on the endpoint
attempting to reconnect and being re-learned by Device Discovery.

When you click the Allow Selected button:

m The selected RADIUS users will be added to the RADIUS server if they do not already exist, or
updated by removing the "Reject" keyword (if it exists) based on the selected endpoints' MAC
addresses.

m  Once the RADIUS users are created or updated, the Status column will display "Allowed" for the
selected devices.

m  During the next reconnect attempt, the selected devices will be allowed access to the network.

m  The Authentication column will display Authenticated for allowed devices.

Default authentication in promiscuous mode

Enabling or disabling promiscuous mode decides if clients are authenticated by default or not.
Depending on if you have your RADIUS server’s authentication set to promiscuous mode or not,

using the auth-mac-promiscuous command, the Endpoints table will show different badges.
Promiscuous mode is disabled by default.
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When promiscuous mode is disabled, when the RADIUS server receives authentication from the
NAS device, it is not automatically authenticated. The RADIUS server checks its database entries to
make sure the corresponding MAC address matches the client’s, and if not, then it does not give the
client access to the network and does not authenticate it.

Visually this displays on the Endpoints table as both blank in the Authentication column, and
Undecided on the Status column.

Status (O Authentication (0

Undecided

However, if you enable promiscuous mode, when the RADIUS server receives information from the
NAS device, the client will be authenticated by default, even if its credentials do not exist in the
database.

Status (D) Authentication ()

Undecided Authenticated

To see more information about enabling promiscuous mode on the RADIUS Server, see "Configuring
the RADIUS Authentication Server" on page 194.

For further support, see the Local RADIUS Server Feature Overview and Configuration Guide.

You can set up Vista Manager to automatically block endpoints based on security alerts received
from third-party applications. For more information, see "Nozomi alert-level based automatic
blocking" on page 192

RADIUS Endpoint column data

From version 3.13.1 onwards, statistical data from RADIUS server connections are added to the
Endpoints table on the Asset Management page, and the RADIUS User page.

The following columns have been added to the Endpoints page:

m  The Last Interaction Time column displays the local timestamp for the most recent connection
between an endpoint device and its associated RADIUS server

B The Failed Connection Attempts column displays the count of unsuccessful attempts from an
endpoint device to connect to the specific RADIUS server since the server's last reboot.

m  The Successful Connections displays the count of successful connections made by an
endpoint device to the specific RADIUS server since the server's last reboot.

The value of these columns is updated every 5 minutes.

Similar columns are added to the RADIUS User table. You can track the timestamp of the most
recent interactions between a RADIUS user and the RADIUS server.
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These RADIUS User columns include:

m  The Last Interaction Time column displays the local timestamp for the most recent interaction
between a RADIUS user and its associated RADIUS server. If the RADIUS user has no connected
physical device, the value in this column may be empty.

B The Failed Login Attempts column displays the count of unsuccessful login attempts made by
the RADIUS user since the server's last reboot.

m  The Successful Logins column displays the count of successful logins of the RADIUS user since

the server's last reboot.

You can sort the table data by the column types. The RADIUS users table will refresh when there are
user changes on the RADIUS server, for example, user creation or user deletion.

RADIUS login for Vista Manager

From version 3.17.1 onwards, as an admin user, Vista Manager supports external user authentication
through a RADIUS server. This allows users to log in without local Vista Manager accounts.

To enable RADIUS login:

1. Goto User Management.

2. Click on the Settings button to open the User Management Settings.

| & Setlings l
Lo

3. Toggle RADIUS Authentication to enable RADIUS login.

User Management Settings X

RADIUS Authentication

Enable RADIUS authentication to allow usersto loginwith  Enabled @G
their RADIUS credentials.

Enable RADSEC {Recommended) Disabled (@)

IPv4 Address or Hostname *

Port *

1812

Shared Secret *

Default Group Permission

Read Only -
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Requirements

B Atleast one local admin account in Vista Manager is required.

B You cannot remove the last local admin account.

B RADIUS authentication is only available after initial configuration is complete.

B After a RADIUS user logs in to Vista Manager for the first time, that user account appears in User
Management.

Email address behavior

B |faRADIUS user has no email address, they are redirected to User Management after login and prompted
to enter one.

® If an email notification rule includes a user with no email address, Vista Manager shows a warning.

Permission assignment

When enabling RADIUS users to login, you can also set a default permission level for users that don't have
Filter-IDs assigned to their account. Vista Manager reads the Filter-ID value returned by the RADIUS server
and applies permissions automatically.

Vista Manager recognizes the following Filter-ID values:
vista-admin
vista-readonly
vista-readwrite

vista-none
If no Filter-Id is provided, Vista Manager applies the configured default permission.
In Vista Manager, you can specify a default permission from the following:
B Read-only
B Read-write
® None
If you select none, an admin will need to manually set their permission through the User Management
page.
Important limitations

B If a RADIUS username matches an existing local Vista Manager username, the RADIUS user cannot log in.

B RADIUS user permissions are evaluated at each login. Permission changes should be made on the
RADIUS server, not locally in Vista Manager.

B Password changes and resets for RADIUS users must be done on the RADIUS server.

m If Vista Manager cannot reach the RADIUS server, RADIUS users cannot log in until connectivity is
restored.

B RADIUS users who are already logged in are not affected until they log out.
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RADSEC

Enabling RADSEC (RADIUS over TLS) is strongly recommended.

For RADSEC, you need to provide three certificates:

m  (Client certificate (.pem)
m  Client private key (.pem)

B CA certificate (.pem)

Enable RADSEC (Recommended) Enabled @S

Client Certificate * Accepted file extension: .pem

No file selected Select File

Client Key * Accepted file extension: pem

No file selected Select File

CA Certificate * Accepted file extension: .pem

No file selected Select File

Certificate Usage
B The Client Certificate identifies Vista Manager to the RADIUS server.
B The Client Private Key proves ownership of the client certificate.

B The CA Certificate validates the RADIUS server certificate during TLS setup.
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Network Services

Access Control list

The Access Control List (ACL) matrix provides a visual representation of the Access Control Lists

applied to your network.

To view the Access Control List matrix, select Network Services > Access Control from the

Service Monitoring

RADIUS

navigation menu. This page displays the Access Control List matrix.

Using the Access Control List matrix provides a visual representation of the ACLs on the network.
The rows and columns show which host groups are being used, and the cell color shows how they
are being used. For example, it is easy to see if no ACLs exist matching network traffic from host
group SALES to host group ENGINEERING. And it is simple to view an ACL's configuration by

clicking on a cell.

The axes of the Access Control List matrix
show the source/destination IP host groups
discovered across the network. Each host
group contains one or more hosts or subnets.
You can use a host group as a source or
destination match in a named hardware ACL.
This means only named hardware ACLs are
displayed within the matrix. Using host groups
is recommended, as it greatly simplifies any
ACL configuration containing many hosts,
subnets, or ports.

Click on a colored cell to learn more detail
about the ACLs with the cell's matching source
and destination groups. When you click on a
cell, the Access Control Lists side-panel will

Destination

Hurman_Resources

Engineering
loT_Devices
Management

Data_Center

Research

Source

Accounts

Sales

Ay

Accounts

Ay

.. Edge_Devices

Edge_Devices

Engineering

Human_Resources

loT_Devices

Management .

Research

Sales

Data_Center

expand, and show deployment and filter details. These details include:

m the filter type and action.

B any source, destination, or port group configuration.
B a section where the access control list is deployed.

Any Access Control lists with identical names and configurations are combined in the side panel.
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For example, if ten switches have the same ACL, it
will appear only once in the side panel. You can Aecess Contral Lists %
click on the Filters section to reveal where the ACL | accounTs = ENGINEERING
is deployed. If there are no interfaces listed, the
ACL exists but is not deployed to any switchports. Stiom Sttex cetzue | M | Show S fie=Y ) Show ety nerts
ABCDE

An Access Control list can contain multiple filter
lines. Each line starts with a single action (Permit,
Deny, etc), then the filter type, followed by the
source and destination matching criteria. Rather
than using a host group, you can use 'any' for a
wildcard match for source and/or destination.

Filters:
Permit TCP v

Deployed to 1 device v

ACL1_p_SSH_p_HTTP

Filters

The Hardware ACLs configured on the network Permit TCP .
must use one of the following filter types to appear Permit TCP v
in the Access Control List Matrix: Deployed to 2 devices 5
- |Cmp copy-to-cpu
| | Ip Filters:

Copy ToCPU TCP -
m proto

Copy ToCPU IP -
m tcp
® udp

Note: ACLs using MAC filters are not supported by the Access Control List matrix, and are not
displayed. Numbered ACLs and Software ACLs are also not supported.

ACL and port group filters

Filter by ACL Filter by port group

All ACLs All Port Groups

Two selection filters are available above the Access Control List matrix.
m  Filter by ACL - this allows you to quickly see where a single ACL exists on the matrix.

m  Filter by port group - this lets you filter out all cells containing an ACL that does not use the
specified port group. Named ACL port groups contain port-matching rules.
For example, a port group called 'HTTP' could contain a rule to match port 80. The name given
to host groups and port groups is user-defined, but should describe the group's content.

Any named hardware ACL using host groups will be displayed on the Access Control List matrix, it

does not need to be deployed. Any ACL that is deployed will show the device's name and deployed
switchports under the ACL Name.
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Cell color key

Mo Action @ Deny Permit @) Deny/Permit Other

The color of each cell indicates if a matching Hardware ACL has been found for that combination of
Source and Destination host groups. The cell colors show the following conditions:

Cell Color Condition

Red At least one deny filter is deployed in a hardware ACL for the
source/destination cell combination. There are no permit filters
configured for the source/destination combination.

Green At least one permit filter is deployed in a hardware ACL for the
source/destination cell combination. There are no deny filters
configured for the source/destination combination.

Blue At least one filter for both permit and deny is deployed in a
hardware ACL for the source/destination cell combination.

Yellow Filters are deployed for the source/destination cell combination,
but none have a permit or deny action (for example, the Send to
CPU action).

Grey No filters are deployed for the source/destination cell
combination.
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Host groups and port groups buttons

Host Groups Port Groups

The Host Groups and Port Groups buttons allow you to see all the groups
that are configured on the network.

Host Groups *
Show deployments

ACCOUNTS
Address 192.168.1.0
Mask 0.0.0.255
Deployed to 2 devices v
ENGINEERING
Address 192.168.2.0
Mask 0.0.0.255
Deployed to 2 devices v

Host groups define one or more lists of hosts using the acl-group command. These hosts can have
masks in the same way hosts specified in existing ACLs do. The Host groups button shows details
of the host groups, and where they are deployed.

Port Groups *
Show deployments
DNS
equal 53
Deployed to 1 device ~
gt22
greater than 22
Deployed to 1 device ~
HTTP
equal 80
Deployed to 2 devices ~

Port groups define one or more lists of ports, along with their operation (equal, not equal, greater
than, less than). The Port groups button shows details of the port groups, and where they are
configured in the network.
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Filters and deployments

Show filter details Show all filters Show deployments

There are several check boxes that provide additional information.
m  Show filter details - displays additional information about the filters
m  Show all filters - display all filters contained in the ACL

m  Show deployments - displays which devices the filters are deployed to

By default, only the filters that exactly match the source/destination cells are displayed.

Creating new hardware ACLs

You can create use the Alliedware Plus CLI to create hardware ACLs and associated host/port
groups on a switch. Follow these steps (in configuration mode) to create and deploy an ACL.

1. Create the source and destination IP Host Groups. These contain the hosts or subnets the ACL
is to match on.

configure terminal
acl-group ip address GUESTS
ip 192.168.10.0/24
exit
acl-group ip address HEADOFFICE
ip 10.1.1.0/24
exit

2. Create the ACL port group containing the ports the ACL is to match on. In this example, we are
going to match against SSH port 22.

acl-group ip port SSH
eq 22
exit

3. Create the hardware ACL to deny TCP packets matching port group SSH from source host group
GUESTS to destination host group HEADOFFICE.

access-1list hardware Deny_SSH_GUESTS_to_HEADOFFICE

deny tcp host-group GUESTS
host-group HEADOFFICE port-group SSH

exit
4. Deploy the ACL to a switchport.

interface portl.0.1

access-group Deny_ SSH_GUESTS_to_HEADOFFICE

This ACL would be shown like this on the ACL Matrix:
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Access Control List Matrix @

Filter by ACL Filter by port group

All ACLs - All Port Groups - NoActien @ Deny @ Permit @ Deny/Permit Other

Destination

any
GUESTS
HEADOFFICE

Source
any

GUESTS

HEADOFFICE

Converting existing hardware ACLs

ACLs that do not use ACL Host Groups can take up many lines of configuration. In the example
below, a numbered hardware ACL is used to block 8 ports on two hosts:

awplus (config)# access-list hardware 3005_My_ACL

awplus (config-ip-hw-acl)# deny tcp 1.1.1.1/32 any eq 10

awplus (config-ip-hw-acl)# deny tcp 1.1.1.1/32 any eq 20
awplus (config-ip-hw-acl)# deny tcp 1.1.1.1/32 any eq 30
awplus (config-ip-hw-acl)# deny tcp 1.1.1.1/32 any eq 40
awplus (config-ip-hw-acl)# deny tcp 1.1.1.1/32 any eq 50
awplus (config-ip-hw-acl)# deny tcp 1.1.1.1/32 any eq 60
awplus (config-ip-hw-acl)# deny tcp 1.1.1.1/32 any eq 70
awplus (config-ip-hw-acl)# deny tcp 1.1.1.1/32 any eq 80
awplus (config-ip-hw-acl)# deny tcp 2.2.2.2/32 any eq 10
awplus (config-ip-hw-acl)# deny tcp 2.2.2.2/32 any eq 20
awplus (config-ip-hw-acl)# deny tcp 2.2.2.2/32 any eq 30
awplus (config-ip-hw-acl)# deny tcp 2.2.2.2/32 any eq 40
awplus (config-ip-hw-acl)# deny tcp 2.2.2.2/32 any eq 50
awplus (config-ip-hw-acl)# deny tcp 2.2.2.2/32 any eq 60
awplus (config-ip-hw-acl)# deny tcp 2.2.2.2/32 any eq 70
awplus (config-ip-hw-acl)# deny tcp 2.2.2.2/32 any eq 80

Blocking the same ports on a third host would take another 8 lines of configuration.

With ACL Host and Port Groups, the equivalent configuration would be:

awplus (config)# acl-group ip address My_Host_ACL_Group
awplus (config-ip-host-group)# ip 1.1.1.1/32

awplus (config-ip-host-group) # ip 2.2.2.2/32
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acl-group ip port My Port_ACL_Group
eq 10
eq 20
eq 30
eq 40
eq 50
eq 60
eq 70
eq 80
access-1list hardware 3005_My_ ACL
deny tcp host-group My Host_ACL_Group any port-

group My Port_ACL_Group

This is already a smaller configuration. But blocking the same ports on a third host would be just one
extra line of configuration:

acl-group ip address My Host_ACL_Group
ip 3.3.3.3/32

Service monitoring

As an administrator, you can use Service Monitoring to learn the status of services running on
devices within Vista Manager. You can configure a monitoring task to run periodically, or to monitor
services on demand.

Service Monitoring will display the status of the services. It helps you track the status of services of
critical importance, and be updated as soon as they go down. Knowing the status of services may
also help when performing diagnostic tasks.

A user that is set to read-only cannot select the ‘Create Monitor’ button, and can only view the
contents of the page.

You can change permissions for Service Monitoring on the User Management page.
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Creating a monitor

To create a monitor:

1. Click on the Service Monitoring section in Vista Manager.

2. Click on Create Monitor.

3. Enter the following details:

®  Monitor Name - a name to identify the monitor
m |P Address - the IP address of the device you want to monitor
m  Service Port - the port that the service is running on
m [nterval - how often to monitor the service
m  Protocol - either TCP or UDP
4. Click Save.

1 Services

o 1 normal

EDT

New Service Monitoring Configuration

Monitor Name: IP Address:

8SH

Enabled: Qp ()

Service Port Interval (mins) Protocal

65535 120 tp

The monitor has now been created and w

monitoring the service.
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ill be displayed on the

service monitoring page. Click on Monitor Now to begin
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Service Monitoring statuses
The service statuses may be one of the following:
m  Pending: The service has not been monitored yet.

B Running: The service has responded to the latest monitoring probe.

m Filtered: Unable to determine the status of the service, because it is blocked by a network

obstacle such as a firewall.

B Indeterminate: Unable to determine the status of the service. It may be blocked by a network

obstacle, up, or down.
m Closed: No application is listening on the specified port.

®  Unresponsive: A service exists on the port, but is not responding to probes.

m  Unreachable: Unable to monitor the service, because the target IP address is unreachable.

m  Error: Unable to monitor this service, because an error occurred while attempting to do so.

View Service Monitoring Configuration x

Maonitor Name: IP Address:

Host Status:

O
Enabled: (

Status Service Port Interval (mins) Protocol Last success Last failure

Orunning 22 5 tep 11/21, 10:44 AM 26,20, 259 PM

= -

The status categories and the statuses that fall into each category are as follows:
m Category Pending - Pending status

m  Category Normal - Running status

m Category Unknown - Filtered and Indeterminate statuses

m  Category Critical - Closed, Unresponsive, Unreachable, and Error statuses

1 Services 1 Services

0 1 critical 01 running

Creating a monitor | Page 217



RADIUS

The main purpose of RADIUS (Remote Authentication Dial In User
Service) is to enable the authentication of network users stored in a
database on a server known as a RADIUS server. You can access
RADIUS from the Network Services drop-down.

Access Control

Service Monitoring

When users connect to the network, the device (usually a switch) the
users connect to can challenge the users for authentication, and pass on the authentication to the
RADIUS server to check. Based on the result of the check against its database, the RADIUS server
informs the switch whether or not to allow the connected user access to the network.

From version 3.12.0, the New Edge Security feature has added the Endpoints category to the Asset
Management page, which shows clients on your network. A local RADIUS server works to easily
authenticate devices from the table on this page. To see more information about Endpoints, see
"Firmware" on page 177.

For more information about RADIUS, see the RADIUS Server Feature Overview and Configuration

Local RADIUS Server ©
Devices s1-gateway & Export Certificate
Q

u Group: NAS
s1-gateway
site2-gateway
sited-gateway

[m} User Group Confliet Act

ite3-core [[I]

[m} U
site3-gateway

f

Local RADIUS Server

RADIUS lets users view and edit local RADIUS server configurations on AlliedWare Plus devices.
The RADIUS page displays a list of all AlliedWare Plus devices with local RADIUS enabled. In some
situations, like a remote branch office, it is convenient to use an AlliedWare Plus™ switch as the
RADIUS server for user and device authentication, rather than to have another, separate RADIUS
server. Hence, RADIUS server capability is provided as a built-in feature of AlliedWare Plus. The
built-in RADIUS server is referred to as Local RADIUS server.

For selected devices, the Users, Groups, and NAS (Network Access Server) tabs are available on
the RADIUS page.

You can view a list of devices with RADIUS server enabled, and view the RADIUS server
configuration of a RADIUS server—-enabled device.

You can also import or export RADIUS user settings to or from a device, as well as edit the RADIUS
server user/group configuration of a device.
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Share multiple RADIUS entities from one device to another by first exporting CSV files, editing them
offline, and importing them onto the new device.

Users need read/write permissions to use RADIUS settings, for information on setting up user
permissions see "User Management" on page 314.

Enabling Local RADIUS on devices

You can enable local RADIUS on devices from the network map.

To enable/disable RADIUS server on a device, right click on a device to bring up the context menu
for the device on the Network Map:

Grcup}sf s ’b__)
Loop F. stecti.

Enable RADIUS Server
L —

For information on how to do this, see "Enabling RADIUS on devices from the Network map" on
page 66.

Shared Secret

The Shared Secret button appears on the RADIUS page from version 3.12.0 onwards, in order for
the endpoints feature to work.

To set a shared secret, click the Shared Secret button in the top left of the RADIUS page.

B Shared Secret

The Shared Secret key is used by the Vista Manager to send a CoA (Change of Authorization)
message to the NAS device. For more information see "Intelligent Edge Security (IES)" on page 194.

Adding RADgate as an external RADIUS Server

From version 3.13.1 onwards, Allied Telesis’ new RADIUS application RADgate is supported as a
plugin in Vista Manager. This means you can add RADgate as an external RADIUS server and
manage it from Vista Manager.
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RADgate runs as a separate application, and can be accessed directly from Vista Manager for any
advanced configuration. For more information about RADIUS, see the RADIUS Feature Overview
and Configuration Guide.

Note: The AT-RADgate RADIUS server is not yet available in all regions. See your Allied Telesis
representative for more information.

As a Vista Manager plugin, the RADgate user database and information are synced to Vista Manager
for an integrated view and simplified user access management. To use RADgate as part of Vista
Manager’s Intelligent Edge Security (IES) solution an AMF Plus license is required.

The following steps describe enabling RADgate as a Vista Manager plugin, and adding it as an
external RADIUS server.

1. Go to System Management > Configuration

About

Configuration

2. Scroll down to Optional Features.

3. Use the Toggle to enable AT-RADgate:

AT-RADgate Enabled @

AT-RADgate provides Authentication Services that comply with the IETF RADIUS standard. It is deployed on a container instance of the ACP system. You can add @
external AFRADgate servers from the Radius feature page

A This feature may impact system performance. Disabling the feature will stop Vista Manager from communicating with any added AT-RADgate servers while the servers
will continue to operate.

4. The RADgate feature is now enabled.
To add an External RADIUS Server for RADgate:

Go to the Network Services > RADIUS page

Network Services

Access Control

Service Monitoring

RADIUS

Click the + Add External Server button

RADIUS Server ® 8 snored scoret m

Devices X930-master

Q
Users  Groups  NAS

930-mast
x! ‘masf erm Q ® & All Groups ~

i

Y -
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Enter the server credentials and IP address

Add External Server X

Server Type

AT-RADgate

Username *

Example

Password *

IP Address *

192.168.1.1| ‘

Cancel Register Server

Click Register Server to add it to Vista Manager.

B The server will appear in the side panel. You can freely add users from the RADIUS page, and they
will display in Vista Manager as well as in the RADgate application.

®  The newly added server also appears as a device on the Network Map.

B You can delete the RADgate server by clicking the Delete button on the RADIUS page, but you
cannot delete local RADIUS servers.

To check information about the RADIUS Server, please check the RADgate application. To do this,
right-click on the RADgate server device icon on the map.

PRl AYE Allicd Telesis  ATRADgate | radgate © manager -

FP R Status Monitor

§=  Status Monitor

Endpoint

A Event Management

&% Account Management @, Search by keyword e

o2 system Management

MAC Address Status. VLAN Device Name Connected NAS IP Address

Note: If you disable the AT-RADgate feature from Optional Features, it will disconnect from Vista
Manager. However, if you re-enable the feature from Vista Manager, then the connection to
AT-RADgate servers will be resumed.

Managing multiple RADIUS devices with groups

From version 3.11.0 onwards, you can manage common RADIUS Users/Groups/NAS on multiple
devices easily.

Previously, you could manage individual devices, but you needed to configure each device one by
one. With this update, you can manage Vista grouped devices in the same way as is currently
possible for a single device.
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First, create a group in the Asset Management page:

1. Create a group of devices for RADIUS:

A% Allied Telesis  vistaManager EX  vista-max Q Search net O manager v
Dashboard
Asset Management
Asset Management
Devices (33)  Groups (5)  Provision(2)  Firmware  Report
Network Map 33) ps (5) @ D
5 2
Bt = Filterdata v Q Search by keyword &l Load Presets  [EEMCETEINT
Network Services
Group Name Devices Total Source Criteria Custom Icon Action
Access Control
S b central 3 Devices Auto-Generated (Network) networkld = central.vista-ma &=
RADIUS
sitel 19 Devices Auto-Generated (Network) networkld = sitel vista-max. ==
AMF Plus " e " ce ool ikl oo 2

1. Go to Asset Mangement > Groups and click +Add Group

2. Enter a group Name.
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3. Inthe Device Search field, start typing a device name.

4. A drop-down list appears. Each device is added one-by-one under Static Devices.

AVL Allied Telesis  vista Manager EX  vista-max

Add Group
Name
Asset Management TestGROUP 9
Devices (33) Groups (5) Provision (2) Firmware Report IP Range Start:
E.g."192.168.1.1"
= Filterdata v Q. Search by keyword
IP Range End:
E.g."192.168
Group Name Devices Total Source Criteria
Vendor
central 3 Devices Auto-Generated (Network) networkld = centr]
Search Vendors -
sitel 19 Devices Auto-Generated (Network) networkld = sitel

Add MAC Address

site3 7 Devices Auto-Generated (Network) networkld = site3 E.0. 0000 mx e + Lrlis

sited 2 Devices Auto-Generated (Network) networkld = siteq, Device Family

Test 4 Devices User Created

Device Search

N - ) < 3

Add 23 devices

s1-bd1-dist-sw1 | site1 | 172.31.8.160
s1-bd1-dist-sw2 | site1]172.31.0.207
s1-bd1-fl1-sw1 | site1]172.31.0.121
§1-bd1-f1-sw1-1.0.10 | site1 | 172.16.111.5
s1-bd1-fl1-sw1-1.0.12 | site1 | 172.16.111.4
s1-bd1-1-sw1-1.0.2 | site1 | 172.16.111.3

s1-bd1-fl1-sw1-1.0.4 | site1 | 172.16.116.1

s1-hr1-A1-sw1-1 N R site1 1172 16111 2

5. Select the devices you want to add under the Device Search heading. The selected devices will
display under the heading.

Device Search

Static Devices e
s1-bd1-dist-sw] €9  sl1-bd1-dist-sw2 €3
s1-bd1-fl1-sw1 £

Select Custom Icons

6. Click Save.

7. Go to Network Services > RADIUS
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8. From the RADIUS page, you can see the newly created groups..

Dashboard
Local RADIUS Server ©

Asset Management

Devices

AV Allied Telesis  Vista Manager EX  docnet Q  Sea

e manager v

Network Map Group &, Export Certificate
Q, Search Device:
Events
This group contains devices that do not have RADIUS enabled
AWC Plug-in Grou; m
P

SNMP Piug-in Users Groups NAS

Group B m

Import Groups + Add a Group
group 1 [EET3 -

Access Control

Service Monitoring

8

Q© sowan

If you see the yellow warning banner at the top of the page with the text:

“This group contains devices that do not have RADIUS enabled”, then you need to enable local
RADIUS server on these devices. To enable RADIUS on devices, see "Enabling Local RADIUS on

devices" on page 219.

Step 8a. Click a group to configure.

The following sections describe the Users, Groups, and NAS tabs on the Local RADIUS Server

page.

Users

From the Users tab, you can import or export CSV files of user lists, and add users from site devices

on the side.

site2-gateway

Users Groups NAS

& All Groups ~ Q Sea

O User = Group Conflict

O Test User

ok Export Certificate

. >

Action

The Users tab allows you to:

B add/edit/delete users to the local RADIUS server of a selected device.

B import/export multiple user entries to/from a device.
B manage users assigned to RADIUS groups.
m  export RADIUS user information to your local PC in pk12 format.

m  export the local CA certificate to a local PC.
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To configure RADIUS Users:

1. Click + Add User

. >

2. Input name of user (This will be MAC address if doing port authentication).

3. Input password of user (This will be MAC address if doing port authentication).

4. Optional - Select a Group that user will belong to.

5. Click Save

RADIUS clients that you interact with on the Endpoint section of the Asset Management page are
listed as User entries on the RADIUS server, and you can see their status when you click on the NAS
device on the sidebar. If the client devices are blocked, the Status column will show a Reject badge,

otherwise nothing will display.

To see information about how endpoints work in Vista Manager, see "Firmware" on page 177.

Groups

Groups on the RADIUS page are listed under the Groups tab. You can add groups from the table on

this page.

site2-gateway

Users Groups NAS

Q Searc

Group = Conflict Network Association User Cou..  VLAN Aftributes Status

123456789012345678901234... = 2

& Export Certificate

Action

The Groups tab allows you to:

m add/edit/delete groups to the local RADIUS server of a selected device
m optionally specify the Dynamic VLAN of a group

B manage the Dynamic VLAN of a group

m optionally specify, manage, and change the RADIUS attributes of a group

B see an error if attempting to delete a group that has users assigned on the device.

The RADIUS group attributes allow you to:

m see all attributes for a group

m add/delete one or multiple attributes of a group.
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To Configure a RADIUS group:

1. Click + Add a Group

2. Input the name of the group

3. Optional - Input dynamic VLAN to be used for this group
4. Optional - Add Radius Attribute key: value info and click +
5. Repeat the above step for each attribute to add

6. Click Save

NAS (Network Access Server)

A Network Access Server (NAS), also known as a RADIUS Client, or simply an authenticator, is a
device on a network that is used for authentication. When a user requests network access, the
Network Access Server initiates RADIUS communication.

site2-gateway &y Export Certificate

Users Groups NAS

:

NAS IP Address = Key Conflict Action

1111 1234abed

You can add a NAS by supplying a device IP Address and a key.

The NAS tab allows you to view, delete, or add a NAS to the local RADIUS server of a selected
device.

Click the + Add a NAS button to add a NAS by supplying the device’s IP Address and a NAS Key.
Note that the key on a NAS Device is different to the Shared Secret key that you set up in RADIUS.
m  The NAS key is to connect a NAS device to RADIUS. It is used to identify the NAS device.

B The Shared Secret enables Vista Manager to send messages to NAS devices. It is used to identify
Vista Manager as a dynamic authorization client (DAC).

You can manage up to 1000 network access servers.

Add a NAS x

IP Address

Cancel

For more information, see the RADIUS Server Feature Overview and Configuration Guide.
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Using AMF Plus Features

Introduction

Allied Telesis Autonomous Management Framework™ Plus (AMF Plus) features provide network
optimization, automation, management, and visualization. The uniquely designed intent-based
configuration, reporting, and map facilities of Vista Manager EX make these powerful tools simple to
configure, initiate, and manage.

In 3.14.0, AMF Plus features have been reworked, and Intent Networks replaces the former menu. To
access AMF Plus features, navigate to the Intent Networks and WAN sections.

You can recognize if a feature is AMF Plus specific by the AMF+ badge in the left-hand menu.

@ Intent Networks

Dashboard

Network Map

Health Monitoring AMF+
Events

Asset Management

The AMF Plus license is not part of the base Vista Manager EX license. But, it is included in the 90-
day trial license. If you want to continue using AMF Plus after the 90-day trial license expires, you
need to install a feature license for it.Please contact your authorized Allied Telesis salesperson for
assistance.
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More about AMF Plus requirements and licensing

The following requirements are needed to run AMF Plus:

m AlliedWare Plus firmware version 5.5.2-2.3 or later running on AMF masters and controllers.
m  AMF Plus license for AMF masters and controllers.

m Vista Manager EX version 3.10.1 or later.
How many AMF Plus licenses do | need?

An AMF Plus license manages up to 10 nodes:

m [f your network has 75 nodes, then 8 licenses are required.
m Alicense is available for either a 1or 5 year period.

B The license code name is AT-SW-APM10-xYR

See the AMF Plus datasheet for full licensing details.

Can | mix AMF and AMF Plus licenses?

It is possible for an AMF Master/Controller to have a combination of both AMF and AMF Plus node/
area licenses.

The Vista Manager AMF Plus functionality requires that only AMF Plus licenses are present before
the Vista Manager AMF Plus functionality is available. If there are any AMF masters with any AMF
node licenses or any AMF controllers with AMF area licenses, then:

m Vista Manager will not display the AMF Plus functionality.

B Both AMF and AMF Plus node/area licenses will count towards the total number of AMF nodes/
areas available.

Intent Networks Menu

The Intent Networks menu is made up of several tools to help you manage your network.

e Intent Networks

Application Priority AMF+
Auto Traffic Shaping AMF+
Intent-Based QoS AMF+
Networks AMF+

Smart ACL AMF+
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See the following sections for more information:

"Application Priority" on page 229
"Auto Traffic Shaping" on page 233
"Intent-based QoS" on page 236
"Networks" on page 273

"Smart ACL" on page 274

Application Priority

You can use Application Priority to choose specific applications and prioritize or deprioritize them.
This ensures your most important business traffic is prioritized for transmission between locations
across your WAN. Vista Manager EX provides 3 priority classes:

1.

2.

3.

Critical Services

Daily Operations

Non-Essential

You can assign different applications to each priority class, save the assignment in a policy, and
deploy the policy on the AR-Series device (firewall or router) at each location in your WAN.

A policy is the overall title for a set of rules and priorities. It also defines the type of algorithm for how
it calculates the priority of traffic. Traffic for any unassigned applications set in the rules will fall into
the Default policy class. The default class is not directly visible when creating a policy, but you can
see the traffic matching the default class (either in throughput or packet loss) in the Monitoring

graphs.

This feature lets you view any existing Application Priority policies, and shows throughput and
packet loss graphs for devices that have a policy deployed on them. You can also see how much
guaranteed bandwidth each class has and how much shared bandwidth remains. When the network
is congested, use the slider or advanced option to set bandwidth requirements to ensure smooth
application traffic.

Vista Manager EX application usage data lets you better prioritize applications. When creating or
deploying policies, you can analyze current traffic present on a device, which helps you assign
applications into the most appropriate priority classes for a policy.
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Step 1: Check application usage on a device.

1. Navigate to the Network Map.
2. Select Traffic mode from the drop-down list.
3. Select the device you want to check. A blue circle appears around it.

4. Examine the traffic usage data, which appears in the left-hand panel.

hg-gw
n = # Traffic
Device DPI 3

Running: Standalone

Top 5 Protocols d """

Top 10 Applications 0

Application nternet Breakout

ssl 161 MB

esp 36 MB

googpl.- 412 KB

QOOgE... 393 KB

Step 2: Create an Application Priority policy.

1. To create a policy, you may:

m  Right-click on the device in Traffic mode of the Network Map and select:
Application Priority > Add Policy, or

m  Navigate to the Application Priority menu item and click +Add Policy, or

m Navigate to the Application Priority menu item, and clone an existing policy by clicking the 3
dots for that policy, in the Action column.

All of the above approaches open the Add Policy page.
2. Next, type in a policy name. For example, Branch-Office.

3. Select an Application Provider. By default, Built-in is selected. If you have bought an Advanced
Firewall licence for your AR-Series UTM firewall, select Procera instead, which enables a much
larger application list to work with.

4. Ontheright-hand panel, choose a Category of applications. For example, Remote Access. A list
of applications will appear.

5. Assign appropriate classes to the relevant applications. You can use the Assigned Class filter at
any point to see what applications you have assigned to a class. When you assign a class, it
appears accordingly on the policy classes on the left.

C613-10634-00-REV B More about AMF Plus requirements and licensing | Page 230



6. Here, you may adjust the bandwidth for each class. To do this, either move the slider or enable
advanced bandwidth adjustment to type in the percentage. Percentages will be converted to
Mbps values when deployed to device. If the advanced option is used after the slider, any
manually-set values are automatically replaced by the slider pre-sets.

Note: The reserved percentage of guaranteed bandwidth for system traffic is displayed here. The
5% value is based on the default value that traffic control sets on a device. The actual value
may vary depending on what device(s) the user deploys the policy on to. Vista Manager will
just show 5% as the system bandwidth.

7. If you have accessed the page via the Network Map, click Save and Deploy. Otherwise, click
Save.

« Add Policy cancel
Policy Name * Assign Applications 0
Branch-Office e

Category Assigned class
Give your policy & descriptive tile E.g. AppCategary_RequiredMbps
Remote Access v All v
Application Provider
Built-in  Procera (license required) a

o.kpplicalmns e Assignedto clazs

Application Priority

m Critical Services -
n Critical Services Mon-Essential hg
[ rap ] Critical Services -
Applications Clear All
Critical Services -
D D D = baly operstions.
B Dpaily operations Daily Operations h
@ Unassigned -
Applications Clear All -
D

Non-Essential

Applications Clear All

Guaranteed Bandwidth

@

o
®
System 5 %
@ Critical Services - 4 % | +
@ Daily Operations — x|+
Non-Essential —_ 6 %+
Shared Bandwidth 75 %
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Step 3: Deploy a policy.
1. Navigate to the Network Map.

2. Select Traffic mode from the drop-down list.
3. Select the device you want to deploy a policy to. A blue circle appears around it.

4. Right-click on the device, select Application Priority > Deploy Policy.

hg-gw
Advanced Traffic Mo layout - o

anced Traffic Monitoring - -
Device DPI o e
Running: Standalone o

Top 5 Protocols
P Sites b

Groups ¥

Application Priority  » Add Policy

Auto Traffic Shaping » el o

Security Setting %

Top 10 Applications

Application Internet Breakout

ol s il f“'—-'li--h“"-_._....‘.’,__’ — B e ,J

5. Select a policy to deploy.
6. Specify a Source Entity to match traffic against.
7. Specify an interface for Destination Entity.

8. Define a maximum bandwidth. This places a cap on the virtual bandwidth.
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9. Click Deploy Policy when complete.

« Deploy Policy o= Deploy Policy
hg-gw Davice 9
Device DPI o
Running: Standalone Source Entity Destination Entity
VM_Zone BREAKQUT_TO @ hd VM_Zone BREAKOUT_FROM [tunne|1ov
Top 5 Protocols
Select a source entity to match traffic against Destination entity must specify an interface
Select Policy Destination Max Bandwidth (Mbps)
test-deploy Q w 100 e
Control destination interfaca Virtual Bandwidth value
test-deploy

Top 10 Applications
Application Irternet Breakout n Critical Services
sl 160 MB
esp 36 ME L

Applications
iemp SMB
udp 2MB

EJ Daily Operations

eth 1ME
facebo.. 957 KB L

Applications
superce| 500 KB
tcp 470KB
googpl.. 449K8 Non-Essential
QoOga... 393 KB

Applications

Auto Traffic Shaping

This feature dynamically adjusts the maximum transit capacity of remote locations (spoke tunnels)
to not exceed the receive capacity of the central site (hub). This is termed the maximum Rx
bandwidth of the hub.

To allocate this bandwidth optimally, we recommend you also deploy Application Priority profiles on
each spoke tunnel.

To manage traffic, an algorithm uses current spoke tunnel traffic rates, and any configured
application priority settings, across all spoke tunnels to fairly allocate bandwidth. Spoke tunnels
have a guaranteed transmit bandwidth. This equals the sum of the CIRs (committed information
rate) plus system bandwidth defaulted to 5%.
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Prerequisite step: Configure tunnels between spokes and hubs.

To configure the tunnels, Go to WAN > Dynamic Connection.

d& waAN

SD-WAN

Internet Breakout AMF+

Dynamic Connection AMF+

Security AMF+

Step 1: Configure the Interface Max Rx Bandwidth value.
Go to the Auto Traffic Shaping page from the Intent Networks sub menu.

e Intent Networks
Application Priority AMF+

Auto Traffic Shaping AMF+

Intent-Based QoS AMF+

Networks AMF+

Smart ACL AMF+

Click the blue Settings button.

«< Auto Traffic Shaping © m

1. Enter the maximum bandwidth a hub can handle. The algorithm calculates and applies optimal
traffic shaping based on this number.

2. Click Apply.

B_AR4050S - Auto Traffic Shaping X

Settings @ About

A Auto Traffic Shaping enables Traffic Control on all spoke devices. Once enabled, any Application
Priority (Traffic Control) pelicies assigned to the selectad interface will become active.

Multipoint VPN Interface Interface Max Rx Bandwidth (Mbps)

tunnel Enabled 200
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Step 2: Monitor hub utilization and traffic loss.

View charts in the Monitoring page, where you can use filters to specify what traffic is shown.

£

Auto Traffic Shaping @

Monitoring

Hub Device Interface Spokes

B_AR4050S tunnell + 3 Spokes December 18 2020, 12:25 pm - December 18 2020, 1:25pm  1h  12h  24h  Custom~

Hub Utilization

0»\75 Enabled (%) ATS Disabled l"_} Max rx (@) B_Spoke2 @) B_Spokel () B_Spoked
120 Mops

100 Mops

80 Mops

60 Mbps

Throughput

40 Mbps

20 Mbps

0

AR a A T o \, ‘\,A

by
ps.
12:24 pm 12:29 pm 12:44 pm 12:49 pm 12:54 pm 12:59 pm 1:04 pm 1:09 pm 1:14 pm 119pm 1:24pm

Hub Traffic Lossg™

@D ATS Enabled () ATS Disabled (@) Traffic Loss
16 Mbps

14 Mbps
12 Mbps
10Mbps %

& Mbps !

6 Mbps 3
4 Mbps
2 Mbps

12:25pmy 5 pm 12:50 pm 12:55 pm 1:00 pm 1:05 pm 1:10 pm 1:15 pm 1:20 pm 1:25 pm

Packet loss
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Intent-based QoS

Introduction

Quality of Service (Qo0S) is a way to prioritize network traffic to ensure that the most important traffic
gets through the network with minimal delay or interference.

e Intent Networks

Application Priority AMF+
Auto Traffic Shaping AMF+
Intent-Based QoS AMF+
Networks AMF+

Smart ACL AMF+

QoS is a complicated feature with many configuration options and different ways to configure the
feature. To configure QoS on a network, you will typically follow these steps:

m |dentify the types of traffic that are important and need to be prioritized, such as voice or video
traffic.

B Assign each type of traffic a priority level based on its importance. This is typically done using a
QoS tagging system.

m  Configure your network devices (routers, switches, etc.) to recognize the QoS tags and prioritize
traffic accordingly.

m  Set bandwidth limits or rate limits on non-priority traffic to prevent it from interfering with the

prioritized traffic.

By configuring QoS on your network, you can ensure that critical applications like voice and video
are given priority over less important traffic, leading to better network performance and user
experience.

From Vista Manager EX version 3.10.1 onwards, you can use Intent-based QoS to easily manage
and troubleshoot a basic QoS configuration on your network as part of AMF Plus.
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The benefits of Intent-based QoS

In a congested network where packets are being dropped, it is quite difficult to determine where the
drops are occurring. A network could consist of numerous devices, each with a number of ports with
egress queues. Detecting drops on one of the queues, on one of those ports, on one of those
devices is challenging. Intent-based QoS helps you troubleshoot and visualize the performance of
egress queues and manage their settings.

You can:

m Visualise egress queues across the entire network and for individual devices:
®  Drops
®  Throughput

m  Modify egress queue settings:
m  Strict priority — queue egress limits

m  Weighted Round Robin — queue weightings
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Getting started

First you need to manually apply a default QoS configuration VISTA_DEFAULT_POLICY to all
switches in your network. Please see "Configuring the Vista Manager EX default policy in the CLI" on
page 252 for guidelines and some complete configuration examples.

This default configuration sets up 2 priority queues and 6 weighted round robin (WRR) queues. The
strict priority queues have an egress rate limit applied, and the WRR queues each have a weighting
applied. The configuration also defines a mapping of DSCP fields to QoS queue based on industry
standards. This mapping cannot be changed via Vista Manager EX.

New ports configured with the default QoS policy are added to the list of polled ports. Likewise,
removed ports with the default QoS policy are deleted from the list of polled ports.

Once the default configuration has been applied on the network, the Intent-Based QoS dashboard
shows the state of the network in regards to the QoS queues.

Each of the eight QoS queues has a label based loosely on what sort of traffic is expected on the
queue. For example, the highest priority queue, QoS queue 7 has the label ‘Voice’ as this queue will
be used for VoIP traffic. Queue 6 has the label ‘Video’ as this queue will be used for a variety of video
services, and so on.

Intent-Based QoS © s 2 th 12h 20 | 7d B aseu»gs

4 Streaming 0 Best Effort
3.89 Ky 1217 M

Queue4 S“eamlng

Queue Drops Queue Drops by Device

Weight 7

Throughput 495,89 Mops Drops Fair Threshold W Bad Threshold \ Device Total Thraughput Quewe Drops.

Queue Drops 389K e 83 Disanion W03 ENEe ACCESST_AMFPLUS_DE.
DIST1_AMFPLUS_DEMO 424,66 M3 0

Boc Thwoshold . 1 i DIST2_AMFPLUS_DEMO 305M8 o

b o L CORE_AMFPLUS_DEMO 88.48K8 0

S .k ACCESS3_AMFPLUS DE.. 41954M8  Unsupported

é 15K ACCESS2_AMFPLUS_DE. o8 Unsupported

Fair Threshald 1

Throughput Queue Drops
Buring last 1 hour During

2
15w BostEffort Bost Effort

Scavenger - Scavenger
$00 Mops W Bulk Data W Bulk Data
W Transactional W Transactional

M
w Steaming 1 Streaming
oM | W Network Managemen
L Video

You can see in the diagram above that the Streaming queue is experiencing queue drops. Using the
dashboard, you can investigate further to see when and on which device drops are occurring.

Queue Drops
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Using the Dashboards

You can adjust the rate limit or weighting of a problematic queue on the entire network by using a

simple graphical tool - the Intent-Based QoS dashboard.

In fact, there are three interlinked dashboards:

1. Intent-based QoS - displays egress queue details across the network. Data is aggregated from

all ports on

all devices in the network.

m  Click on a device name to open the device dashboard.

2. Device - displays egress queue details from a single device. Data is aggregated from all ports on

the device.

m Click on a port name to open the port dashboard.

3. Port - displays queue drops and throughput from a port.

The three dashboards allow you manage QoS configurations on your network. You can use them to
drill-down from a wide-angle view of the network traffic, select a device, and then select a port on

that device.

Intent-Based QoS @

Queue 7: Voice
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Click on a device to open the
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Navigating the dashboards

The Intent-Based QoS dashboard shows queue details for the entire network. Data is aggregated
from all ports configured with the VISTA_DEFAULT_POLICY. Vista Manager EX scans the network for
any ports configured with the default Vista QoS policy. Every five minutes Vista will poll these ports
for queue drops and queue throughput (transmitted bytes). Intent-Based QoS presents the data in
dashboards:

The layout is similar for all three dashboards. The Queue status ribbon run along the top, with
specific queue details and historic charts below.

Queue status ribbon
Click on a queue to see
queue details

Queue details
Details for a particular
queue

Historic charts
Cumulative data from all
queues over the selected
time period

Intent-Based QoS @ Time period March 21 2023, 1038 am -March 282023, 1038m | 1h | 12h | 24h  7d (8 | £ Settings
o o o o
Queue 7: Voice
‘Traffic requiring minimum loss, latency and jitter, such as VoIP Telephony Access to:
> - Queue configuration
Queue Drops Queue Drops by Device - Monitoring thresholds
Bandwidth Limit 50% | Duringlest7 days During 2517 days
Throughput 1.09 Mbps Drops 1 Fair Threshold [ Bad Threshold 1 QoS Disabled M QoS Enabled Bevcs Tors| Thraughput  Quave Dropz
2
Queue Drops 0 AGGESS1_AMFPLUS_DE.. 534668 0
- CORE_AMFPLUS_DEMO e 0
! DISTLAMFPLUS_DEMO 08 0
3
g DIST2_AMFPLUS_DEMO e 0
1 '
g ACCESS2_AMFPLUS DE... 0B Unsupparted
e AGGESS3_AMFPLUS_DE.. 05 Unsupported
o
Wed ™ r sat sn Mon r
Throughput Queue Drops
Duringlazt 7 days During a7 days
00 Ube °H
s00mbpe 08
- Best Effort e Best Effort
Seavenger Scavenger
600 Mbps W Bulk Data «s ' Buk Data
lransactional 4 lransactional
3 wouten W Transactional 8 e ® Transactional
Streaming o Streaming
£ aombpn W Network Management 3 we W Network Management
" a
- m Video .  Video
o Voice ™ Voice:
200 Mbps B QoS Disabled w8 B QoS Disabled
- QoS Enabled e QoS Enabled
otps o
Vied Ty E sat sn Mon T ied T r sat S Mon e

display its details
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Click on a queue to

Queue label

6 Video

0

Cumulative drops on the
queue network-wide in the
last 5 minutes

The queue color changes based on
threshold settings:
- Green - below the Fair threshold

- Red - above the Bad threshold

Drops should be investigated, especially on higher numbered queues, as it could be an indication
that congestion is occurring in the network, and potentially impacting on user experience.
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Where do the dashboard queue names come from?

Each of the eight queues has a label describing what sort of traffic is expected on the queue.

QUEUE LABEL DESCRIPTION

7 Voice Traffic requiring minimum loss, latency, and jitter, such as VoIP
telephony.
6 Video Traffic requiring low loss, latency, and jitter, such as video-

conferencing.

5 Network Management Traffic protected with a minimum bandwidth guarantee such as
SNMP, NTP, and Syslog.

4 Streaming Highly interactive traffic, such as instant messaging and Telnet

3 Transactional Low response time traffic where users wait for transactions to
finish, such as SAP and Oracle.

2 Bulk Data Low interaction, not drop sensitive traffic, such as FTP, E-Malil
and Backup Operations.

1 Scavenger Business-irrelevant traffic, such as Gaming and Peer-to-Peer
Media Sharing.

0 Best Effort Traffic not requiring differentiated treatment.

We recommended traffic is place into the correct queues, but there is no strict requirement. For
example, there is nothing stopping you from putting Voice traffic into the Streaming queue. However,
the labels in Intent-Based QoS cannot be changed.

It is ultimately up to you how you want to bind RFC4594 traffic classes to egress queues, however
the bindings denoted in the following diagram are recommended.

Application DSCP

[ mees &) — a7 Par 10%

Internetwork Control m— —
Q6 (PQ2 33%)
VolP EF )

Broadcast Video CS5 = ) Q5

(WRR weight 4)

Multimedia Conferencing “—I
N i
. é AF2 Q2.
Transactional Data (WRR weight 3)
| NetworkManagement  cs2 a1

Bulk Data (WRR weight 1)
Scavenger Cs1

Qo
| Best Effort | DF i »| DOF (WRR weight 15)
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Queue details

Click on a queue in the Queue Status ribbon to see its details

is selected and its details displayed underneath.

. In the example below, queue 7 Voice

Intent-Based QoS @

7 Voice

0

Gueue number, label, description

Queue 7: Voice

‘Traffic requiring minimum loss, latency and jitter, such as VolR Telephony

Queue egress rate limit %
setting

3 Bandwidth Limit 50%

network.

network.

Aggregated throughput (in bps)
for the queue across the

Helps identify possible
congestion and issues in the

Aggregated drops for the
queue from all ports across the
network over the last 5 minutes.

hroughput 1.09 Mbps
Queue Drops 0
During last 5 minutes

Bad Threshold 1
Maximum queue drop count per § minutes

Fair Threshold T

Maximum queue drop count per 5 minutes

Historic charts

ueueDrops
During last 7 days

Drops W Fair Threshold M Bad Threshold m QoS Disabled m QoS Enabled Devics

Queue Drops displays
drops over a time period.
This allows you to
determine if there is a
persistent drop issue or
just a one off or intermittent
spike in drops

Fair/Bad
threshold
setting

March 212025, 347 pm-March 282023.347pm | 1h | 12h  24h | 7d (3 | SN

1 Scavenger

1.7B

Queue Drops by Device
During last 7 days

Total Throughput Queus Drops.
ACCESS1_AMFPLUS_DE. 558268 0
CORE_AMFPLUS_DEMO 0B 0
DISTI_AMFPLUS_DEMO 08 0
DIST2_AMFPLUS_DEMO LE:] 0
ACCESS2_AMFPLUS_DE.. 0B Unsupported

QoS enabled

Number of
drops

ACI\eSS3_AMFPLUS _DE.. 0B Unsupported

Link to the Device
Dashboard of each device.
Sorted by largest queue
drops. If drops are equal,
sorted by largest
throughput.

Toe

The historic charts display past details for all queues across all devices on the network. In the left
chart below you can see the throughput per queue aggregated from ports over the selected time
period, in this case the last 7 days. In the right chart, you can see drops per queue aggregated from

ports over the same time period.

5 Kbps

4 Kbps

3 Kbps

Throughput

2 Kbps

1 Kbps

Obps

Throughput
During last 7 days

i Best Effort

|| m Scavenger

| mBukDats
Streaming

W Video
m Voice

QoS enabled

M Transactional

m QoS Disabled
m QoS Enabled

W Network Managemeni

Queue Drops
During last 7 days

Queue Drops

2

Best Effort
Scavenger

W Bulk Data

W Transactional
Streaming

W Network Managemeni

W Video

W Voice

m QoS Disabled

| QoS5 Enabled

QoS enabled

Drops broken
down by queue
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Configuring the queue settings

Use the Settings button to access the Intent-Based QoS Settings window.

Dashboard
Asset Management
Network Map
Events

Network Services

Access Control
Service Monitoring

RADIUS

AMF Plus
Dynamic Connection
Internet Breakout

Auto Traffic Shaping

Application Priority

Security
Health Monitoring
Networks

Smart ACL

Intent Based QoS

SD-WAN

User Management

System Management

2023,11:38am | Th

12h | 24h

AVZ Allied Telesis  Viste Manager EX

Intent-Based QoS ©

7Voice 6Video 5 Network Manag...
0 0 0

Queue 7: Voice
Traffic requiring minimum loss, Iatency and jitter, such as VoIP Telephony

Bandwidth Limit 10%
Throughput 0bps
Queue Drops 0

During last 5 minutes
Bad Threshold 1
Maximum gueue drop count per 5 minutes

Fair Threshold T

Maximum queue drop count per 5 minutes

Throughput
During last 7 days
14 Kbps

12 Kbps

10Kbps

7d

4 Streami

0

Queue Drops
During last 7 days

Drops M Fair ]

2

&
O —_—
F]
3
E]
s}
0
Thu L
Best Effort
Scavenger
W Bulk Data

Intent-Based QoS Settings

Monitoring Thresholds Queu

QoS Polling

Enables polling for all QoS data.

Queue Monitoring Thresholds
Thresholds define Queue state in dashb
time period

Queue

7 Voice
Traffic requiring
aten

6 Video
Traffic req

latency

and jtter, conferencing

5 Network Management
Traffi ith a minimum

4Streaming
Highly interactive traffic, such as

nstant messaging and Teinet

ional
time traffic where

transactions to finish,
such as SAP and Oracle

2Bulk Data
Low interaction, not drop sensitive

traffic, such as FTP, EMail and

e Configuration  Auto Queue Configuration

enavied @Y

(Good, Falr, Bad). Adjust the amount of queue drops acceptable per queue during 5 min

Queue Drops (5 minutes) Include ()

Fair Bad

L I L

Fair Bad

o
°
8

Fair Bad

Fair Bad
@ @
Fair Bad

L]

Fair Bad

e e «

ancel E

This is where you set or change queue parameters for Strict Priority egress limits and WRR queue
weightings. Any changes you make are pushed out to all devices configured with the QoS policy
named: VISTA_DEFAULT_POLICY.

If you don't see a screen resembling the one shown above, where no data appears in the
dashboard, it indicates that the default values have not been configured. You will need to use the
CLI to configure these settings. This is described in the section "Configuring the Vista Manager EX
default policy in the CLI" on page 252.
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There are three setting tabs: Monitoring Thresholds, Queue Configuration and Auto Queue

Configuration:

Monitoring Thresholds tab

The Monitoring Thresholds tab lets you change the drop threshold for queues. By default, the Fair
and Red thresholds are set to 1 drop. This means that if there are >=1 drops, the queue display will

show as red.

Thresholds define the queue state display in the dashboard (Good, Fair, Bad). The thresholds are
based on the acceptable number of dropped packets per queue during a 5-minute time period. You
can set threshold values for each queue individually.

Intent-Based QoS Settings

Monitoring Thresholds Queue Configuration

QoS Polling

Enables polling fer all QoS data

Queue Monitoring Thresholds

time period

Queue

7 Voice
Traffic reg

g minimum loss,
d jitter, such as VolP

6 Video

Traffic requiri v loss, latency

and jitter, such as Videoconferencing

5 Network Management
Traffic protec th a minimum

4 Streaming
Highly interactive traffic, such as

nstant messaging and Telnet

3 Transactional
Low response time traffic where

users wait fo s to finish,

such as SAP and O

2 Bulk Data
Low interaction, not drop sensitive
traffic, such as FTP, E-Mail and

s define Queue state in dashbo:

ood, Fair, Bad)

Auto Queue Configuration

Adjust the amount of queue d

Queue Drops (5 minutes)

Fair

Bad

Bad

Bad

Bad

Bad

Bad

*
Enabled Q@Y
include ()
[ o9
@ L)
O -9
a L
@ L
® -9
Cancel E

Thresholds are applied network-wide and cannot be set on a single device or port. If the QoS
configuration is different between device ports, a warning message is displayed in the Intent-Based

QoS dashboard.
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Queue Configuration tab

The Queue Configuration tab lets you set queue parameters for: Strict Priority (egress rate limiting)
and WRR - weighting.

Strict Priority queue settings

Use the Strict Priority queues for traffic requiring minimum loss, latency, and jitter, such as VoIP and
video conferencing.

Priority queues send their packets first, in order of priority. This means that queue 7 sends packets
until it is empty (or reaches its bandwidth limit), then queue 6 sends packets. Queues 0-5 only get to
send packets when both queues of 6 and 7 are empty or have reached their bandwidth limit. If you
don’t restrict the queue bandwidths, the highest priority queues could stop the other queues from
getting any bandwidth on particularly busy interfaces.

The settings allow you to limit the bandwidth used on the interface on each device, by setting the
egress rate limit % value of the queue. This allows you to reserve bandwidth on the interfaces of the
devices for other lower priority queues, which stops the highest priority queues from ever using all
the bandwidth.

B You cannot set the egress rate limit to zero, because this is the same as disabling traffic flow from
the interface.

B You can set the egress rate limit to 100%. This means that the queue in question will use as much
of the egress bandwidth as it can, up to the capacity of the interface.

m [f you set both Strict Priority queues to an egress rate limit of 100%, then the higher priority queue
(7 - Voice) will use as much capacity as it needs. The capacity that queue 7 does not use is
available for the lower priority queue (6 - Video), which will use as much of that remaining capacity
as it needs.

m If you try to set the total egress rate limit to over 100%, Vista Manager gives you a warning,
because this will allow the Strict Priority queues to "starve" the WRR queues if the strict priority
queues’ traffic demand uses all the interface bandwidth.

Weighted Round Robin (WRR) queue settings
Use the Weighted Round Robin (WRR) queues for:

m  Network Management, Streaming, Transactional, Bulk Data, Scavenger, and Best Effort.
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@ Weighted Round Robin (WRR)

Weighted Round Robin (WRR) WWR queues are configured using a weight of 1-15. The higher the weight the more frames are
sent. Queue values will be converted to absolute throughput value using the actual speed of the interface on each device. More
info

Queue Weight 1-15

5 Network Management

Traffic protected with a minimum bandwidth guarantee such as 4 ﬁ

SMMP, NTP and Syslog

4 Streaming

Highly interactive traffic, such as instant messaging and Telnet

3 Transactional

Low response time traffic where users wait for transactions to 6 ﬁ

finish, such as SAP and Oracle

2 Bulk Data

Low interaction, not drop sensitive traffic, such as FTR, E-Mail and 3 ﬂ

Backup Operations

1 Scavenger

Emtertainment traffic, such as Gaming and Peer-to-Peer Media 1 .

WRR queues have a weight of 1-15. The weights are relative to each other and work as ratios. When
the egress interface is congested, a greater proportion of traffic is sent over queues with a higher
relative weighting.

For example, a queue configured with a weighting value of 15 will send 15 times as much traffic as a
queue configured with a weighting of 1 when the egress interface is congested. Likewise, if all
queues are configured with a value of 15, all the queues will send the same amount of traffic. It is the
relative difference that matters, so setting all queues to 15 is the same as setting all queues to 1.

Intent-Based QoS ©

Configuration mismatch
Some devices are out of sync with Vista Manager Settings. Save settings 1o apply configuration 10 all devices

Auto Queue Configuration tab

Autonomous Queue Configuration empowers you to automate QoS configuration changes across
the network in response to changing traffic flows. If any queue’s number of egress drops exceeds
the 'bad' monitoring thresholds, the Auto Queues Configuration feature will adjust the resource
allocated to that queue.

You can choose how frequently you want the autonomous configuration to run. You can also provide
upper and lower bounds for resources automatically allocated to each queue.
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Each time the Auto Queue Configuration feature changes the QoS configuration, you will receive a
message in the event log specifying which queues changed, their previous values, and their new
values.

The priority queue optimisation algorithm

Each time the Autonomous Queue Configuration algorithm runs, Intent-based QoS inspects the
egress queue drops for each priority queue in turn. These queue drops include all drops for the
queue across the whole network.

If the queue is in a 'bad' state, Intent-based QoS increases the egress rate for the queue by 3%. It
applies the new configuration to every QoS capable device in the network.

It determines a 'bad' state by summing all egress drops for the queue within each 5-minute
monitoring period, since the algorithm last ran. This gives a number for each 5-minute period, called
the “summed drops”. If the summed drops in any of the 5-minute periods exceed the 'bad'
monitoring threshold, then the queue is considered to be in a bad state. You can change the
monitoring threshold for each queue on the Monitoring Thresholds tab.

Intent-based QoS can automatically increase each queue up to the queue’s maximum egress rate.

The weighted round robin optimisation algorithm

Each time the Autonomous Queue Configuration algorithm runs, Intent-based QoS inspects the
egress queue drops for each weighted round robin queue in turn. These queue drops include all
drops for the queue across the whole network.

If the queue is in a 'bad' state, Intent-based QoS donates one unit of weight from a good queue to
the bad queue. The good queue is called the 'donor' queue. The algorithm attempts to perform this
transfer for all queues that are in a bad state.

It determines a 'bad' state by summing all egress drops for the queue within each 5-minute
monitoring period since the algorithm last ran. If the summed drops in any of these 5-minute
windows exceeds the 'bad' monitoring threshold, the queue is considered to be in a bad state. You
can change the monitoring threshold for each queue on the Monitoring Thresholds tab.

The algorithm selects the 'donor' queue according to the following criteria:

m |t must be in a good state, which means it has not exceeded the queue drops specified in its
monitoring threshold.

m [ts current weight must be greater than the minimum weight.
B |ts current weight must be lower than the maximum weight.

®  Among all the queues that satisfy the above criteria, the algorithm chooses the queue with the
largest baseline surplus. The baseline surplus is the queue's initial weight minus the queue’s
current weight.
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The lowest priority queue which satisfies all these conditions is chosen as the donor queue. If no
donor queue can be found, no weight will be transferred between the queues.

m If the recipient queue's current weight is already equal to its maximum weight, no weight will be
donated to it.

m If the algorithm decides the weight must be changed, it applies the new configuration to every

QoS capable device in the network.

You can limit the extent of the automatic weight changes by specifying min and max weights. Auto
Queue Configuration will keep the queue weightings within those min and max weights.

Port congestion

When a port receives more traffic than it can transmit, it buffers the traffic until the traffic can be
sent. If the buffer becomes full and cannot buffer any more packets, any new incoming packets will
be dropped, this is known as tail drop. This can cause two issues:

m packet delay - the packet in the buffer is delayed until the port is ready to send it.
m packet drops - the packet is dropped and lost forever.

The transmitting device may choose to resend the lost packet, but this could take some time,
because it has to detect the packet has been lost.

Delays and drops result in network degradation, and for some applications can cause serious
problems. For example, voice traffic is sensitive to packet loss, so excessive loss will cause a
deterioration of voice quality.

If the incoming traffic is more than the port can
transmit, the incoming traffic will be buffered.
Eventually the buffer become full and new incoming
traffic will be dropped (known as tail drop)

-
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other ports are sent
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Egress queue modelling

Vista Manager’s Intent-based QoS uses two strict priority and six WRR queues. The QoS queue

types, Strict priority and WRR are described in more detail next.

Queue 7: Voice

Queue 6: Video

Queue 5: Network Mgmt
Queue 4: Streaming
Queue 3: Transactional
Queue 2: Bulk Data

Queue 1: Scavenger

Queue 0: Best Effort
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— Strict Priority Queue

— Strict Priority Queue

— WRR Queues
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QoS egress queue types

Egress queues help with application performance by allocating a preference to outgoing traffic. For
example, voice traffic could be given a high priority so it will be sent before other types of traffic.

There are two types of egress queues available, strict priority and weighted round robin:

m  Strict priority - traffic in a higher queue is sent before traffic in a lower queue. The lowest queue
is queue 0 and the highest is queue 7.

Voice traffic is
put into Q7

Other traffic is
put into Q2

Port

Queue 7

Y

Queue 6

Queue 4

Queue 3

Y

Queue 1

Queue 0

Strict Priority Queues

Q7 traffic is sent
before Q2 traffic

Q2 traffic must
wait until there is
no traffic in Q7

m  Weighted round robin - queues are given a weighting. When the egress interface is congested,
the specified weightings act as relative ratios to each other. For example:

If Q2 weight = 1 and Q5 weight = 15, then Q5 will send 15 times as much traffic as Q2.

If Q2 weight = 15 and Q5 weight = 15, then Q2 and Q5 will send the same amount of traffic.

Priority traffic is
put into Q5

Other traffic is
put into Q2

Port

Queue 7

Queue 6

Queue 5

Queue 4

Queue 3

Queue 2

Queue 0

Q5 frames are 15x
more likely to be
sent than Q2

J

Weight Round Robin Queues
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Advantages and disadvantages of WRR and Strict Priority queues

The main advantage of strict priority queues is that they ensure that drop sensitive traffic can be
forwarded without loss. The difficulty with strict priority queues is that they can lead to starvation of
traffic on lower priority queues.

The main advantage of WRR queues is that they ensure that at least some traffic on all queues in a
WRR group is sent when congestion occurs, making full starvation of lower priority queues
impossible. The difficulty with WRR queues is that some degree of packet-loss occurs on all queues
when under congestion, which is problematic for applications sensitive to packet-loss.

Vista Manager EX uses two strict priority queues with egress-rate-limiting and six WRR queues. This
ensures forwarding of drop sensitive traffic, while also ensuring that starvation doesn't occur on the
lower priority queues.

Port

Queue 7 :l— Strict Priority Queue

Queue 6 — Strict Priority Queue

Queue 4

Queue 3 — WRR Queues

Queue 2

Queue 0

The initial default configuration ensures that:
m Packets are marked and put into an appropriate queue.
m  Queues types are set and configured with the appropriate weight and bandwidth settings:

m  Strict Priority queues for the high priority traffic (queues 7 Voice and 6 Video).
m  Weighted Round Robin (WRR) queues for the lower priority queues (all other queues).

m Interfaces are configured for QoS.
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Configuring the Vista Manager EX default policy in the CLI

The initial manual configuration includes: enabling QoS on devices, creating a default policy
‘VISTA_DEFAULT_POLICY’, and applying the default policy to interfaces.

1.

3.

C613-10634-00-REV B

For platforms:

Enable QoS on all devices to be managed by Intent-based QoS:

mls gos enable

Create a QoS policy VISTA_DEFAULT_POLICY and apply it to all ports that you want Intent-based
QoS to monitor and manage:

policy-map VISTA_DEFAULT_ POLICY
trust dscp

class default

Set default policy queue weights:
For platforms: SBx8100, x220 and GS980M, x530 and GS980MX, x320 and GS980EM:

On these platforms the weights can be configured to any multiple of 17 that you choose (between
17 and 255). The reason for this is that AlliedWare Plus platforms, aside from the ones listed
above, only support weightings between 1 and 15.

For Vista Manager EX to support both platform weightings - i.e. some between 1 and 15 and
some between 17 and 255 in a single network, the number of possible weightings on platforms
which support 17 and 255 has to be reduced to 15 possible combinations. 255/17=15, hence
why these platforms must be configured with a weighting which is a multiple of 17.

If the weight is not a multiple of 17, then when the configuration is updated by Vista Manager, it
will be updated to a multiple of 17.

m  Set the scheduler to configure the WRR queue weights.
mls gos scheduler-set wrr-queue group 1 weight 255 queue 0
mls gos scheduler-set wrr-queue group 1 weight 11 queue 1
mls gos scheduler-set wrr-queue group 1 weight 40 queue 2
mls gos scheduler-set wrr-queue group 1 weight 104 gqueue 3

wrr-queue group 1 weight 104 queue 4

1
1
1
1
mls gos scheduler-set 1
1

mls gos scheduler-set wrr-queue group 1 weight 70 queue 5

m  The QoS policy must then be applied to each interface that will use QoS.

In addition to this the queue weights and egress rate limits must be set on each queue. The
egress-rate limit can be set to whatever values you choose. Here they are set to 333m and 100m
on a 1Gig link, this is equivalent to 33% and 10% of the total bandwidth of this interface.

interface portl.0.1

service-policy input VISTA_ DEFAULT_POLICY
strict-priority-queue egress-rate-limit 333m queues 6
strict-priority-queue egress-rate-limit 100m queues 7

mls gos scheduler-set 1
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®  For other platforms:

For other platforms, the configuration is slightly different. Instead of having a scheduler-set the
weights, they are applied individually to each interface. The egress-rate limit can be set to
whatever values you choose. Here they are set to 333m and 100m on a 1Gigabit link. This is
equivalent to 33% and 10% of the total bandwidth of this interface. The percentage values must
be consistent across the entire network. If queue 7 is set to the equivalent of 10% on one
interface, then it must be the same percentage for all other interfaces.

interface portl.0.1
service-policy input VISTA_DEFAULT_ POLICY
wrr-queue weight 15 queues 0

wrr-queue weight 1 queues
wrr-queue weight 3 queues
wrr-queue weight 6 queues

wrr-queue weight 6 queues

O R R

wrr-queue weight 4 queues 5
strict-priority-queue egress-rate-limit 333m queues 6
strict-priority-queue egress-rate-limit 100m queues 7

QoS mapping traffic to the right queue
For platforms: x8100, x220 and GS980M, x530 and GS980MX, x320, and GS980E:

Additionally, you will need to ensure the right traffic ends up on the right queues. Here are two
possible ways of doing this, but it's entirely up to you how this is done.

1:

Mapping from DSCP values to queues

One way to achieve this is with the following configuration that uses the existing DSCP value on
each packet to map the packet into the specified queue.

mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
mls
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gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map
gos map

premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp

8 to new-queue 1

10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
46
48
56

to
to
to
to
to
to
to
to
to
to
to
to
to
to
to
to
to
to
to

new-queue
new-queue
new-gueue
new-gqueue
new-gueue
new-queue
new-queue
new-queue
new-gqueue
new-gueue
new-gueue
new-queue
new-queue
new-queue
new-gueue
new-gueue
new-gqueue
new-gqueue
new-queue
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2: Mapping from CoS to DSCP to queue:

Alternatively, if CoS is being used then it can first be mapped to a DSCP value on the edge of the
network, and then on the internal parts of the network, the previous configuration can be used.

To map the CoS values to DSCP values the following configuration can be used, the
VISTA_DEFAULT_POLICY will then need to be applied to each interface as described above.

mls gos map premark-dscp 8 to new-queue 1
mls gos map premark-dscp 10 to new-gqueue
mls gos map premark-dscp 12 to new-gueue
mls gos map premark-dscp 14 to new-queue
mls gos map premark-dscp 16 to new-queue
mls gos map premark-dscp 18 to new-gueue
mls gos map premark-dscp 20 to new-gqueue
mls gos map premark-dscp 22 to new-gueue
mls gos map premark-dscp 24 to new-gueue
mls gos map premark-dscp 26 to new-queue
mls gos map premark-dscp 28 to new-queue
mls gos map premark-dscp 30 to new-gueue
mls gos map premark-dscp 32 to new-gqueue
mls gos map premark-dscp 34 to new-gqueue
mls gos map premark-dscp 36 to new-gueue
mls gos map premark-dscp 38 to new-queue
mls gos map premark-dscp 40 to new-queue
mls gos map premark-dscp 46 to new-gueue
mls gos map premark-dscp 48 to new-gqueue
mls gos map premark-dscp 56 to new-queue
mls gos scheduler-set 1 wrr-gueue group

mls gos scheduler-set 1 wrr-gueue group

mls gos scheduler-set 1 wrr-gqueue group

mls gos scheduler-set 1 wrr-gqueue group

1
1
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weight 255 queues 0
weight 11 queues 1
weight 40 queues 2
weight 104 queues 3
weight 104 queues 4
weight 70 queues 5

mls gos scheduler-set wrr-gqueue group
mls gos scheduler-set wrr-gqueue group
class-map COS-DSCP_TRANSLATE_7

match cos 7

O = W EE G Y

class-map COS-DSCP_TRANSLATE_6
match cos 6

class-map COS-DSCP_TRANSLATE_5
match cos 5

class-map COS-DSCP_TRANSLATE_4
match cos 4

class-map COS-DSCP_TRANSLATE_3
match cos 3

class-map COS-DSCP_TRANSLATE_2
match cos 2

class-map COS-DSCP_TRANSLATE_1
match cos 1

policy-map VISTA_DEFAULT POLICY
trust dscp
class default
class COS-DSCP_TRANSLATE_7
set dscp 56
set queue 5
class COS-DSCP_TRANSLATE_6
set dscp 48
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set queue 5
class COS-DSCP_TRANSLATE_b5
set dscp 46

set queue 7
class COS-DSCP_TRANSLATE_4
set dscp 34

set queue 6
class COS-DSCP_TRANSLATE_3
set dscp 26

set queue 4
class COS-DSCP_TRANSLATE_2
set dscp 18

set queue 3
class COS-DSCP_TRANSLATE_1
set dscp 10

set queue 2

QoS mapping traffic to the right queue - For other platforms

1: Mapping from DSCP values to queues

mls gos map cos-queue 0 to 0

mls gos map cos-queue 1 to 1

mls gos map cos-gueue 2 to 2

mls gos enable

mls gos map premark-dscp 8 to new-cos 1
mls gos map premark-dscp 10 to new-cos
mls gos map premark-dscp 12 to new-cos
mls gos map premark-dscp 14 to new-cos
mls gos map premark-dscp 16 to new-cos
mls gos map premark-dscp 18 to new-cos
mls gos map premark-dscp 20 to new-cos
mls gos map premark-dscp 22 to new-cos
mls gos map premark-dscp 24 to new-cos
mls gos map premark-dscp 26 to new-cos
mls gos map premark-dscp 28 to new-cos
mls gos map premark-dscp 30 to new-cos
mls gos map premark-dscp 32 to new-cos
mls gos map premark-dscp 34 to new-cos
mls gos map premark-dscp 36 to new-cos
mls gos map premark-dscp 38 to new-cos
mls gos map premark-dscp 40 to new-cos
mls gos map premark-dscp 46 to new-cos
mls gos map premark-dscp 48 to new-cos
mls gos map premark-dscp 56 to new-cos

Ul I a0 bk UlwwwourdNdN

2: Mapping from DSCP values to queues

mls gos map cos-queue 0 to 0

mls gos map cos-queue 1 to 1

mls gos map cos-queue 2 to 2

mls gos enable

mls gos map premark-dscp 8 to new-cos 1
mls gos map premark-dscp 10 to new-cos
mls gos map premark-dscp 12 to new-cos
mls gos map premark-dscp 14 to new-cos
mls gos map premark-dscp 16 to new-cos
mls gos map premark-dscp 18 to new-cos
mls gos map premark-dscp 20 to new-cos
mls gos map premark-dscp 22 to new-cos
mls gos map premark-dscp 24 to new-cos
mls gos map premark-dscp 26 to new-cos
mls gos map premark-dscp 28 to new-cos
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mls
mls
mls
mls
mls
mls
mls
mls
mls

gos
gos
gos
gos
gos
gos
gos
gos
gos

map
map
map
map
map
map
map
map
map

premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp
premark-dscp

1

class-map COS_7
match cos 7

1

class-map COS_6
match cos 6

1

class-map COS_5
match cos 5

1

class-map COS_4
match cos 4

1

class-map COS_3
match cos 3

1

class-map COS_2
match cos 2

1

class-map COS_1
match cos 1

1

class-map EF
match dscp 46
1

class-map CS7
match dscp 56
1

class-map CS6
match dscp 48
1

class-map CS5
match dscp 40
1

class-map CS4
match dscp 32
1

class-map CS3
match dscp 24
1

class-map CS2
match dscp 16
1

class-map CS1
match dscp 8

1

class-map AF41
match dscp 34
1

class-map AF42
match dscp 36
1

class-map AF43
match dscp 38

1

C613-10634-00-REV B

30
32
34
36
38
40
46
48
56

to
to
to
to
to
to
to
to
to

new-cos
new-cos
new-cos
new-cos
new-cos
new-cos
new-cos
new-cos
new-cos
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class-map AF31
match dscp 26
1
class-map AF32
match dscp 28
1
class-map AF33
match dscp 30
1
class-map AF21
match dscp 18
1
class-map AF22
match dscp 20
1
class-map AF23
match dscp 22
1
class-map AFl1l
match dscp 10
1
class-map AF12
match dscp 12
1
class-map AF13
match dscp 14
1
policy-map VISTA_DEFAULT POLICY
class default
remark new-cos 0 internal
class COS_7
remark new-cos 5 internal
remark-map to new-dscp 56
class COS_6
remark new-cos 5 internal
remark-map to new-dscp 48
class COS_5
remark new-cos 7 internal
remark-map to new-dscp 46
class COS_4
remark new-cos 6 internal
remark-map to new-dscp 34
class COS_3
remark new-cos 4 internal
remark-map to new-dscp 26
class COS_2
remark new-cos 3 internal
remark-map to new-dscp 18
class COS_1
remark new-cos 2 internal
remark-map to new-dscp 10
class EF
remark new-cos 7 internal
class CS7
remark new-cos 5 internal
class CS6
remark new-cos 5 internal
class CS3
remark new-cos 5 internal
class CS2
remark new-cos 5 internal
class CS5
remark new-cos 6 internal
class CSs4
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remark new-cos
class AF41
remark new-cos
class AF42
remark new-cos
class AF43
remark new-cos
class AF31
remark new-cos
class AF32
remark new-cos
class AF33
remark new-cos
class AF21
remark new-cos
class AF22
remark new-cos
class AF23
remark new-cos
class AF1l1l
remark new-cos
class AF12
remark new-cos
class AF13
remark new-cos
class CS1
remark new-cos

internal

internal

internal

internal

internal

internal

internal

internal

internal

internal

internal

internal

internal

internal

Complete QoS configuration example - for the x220 and x230 series

switches

You could use the following configuration on an access switch. The configuration for distribution and
core switches would largely be identical, except that the configured egress-rate-limiting would occur
on all ports, not just on uplinks.

x220 - Access CoS to DSCP

x230#show run
!

service password-encryption

1
hostname x230
1

no banner motd
1

username manager privilege 15 password 8 $1$bJoVec4D$SJIJwOJIGPr7YQoExAOGVasdEQD

1
!
no service ssh
!
service telnet
1

service http
1

no clock timezone

1
snmp-server

1

1

1
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aaa authentication enable default local
aaa authentication login default local
1

1

1

1

!

ip domain-lookup

1

1

1

no service dhcp-server

1

spanning-tree mode rstp

1

service power-inline

no lacp global-passive-mode enable

1

mls gos map cos-queue 0 to 0

mls gos map cos-queue 1 to
mls gos map cos-queue 2 to 2

mls gos enable

mls gos map premark-dscp 8 to new-cos 1
mls gos map premark-dscp 10 to new-cos
mls gos map premark-dscp 12 to new-cos
mls gos map premark-dscp 14 to new-cos
mls gos map premark-dscp 16 to new-cos
mls gos map premark-dscp 18 to new-cos
mls gos map premark-dscp 20 to new-cos
mls gos map premark-dscp 22 to new-cos
mls gos map premark-dscp 24 to new-cos
mls gos map premark-dscp 26 to new-cos
mls gos map premark-dscp 28 to new-cos
mls gos map premark-dscp 30 to new-cos
mls gos map premark-dscp 32 to new-cos
mls gos map premark-dscp 34 to new-cos
mls gos map premark-dscp 36 to new-cos
mls gos map premark-dscp 38 to new-cos
mls gos map premark-dscp 40 to new-cos
mls gos map premark-dscp 46 to new-cos
mls gos map premark-dscp 48 to new-cos

mls gos map premark-dscp 56 to new-cos
1

=
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class-map COS_7
match cos 7

1

class-map COS_6
match cos 6

1

class-map COS_5
match cos 5

1

class-map COS_4
match cos 4

1

class-map COS_3
match cos 3

1

class-map COS_2
match cos 2

1

class-map COS_1
match cos 1

1
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class-map EF
match dscp 46

1

class-map CS7
match dscp 56

1

class-map CS6
match dscp 48

1

class-map CS5
match dscp 40

1

class-map CS4
match dscp 32

1

class-map CS3
match dscp 24

1

class-map CS2
match dscp 16

1

class-map CS1
match dscp 8

1

class-map AF41
match dscp 34

1

class-map AF42
match dscp 36

!

class-map AF43
match dscp 38

1

class-map AF31
match dscp 26

!

class-map AF32
match dscp 28

1

class-map AF33
match dscp 30

!

class-map AF21
match dscp 18

1

class-map AF22
match dscp 20

!

class-map AF23
match dscp 22

1

class-map AF11
match dscp 10

!

class-map AF12
match dscp 12

1

class-map AF13
match dscp 14

!

policy-map VISTA_DEFAULT_POLICY
class default
remark new-cos 0 internal
class COS_7
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remark new-cos 5 internal

remark-map to new-dscp 56
class COS_6

remark new-cos 5 internal

remark-map to new-dscp 48
class COS_5

remark new-cos 7 internal

remark-map to new-dscp 46
class COS_4

remark new-cos 6 internal

remark-map to new-dscp 34
class COS_3

remark new-cos 4 internal

remark-map to new-dscp 26
class COS_2

remark new-cos 3 internal

remark-map to new-dscp 18
class COS_1

remark new-cos 2 internal

remark-map to new-dscp 10
class EF

remark new-cos 7 internal
class CS7

remark new-cos 5 internal
class CS6

remark new-cos 5 internal
class CS3

remark new-cos 5 internal
class CS2

remark new-cos 5 internal
class CS5

remark new-cos 6 internal
class CS4

remark new-cos 6 internal
class AF41

remark new-cos 6 internal
class AF42

remark new-cos 6 internal
class AF43

remark new-cos 6 internal
class AF31

remark new-cos 4 internal
class AF32

remark new-cos 4 internal
class AF33

remark new-cos 4 internal
class AF21

remark new-cos 3 internal
class AF22

remark new-cos 3 internal
class AF23

remark new-cos 3 internal
class AF11

remark new-cos 2 internal
class AF12

remark new-cos 2 internal
class AF13

remark new-cos 2 internal
class CS1

remark new-cos 1 internal
1
!
interface portl1.0.1-1.0.16
switchport
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switchport mode access

service-policy input VISTA_DEFAULT POLICY
1

interface portl.0.17-1.0.18

switchport

switchport mode access

service-policy input VISTA_DEFAULT_ POLICY
wrr-queue weight 15 queues 0

wrr-queue weight 1 queues
wrr-queue weight 3 queues
wrr-queue weight 6 queues
wrr-queue weight 6 queues
wrr-queue weight 4 queues 5

wrr-queue egress-rate-limit 333m queues 6

wrr-queue egress-rate-limit 100m queues 7
1

s W N

!

line con 0
line vty 0 4
1

end

x220 Access basic

x220#show run

!

service password-encryption

1

hostname x220

1

no banner motd

1

username manager privilege 15 password 8 $1$bJoVec4dD$SJwOJGPr7YgoExAOGVasdEOD
1

!

no service ssh

!

service telnet

!

service http

1

no clock timezone

!

snmp-server

1

1

1

aaa authentication enable default local
aaa authentication login default local
1

1

1

1

!

ip domain-lookup

1

1

spanning-tree mode rstp

1

service power-inline

lacp global-passive-mode enable
1

mls gos enable
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mls gos map premark-dscp 8 to new-gqueue 1
mls gos map premark-dscp 10 to new-gueue
mls gos map premark-dscp 12 to new-gqueue
mls gos map premark-dscp 14 to new-gqueue
mls gos map premark-dscp 16 to new-gqueue
mls gos map premark-dscp 18 to new-queue
mls gos map premark-dscp 20 to new-queue
mls gos map premark-dscp 22 to new-gueue
mls gos map premark-dscp 24 to new-gqueue
mls gos map premark-dscp 26 to new-gueue
mls gos map premark-dscp 28 to new-gueue
mls gos map premark-dscp 30 to new-queue
mls gos map premark-dscp 32 to new-queue
mls gos map premark-dscp 34 to new-gueue
mls gos map premark-dscp 36 to new-gqueue
mls gos map premark-dscp 38 to new-gqueue
mls gos map premark-dscp 40 to new-gueue
mls gos map premark-dscp 46 to new-queue
mls gos map premark-dscp 48 to new-queue
mls gos map premark-dscp 56 to new-gueue
mls gos scheduler-set 1 wrr-gueue group
mls gos scheduler-set 1 wrr-gueue group
mls gos scheduler-set 1 wrr-gueue group
mls gos scheduler-set 1 wrr-gqueue group
1
1
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weight 255 queues 0
weight 11 queues 1
weight 40 queues 2
weight 104 queues 3
weight 104 queues 4
weight 70 queues 5

mls gos scheduler-set wrr-queue group

mls gos scheduler-set wrr-gqueue group
1

PR R RR R

!

policy-map VISTA_DEFAULT_POLICY
trust dscp
class default
1
interface portl.0.1-1.0.47
switchport
switchport mode access
service-policy input VISTA_DEFAULT_ POLICY
1
interface portl1.0.48-1.0.50
switchport
switchport mode access
service-policy input VISTA_DEFAULT POLICY
wrr-queue egress-rate-limit 333m queues 6
wrr-queue egress-rate-limit 100m queues 7
mls gos scheduler-set 1
1
interface portl.0.51-1.0.52
switchport
switchport mode access
1
line con 0
line vty 0 4
1

end

x220 Distribution or Core basic

x220#show run
!

service password-encryption
1

hostname x220
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1
no banner motd
1
username manager privilege 15 password 8 $1$bJoVec4D$SIJwOJGPr7YgoExAOGVasdEOD
1
!
no service ssh
1
service telnet
1
service http
1
no clock timezone
!
snmp-server
1
1
!
aaa authentication enable default local
aaa authentication login default local
1
1
1
1
!
ip domain-lookup
1
!
spanning-tree mode rstp
1
service power-inline
lacp global-passive-mode enable
1
mls gos enable
mls gos map premark-dscp 8 to new-queue 1
mls gos map premark-dscp 10 to new-gueue
mls gos map premark-dscp 12 to new-queue
mls gos map premark-dscp 14 to new-gueue
mls gos map premark-dscp 16 to new-gueue
mls gos map premark-dscp 18 to new-gqueue
mls gos map premark-dscp 20 to new-gueue
mls gos map premark-dscp 22 to new-gueue
mls gos map premark-dscp 24 to new-gqueue
mls gos map premark-dscp 26 to new-gueue
mls gos map premark-dscp 28 to new-gueue
mls gos map premark-dscp 30 to new-gqueue
mls gos map premark-dscp 32 to new-gueue
mls gos map premark-dscp 34 to new-gueue
mls gos map premark-dscp 36 to new-queue
mls gos map premark-dscp 38 to new-gueue
mls gos map premark-dscp 40 to new-gueue
mls gos map premark-dscp 46 to new-gqueue
mls gos map premark-dscp 48 to new-gueue
mls gos map premark-dscp 56 to new-gueue
mls gos scheduler-set 1 wrr-queue group
mls gos scheduler-set 1 wrr-gqueue group
mls gos scheduler-set 1 wrr-gqueue group
mls gos scheduler-set 1 wrr-gueue group
1
1
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weight 255 queues 0
weight 11 queues 1
weight 40 queues 2
weight 104 queues 3
weight 104 queues 4
weight 70 queues 5

mls gos scheduler-set wrr-gueue group

mls gos scheduler-set wrr-gueue group
1

PR R R R

1

policy-map VISTA_DEFAULT POLICY
trust dscp
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class default

1

interface portl.0.1-1.0.50

switchport

switchport mode access

service-policy input VISTA_DEFAULT_ POLICY
wrr-gqueue egress-rate-limit 333m queues 6
wrr-queue egress-rate-limit 100m queues 7
mls gos scheduler-set 1

1
interface portl.0.51-1.0.52

switchport

switchport mode access

1
line con 0
line vty 0 4

!

end

x230 Access CoS to DSCP

x230#show run

!

service password-encryption
1

hostname x230

!

no banner motd

1

username manager privilege 15 password 8 $1$bJoVec4D$SIJwOJGPr7YgoExAOGVasdEOD
1

1

no service ssh

!

service telnet

!

service http

1

no clock timezone

!

snmp-server

1

1

1

aaa authentication enable default local
aaa authentication login default local
1

1

1

1

1

ip domain-lookup

1

1

1

no service dhcp-server

1

spanning-tree mode rstp

1

service power-inline

no lacp global-passive-mode enable
!
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mls gos map cos-queue 0 to 0
mls gos map cos-queue 1 to
mls gos map cos-queue 2 to 2

mls gos enable

mls gos map premark-dscp 8 to new-cos 1
mls gos map premark-dscp 10 to new-cos
mls gos map premark-dscp 12 to new-cos
mls gos map premark-dscp 14 to new-cos
mls gos map premark-dscp 16 to new-cos
mls gos map premark-dscp 18 to new-cos
mls gos map premark-dscp 20 to new-cos
mls gos map premark-dscp 22 to new-cos
mls gos map premark-dscp 24 to new-cos
mls gos map premark-dscp 26 to new-cos
mls gos map premark-dscp 28 to new-cos
mls gos map premark-dscp 30 to new-cos
mls gos map premark-dscp 32 to new-cos
mls gos map premark-dscp 34 to new-cos
mls gos map premark-dscp 36 to new-cos
mls gos map premark-dscp 38 to new-cos
mls gos map premark-dscp 40 to new-cos
mls gos map premark-dscp 46 to new-cos
mls gos map premark-dscp 48 to new-cos

mls gos map premark-dscp 56 to new-cos
1

=
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class-map COS_7
match cos 7

1

class-map COS_6
match cos 6

1

class-map COS_5
match cos 5

1

class-map COS_4
match cos 4

1

class-map COS_3
match cos 3

1

class-map COS_2
match cos 2

1

class-map COS_1
match cos 1

1

class-map EF
match dscp 46
1

class-map CS7
match dscp 56
1

class-map CS6
match dscp 48
1

class-map CS5
match dscp 40
1

class-map CS4
match dscp 32
1

class-map CS3
match dscp 24

1
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class-map CS2
match dscp 16
1
class-map CS1
match dscp 8
1
class-map AF41
match dscp 34
1
class-map AF42
match dscp 36
1
class-map AF43
match dscp 38
1
class-map AF31
match dscp 26
1
class-map AF32
match dscp 28
1
class-map AF33
match dscp 30
1
class-map AF21
match dscp 18
1
class-map AF22
match dscp 20
!
class-map AF23
match dscp 22
1
class-map AF11
match dscp 10
!
class-map AF12
match dscp 12
1
class-map AF13
match dscp 14
!
policy-map VISTA_DEFAULT_POLICY_DOWNLINK
class default
remark new-cos 0 internal
class COS_7
remark new-cos 5 internal
remark-map to new-dscp 56
class COS_6
remark new-cos 5 internal
remark-map to new-dscp 48
class COS_5
remark new-cos 7 internal
remark-map to new-dscp 46
class COS_4
remark new-cos 6 internal
remark-map to new-dscp 34
class COS_3
remark new-cos 4 internal
remark-map to new-dscp 26
class COS_2
remark new-cos 3 internal
remark-map to new-dscp 18
class COS_1
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remark new-cos 2 internal
remark-map to new-dscp 10
class EF
remark new-cos 7 internal
class CS7
remark new-cos 5 internal
class CS6
remark new-cos 5 internal
class CS3
remark new-cos 5 internal
class CS2
remark new-cos 5 internal
class CS5
remark new-cos 6 internal
class Cs4
remark new-cos 6 internal
class AF41
remark new-cos 6 internal
class AF42
remark new-cos 6 internal
class AF43
remark new-cos 6 internal
class AF31
remark new-cos 4 internal
class AF32
remark new-cos 4 internal
class AF33
remark new-cos 4 internal
class AF21
remark new-cos 3 internal
class AF22
remark new-cos 3 internal
class AF23
remark new-cos 3 internal
class AF11
remark new-cos 2 internal
class AF12
remark new-cos 2 internal
class AF13
remark new-cos 2 internal
class CS1
remark new-cos 1 internal
!
policy-map VISTA_DEFAULT POLICY_ UPLINK
trust dscp
class default
1
interface portl.0.1-1.0.16
switchport
switchport mode access
service-policy input VISTA_DEFAULT POLICY_DOWNLINK
1
interface portl1.0.17-1.0.18
switchport
switchport mode access
service-policy input VISTA_DEFAULT POLICY_UPLINK
wrr-queue weight 15 queues 0
wrr-queue weight 1 queues
wrr-queue weight 3 queues
wrr-queue weight 6 queues
wrr-queue weight 6 queues
wrr-queue weight 4 queues 5
wrr-queue egress-rate-limit 333m queues 6
wrr-queue egress-rate-limit 100m queues 7

O A
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11

line con 0
line vty 0 4
1

end

x230 Access basic
!

service password-encryption
1

hostname x230

1

no banner motd

!

username manager privilege 15 password 8 $1$bJoVec4D$SJIJwOJIGPr7YQoExAOGVasdEQD
1

!

no service ssh

1

service telnet

1

service http

1

no clock timezone

!

snmp-server

1

aaa authentication enable default local
aaa authentication login default local
1

ip domain-lookup

1

1

1

no service dhcp-server

1

spanning-tree mode rstp

!

service power-inline

no lacp global-passive-mode enable

1

mls gos map cos-queue 0 to 0

mls gos map cos-queue 1 to 1

mls gos map cos-queue 2 to 2

mls gos enable

mls gos map premark-dscp 8 to new-cos 1
mls gos map premark-dscp 10 to new-cos
mls gos map premark-dscp 12 to new-cos
mls gos map premark-dscp 14 to new-cos
mls gos map premark-dscp 16 to new-cos
mls gos map premark-dscp 18 to new-cos
mls gos map premark-dscp 20 to new-cos
mls gos map premark-dscp 22 to new-cos
mls gos map premark-dscp 24 to new-cos
mls gos map premark-dscp 26 to new-cos
mls gos map premark-dscp 28 to new-cos
mls gos map premark-dscp 30 to new-cos
mls gos map premark-dscp 32 to new-cos
mls gos map premark-dscp 34 to new-cos
mls gos map premark-dscp 36 to new-cos
mls gos map premark-dscp 38 to new-cos
mls gos map premark-dscp 40 to new-cos
mls gos map premark-dscp 46 to new-cos
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mls gos map premark-dscp 48 to new-cos 5
mls gos map premark-dscp 56 to new-cos 5
1
policy-map VISTA_DEFAULT POLICY
trust dscp
class default
1
interface portl.0.1-1.0.16
switchport
switchport mode access
service-policy input VISTA_DEFAULT_ POLICY
1
interface portl.0.17-1.0.18
switchport
switchport mode access
service-policy input VISTA_DEFAULT POLICY
wrr-queue weight 15 queues 0
wrr-queue weight 1 queues
wrr-queue weight 3 queues
wrr-queue weight 6 queues
wrr-queue weight 6 queues
wrr-queue weight 4 queues 5
wrr-queue egress-rate-limit 333m queues 6

wrr-queue egress-rate-limit 100m queues 7
1

B W N R

line con 0

line vty 0 4
1

end
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x230 Distribution or Core basic
!

service password-encryption
!

hostname x230

1

no banner motd

1

username manager privilege 15 password 8 $1$bJoVec4D$SIJwOJGPr7YgoExAOGVasdEOD
!

!

no service ssh

1

service telnet

1

service http

1

no clock timezone

!

snmp-server

1

!

!

aaa authentication enable default local
aaa authentication login default local
1

1

1

1

!

ip domain-lookup

1

1

1

no service dhcp-server

1

spanning-tree mode rstp

1

service power-inline

no lacp global-passive-mode enable

!

mls gos map cos-queue 0 to 0

mls gos map cos-queue 1 to 1

mls gos map cos-gueue 2 to 2

mls gos enable

mls gos map premark-dscp 8 to new-cos 1
mls gos map premark-dscp 10 to new-cos
mls gos map premark-dscp 12 to new-cos
mls gos map premark-dscp 14 to new-cos
mls gos map premark-dscp 16 to new-cos
mls gos map premark-dscp 18 to new-cos
mls gos map premark-dscp 20 to new-cos
mls gos map premark-dscp 22 to new-cos
mls gos map premark-dscp 24 to new-cos
mls gos map premark-dscp 26 to new-cos
mls gos map premark-dscp 28 to new-cos
mls gos map premark-dscp 30 to new-cos
mls gos map premark-dscp 32 to new-cos
mls gos map premark-dscp 34 to new-cos
mls gos map premark-dscp 36 to new-cos
mls gos map premark-dscp 38 to new-cos
mls gos map premark-dscp 40 to new-cos
mls gos map premark-dscp 46 to new-cos
mls gos map premark-dscp 48 to new-cos
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mls gos map premark-dscp 56 to new-cos 5

1

policy-map VISTA_DEFAULT_POLICY

trust dscp

class default

1

interface portl.0.1-1.0.18

switchport

switchport mode access
service-policy input VISTA_DEFAULT POLICY
wrr-queue weight 15 queues 0

wrr-queue weight 1 queues
wrr-queue weight 3 queues
wrr-queue weight 6 queues
wrr-queue weight 6 queues
wrr-queue weight 4 queues 5

wrr-queue egress-rate-limit 333m queues 6
wrr-queue egress-rate-limit 100m queues 7

B W N R

1

line con 0
line vty 0 4
1

end
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Networks

Vista Manager EX defines a Network as an IP subnet attached to a VLAN. For example, subnet
192.168.1.0/24 is associated with VLAN1. As part of the Smart ACL feature, network entries are
automatically imported and maintained by Vista Manager EX via the attached network devices.

Each network is given a default Network Name and Description which you can Edit to suit your
needs.

From version 3.13.1 onwards, you can enter a single dash, underscore or letters from languages
other than English as a network name on the Networks page.

AV Allied Telesis  Vista Manager EX - AMFPLUS-Demo Q e manager v
Dashboard
———— Networks ©
Health Monitoring AMF+
Events Network Name Description Subnets Action
i= Asset Management

Security

Network Services
Edit

Access Control L3-Link - @ .
Service Monitoring

Accounts - :
RADIUS

Core-to-Router - :
Intent Networks
Application Priority AMEs Production :
Auto Traffic Shaping AMF+

Core-to-Dist1
Intent-Based QoS AMF+
e Rl Advertising - :
Smart ACL AMF+

CCTV_Network - :
WAN

Marketing - :
SD-WAN
Internet Breakout AMF+ . .

Engineering - :
Dynamic Connection AMF+
Security AMF+ Core-to-Dist2 - :

NETWORKS - FIELD DESCRIPTION
Network Name These are auto-generated in sequence Network-1, Network-2...Network-n,

but you can rename them via the Edit Action.

Description The network description, for example: VLAN100.
Use the Edit Action to add or change a description.

Subnets The subnet IP address, these are auto-generated and derived from the
attached networks. But, networks can only be added via the CLlI, i.e.
configuring a VLAN with subnet(s).

Action Use the Action menu to edit the network name and description.
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Smart ACL

The Smart ACL tool allows you to manage ACLs across devices in the network. ACLs provide traffic
flow control and decide which types of traffic are forwarded or blocked.

You can (could) use Smart ACL to control the resources that clients access in the network. For
example, you might want to stop marketing clients from being able to see a security client’s CCTV
video stream and also stop the security clients from accessing marketing videos.

There are three parts to the Smart ACL tool:
1. Networks: VLANs configured with an IP subnet.
2. Policies: Access List filters (rules) used to control network traffic.
3. Policy Matrix: A display of:
m currently configured source and destination networks

B policy status - configured, active, and hits on the ACL policy

The objective of Smart ACL is to allow you to apply policies between networks - to control traffic
from a source network going to a destination network.

AVE Allied Telesis  Vista Manager EX

Smart ACL ©

Policy Matrix Policies

Default Policy Configured Policy Active @ Policy Hit

Destination

@ ) » Wg® i = |

Network-1
Network-2
Network-3
Network-4
Network-5

Source

Network-1 Edit Policies
Network-2 Edit Policies
Network-3 Edit Policies
Network-4 Edit Policies
Netwaork-5 Edit Policies
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Getting started with Smart ACLs

You need to do some initial configuration before you can use the Smart ACL tool. The initial
configuration ensures that the Policy Matrix shows the current active policies.

In brief, you first configure a network and optionally assign it a meaningful name, then create an ACL
policy and apply it to the network. Let’s look at each step in more detail:
1. Configure a network.
m  Use the CLI to configure a network on your AlliedWare Plus device.
For example:
vlan database
vlan 100
interface portl.0.5
switchport mode trunk
switchport trunk allowed vlan add 100
interface vlanl00
ip address 172.16.2.1/24
2. Assign a meaningful name to the network (optional).
m  Go to Intent Networks > Networks

m By default, networks are auto-generated in sequence Network-1, Network-2...Network-n, but
you can change the default name to a more meaningful one by using the Edit action. You can
also add a useful Description to the Network Name.

Networks ®
Network Name Description Subnets Action
Network-1 VLAN200 - has these subn.. :
Edit

Network-2 VLAN100 - has these subn.. @ =
Network-3 VLAN1037 - has these sub.. Networks
Network-4 VLAN1034 - has these sub..

Network Name
Network-5 VLAN?2 - has these subnets. Security

Description

VLAN200-has these subnets
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3. Create an ACL Policy
B Go to Intent Networks > Smart ACL

m  The Policy Matrix displays all currently configured networks. In the example below, there are
5 networks configured with default names.

Smart ACL ©

Policy Matrix Policies

Default Policy Configured Policy Active @ Policy Hit

Destination

Network-1
Network-2
Metwork-3
Network-4
Network-5

Source

Network-1 Edit Policies
Network-2 Edit Policies
Network-3 Edit Policies
Network-4 Edit Policies
Network-5 Edit Policies

4. Select the Policies tab, then:
a. Click +Add Policy
b. Enter a Policy Name and Description

c. Click + Add Filter - set the Action and Filter Type

d. Click Save.

Smart ACL Policy X Add Filter x

Policy Name o
% Filter Type:

DENY-ANY-ANY-UDP
CMP P TCP UDP

Smart ACL @ Description 0 Action
Deny -
Policy Matrix Policies o

Source port

Destination port
Policy Name  Deseription Filters Status Action
+ Add Filter Equal v 100

Senal m o Cancel m

In the example above, an ACL policy called DENY-ANY-ANY-UDP has an action of DENY if the
packet matches UDP source port =100and destination port =100.
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5. Back in the Policy Matrix tab, apply a policy to a network.

a. Select Edit Policies

b. Configure as required - i.e. select a policy and destination

c. Check the policy is applied to the correct device(s)

d. Click Save

Smart ACL @ Voice
Policy Matrix  Palicies Policies Devices
Default Policy Configured Policy Active @ Policy Deploy fo all VLANs

Destination

Voice o «

Deploy Policies to Network devices o

”
T
4
@
= Select Policy
o}
=3
™
5 DENY-ANY-ANY-UDP
s 2 &
B % B
Data it Policies
Network Management Edit Policies
Voice Edit Policies

Disabled

enavled (@)

Select Destination

v Data K ¥ i

+ Add Policy
Cancel &

Policies >Duv ices

Device Name VLAN Status.

%930-28 4000

Devices without an |P subnet
attached to the VLAN can be
configured with the policy if this

button is enabled

In the example above:

m  The ACL policy DENY-ANY-ANY-UDP is applied to packets from the Voice network going to the

Data network.

m  The Devices tab shows all the devices that the policy will be applied to. In this case, only the
device x930-28 will be configured with the ACL policy.

Now you can see the policy is active from source network Voice to destination network Data.

Smart ACL ©

Policy Matrix Policies

Default Policy Configured Policy Active @ Policy Hit

Destination

Network Management

Data
Voice

Source
Data £dit Policies

Network Management

-

Edit Policies

Vioicea
Voice Edit Policies

Reset Hit Counters

This completes the initial configuration.
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Understanding the Smart ACL Policy Matrix and its operation

The Smart ACL tool makes configuring complex ACLs on networks easier. It allows you to create,
edit, view, and delete ACL policies. ACL policy changes are synced and applied by Vista Manager
EX automatically to VLANs using per-VLAN ACLs.

Once the initial configuration is complete, the Policy Matrix is set up with the configured networks. In
the example below, you can see an active policy from source network Voice to destination network

Data.

Policies are
assigned to
networks

Default

Data

Voic

\ Policy Matrix

Source

e

Smart ACL @

Policies

Network Management

Policy Configured

Destination

Policies are
filters to
control traffic

Reset Hit Counters

Policy Active @ Policy Hit

@
s}
<}
=

Network Management

Data

Edit Policies
Edit Policies
Edit Policies

Policies are applied
between networks

You can hover your mouse over a network name to see how many of the devices in that network
have been synced with the ACL configuration for the policy.

Smart ACL ©
Policy Matrix Policies
Default Pelicy Configured

Destination

Voice: 1/1 devices have been
synced with 1 policy configured

Voice

Voice

Policy Active

Edit Policies
Edit Policies

@ Policy Hit Reset Hit Counters
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The benefit of this is every time a new device is added as part of the network and this subnet, the
values will increase and the new device will automatically receive the policy.

What are per-VLAN ACLs?
Per-VLAN ACLs filter traffic as it ingresses a VLAN.

Per-VLAN ACL rules are applied to all ports on which the VLAN is active. This means they are
applied to all ports that are access ports in the VLAN, all trunk ports that allow packets tagged for
the VLAN, and all trunk ports whose native VLAN is this VLAN.

VLAN
Port1.0.1
Port1.0.2 ACL applied
Port1.0.5 when traffic
e ingresses the
backet Port1.0.8 VLAN
Port1.0.10

Can Smart ACL configure other types of ACLs, for example an interface ACL?

Smart ACL only supports per-VLAN ACLs, and only applies when traffic is going from one subnet to
another subnet.

What actual configuration is applied to the device?
Take the example used in "Getting started with Smart ACLs" on page 275:

®  An ACL policy called DENY-ANY-ANY-UDP has an action of DENY if the packet matches UDP
source port =100 and destination port=100.

m This policy is applied to traffic from the Voice network (V4000, 172.16.0.0/16) going to the Data
network (V1, 10.37.62/27).

! acl-group matching the Data subnet 10.37.62.64/27
acl-group ip address VISTA_V4_1
ip 10.37.62.64/27

! Deny traffic matching source IP = any, UDP source port = 100, and
destination IP = Data subnet, UDP destination = 100.

access-1list hardware VISTA V4 source2_ destinationl policyl

deny udp any eq 100 host-group VISTA_V4_1 eg 100

! Apply access-list to access-map
vlan access-map VISTA ACCESS_MAP_source2

match access-group VISTA V4 source2 destinationl policyl

! Attach access-map to VLAN 4000
vlan filter VISTA_ACCESS_MAP_source2 vlan-1list 4000 input
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What commands can | use to view the Smart ACL configuration?

Use the following commands to view the Smart ACL configuration:

show
show
show

show

acl ip address

access-list

vlan access-map

vlan filter

To view the hit counters, use the command:

show access-list counters

Applying policies to all devices or networks

From version 3.13.1 onwards, four new enhancements have been added to the Intent-based Access
Control List feature.

1. Use destination networks when creating ACLs to permit or deny traffic to these destinations.
These destination networks can include networks outside of ones Vista Manager knows about.

You can add a new network by clicking the + Add Network button from the Intent Networks >
Networks menu.

Dashboard

Network Map

Health Monitoring AVIF+
Events

Asset Management
Network Services
Access Control

Service Monitoring

RADIUS

Intent Networks

Application Priority AMF+

Auto Traffic Shap

Intent Based QoS AMF+
Networks A

Smart ACL AMF+

Networks

Network Name
Network-1
Network-2
Network-3
Network-4
Network-5

Network-6

Bl AL Allied Telesis

6]

End-To-End

End-ToEnd

End-To-End

End-To-End

End-ToEnd

End-To-End

Vista Manager EX

Description

VLAN2000 - has these subnets.

VLANAO - has these subnets.

VLANT - has these subnets

VLAN20 - has these subnets.

VLAN30 - has these subnets.

VLANSO - has these subnets.

Subnets

192.168.12.0/24.

192.168.40.0/24.

169.254.0.0/16

192.168.20.0/24.

192.168.30.0/24.

192.168.50.0/24.

q Q monsger -

+ Add Network

Action

2. A new ANY destination has been added, which allows you to to block or permit user access to
all external networks. You can filter traffic through a list of rules, with ANY as a catch-all final rule.

3. When using IP filtering for managing which traffic types (protocols) an ACL will block or permit,
anew ANY option will select all IP protocols (e.g. TCP, UDP, ICMP, etc). This makes configuration
simpler, and saves needing a separate IP filter for each individual IP protocol.
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AVL Allied Telesis

Vista Manager EX

Smart ACL ©

Policy Matrix Policies

Default

Policy Configured

Destination

Network-1
Network-2

ANY

Source

Network-1

Network-2

Network-3

Network-4

Network-3

Policy Active @ Policy Hit

Network-4

Network-1 x
1 Device
Policies Devices
Deploy to all VLANS
Includes VLANs without subnet configured Exbicy Q
Deploy Policies to Network devices Enabled Q
Select Policy Select Destination
tep_permit X v | Network-2 x v B
udp_permit X - ANY X - [ ]
Edit Policies + Add Policy
Edit Policies
Edit Policies Eangsk E
Edit Policies

4. You can apply Smart ACL policies to all network devices if desired (although this is not often
necessary for ACL operation in the network). When choosing to deploy to all switches, a toggle
has been added to allow you to exclude edge switches with a low ACL limit to avoid
oversubscribing capacity if you expect to need a large number of ACLs (see below).

Switches with a low ACL limit

A low limit of ACLs refers to devices with less than 512 ACL entries.

You can confirm the number of ACL entries on a device with the show platform classifier statistics
utilization brief CLI command.

Edge devices with a low limit of ACLs include the following devices:

Device Series ACL Entries

FS980M

GS900MX

IE200

IE270L

IE220

IE300

IE340, IE340L

IE510

X230, GS970M, x230L
x310

GS970EMX, x330
x510, x510L, x510DP, IX5
XS900MX

496/408
119
496
119
247
247
119
247
119
119
247
247
248
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Bwan

Introduction

The WAN menu hosts a variety of features related to wide area network configuration. The Software
Defined WAN (SD-WAN) feature provides you with improved inter-branch network performance and
reduced cost, by automatically optimizing application traffic over multiple VPN links between offices.

& Wwan

SD-WAN

Internet Breakout AMF+

Dynamic Connection AMF+

Security AMF+

The SD-WAN dashboard provides centralized management of your WAN infrastructure, and
dynamically configures the firewall/router endpoints at each branch location. You can easily set
acceptable performance metrics for any application, and load-balance traffic to meet requirements.
By monitoring VPN link quality, time-sensitive or critical traffic is automatically switched over to the
optimal link as required.

Visual monitoring enables easy management of the WAN, with the ability to drill down to specific
VPN links or applications to assess live and historical operation.

For more information on SD-WAN, and details on instead configuring it via the CLI of individual
firewall/router endpoints, refer to the SD-WAN Feature Overview and Configuration Guide.
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Initial configuration of devices for SD-WAN

The SD-WAN feature provides a GUI for you to set up your network. Before that can be done, the
devices first need some initial configuration via the CLI.

Tunnel Setup

Vista Manager detects tunnels using an algorithm. Only tunnels that match that algorithm can be
shown on the map. IP Sec tunnels must be pre-configured on the network as shown below.

interface tunnell0
tunnel source
tunnel destination
tunnel local name
tunnel remote name
tunnel protection ipsec
tunnel mode ipsec
description <<<tunnel name>>>

STATUS DESCRIPTION

interface tunnell0 This does not need to match the other end of the tunnel.

tunnel source This must be either eth, sub-interface, or PPP, or the IP of those. The API
must return an IP address.

tunnel destination This must match the source IP address of the other end of the tunnel.
Where the destination is a domain, the APl must return an IP address.

tunnel local name Not used for tunnel matching logic.
tunnel remote name Not used for tunnel matching logic.
tunnel protection ipsec Must be present.

tunnel mode ipsec Must be only this mode, and either ipv4 or ipv6. Must match the config
of the other end of the tunnel.

description <<<tunnel Optional. If description is not present, the VTl name is used (e.g.
name>>> tunnel10).
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Tunnel Names

If you want to set a custom tunnel name inside Vista Manager EX, you can specify the name in the
description field of the interface. An example can be found above, or in "Configuration example" on
page 285.

Routing

Routing must be up and working before SD-WAN functionality will work in Vista Manager EX.

DPI Engine

When creating a rule, you have the ability to select an application to monitor. The application is
determined using DPI on the device. The SD-WAN feature uses the enabled DPI Engine. If no DPI
Engine is set, it will default to the built-in engine. DPI is not enabled for SD-WAN by default. You
must pre-configure DPI on the device, or enable it via Traffic Monitoring in Vista Manager EX.

Note: If you have purchased a Procera license, it is strongly recommended that Procera is set as
your DPI Engine, and enabled on all of your devices before running the SD-WAN feature.

Network time protocol

Network time protocol (NTP) is a protocol designed to synchronize the clocks of computers over a
network. The objective of NTP is simple: to allow a client to synchronize its clock with Coordinated
Universal Time (UTC), and to do so with a high degree of accuracy and stability.

To allow SD-WAN to work correctly, NTP should be running on the network so that all clocks are
synchronized. For more information on NTP, refer to the Network Time Protocol (NTP) Feature
Overview and Configuration Guide.

Configuration example

Below is an example of a configuration for a device that will be used in a Vista Manager EX SD-WAN
network.

1
éervice password-encryption
1
ﬁostname AR3050S-Master
1
ﬁo banner motd
1
ﬁsername manager privilege 15 password 8 $13$bJoVec4D$JwOJGPr7YgoExAOGVasdEOD
i
no service ssh
1
éervice telnet
1
éervice http
1
énmp—server
1
1
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aaa authentication enable default local
aaa authentication login default local
1

!

atmf network-name SDWAN

atmf master

atmf area B id 2 local

atmf area B password 8 rnTNKv0fF4iHLJO+ghWojjIeSpzhx7FdZTOUyOPEtLXE=

atmf area A id 1

atmf area A password 8 FtzApz+UFXW792nmEuo/TbLSxIuPYiQ8tbu8Mtdz6al=

atmf topology-gui enable
1
1

api

provider built-in <«-DPI engine should be specified, otherwise Vista Manager will default to built-in

enable
1

crypto isakmp key 8 3560BeBg/eKTE/uhg5C5May0drVT1L4o00bBlkauvp9c= hostname

TUNNEL10

crypto isakmp key 8 2efK2dZ6h0EMVG7+8gfBEKImM73JX3UurzJd2+MVpiH7I= hostname

TUNNEL100

crypto isakmp key 8 jv6hbNiRdAjwNOluRU/3KFkkKQ8Cg6XJ9+otnF+SahaA= hostname

TUNNEL1000

crypto isakmp key 8 wXyMxF5WzvFVc/BtCk5JatDonDQfLMctdpjnK+N5Lzk= hostname

TUNNEL11

crypto isakmp key 8 c¢/KHKV6pkaCDimGlrFgsTZBIdsZYNIh7UnlGC3cYaeA= hostname

TUNNEL2100

crypto isakmp key 8 Sg3MBtl8tCHZD9aPkwrgK5F/FBJidujlNAFF/rFyknE= hostname

TUNNEL2101

!

1

!

!

ip domain-lookup
1

no service dhcp-server
1

no ip multicast-routing
1

spanning-tree mode rstp
1

tunnel security-reprocessing

no lacp global-passive-mode enable
1

vlan database

vlan 4000 name testNet
vlan 4000 state enable

1

interface portl.0.1
switchport

switchport mode access
switchport access vlan 4000
1

interface portl.0.2-1.0.6
switchport

switchport mode access

1

interface portl.0.7
switchport

switchport mode trunk
switchport atmf-link
1
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interface portl.0.8

switchport

switchport mode trunk

rmon collection history 4 buckets 10 interval 30 owner VISTA
switchport atmf-link

1

interface ethl
encapsulation dotlg 2
encapsulation dotlg 3
encapsulation dotlg 1000
1

interface ethl.1000
ipv6e address 2001:db9:1:1::2/64
1

interface ethl.3
ip address 11.0.5.1/30
1

interface ethl.2
ip address 11.0.4.1/30
1

interface eth2
encapsulation dotlg 100
1

interface eth2.100
ip address 12.0.100.1/30
1

interface mgmt
ip address 10.37.130.10/27
1

interface tunnelll <-lIpsec tunnelinterfaces must already be configured
tunnel source ethl.2

tunnel destination 11.0.2.1

tunnel local name TUNNEL11

tunnel remote name TUNNEL10

tunnel protection ipsec

tunnel mode ipsec ipv4

ip address 192.168.10.2/30

1

interface tunnell0O0

tunnel source ethl.3

tunnel destination 11.0.3.1
tunnel local name TUNNEL100
tunnel remote name TUNNEL100
tunnel protection ipsec
tunnel mode ipsec ipv4

ip address 192.168.100.2/30
1

interface tunnell000

description <<<IPv6 Tunnel>>> <«Example tunnel name configuration
tunnel source ethl.1000

tunnel destination 2001:db9:2:1::2

tunnel local name TUNNEL1000

tunnel remote name TUNNEL1000

tunnel protection ipsec

tunnel mode ipsec ipv6

ipv6 address £d00:10::2/64

1

interface tunnel2100

tunnel source eth2.100

tunnel destination 12.0.100.2
tunnel local name TUNNEL2100
tunnel remote name TUNNEL2100
tunnel protection ipsec
tunnel mode ipsec ipv4

ip address 192.168.200.2/30

1

atmf virtual-link id 11 interface ethl.2 remote-id 10 remote-ip 11.0.2.1 remote-
area A

atmf virtual-link id 200 ip 12.0.100.1 remote-id 201 remote-ip 12.0.100.2

1

ipve forwarding
1
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ip route 11.0.2.0/30 11.0.4.2 <«Routing must already be set up and working for SD-WAN features to
work

ip route 11.0.3.0/30 11.0.5.2

!

ipv6 route 2001:db9:2:1::/64 2001:db9:1:1::1

!

line con 0

exec-timeout 0 0

line vty 0 4

1

end

SD-WAN Dashboard

The SD-WAN dashboard provides you with an overview of the current state of your network. You
can see throughput, a breakdown of application use, the state of rules that have been applied, and
events in the network.

You can also choose the time-frame you wish to display; either the last 1 hour, the last 12 hours, the
last 24 hours, or a custom range.

WAN Devices Select VPN Members(7)
AREAD | ha-gw ~ Members
Throughput (KB/s)

I Al received [ Al sent

Throughput (KB/s)

25

a7s

50
1435 14:40 14:45 1450 14:55 15:00 15:05 15:10 15:15 1520 15:25 15:30 15:35

Time

The throughput chart shows an overview of sent and received data for a device. You can select
which device to view from the WAN Devices drop-down. You can also choose which members to
include from the Select VPN Members drop-down.
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Application Use

WAN Devices
AREAD | hg-gw ~ Bytes Packets
53 51 MB
esp 48 MB
udp 4MB
facebook 4MB
cmp 3MB

The application use chart shows the amount of data sent and received for a device, broken down by
application.You can select which device to view from the WAN Devices drop-down. You can also
choose whether to view bytes or packets by choosing the appropriate toggle.

SD-WAN Rule Monitoring 2 of 3

Source-Dest

A.AR2050V-top -> B.AR4050S-bottom ~ -4
Skype
tunnel100
tunnel10/t.. L tunnel10/t.. L
a a L
15:43 15:55 16:07 16:19 16:31 16:43 15:43 15:55 16:07 16:19 16:31 16:43 15:43 15:55 16:07 16:19 16:31 16:43

office365_LB sctp

tunnell00 — tunnell00

tunnel10/t..

The rule monitoring chart shows the status of rules in your network. You can change which rules are
shown from the Source-Destination drop-down.

SD-WAN Events
Q Keyword Filters = 9

Date Rule Application Source Destination Event Previous Link Selected Link Selection decision Message
9:55:13 AR40S0S AR2050V- G g
?‘,Ifilu Connect http_connect ENW Shettom R2050V-top tf‘rs‘“‘“ Geed “;:”‘» " [Rule: Connect] tunnel11 lin}
09:5513 . . AR4050S-bottom AR2050V-top Link Selested tunnel10 . PR
v Connect http_connec i A Cortosion chonge e lowest available memberid  cause: Configuration chang|
9:55:13 AR4050S- AR2050V- G
0e551 Connect http_connect 40505 botiom R2050V-top Lk State Good [Rule: Connect] tunnel100 i
20150810 e A tumnelt 00
09:5513 . . AR2050V-top ARA050S-bottom Link Selested . PR
v Connect http_connec A i Cortosion chonge lowest available memberid  cause: Configuration chang|

The SD-WAN Events chart shows all of the events that have occurred. You can limit which events
are shown by using a keyword to filter the results. Click on the Export as CSV button to export all
values. Click on the Columns button to choose which columns are shown.
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SD-WAN Topology map

The SD-WAN topology map gives you a visual overview of your network.

SD-WAN + Add Rule
Dashboard WAN Map Health Monitoring Rules
VPN Tunnels  Rules
®
®
®
A
AREAT
bl-gw
‘:J o L = & + =

You can see the state of all tunnels on the map. The state of each tunnel is indicated by the following
colors:

m  Grey with dashed line - Tunnel disabled or tunnel configuration incorrect
® Blue - Tunnel configured, probe disabled

®  Orange - Tunnel configured, probe in unknown state

®  Red - Probe enabled and tunnel destination is not reachable

® Green - Probe enabled and tunnel destination reachable

You can click on the Information button to bring up a key explaining each of the colors.

VPN Tunnel Status
Tunnel disabled
=8~ Tunnel configured, Probe disabled
£ Tunnel configured, Probe in unknown state
—# Probe enabled, destination unreachable
-

Probe enabled, destination reachable

You can also see the health of SD-WAN rules on the map. The health of each rule is indicated by the
following colors:

B Red - Failed to meet all rule criteria
m  Orange - Failed to meet one or more rule criteria

® Green - Meets all rule criteria
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As with the VPN Tunnel Status, you can click on the Information button to bring up a key explaining
each of the colors.

SD-WAN Rule Status
Tunnel disabled
=8~ Tunnel configured, Probe disabled
£ Tunnel configured, Probe in unknown state
- Probe enabled, destination unreachable
-8 Probe enabled, destination reachable
—— Failed to meet all rule criteria
Failed to meet one or more rule criteria

—— Meaets all rule criteria

To change between showing the health of the tunnels or the rules, select either VPN Tunnels or
Rules by clicking on the control in the top right corner.

VPN Tunnels Rules

When you click on a tunnel, the tunnel details are displayed in the side panel. The side panel shows
the following information:

Tunnel details tab:
@ tunnel10 / tunnelll X

mProbe Status. You can use this slider to enable or disable a
probe.

Tunnel

Probe Status
mProtection

Protection IPSec
Mode IPSec .MOde
minterface Name

@ twnnel10 ~

Router: A/ARZO50V-top
Interface Name tunnel10 ISOUFCG
Source th.2

B - mSource IP
Source IP _=
D —— - mDestination
@ tunnelll ~

Router: B/AR30505-bottom

Inte e unnelt
Source ethl.2
Source IP r-a
Destination -
SD-WAN rules tab:

@ tunnel10 [ tunnelll X

fules mRule Name
Facebook . .| ®MRule Details
Ranked

A | AR2050V-top

B | AR3050S-bottom
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When you click on a router, the router details are displayed in the side panel. The side panel shows
the following information:

Router details:

AR4050S-bottom *

Reboot Device Backup Device SSH to Device

Router

Basic Information

Status Normal
IP Addresses TFLZI1LE
Type Router
Model AR4050S
Serial P - =S
Version 5.4.9-1.3
Vendors Allied Telesis Labs Ltd

AMF Information

Area B

Events

Running config updated - Requires sav... X

VPN members:

AR2050V-top X

Reboot Device Backup Device SSH to Device

Members
B
ell0 U
nnel100 Up
nnellooo Up

mStatus

m|P Address
mType
mEModel
mSerial
mVersion
mVendors

BAMF Information

m  SD-WAN rules associated with this router. The colours here represent the status of each tunnel

as described above.

A | AR2050V-top

nell0

A | AR2050V-top

nel100

C613-10634-00-REV B

Rules:
AR2050V-top x
Reboot Device Backup Device SSH to Device .RUIe Name
Rules mRule Details
Facebook Z o~
Ranked
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Probes on the Topology map

When arule is created, any required probes will also be created and enabled. However, you can also
create, enable, and disable probes from the SD-WAN map screen.

On the SD-WAN map, you can enable a probe for a specific link. To enable a probe, select the tunnel
by clicking on it on the map. In the side panel, click on the Probe Status slider to enable the probe.

@ IPv6 Tunnel X

Tunnel

Probe Status

Mode IPSec-IPvé

The Probe Status slider will then show the status as enabled.

@ IPv6 Tunnel X

Tunnel

Probe Status

Mode IPSec-IPvé

The SD-WAN feature will create the probe and provide sensible default values for:
m [P Version (IPv4 or IPv6)
® |Interval (ms)

B Packet size (bytes)

Probes that are created use ICMP by default, and this cannot be changed by a user.

You can disable a probe again by clicking on the Probe Status slider.

You can also use the SD-WAN map to see which links have probes enabled and disabled.

On the VPN-Members health screen, you can see a table of all VPN members in the network. You
can also see which VPN Members have a probe enabled or disabled.

Note: If a probe has been configured by the CLI, it is not visible in the SD-WAN feature. It is
recommended that you use the SD-WAN feature in Vista Manager EX to create the probes.
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Link selection strategy

For each group of links, a rule is applied so there will always be a selected link (when not load-
balanced). This selected link is the link that all traffic for that rule is directed through. If that selected
link’s metrics breaks one or more thresholds (configured by link status thresholds), then the Link
Selection Strategy is used to determine the new selected link.

Regardless of Link Selection Strategy, links within threshold are always preferred over links breaking
one or more thresholds.

B Latency - the link with the lowest latency is picked.

m Jitter - the link with the lowest jitter is picked.

B Probe Loss - the link with least current consecutive probe loss is selected.
B Ranked - the link highest in the groups list is selected.

m  Combined - takes latency, jitter, and probe loss metrics into account to determine a single
combined score. The link with the best (lowest) score is selected.

Site deployment

Site Deployment + Add group

No group is selected

Links picked to make up the groups for a rule determine where the rule will be deployed. Between
each router pair selected, two identical instances of the rule will be deployed, one on each of the
routers.

Even though a 'source' and 'destination’ router are selected, the rules are deployed identically on
each router pairing.

Selecting a router pairing as Load Balanced means that when there are more than one link with a
status of good (status determined by Link Status Thresholds) then traffic flows will proceed evenly
over all those good links. If all links have gone bad then the Link Selection Strategy is used to pick
one link for the traffic to use.

Within each router pair, links can be moved to have a higher or lower ranking within the group. This
ranking is solely used for the Link Selection Strategy of 'Ranked'.

Site Deployment + Add group

ARZ050V-top 4 = E AR3050S-bottom
Load Balance Members

tunnel10/tunnel1l

tunnel100
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When selecting a VPN member, you will be notified how many more rules can be created on the
device. Remaining rule spaces are calculated by taking the highest rule ID and subtracting it from
500. When there are 0 rules available, you cannot select the member as a source or destination.

When selecting a VPN member, you can only select links between a source and destination device
that have the same IP Version. If you select a link of type IPV6, then an IPV4 link cannot be selected
in the same rule. Likewise, if you select a link of type IPV4, then an IPV6 link cannot be selected in

the same rule. You will see a warning message if you attempt to select links that do not match.

Application

Application @ + Add application

Mo application is selected

The application list is provided by the active DPI engine. If there is no active DPI engine, then SD-
WAN will enable the built-in DPI engine by default.

Applications X

afp

aim

aimini

ajp

amazon
amazonvideo
amgp

apple
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Health

The health tab gives you an overview of the current health of your network in a single location.

The Source-Destination drop-down allows you to select a specific router, or show all routers. You

can also limit which rules are shown by using a keyword to filter the results.

Click on the Export as CSV button to export all values. Click on the Columns button to choose which

columns are shown.

Clicking on the toggle allows you to change the view between Rule Health and VPN Health.

Rule health

Health
Source-Dest
All ~ Rule Health VPN Health
= Filterdata ~ Q Search by keyword & e
Name Source/dest Application Performance Profile Latency Member Loss Rule Health
Rule_17_7030_dns B.AR30. AAR20. dns Latency Good
Rule_14_4146_http_connect B.AR30. AAR20. http_connect Latency Good
Rule_13_461_hotmail B.AR30. AAR20. hotmal Probe Loss Good
The rule health tab shows a summary of the state of all the rules in the network. You can click on a
specific rule to see more information about that rule:
m the rule settings
B the rule status
m the current settings for:
m |atency
m jitter
m probe loss
VPN health
Health
Source-Dest
Al + Rule Health VPN Health
= Filter data ~ @ Search by keyword & e
Name Source/dest Probe status Latency Jitter Probe Loss
tunnel10 / tunnel11 A AR2050V-top B.AR30505-bottom on ;) 2’]' ;) ; Z 8
tunnel100 A AR2050V-top B.AR30505-bottom on ;) 25 Z ‘E Z 8
IPv6 Tunnel A AR2050V-top B.AR30505-bottom off ;) g ;) 2

The VPN health tab shows a summary of the state of all the VPNs in the network.
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Monitoring

Monitoring

Source-Dest

A.AR2050V-top -> B.AR4050S-bottom + S5

Application Rule September &

Alister ~ C= Link Selection [1] Link Performance 1h 12h 24h Custom ~

The monitoring tab displays historic link and rule information. Vista Manager EX allows you to view
up to 7 days of historic data.

The Source-Destination drop-down allows you to select a specific router, or show all routers. The
Application Rule drop-down lets you select which rule to show. You can also choose the time-frame
you wish to display; either the last 1 hour, the last 12 hours, the last 24 hours, or a custom range.

You can toggle which charts are shown. The Performance Routing Events chart is always available.
The Link Selection Path and Link Performance charts are only available after a source and
destination have been selected.

Cz Link Selection Path

Alister

Current link selection strategy: Ranked

tunnel 100

tunnel10/tunnelt 1

14:34 14:41 14:47 1454 15:01 15:07 15114 1521 1527 15:34

The Link Selection Path chart shows a time-line of which link is being used for the selected rule. You
can see which link selection strategy is being used, and the history of which link has been chosen.

The Link Performance charts show the performance history of a link for either latency or jitter. You
can select which member you would like to see from the Members drop-down, or select multiple
members to compare them.

[@ Link Performance

Select VPN Members(1)

Nﬁ}mbers M Latency  Jitter

Latency

I tunnel2100 / tunnel2101

120

100

60

Latency (milissconds)

40

14:41 14:48 1455 15:01 15:08 1515 15:21 15:28 15:35
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The latency chart shows the history of the latency for the link. It also shows the good-below (green
line) and bad-above (red line) thresholds for the link if they have been configured.

[ Link Performance

Select VPN Members(1)

Members Latency | Jitter

Jitter

I tunrel2100 / tunnei2101

conds)

Jitter (millisex

14:42 14:49 14:56 15:02 15:08 15:16 15:22 1529 15:36

The jitter chart shows the amount of jitter for the link.

= Performance Routing Events
= Filterdata ~ Q_search by keyword & '|||'
Date Rule Application Source Destination Event Previous Link Selected Link Selection decision Message
11:25: 547 YNG e AR4050S-bottom AR2050V-top Link Sltate Good - ‘TH‘E:‘ [‘iC . R [Rule: VNC] tunnel100 Ii
8 e A tunnel100 - 921681002
Link Selected
VNC vne e cause: ID 2 removed frc
AR40508-bottom AR2050V-top Link Selected tunnel2101 tunnel100 B
VNC vne oo mneel unenee only available link cause: ID 1 added te gn
e A 1D 1 added o group VM_VNC,  192.168.200. 68.100. ’
AR40508-bottom AR2050V-top Link State Good - tunnell 1 .
VNC ne . — e B [Rule: VNC] tunnel11 lin

The Performance Routing Events chart shows all of the events that have occurred. You can limit
which events are shown by using a keyword to filter the results. Click on the Export as CSV button to
export all values. Click on the Columns button to choose which columns are shown.

User permissions

A user must have read permissions to at least one router in a router pair in order to view rule
information for that router pair. This applies to both viewing rule configuration, and viewing the
historic link selection path. A user can only see events in the SD-WAN Routing Events table when
they have at least read permissions on the source router for that event.
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Rules

SD-WAN rules, also known as PBR (policy-based routing), allow your network to determine the best
path for network traffic. SD-WAN uses metrics about the health of the link to decide if the link is
“good” or “bad”. This allows traffic to be re-directed from a “bad” link to a “good” link, even if both
links are still up. The metrics that SD-WAN can use to judge the health of a link are jitter, latency, and
packet loss. Each metric is examined separately, so that a link that is “bad” for voice traffic due to
high latency may still be “good” for bulk data due to low packet loss.

When there are no rules configured, you will see the following message on the SD-WAN rules
landing page:

MNo SD-WAN Rules have been configured

Create a new SD-WAN Rule

From version 3.14.0 onwards, support has been added for an 'any' option for applications from the
SD-WAN > Rules page.

You can now create an SD-WAN rule that applies to any application. This support helps you to
deploy SD-WAN across multiple sites easily, by using rules that apply to all applications instead of
making individual rules for each application.

First, click on the Create a new SD-WAN Rule link to create your first rule.

If you already have SD-WAN rules configured, you can create a new rule by clicking on the Add Rule
button.

SD-WAN + Add Rule

Dashboard

You will then see the Application Rule screen:

Name

Performance Profile (© Site Deployment (& + Add group Application © + Add application

Link Status Thresholds (O
No group is selected No application is selected

Latency (ms) (3

Bad above Recovery margin

Jitter (ms) (D)

Bad above Recovery margin

Probe Loss (i)

Bad when Good when Unreachable when

Link selection strategy ()

Ranked v

The Name field allows you to specify a name for your new rule.
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The Performance Profile is made of two parts. The Link Status Thresholds are used to determine
each link’s status (good/bad/unreachable). The Link Selection Strategy is used when any selected
link moves from good to bad status. The Link Selection Strategy is used to pick the new selected
link to use.

MName

Performance Profile (@

Link Status Thresholds (0

Latency (ms) (D)

Bad above Recovery margin
Jitter (ms) (D
Bad above Recovery margin

Probe Loss (3)

Bad when Good when Unreachable when

Link selection strategy (D

Ranked ¥
Rules
= Filterdata ~ Q Search by keyword o I|||I
Name - Link selectio... - Application ~ Members Action
Facebook Ranked facebook 2 members :
Rule_1_dns Ranked dns 2 members :
Rule_2_applepush Ranked applepush 2 members :
Rule_3_ssl_no_cert Jitter ssl_no_cert 2 members :
1to4of4 Page 1 of 1

You can see a table of the existing rules by clicking on the Rules tab.

The table of existing rules contains link state history. History information is polled and stored, so
there may be a delay in the rule table.

Note:

Rules that have been configured using the CLI will not be visible in Vista Manager. If a rule

was configured by Vista Manager, and then is altered via the CLlI, the changes made in the
CLI will not be visible inside Vista Manager. Therefore, you should not alter rules created in

Vista Manager from the CLI.
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Link status thresholds

Each link in a rule has a set of metrics collected for it using probes. When these metrics for a
particular link break or move back within the Link Status Thresholds, the status of that link changes
between bad/good/unreachable.

Each row in Link Status Thresholds sets thresholds for a particular metric. At least one row needs to
be configured. The rows configured are independent of the Link Selection Strategy.

A link must be within all three thresholds to be considered good. If a link is breaking at least one of
the three thresholds it is considered bad.

Latency m Bad above - If a link's latency increases past this threshold then the link’s status becomes bad.

®  Recovery margin - A bad link will be considered good again (at least in terms of latency) once
latency has reduced below the 'Bad Above' threshold by this amount.

Jitter m Bad above - If a link's jitter increases past this threshold then the link’s status becomes bad.

m Recovery margin - A bad link will be considered good again (at least in terms of jitter) once jitter
has reduced below the 'Bad Above' threshold by this amount.

Probe loss ® Bad when - A link will be considered bad (at least in terms of probe loss) if this many probes are
lost in succession.

m  Good when - A bad link will be considered good again (at least in terms of probe loss) once this
many probes are successful.

m  Unreachable when - A link will be considered unreachable if this many probes are lost in
succession.

Rule Discovery

If the Vista Manager database is reset or initialized, the SD-WAN configuration will be read from
each router in the network. The naming convention used by Vista Manager will be used to retrieve
this information.

When the Vista Manager server is started, or when a new router is added to the network, the SD-

WAN configuration will be read from the device and compared with the current database state. If
there is a mis-match, then an event will be generated in Vista Manager to tell the user that the
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configuration of the device is not compatible with Vista Manager's SD-WAN feature. The event log
entry will be created when:

Any rule configuration parameter differs between the Vista Manager database and the device.

Any profile configuration parameter differs between the Vista Manager database and the device.
Any group configuration information differs between the Vista Manager database and the device.
Any probe configuration parameter differs between the Vista Manager database and the device.

A rule on a device does not have an equivalent rule on another device, to maintain Vista
Manager's rule of symmetry.

When Vista Manager detects a configuration mismatch, it will generate one event for the device that
has the mismatch:

SD-WAN configuration on the device does not match Vista Manager.

When Vista Manager detects a configuration mismatch, a notification will be displayed on the rule
configuration table. The user will have the option to:

Fix the rule using the Reconcile action, or

Delete and recreate the rule.

Editing and deleting an SD-WAN rule

Name - Link selectio.. Application ~ Members Action
Rule_100_3601_iax Ranked iax 2 members
Edit
101_5498_y: obe Loss youtub 2 el
Rule_101_5498_yo... Probe Loss youtube members Delete

To edit an SD-WAN rule, click on the Action drop-down, and select Edit. This will take you to the
Application Rule screen for that rule.

To delete an SD-WAN rule, click on the Action drop-down, and select Delete. This will prompt you
whether you want to delete the rule, and clicking on Delete will remove it.

User permissions for SD-WAN rules

C613-10634-00-REV B

A user can only create or edit a rule if they have read/write permissions for all routers specified in
that rule.

If a user has at least read-only permissions to one router in a rule, then they are able to view the
rule configuration.

If a router in a rule is down, the user cannot edit that rule. They can press delete for the rule, but
this will only do a partial delete. This will only remove it from the online routers in the rule. They
will be warned that the rule cannot be deleted from the routers that are offline. The rule containing
the offline routers will remain in the configured rules table.
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Applying SD-WAN rules to all applications

From version 3.14.0 onwards, support has been added for an 'any' option for applications from the
SD-WAN > Rules page.

You can now create an SD-WAN rule that applies to any application. This support helps you to
deploy SD-WAN across multiple sites easily, by using rules that apply to all applications instead of
making individual rules for each application.

Internet Breakout

Internet Breakout lets specific applications being used at branch office locations, access the
Internet directly, rather than going via the head office. This improves the performance of cloud-
based applications (e.g. Office 365) and reduces traffic volumes on VPN connections between
branch offices and the head office.

B This feature requires AR-series devices to run AlliedWare Plus 5.5.0-2.1 or later.
B Internet Breakout requires Device DPI Per Entity and DPI Learning to be enabled.

m  Before configuring, start by identifying the types of applications you may want to allow direct
Internet access.

m  Enabling this feature reduces router throughput.

B Any traffic that bypasses security processing may reduce security and threat protection at the
local branch office. Carefully consider the potential consequences of giving direct Internet access
to a type of traffic, and whether additional local or cloud-based security needs to be implemented
to protect Internet Breakout traffic and the branch office.

B Internet Breakout needs to classify applications for sending direct to the Internet. It does this
most effectively when it can read both incoming and outgoing traffic on the interface that was/is
sending those applications to the head office. For IPSec protected tunnels, this requires a feature
called tunnel security reprocessing. Vista Manager does not enable tunnel security reprocessing
because it reduces router performance.

m  To enable tunnel security reprocessing, enter the following commands on the router’s CLI:

enable
conf t
tunnel security-reprocessing
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Step 1. Enable Internet Breakout and specify the traffic path for applications

By default, Internet Breakout inputs are disabled until Breakout or Non-Transparent Proxy is
enabled. If invalid options are selected followed by disabling Internet Breakout, these options will be
removed. This prevents saving a disabled but invalid configuration.

Use the Internet Breakout > Breakout tab and select a device:

1. Click the Settings icon.

2. Enable Device DPI (save any changes).

BranchOffice-Firewall

Breakout Monitoring

Internet Breakout

Enable Breakout

Non-Transparent Proxy

Enable Non-Transparent Proxy

Proxy Settings

Proxy Bypass URLs

DPI learning with counter Disabled @q BranchOffice-Firewall X

© Internet Breakout requires Device DPI Per Entit

Application(s) Break From

®

=,/ Apply Changes

@ cChanges to DPI configuration may affect features that use
applications including Internet Breakout, Firewall rules, NAT
rules, SD-WAN rules.

Device DPI %

Provider Procera (license... v
DPI Learning (,
DPI per Entity (\

Application Sharing (requires DPI Learning)

Cancel Apply Changes

3. Select Enable Breakout

4. Add Applications to the Breakout List, for example, Office365, Google, Youtube, etc.

5. Select the interfaces to Break from and Break to.

® To add another break from or break to interface, click + Add another Breakout and repeat
steps 4, 5, and 6.

6. Enter the Next Hop address (optional). If ‘tunnel’ is selected as ‘break from’, then next hop is

disabled.

7. Enable and configure the Non-Transparent Proxy settings (optional).

8. Click Apply Changes.
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BranchOffice-Firewall

Breakout Monitoring

DPI learning with counter Running: Server e

Internet Breakout
Internet Breakout lets specific applications access the Internet directly

Enable Breakout (ﬂ

Apply Changes

Application(s) Break From Break To
X ¥ tunnel1 X v || fethl
google X eth1
office X eth2
youtube X tunnell
tunnel10
tunnel2

Non-Transparent Proxy
Enter your proxy server configuration

Enable Non-Transparent Proxy

Proxy Settings

12.22.34.45 3128

Proxy Bypass URLs

Add url

Add url

www.google.com X

www.microsoft.com X

Next Hop a

X @ 10.0.0.2 i

+ Add another Breakout
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Step 2. Monitor the breakout

Use the Internet Breakout > Monitoring tab
Two charts are available here:

B The pie chart shows the top 5 breakout applications. Clicking applications on the vertical legend
adds/removes them to/from the chart.

® The line graph shows breakout traffic over a set period of time. Clicking applications on the
horizontal legend or using the drop-down list adds/removes them to/from the graph.

. netflix .fac.et-cok .t-.'.-i.‘ter ubuntuone @google '_\-'-:utut-e microsoft @tﬁﬁceBBS
97.66 KB

8780 KB |
7813 KB
68.36 KB
5350 KB
4333 KB

TX Bytes

39.06 KB
293 KB
1953 KB
9.77 KB

90%9am S14am %19am 9S24am 9209am 934am 93%9am Sd4d4am S49am S54am 959 am  10:04 am 10:09 ar

Dynamic Connection

This feature lets you use the simplicity of drag-and-drop on the network map, to create new VPN
tunnels between the AR-Series devices (firewalls or routers) at different locations across your WAN.

m Point-to-point tunnels require a source device and destination device.

m  Point-to-multipoint tunnels require a source device and multiple destination devices.
Note: The AR1050V does not support Dynamic Connection.

For this feature to be fully functional, apart from installing the AlO license, you must also have either
administrator access or write permission on a device.

To create a tunnel, both devices must be part of the AMF network, support GRE tunnels and be
running firmware version AlliedWare Plus 5.5.0-2.x or later.

You cannot create multiple tunnels with the same source and destination interface pair (e.g. eth1).
Split up the interface if you wish to create more than one tunnel, for example, split eth ports into
sub-interfaces. You may create another tunnel with the same source interface as long as the
destinations are on different devices.

All tunnels are encrypted with IPSec to secure your WAN traffic. Each tunnel will have a different
crypto key with a unique name.
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Creating tunnels

Option 1: Create a Point-to-Point Tunnel

Create Point to Point Tunnel s

0 Tunnel protection type is IFSec

Tunnel Mode
o ‘ GRE

AR20505

% Tunnel Interface *

‘ ethl ()

Tunnel IP Address * Subnet

‘ 172.28.01

Tunnel Description

‘ AKL-zource

Tunnel Routing

Mo Routing

ARZ010V
Tunnel Interface *

‘ ath2 ()

Tunnel IP Addrass * Subnet

b

‘ 172.28.02

Tunnel Description

‘NSN-cestinatic:'i

Tunnel Routing

Na Routing

8

9

Cal Create

1. Usethe pencil icon to draw a line between devices (firewalls/routers) at the two locations you wish
to connect with a new VPN tunnel.

2. Next, set up tunnel options. Select tunnel mode.
3. Select an interface for the tunnel to be on.

4. Vista Manager EX generates the tunnel interface IP addresses. The subnet prefix is /30.

Note: If you choose your own IP address, it must be in the same subnet and must not be used on
another interface on those devices.

5. Enter a description name for the tunnel.

6. Configure tunnel routing.
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Note: The options here are default or static. You may enter IP addresses for each end of the tunnel

by selecting static routing.

7. Repeat steps 3-6 to set up tunnel options for the destination device.

8. Click Check connectivity. There should be a ping from source interface to destination interface

if there is a connection.

9. Click Create when complete.

Option 2: Create a Point-to-Multipoint Tunnel

1. Click on the pencil icon and select point-to-multipoint tunnel.

2. Use the pencil icon to first select a tunnel hub. This is usually a head office router.

3. Next, select spokes one by one. These should be your branch offices.

4. Perform Option 1 steps 2-6 to set up tunnel options.

Note: In version 3.5.0, adding a static route to the hub of a multipoint tunnel is not supported.

5. Repeat for all your spokes (branch offices).
6. Click Check connectivity.

7. Click Create when complete.

Note: For multipoint tunnels, a hub of multipoint tunnel cannot share the same interface (with the

same IP address) as a GRE point-to-point tunnel.

Note: Connectivity is not needed for the new tunnel configuration to be created, although the tunnel

will not be fully formed until there is a connection.
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Distributed tunnel routing

When you create a tunnel, you can choose to distribute routes to additional devices in order to
create a return routing path.

You will see a list of subnets to choose from, with these subnets being accessible from the device.
However, not all networks and devices at the tunnel destination are used to form new primary
routes. The list of destinations are pre-filtered.

The following types of networks and hosts are allowed:
B connected by static routes
m  directly connected to the end router (direct routes)

m routed through a dynamic routing protocol

Example: When a tunnel is created from (A) to (B), (A) will distribute networks and hosts (X) to (B).
However, that does not necessarily mean (X) can reach (B), so networks on (B) are allowed to be
distributed to add as routes on (X).

If a tunnel is deleted, all static routes associated with the nexthops of that tunnel will also be
deleted. However, manual routes can still be added from the pull-down menus.

Administrative distances are added to static routes; static routes with the same default
administrative distance (zero) to the same destination is not supported. When a route is shared,
Vista Manager adds a 1 to its distance. Therefore, a direct connection route with a default distance
of 0 will have a distance of 1 when added to a destination device’s route table.

For this feature to be fully supported, AlliedWare Plus version 5.5.1-2.1 or later is required.

Settings for the source end of tunnel (Auckland)

1. The route to Auckland (1.0.0.0/8) is selected in the “Distribute Routes” input. This route is added
to the route table of the Christchurch device, allowing traffic to go from Auckland to Christchurch.

2. Atunnel between Auckland and Waimate already exists, so the route to Waimate (2.0.0.0/8), is
an option in the “Distribute Routes” input. This route is added to the route table of the
Christchurch device, allowing traffic to go from Waimate to Christchurch.

3. Nothing is needed in the “Distribute routes to devices” input because the selected routes are
automatically distributed to the destination end of the tunnel (Christchurch).

Settings for the destination end of tunnel (Christchurch)

4. The route to Christchurch (3.0.0.0/8) is selected in the “Distribute Routes” input. This route is
added to the route table of the Auckland device, allowing traffic to go from Christchurch to
Auckland.

5. Because the route to Waimate is added to the route table of the Christchurch device, there is now
an option to distribute a route to Christchurch on the Waimate device. This route is added to
Waimate, allowing traffic to go from Christchurch to Waimate.
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Create Tunnel

@ Tunnel protection type: IPSec

Tunnel Mode

IPSec GRE GRE-IPv6

@ Auckland o]

Distribute Routes
Auckland

1.0.0.0/8 —

Selecte will be added ination devices

Distribute routes to devices

e ®

Routes to distribute are not compatible with any devices

2.0.0.0/8 3.0.0.0/8 Distribute Routes
(4]

Selected routes will be added to destination devices

Distribute routes to devices

Select Devices ‘ W

Waimate 6

CanCEI

Note: It is mandatory to choose a route. Vista Manager is unable to prevent loops from being

created as all forwarding paths in the network are not known. Some WAN-facing interfaces
will not be included in the list of routing destinations, as this could form routing loops caused
by networks beyond the immediate control of the user.

Feature limitations

There are some feature limitations to take note of:

C613-10634-00-REV B

Because this is adding static routing, there may be potential for routing loops. The risk of causing
such loops cannot be eliminated.

Entity subnets will not be filtered out if they overlap or are duplicated with other subnets. It is up
to the user to create valid entities.

Changes made to subnets and entities after the tunnel has been created will not be automatically
deleted; routes on the devices will not be updated. Users will have to make these changes on the
tunnels and devices if they make changes to subnet and entities.

IPv6 routes are supported as static routes, but are not supported as distributed subnets. The IP
version of static routes must match the IP version of the tunnel IP address.

MGRE tunnels use GRE-based protocols and are therefore stateless. Static routes on mGRE will
not be re-routed automatically if a hub-to-spoke tunnel link goes down.
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Security

The security feature lets you configure the web control and IP reputation features on the UTM
firewalls at a number of locations simultaneously, for centralized and simplified management.

m  Web control offers an easy way to monitor and control the types of websites viewed by
employees.

m |IP reputation blocks employee access to websites that are known source of spam, viruses and

other malicious activity, to protect your network against security threats.

The overall security feature allows you to enable recommended security settings for a group of UTM
firewall devices based on an industry type and security strength. This simplifies the process as there
is no need to manually choose website or reputation categories for each device.

Note: For this feature to be fully functional, you may need to do additional configuration in the
device GUI. Internet access and domain name lookup are required. Enable the ATL Live
update server in order to download and check for IP reputation or web control updates.

Step 1: Enable security features and select industry settings.

Use the Security > General tab

1. Enable IP Reputation and Web Control for the desired device group(s).
2. Select a Security provider (e.g. Digital Arts).

3. Select the industry type (e.g. High School).

4. Set atime to check for updates.

5. Select the desired security strength for the industry (e.g. Medium).

6. Click Apply Changes.

CanterburyHigh @

General Advanced IP Reputation Advanced Web Control Monitoring

Security Features

IP Reputation

Web Control & n

Web-control (License Required)

Digital Arts Webroot e

Industry

High School e
Check for updates every

24 hours e

Industry Strength

Low Medium High e
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Step 2: Edit advanced IP reputation settings if required.

Use the Security > Advanced IP Reputation tab

1. Click Edit Industry Settings.

CanterburyHigh

General Advanced IP Reputation

Industry Strength

Low Medium High

Industries

N
| ]
\!} Custom

N
P Infant Scheol

IC::I Elementary School

—
-

:: Junior High School

N e
) High School

Advanced Web Control

3

Monitoring

Check for updates every

24 hours - |

Edit Industry Settings

View Details

View Details

View Details

View Details

2. Permit, alert, or deny a reputation category action as needed.

A warning appears if one or more devices in the group have had different IP reputation or

Web Control settings already applied via another group.

3. Click Apply Changes. This changes the industry type to Custom.
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IP Reputation X
Abused TLD Permit  Alert Deny
Bitcoin Related Permit Alert Deny
Blackhole Permit Alert Deny
Bot Permit  Alert Deny
P S T N Y
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Step 3: Edit advanced Web Control settings if required.
Use the Security > Advanced Web Control tab
1. Click Edit Industry Settings.

2. Permit or deny website categories as needed.
A warning appears if one or more devices in the group have had different IP reputation or
Web Control settings already applied via another group.

3. Click Apply Changes. This changes the industry type to Custom.
Step 4: Monitor Web Control and IP Reputation performance.
Use the Security > Monitoring tab

1. Click on the IP Reputation and Web Control buttons to view respective graphs.

2. For IP Reputation, click the drop-down list to select the UTM firewall device from a specific
location to view.

3. For Web Control, click the drop-down list to select the UTM firewall device from a specific location
to view. Clicking Categories on the legend or drop-down list lets you add/remove categories to
view on the graph.

IP Reputation  Web Control o ’ Decemnber 21 2020, 7-:01 am - December 21 2020, 801 am 1h  12h  24h Custom ™~

Devices Categories f
all - 5 Categories ~ ‘
F
L
Category Hits
( .,-:c"c Tobacco .C edit Cards, Onfine Payment. E-Mone .E::s wehworking
36 f
30 4
25 /
2 :
r 2
g
=]
£ 15
o 1
10 f
5 £
0
7:01 am T:08 am " T-41 an T:48 am T-51 am 7:56 am E:01 am
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E User Management

From the User Management menu, you can create new users and manage your account. There are
two types of user account, Admin and User. The User Management page is only accessible to
Admin users. Any other account types do not have access.

Admin accounts have read/write access across all AMF areas. An Admin can create other user
accounts and give them specific access to read/write permissions for sites and groups, as well as

customize other feature permissions.

New User

Usermname

Full Name:

Emai

Password:

Confirm Password:

Account Type:

S5H Permissions

Feature Permissions :

Service Monitoring

Sites and Groups:

Language:

Timeout (in mins):

Receive Event and Syslog Rule
email notifications:

Metwork Topology Layout

Layouts can be created from the
map

User
Caution: Allowing SSH access for a user may result in user access 1o devices outside
° of the control of the Vista Manager permissions for that user.
Read Only
Read/Write Read Only
Sites
site 1 O O
Groups

central Network
Masters Network
Router

sitel Network
site3 Network

Skynet

Auto Detect

5 minutes

L]

OO0O0O0aOgao

OO0O0O0aOgao

Cancel E
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Create an account

1. Log in with an Administrator account type and select User Management from the menu item.

2. Click the +Create New button in the upper right hand corner of the screen.

+ Create New

3. Inthe New User dialog boxes enter the relevant user details.

4. Click the Save button when complete.

Edit an existing account

1. Log in with an Administrator account type.

2. Select User Management from the menu item.

3. Select the account you want to edit from the account list.
4. Click the Edit button.

5. From the Edit User dialog box make the changes.

6. Click the Save button when complete.

Set the time-out for an account

1. Log in with an Administrator account type.

2. Select User Management from the menu item.

3. Select the account you want to edit from the account list.
4. Click the Edit button.

5. From the Timeout dialog box, select how long until a user is automatically logged out, or select
Never to disable automatic logout for that user.

6. Click the Save button when complete.
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Delete an existing account

1. Log in with an Administrator account type.

2. Select User Management from the menu item.

3. Select the account you want to delete from the account list.
4. Click the Delete button.

5. From the Delete User dialog box click the Delete button again.

Note: The default Admin (Manager) account cannot be deleted.

Event and Syslog Notifications

Event and syslog notifications are enabled by default for all users. This setting determines whether a
user will receive an email when a syslog matches a syslog rule configured with email notification.
Admin users can enable/disable email notification for all users.

As a non-admin user, you can change this setting only for yourself.

te.t
areal_read
Receive Event and Syslog Rule email
Area? read notifications:
g i B e S ke At .
Permissions

Service Monitoring Permissions

Service monitoring permissions can be changed to be user-specific. This affects what a user can
see on the Service Monitoring page. You can change permissions between Read Only, or Read/
Write.

Syslog Permissions

m  Only an admin user can view all syslog messages received from an IP address that Vista Manager
has not discovered in the network.

B Any device can send syslog messages. If the source IP address does not correspond with a Vista
device, only an admin user can view the message.

B Ausercan only view and search for syslog messages on the network or for a specific device they
have read/write access to.

B A user cannot edit or delete syslog messages.
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Sites and Groups Permissions

Groups that correspond to a network have a gray badge next to them.

As an administrator, you can edit both feature permissions and specific sites and groups
permissions from Read Only or Read/Write for each user.

In the event the user would like to restrict permissions to specific users for different sites or groups,
the permissions can be changed in the Sites and Groups menu. Groups corresponding to specific
networks have a gray badge next to their names.

From version 3.17.1 onwards, you can select all permissions for sites and groups when managing user
accounts from the User Management page.

To add read/write or read-only permissions for a user, click the Select All checkbox above the permission
type from the specified user’s predefined settings from the User Management page.

This enables you to immediately assign permissions for all sites and groups on your network, regardless of
size.

Service Monitoring Read only

Sites and Groups Read/Write  Read Only

nozomi-plugin Network

radius-users-radgate Network

Sites O ]
Test O (m}

Groups % O S
AR4050 Group (] & O
/AR4050S-master D \\\ D
areal Network O E‘
area3 Network (] o =
at-radgate-plugin Network 0O a
Default Group Network- a m}
forescout-plugin Network (] O
intune-plugin  Network O (m}

O ]
(m] ]

<

|

Setting the default network topology layout for all users

Administrators can select a map layout and set it as the global default map layout for all users.

To set the global default layout:
1. Select User Management from the menu.
2. Select your user, and click on the Edit button.

3. Inthe Global Default Network Topology section, click on the drop-down, and select the layout
to be the default.

Global Default Network MNone v ‘
Topology:
Assign default map S l}
topology layout. Layout2
Layout3

Default layout can be
assigned individually
PET USEr

Layouts can be created
from the map

LayoutA: Administrator Two
None

4. Click on the Save button.
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Setting the default network topology layout for a specific user

Administrators can also select a map layout and set it as the default map layout for a specific user.

To set the default layout for a specific user:

1. Select User Management from the menu.

2. Select the user whose default you want to set, and click on the Edit button.

3. Inthe Global Default Network Topology section, click on the drop-down, and select the layout
to be the default.

Default Network

Topology:

Assign default map
topology layout.

assigned individually
PET USEr

Layouts can be created
from the map

None

Layout

Layout2

Layout3

LayoutA: Administrator Two
None

4. Click on the Save button.

When a user logs in for the first time, the default map layout will be used. The default map layout will
also be included in the map layout drop-down list.
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System Management

Navigating the System Management menu

The Vista Manager EX system itself can be managed in the System Management menu. At a glance.
the menu contains the following features:

AVE Allied Telesis  vista manager x

System Management

About

Configuration

Network Configuration
Resource Management
Database Management
Licenses

Plugins

Optional Features

Vista Labs

Generating Tech Support Information

In the event that you encounter any issues, tech support information can be generated from the
System management menu on any page by clicking on the Tech Support button in the top left.

Tech Support
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You can to select different categories of information and logs which can be used by an Allied Telesis
Customer Support representative to help with any problems you may be experiencing and diagnose
any network problems.

Tech Support *

Select all

Plugin logs
Elasticsearch

Logstash

MongoDB dump files
PM2

Version file

Version change file
MongoDB logs
MongoDB Diagnostic Data
Server side config file
Versions of NodeJS processes
MongoDB information

Metwork connectivity information

You can click on the Download button to generate a Tech Support zip file. Clicking on this button
will download a zip file named vista_tech_support.zip with the information you have selected to
your local PC.

When the files are downloading, a bar above the Tech Support button will move to signify the
download is running.

Tech Support

If the Tech Support fails, Vista Manager will notify you in the bottom left with a notification. You can
retry the download.

You can contact technical support from the Contact page on the Allied Telesis website.

About

The About section shows key information about the current release of Vista Manager EX such as:
m Vista Manager EX version, build, serial number and base license expiry date.

Device GUI version and build.

Language information for events.

Default Map layout for all users.

About SMTP section
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About

Vista Manager EX

Version:

Build:

Serial Number:

Base License Expire:

Device GUI

Version:

Build:

Configuration

The Configuration page allows you to view and modify core system settings in Vista Manager, based
on Allied Telesis management functions. Use this page to manage communication, security, and
system integration settings.

This page includes options to:

B Set the event display language

m  Configure SMTP authentication

m  Enable HTTPS with a Certificate Signing Request (CSR)
B Assign the Vista Manager server IP address

m  Configure AMF system settings
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Event Language toggle

Administrators have the ability to change the event language.

System Management

About

Configuration Configuration

Network Configuration
Language
Resource Management
Event Language: English

Database Management

Licenses @

Go to System Management > Configuration and click Edit to change the Event Language.

®  When the event language has been updated, a confirmation will display.

o Event Language changed from English
to H<55. Initiating translation of past

events. If there are many events, this
may take several minutes to complete

Support for SMTP OAuth Configuration

From version 3.15.0 onwards, you can use OAuth as an SMTP authorization method by configuring
OAuth for SMTP.

OAuth allows Vista Manager to securely request permission to send emails on your behalf without
storing your password.

Support for SMTP OAuth is supported with the following email providers:
m  Google

®  Microsoft
Note: You must access Vista Manager from the same hostname as specified in your redirect URI
for security reasons. We recommend using the most public hostname of your Vista Manager

EX server or a DNS-allocated host address.
Your redirect URI must use HTTPS.
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How to configure OAuth with a Microsoft email address
You will need the following prior to setup:

®  an Azure subscription,

B a Microsoft Entra Subscription,

® and an Outlook Online subscription with at least 1 user set up.
Vista Manager will send emails from this account.

1. Access the Azure Portal

Access the Azure Portal from https://portal.azure.com/#home and log in using your Microsoft
Azure credentials.

2. Navigate to Microsoft Entra ID
Go to All Services > Identity > Microsoft Entra ID.

m Alternatively search for Microsoft Entra ID and move to step 3.

‘ Microsoft Entra ID 4 Microsoft Entra ID

" View

Description

Streamline identity management across
Microsoft Entra devices and services with
centralized administration and enhanced
security features.

3. Register a New Application
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Click Add > App Registration

= Microsoft Azure es, sen +

All services >

@ Home | Overview - i
S @ Manage tenants  [7] What's new [55 Preview features & Got feedback?

© Overview User

>
1pler, integrated experience for managing_all your Identity and Access Management needs. Try, the new Microsoft Entra admin cente|

I8 Preview features Group

Properties Recommendations Setup guides
X Diagnose and solve problems e ieation

> Manage
App )

> Monitoring

> Troubleshooting + Support Basic information

4. Register an Application in Azure

Fill out the Application registration form with the required details:

m  For Web Application Type select Single Tenant.

m Paste the redirect URI from Vista Manager.

This is auto-generated by Vista Manager in the Redirect URI form field.

Copy this from Vista Manager and paste it into the Redirect URI field in the Azure App Registra-
tion form. You can see how to get the Redirect URI from "Support for SMTP OAuth
Configuration" on page 322.

Click Register to complete this step.

Microsoft Azure £ Search resources, services, and docs (G+/) l T Copilot .I

Home > App registrations >

Register an application

* Name

The user-facing display name for this application (this can be changed later)

oauth-web v

Supported account types

Who can use this application or access this API?
(8) Accounts in this arganizational directory only (Home only - Single tenant)
(O Accounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant)

O Accounts in any organizational directory {Any Microsoft Entra ID tenant - Multitenant) and personal Microsoft
accounts (e.g. Skype, Xbox)

(O Personal Microsoft accounts only

Help me choose

Redirect URI (optional)

We'll return the authentication response to this URI after successfully authenticating the user. Providing this now is
optional and it can be changed later, but a value is required for most authentication scenarios,

Web ~ | [ eg. htipsit/example.com/auth %

Register an app you're working on here. Integrate gallery apps and other apps from outside your organization by adding from Enterprise applications.

5. Assign Email-Sending Permissions to Azure for Vista Manager
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Go to the API Permissions page (Manage > APl Permissions).

~ Manage

-5~ API permissions

Click Add a permission to add a new permission for Microsoft Graph:
m  Type - Delegated.

B Permission - Mail.Send.

Request APl permissions x

<Al APIs
& Microsoft Graph
" hetpsi/graphmicresoftcom/ Docs o7

What type of permissions does your application require?

Delegated permissions Application permissions
Your application needs to access the API as the signed-in user. Your application runs s 3 background service or daemen without a
signed-n user,

Select permissions expand all

2 mailsend %

Permission Admin consent required

¢ Mail (1)

MailSend ®
/]

Send mail as a user

Mail.Send.Shared ©

O No

Send mail on behalf of others

No

=

m Click Add permissions to add the permission and return to the APl Permissions page:
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Microsoft Azure P Search resources, services, and docs (G+/)

Home > App registrations > cauth-web

= oauth-web | API permissions %

o« ) Refresh | /7 Got feedback?

B Overview

& Quickstart
M\ Granting tenant-wide cansent may revake permissions that have already been granted tenant-wide for that application. Permissions that users have already granted on their own behalf are:
#7 Integration assistant

7 Diagnose and solve problems

@ The “Admin consent required” column shows the default value for an organization. However, user consent can be customized per permission, user, or app. This column may not reflect the v
~ Manage app will be used. Learn more

B2 Branding & properties

o Configured permissions
-:») Authentication (Preview)
Applications are authorized to call APls when they are granted permissions by users/admins as part of the consent process. The list of configured permissions should include

Certificates & secrets all the permissions the application needs. Learn more about permissions and cansent

11l Token configuration
Add a permission " G ent f
-~ APl permissions

AP1 / Permissions name Type Description Admin consent requ... Status
& Expose an AP
v Microsaft Graph (1)
App roles
Mail.send Delegated  Send mail as a user No @ Granted for Home
2 Owners

6. Complete Registration and Collect IDs from the Application Overview page.
m  Once you have added the permission, select Overview in the left-hand menu.
m  The Overview page will open, where you can find the Tenant ID and Client ID.
a. Copy the Client ID.

b. Copy the Tenant ID.

c. Click the 'Client Credentials' link and create a new Client Secret.

m  Copy the Client Secret.

Allservices > Home | Overview >

H vista-oauth-connection =

0 Eearch s« li] Delete @ Endpoints Preview features

H overview
A Essentials

&5 Quickstart
Display name : vista-oauth-connection 0 Client credentials : Add a certificate or secret )
7" Integration assistant
‘Application (client) ID ) Redirect URls : Qweb,
X Diagnose and solve problems Object ID Application ID URI plication ID URI
' Manage Directory (tenant) ID < ) Managed application in ... : vista-oauth-connection
9 Branding & properties Supported account types : My organization only
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7. Set up the OAuth in Vista Manager:
m  Go to the System Management > Configuration page.
m  Scroll down to the SMTP settings and click Edit.
B Under the SMTP Auth Method, select the OAuth tab.

m  Select from Microsoft as a provider and enter the previously copied Client ID, Tenant ID, and
Client Secret.

SMTP

@ Note that the 'Send mail as' option may be ignored and the email associated with the SMTP provider may be chosen
by some SMTP providers.

SMTP Auth Method: (D)

Basic Auth OAuth

OAuth Provider:

Google Microsoft

OAuth Client ID: *

OAuth Redirect URI: *

(n]

Microsoft Azure Tenant ID: *

Send mail as: *

vista@alliedtelesistest.com

Connect The connection status with the provider cannot be verified. Reconnect to update your SMTP settings

Cancel

8. Connect your Microsoft Entra account with Vista Manager:

m Click Connect and Save to go to the Microsoft landing page.
m  Sign in with your Microsoft Entra credentials, and you will be sent back to Vista Manager.
B You will see a Green Tick when the connection is successful.

m |[f verification takes longer than 30 seconds a warning message is shown.

How to configure OAuth with a Google email address

You will need the following prior to setup:
® a Google Workspace account.

B access to the Google Cloud Platform.
1. Access the Google Cloud platform.

Navigate to https://console.cloud.google.com/ and log in using your Google account creden-
tials.
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2. Create a new OAuth project:

m  Click on the Project button in the top navigation bar.

= Go gle Cloud e® myProj ‘ ‘

m  Select New Project.

Select a project E3 New project

Q_ Search projects and folders

Recent Starred All
Name Type 1D
¢ Example @ Project example-482100 Y

® Enter a name (such as myProj) for your project and click Create.

New Project

- Project name *

‘ myProj ® ‘

Project ID: myproj-483320. It cannot be changed later. Edit

~ Location *
‘ 1 No organization Browse ‘

Parent organization or folder
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B You will arrive at the Project’s dashboard.
m [n the top right of the window, click the Notification Bell icon.

B You should see the newly created Project notification.
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m  Click Select Project to go directly to this project.

= Google Cloud [ 2 TestAgain ] [ Search (/) for resources, docs, products, and more ‘ Qsearch ] 4+ = @ @ : o
Dashboard Activity Recommendations Notifications #' Customize
@ Create Project: myProj Just now
&® Project info H API APls H & Goog

3. Configure OAuth Consent Screen:

m  Navigate to the overview page of your new Project.

® Click on Go to API's overview.

—> Goto APIs overview

B In the left menu, select OAuth consent screen.

i OAuth consent screen '
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m  The Google Auth Overview page opens. Click the Get started button.

) Google Auth Platform / Overview

E  Overview OAuth Overview
@  Branding
@  Audience

Clients /\

o Data Access

8]

Verification Center

~Ne oo
£ Settings

Google Auth Platform not configured yet
Get started to configure your application's identity and manage credentials
for calling Google APIs and Sign in with Google. Learn more (2

Get started
<l

Now configure your application:

m  We recommend selecting Internal as Google Workspaces will restrict access to ‘send emails
as’ to emails within your organization.

We do not recommend choosing External because with an unpublished External app, refresh
tokens expire after 7 days. This means you have to intervene manually to authenticate the
device every 7 days, which is not recommended for autonomous email alerts.

m  Fill in the required fields (App name, User support email, Developer contact information).

= Google Cloud

8= example-project ‘ Search (/) for resources, docs, products, and more ‘ Q search ‘ + 3 = ‘
9 Google Auth Platform / Overview / Create branding
E Overview Project configuration
€3  Branding

9 Audience

© App Information
Clients ~ App name *
VistaOAuthApp ‘

St Data Access

The name of the app asking for consent

User support email *
{ M l

For users to contact you with questions about their consent. Learn more (4

Verification Center

=

® Audience
I

© Contact Information
I

@ Finish

Create Cancel

m Click Create and continue.
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4. Create OAuth Client ID Credentials:

®  From the OAuth Overview page, click Create OAuth Client.

Create OAuth client

® In the Authorized redirect URIs section, add the redirect URI provided by Vista Manager.
= Google Cloud

%* example-project l [ Search (/) for resources, docs, products, and more

g Google Auth Platform / Clients / Create client

El  Overview 4 Create OAuth client ID
€ Branding

A client ID is used to identify a single app to Google's OAuth servers. If your app
@ Audience

runs on multiple platforms, each will need its own client ID. See Setting up OAuth

Clients 2.012 for more information. Learn more [2 about OAuth client types.

B type *
Su  Data Access (Weh application h I

@ Verification Center Name *

{ vistaOAuthClient I

The name of your OAuth 2.0 client. This name is only used to identify the client in the
console and will not be shown to end users.

o The domains of the URIs you add below will be automatically added
to your OAuth consent screen as authorized domains 2.

Authorized JavaScript origins &

For use with requests from a browser

+ Add URI

Authorized redirect URIs @

For use with requests from a web server

URIs1*
[ https://vista-example.mydomain.org|

+ Add URI

Note: It may take 5 minutes to a few hours for settings to take effect

m Click Create.

m After creating the credentials, copy the Client ID by clicking the copy icon.
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m  Click on the name of the new Client ID to go to the Client ID for Web application page.

vistaDAuthClient

m  Copy the Client Secret displayed on the screen in the bottom right.

= GoogleCloud | i+ exampleproject | [ seareh () for resources, docs, prodcts, and more [ Qsearen | + T DO
@ Google / Clients / CI
B Overview 4 Client ID for Web application W Delete
©  Branding
() [ — Additional information
@ [Mmdlm
S 7 Client 1D - -
S Data Access ‘cansole and will nat be shown 1o end users.
-—
£ Conesy Ci July 28, 2025 at 4:37:28 PM GMT+12
o your OAuth consent screen s authorized domains @. Last used date. July 27, 2025 (Note: this data could be delayed by
a day or more.)
Authorized JavaScript origins @ o
For use with requests from a browser ° months.
Client secrets
If you are in the process of changing client secrets, you can manually rotate them
without downtime. Learn more 2
Authorized redirect URIs @
For use with requests from a web server Client secret
*
['“""“ Creation date July 28, 2025 at 4:37:28 PM GMT+12
https://vista-example.mydomain.org
Status © Enabled
+ Add secret
Note: It may take 5 minutes to a few hours for settings to take effect
[
5. Set up the OAuth in Vista Manager:
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m  Go to the System Management > Configuration page.
m  Scroll down to the SMTP settings and click Edit.
B Under the SMTP Auth Method, select the OAuth tab.

B Select from Google as a provider and enter the previously copied OAuth Client ID and OAuth
Client Secret.

m  Enter the email account you would like to send emails as.
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® Click Connect and Save.

SMTP
SMTP Auth Method: (i)
Basic Auth 0OAuth

OAuth Provider:

Google  Microsoft

OAuth Redirect URI (Auto Generated): *

https://example-vista.mydomain com/apifoauth/smtp/google |

OAuth Client ID: *

<client-id>

OAuth Client Secret:

<client-secret>

Send mail as: *

<mygmailaccount@gmail.com=

Cancel Connect And Save

m |[f verification takes longer than 30 seconds a warning message is shown.
6. Connect your Google account with Vista Manager:
m Click Connect and Save to go to the Google landing page.
m  Sign in with your Google account, and you will be sent back to Vista Manager.

B You will see a Green Tick when the connection is successful.

HTTPS access to Vista Manager EX

All traffic between Vista Manager EX and users is able to be secured with HTTPS. This option can be
turned on in your Vista Manager EX configuration settings. Enabling HTTPS requires a signed
certificate.

Vista Manager EX can generate a Certificate Signing Request (CSR) which you can then submit to a
Certificate Authority (CA). The CA will then give you a signed certificate which you can import back
into Vista Manager EX. Note that both the application's and CA's private key are never transmitted;
this is essential to maintaining proper security.

Alternatively, you can use OpenSSL to self-sign the CSR. For more information, visit
https://www.openssl.org/.

Note: Only certificates generated from Vista Manager’s CSR can be uploaded into Vista Manager.
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To enable HTTPS:

1. Go to System Management > Configuration.

2. Click on Create CSR.

System Management

About

Configuration

Network Configuration
Resource Management
Database Management
Licenses

Plugins

Optional Features

Vista Labs

Tech Support

HTTPS

@ Toenable HTTPS, you will need to generate a Certificate Signing Request in Vista Manager, arrange for it to
be signed by your local Certificate Authority, then upload the resulting certificate into Vista Manager.

If your organization does not have a Certificate Authority, you can self-sign the Certificate Signing Request

yourself. Please consult the Vista Manager documentation for details.
| createhcsﬂ |

Server Configuration

Vista Manager Server IP 10.37.179.21

AMF System Configuration

Maximum Concurrent Nodes 100

m  Make sure the primary domain name and email are correct. You can also add other domain names

if required.

m  Once the CSR has been generated, save it somewhere safe. Send this CSR to your CA to be

signed.

HTTPS

Common Name: The primary domain name of Vista Manager

Country:

State / Province / Region:

City / Town / Locality:

Organization:

Organizational Unit:

Email

example@example.com

Subject Alternative Names: Other domain names that Vista Manager is accessible from

Cancel NeEEEC o]

m  Once the CA has returned to you with a certificate, click the Generate CSR button.
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Then upload the certificate to Vista Manager.
You can also optionally upload a certificate chain.

m  Click on Verify and Enable.

Once your certificate has been verified, HTTPS will be enabled.

HTTPS

@ To enable HTTPS, please upload a certificate and optionally a certificate chain. This certificate must correspond to
the previously generated Certificate Signing Request.

Certificate: Accepted extensions .crt, .pem

Mo file selected Select file

Certificate Chain: Accepted extensions .crt, .pem

Mo file selected Select file

Discard CSR

Once you have configured HTTPS for Vista Manager, you access it using the default SSL port. To
connect via HTTPS, use either of the following URLSs:

m  https://<ip address>

m https://<ip address>:443

Changing the AMF system configuration settings

You may need to change the AMF system configuration settings in Vista Manager EX. This was
previously done by a support engineer onsite to resolve various network errors that involved
changing variables in the configuration file. An event log will be generated after you have applied the
new values.

To change these settings:
1. Navigate to the System Management menu item.
2. Select the Configuration tab.

3. Under AMF System Configuration, click on the Edit button.

Click Save when complete.
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Note: No restarting is required.

Vista Labs
AMF System Configuration
Maximum Concurrent Nodes 100
AMPF Request Timeout (ms) 10000
Task Running Timeout (ms) 60000
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Network Configuration

The Network Configuration section shows the Network Display Name and AMF Network
Configuration settings. You are able to edit the network display name and AMF Network
Configuration details from this page.

Network Configuration

About Network

Network Display Name: docnet

AMF Network Configuration

Network Name: docnet
Network IP:

Username:

Password:

Use certificates (recommended):

Use password if certificate fails:

Changing the Vista Manager EX controller IP address

You may need to change the IP address of the Vista Manager EX controller in Vista Manager EX. For
example, if the IP address of the controller has changed, this also needs to be changed in Vista
Manager EX. To change the IP address:

1. Click on System Management, and select the Network Configuration tab.
2. Under AMF Network Configuration, click on the Edit button.

3. Click on the Change controller address button. Once you have confirmed that the changed IP
address belongs to a device with the same MAC address as the current controller, click on the
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Configure button.

Change controller address
A Warning
You will be required to upload a valid VISTA base license.

The changed IP address must belong to a device with same MAC address as the current
controller. Proceed?

4. The Upload Licence File dialog will then be displayed. Select your license file, and click Next.

5. The Set Up Your Network dialog will then be displayed. You can change the IP address to the
new address. Click Next.

Note: The changed IP address must belong to a device with the same MAC address as the current

controller.
6. The Set Up Your SMTP settings dialog will then be displayed. Click Proceed.

Note: This does not provide a method to change your controller to a new network. That requires a

reinitialization of Vista Manager EX.
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Resource Management

From the Resource Management page, you can see information about your system storage and
specifications. From this page, you can manage what features are running and the amount of
resources to use from the environment given (RAM/disk space/CPU). You can also match the
resources to feature requirements and vice versa. This allows you to maximize network functionality.

Resource Management

Overview

0s linux
CPU 4vCPU
Max RAM 7.77GB
Free RAM 3.93GB
Max Storage 195.8 GB
Free Storage 184.49 GB
Vista Manager Feature Storage 19.41 MB

Excludes external plugins

Expand all
@ System 11.16 MB
@® Device Configuration 116 KB
A Tronloow A TA KB

Database Management: Backup and Restore

The Database Management page displays the Backup, Initialize, and Restore settings.

Database Management

Backup

Backing up will save a copy of the Vista Manager EX database of user, system, and network information.
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Initialize
Warning

Initializing Vista Manager EX will reset it to factory defaults, and all Vista database information will be lost. It is recommended that a
Backup is performed prior to Initialization.

Initialize

Restore

Restore will load a backup of the Vista Manager EX database of user, system, and network information.

To backup your Vista Manager database, follow these steps:
1. Navigate to the System Management menu item.

2. Then go to the Database Management tab.

3. Click on the Backup button in the Backup pane.

4. Click Backup again to confirm you wish to make a backup.

System Management

About
Database Management

Configuration

Backup

Network Configuration

Backing up will save a copy of the Vista Manager EX database of user, system, and network

Resource Management information.

Database Management e

Plugins

Licenses

This automatically downloads a tar file backup to your default download location.
Keep this tar file in a safe location.

Note: Restoring Vista Manager backups from a newer version into an older version is not

supported. It is not possible, for example, to restore a backup made in Vista Manager 3.8.0

into a Vista Manager 3.9.0 installation.
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Licenses

The Licenses page shows various licenses running on Vista Manager EX. You can update licenses
from this menu. Note that this is different from device-specific licenses. For information on
managing device-specific licenses see "Asset Management" on page 148.

Licenses

'90 day trial' license started on 30 July Update Licenses

2023 2024
lay Jun Jul Alg Sep Oct Nov Dec Jan Feb Mar Apr
Vista Manager EX Vista Manager EX Base Licens
Allied Intent-based Orchestrator Allied Intent-based Orchestratc
AWC Plugin AYVC Plugin - Access Points Lit
AWC Smart Connect AWC Smart Connect - Access
AWC Channel Blanket AWC Channel Blanket - Access
SNMP Plugin SNMP Plugin License

AMF Licenses

0 AMF Plus functionality is only available when all AMF Controllers and Masters in the network have an active AMF Plus license without any active AMF licenses, or the AMF
licenses have been negated by enabling AMF Plus Forced.

Changing these values will save the current running configuration to the device.

SNMP is licensed via AMF Plus but not registered. Reinstall the Vista Manager EX software, including the SNMP plugin if necessary

Device Name AMF Plus Forced

AR4050S-master M A\ Device has no active AMF license(s). No need to force AMF Plus.

vaa-controller C A\ Device has no active AMF license(s). No need to force AMF Plus.

x530l-master M A\ Device has no active AMF license(s). No need to force AMF Plus.

x930-master M A\ Device has no active AMF license(s). No need to force AMF Plus.
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Plugins

The Plugins section shows Vista Manager’s certificate fingerprints (SHA1 and SHA256) and installed
plugins on your network.

Plugins

Vista Manager's Certificate Fingerprints

SHAT

SHA256

Plugins

AWC Plug-in

Regenerate Certificate

+ Add Plugin

You can regenerate certificate fingerprints by clicking Regenerate Certificate. You can also register
plugins from a server URL by clicking + Add Plugin.

To see how to configure plugins, see "Registering/Installing plugins" on page 28.

Optional Features

From the Optional Features tab, you can enable randomized MAC Addresses to be recorded from
the Endpoints table, and can turn features on and off from the System Management page.

When you restore a backup, any features that were enabled at the time of the backup will remain
enabled when you restore that backup.

AP Settings

AWC Settings
MAC Address List
IDS/IPS Settings

Wireless Concierge

Wireless Maintenance

Firmware Reglsﬂatmn
Task Scheduling

Emergency Mode

Device Search
Vista Appliance Storage

System Setting

Bookmarks
@ User Guide: Vista Manager EX
@ Vista Manager Tech Docs

@ Vista Manager Release Notes

User Management

System Management
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System Management

About

Configuration Optional Features

Network Configuration
A Enabling these features may have a performance and/or storage impact on Vista Manager EX.

Resource Management

Database Management
Licenses Record Randomized MAC Addresses (O Enabled @G
. Display devices with randomized MAC addresses such as mabile phones in Network Map and
Plugins Asset Management.
Optional Features A Enabling this option may significantly increase the number of devices in the network
topology and on the Network Map, which may impact system performance.
Vista Labs

Convert Syslog Security Messages Enabled Q

Convert syslog security messages from third party applications into dismissable alarms/events
an the event log

AT-RADgate ®© Enabled @S

ATRADgate provides Authentication Services that comply with the IETF RADIUS standard. It is deployed on a
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Recording Randomized MAC Addresses

You can enable or disable the Record Randomized MAC Addresses feature by toggling the feature
on the Optional Features section of the Configuration page. This feature is disabled by default.

Optional Features

Record Randomized MAC Addresses (D Enabled %

Display devices with randomized MAC addresses such as mobile phones in Network Map.

This feature will increase the number of visible devices in the Network Map and may reduce
performance.

If you enable the Record Randomized MAC Addresses feature, and later decide there are now too
many endpoints on the Network Map and Asset Management pages, you can remove the endpoints
by disabling the Record Randomized MAC Addresses feature.

Note: It may take several minutes for this change to appear. When you disable the Record
Randomized MAC Addresses feature, the previously collected information will be removed
from the Offline Device table.

Security notes about Randomised MAC address filtering

If you allow a device with randomised MAC addressing enabled, when a device connects to the
network, it will experience a loss of connection as soon as the MAC address changes.

If you enable Random MAC Filtering for Offline Devices in Asset Management, the device’s MAC
address will not be listed and no history of it's connection will be stored.

Alternatively, if the user has spoofed a randomized MAC address and gained connection to the
network, they will remain connected while the MAC address is static.

If Random MAC filtering is enabled for Offline Devices in Asset Management and the spoofed MAC
device disconnects from the network, Vista Manager will not list the device MAC address after it
disconnects.

We recommend you create a controlled access environment such as a VLAN quarantine or guest
separation to prevent issues with randomized MAC addresses and spoofing.
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HCNET integration support

From version 3.17.1 onwards, Vista Manager EX can integrate with HCNET servers to manage RADIUS

authentication for network devices.

To enable HCNET external RADIUS support:

1.

Go to Optional Features and toggle to enable HCNET.

B Onceenabled, the selectable Server Type ‘'HCNET will appear in the Server List on the RADIUS page,
and the Network Map page when you add it as an External Server.

Go to the Network Services > RADIUS page and click + Add External Server.

Add a custom server entry for HCNET by clicking the HCNET tab and entering the credentials from your
HCNET Account@Adapter instance.

Note that you cannot enable or disable the external RADIUS server from the Network map.

+ Add External Server

g

Using HCNET
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As an Admin user, you can enter the HCNET IP address, APl key, and management port number.
You can view, add, edit, or delete RADIUS users from HCNET from the RADIUS feature page.
You can block or allow endpoints from the Endpoints table.

If you delete the RADIUS server from Vista Manager, the external server will still function, but it will no
longer communicate with Vista Manager unless re-added.

Vista Manager synchronizes with the HCNET server every 5 minutes.

You can include HCNET as a member in a Vista Manager RADIUS Server group. Note that Vista Manager's
RADIUS NAS or Group functions are not supported by HCNET.
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New events added for this integration are as follows:

Severity Title Message

NOTICE Optional Feature Enabled  Successfully Enabled HCNET

NOTICE Optional Feature Disabled  Successfully Disabled HCNET
INFORMATION  HCNET Server Deleted Successfully deleted the HCNET server: {ip}
INFORMATION HCNET Server Added Successfully added the HCNET server: {ip}

Requirements

Vista Manager is compatible with HCNET servers running Account@Adapter ver. 7.02.00 or later. This
feature requires a NAS device and a RADIUS server.

A shared secret must be configured on the NAS device. This secret is used to authenticate
communication between the NAS and the RADIUS server.

The NAS should be provisioned and managed by the HCNET server to ensure consistent RADIUS and
MAC authentication behavior.

When PAP or CHAP is enabled for MAC authentication, the HCNET server RADIUS settings must be
configured to ignore the MAC address delimiter.

B This is because Alliedware Plus NAS devices use the delimited MAC address format (e.g. Xx-XX-XX-Xx-
xx-xX) as both the username and the password during authentication, while HCNET stores MAC-auth
terminal accounts without delimiters. Without ignoring the delimiter, the RADIUS server would not

be able to match incoming authentication requests to existing users.

To ensure successful authentication with NAS devices that send the MAC address with delimiters as the
password, Vista Manager explicitly configures the optional password of MAC-auth terminal accounts to

the delimited MAC address using the optional APl parameters.

Saving memory by disabling features

Disabling features can reduce the amount of memory Vista Manager uses.

Features you can turn on or off include AT-RADgate, Advanced Monitoring, Bookmarks, and the
Vista Manager EX API access.
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AT-RADgate Disabled (@)

AT-RADgate provides Authentication Services that comply with the IETF RADIUS standard. It is deployed ona
container instance of the ACP system. You can add external AT-RADgate servers from the Radius feature page

A This feature may impact system performance. Disabling the feature will stop Vista Manager from communicating
with any added AT-RADgate servers while the servers will continue to operate.

Advanced Monitoring (0 Disabled (g

Visualize data sourced from third-party monitering agents in Health Monitoring dashboards. Advanced monitoring
must also be enabled per device via the map or Asset Management. - View advanced configuration guide.

A\ This feature may impact system performance. Each device with Advanced Monitoring enabled will increase the
systenn's storage requirements and the time required for data retrieval.

Bookmarks Disabled (g
Display external links in the main menu.

Vista Manager EX APl (D) Disabled (g
Access Vista Manager EX content in external applications

A Regenerating the token will invalidate the current token

Bookmarks

From version 3.14.0 onwards, you can add bookmarks to the side menu. You can bookmark IP

Addresses or other URLs for quick access.

Bookmarks

@ User Guide: Vista Manager EX

@ Vista Manager Tech Docs

@ Vista Manager Release Notes

For example, you may want to bookmark this user guide so you can access it directly from Vista

Manager. To do this:

1. Toggle Bookmarks on from the System Management > Optional Features page.
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2. Click + Add Bookmark.

Bookmarks Enabled @I

Display external links in the main menu.

No Bookmarks yet

+ Add Boo@ark

3. Enter a name for the bookmark.

4. Then enter its URL, which is ‘https://www.alliedtelesis.com/configure/vista-manager-ex-user-
guide’.

Add Bookmark

© You are adding a bookmark to an external URL outside of Vista Manager's controlled
environment. This may pose potential security risks if the destination is not from a verified and
trusted source.

Name
User Guide: Vista Manager EX

Max 64 characters

URL

https:/fwww.alliedtelesis.com/configure/vista-manager-ex-user-guide

Visible To

AllUsers  Admin Only

cancel E

5. Click Save. The new bookmark will be added to the list.

6. If you have multiple bookmarks, you can rearrange them by dragging them from the drag icon on
the left.

Bookmarks Enabled @)

Display external links in the main menu.

User Guide: Vista Manager EX

https:/fwww._alliedtelesis.com/configure/vista-manager-ex-user-guide u 4
Vista Manager Tech Docs & 7
https:/fwww._alliedtelesis.com/documents,/vista-ex-tech-docs
Vista Manager Release Notes ==

S i o/

G% https:/fwww._alliedtelesis.com/documents/vista-manager-ex-release-note

+ Add Bookmark

If you scroll down on the left-hand side, your bookmarks will appear under the Bookmarks tab.
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Bookmarks

@ User Guide: Vista Manager EX

@ Vista Manager Tech Docs
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@ Al Network Assistant

From version 3.17.1 onwards, you can access our Al Network Assistant within Vista Manager to
receive assistance.

The Al Network Assistant is a conversational interface within Vista Manager that helps users manage
their network more easily. It can assist with checking network information, providing guidance on
configuration and features, answering questions about Allied Telesis products, summarizing recent
network events, and supporting selected Al-assisted workflows.

Available Features

m  Network Visibility - Check firmware-manageable devices and network information using natural
language.

m  Event Summarization - Summarize recent network events to help identify issues more quickly.
(Advanced Al License required).

m  Firmware Upgrades - Assist with checking firmware files and upgrading devices.
(Advanced Al License required).

m Configuration Guidance - Get step-by-step configuration guidance and ready-to-run
commands for your devices.

B Product Information - Ask questions about Allied Telesis products and features.

m  Networking Knowledge - Get explanations of networking concepts in natural language.

Note: Some responses may include source links to relevant documents. Use these links to review
the referenced material or confirm the answer in more detail.

How to enable the Al Network Assistant
You can enable the Al Network Assistant from System Management > Optional Features.

B When you first see the widget, the Enable/Disable toggle will be greyed out.

® To enable the Al assistant, you must first read the Terms of Service under the widget before you
can Enable the feature. Once accepted, you can enable the feature.

m  After you enable the Al assistant, click the new icon in the top right corner to start a chat.
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€ manager ~ @

Note that in earlier versions of Vista Manager, you can access the Al Network Assistant from the
Vista Labs section.

License Details

You can chat with the Al Network Assistant without a license. However, some advanced features
require an Advanced Al License. These include:

B Event Summarization

®  Firmware Upgrades

These licensed features extend the Al Network Assistant with additional workflow support for
reviewing recent event activity and performing firmware upgrade tasks.

To obtain an Advanced Al License, contact your Allied Telesis support representative.

Checking network information

You can use the Al Network Assistant to check current network information of firmware manageable
devices. Use natural language to ask questions related to your network.

For example, you can ask the assistant to check firmware across your network. If your devices are
organized into sites, the results are grouped by Site to make them easier to review. This can help
users quickly understand what is on their network, especially in larger environments or where
manual inventory checks would otherwise take significant time.

Sample prompts include:
m  “Give me the list of firmware-manageable devices on my network”

m  “What firmware are the devices running?”
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Al Network Assistant New Chat X
What firmware are devices running?

Al Networl

Assistant

Here is the firmware information for your devices:
Area-1:

= Device: CHCH_HR_3050-R1
« Model: AR30505
« Firmware Version: 5.5.6-0.2

« Device: CHCH_IT_x930VCS-SW2
+ Model: ATx930-52GTX
« Firmware Version: 5.5.6-0.2

Area-2:

= Device: AKL_HR_3050-R20
« Model: AR30505
« Firmware Version: 5.5.6-0.2

= Device: AKL_IT_3050-R21
+ Model: AR3050S
« Firmware Version: 5.5.6-0.2

* Device: sw11-TQ6702_GENZ-R
« Model: AT-TO6702 GEN2-R
« Firmware Version: 5.5.6-0.2

= Device: MY_Device
+ Model: ATGS230MX/10HSmM
« Firmware Version: 5.5.6-0.2

Summarizing Recent Events

You can ask the Al Network Assistant to summarize recent network events. The assistant presents a
summary of events together with their time of occurrence, helping users identify recent critical
issues more quickly and reducing the effort required to review event activity manually. This feature is
especially useful for teams that want faster visibility into important recent network activity.

Sample prompts include:
m  “What are the key takeaways from my recent events?”

B “Summarize my recent events”
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Critical events over the last 3 days

Al Network Assistant
Here is a summary of the critical events from the last 3
days:

1. Tunnel Destination Misconfigured

* Node: AKL_HR_3050-R20

= Time: May 4, 2026, 2:39 PM

= Message: Tunnel tunnel2 with source on Area-2,
AKL_HR_3050-R20 cannot be learnt due to a
duplicate IP of 192.168.1.1 occurring on devices in
multiple areas.

2. Feature State Change

= Time: May 4, 2026, 1:59 PM
= Message: The Feature AMF Plus is now Enabled

3. Tunnel Destination Misconfigured

= Node: AKL_HR_3050-R20
= Time: May 4, 2026, 1:59 PM

= Message: Duplicate IP issue similar to the first
event.

Upgrading Firmware

You can request the Al Network Assistant to upgrade firmware for devices on your network.

You can ask the assistant to check current firmware files and distribute firmware files to devices on
your network from the AMF Master device. This helps simplify firmware upgrade workflows while
keeping you in control of the process. The assistant helps reduce the effort involved in planning and
initiating upgrades, while confirmation steps allow you to verify the changes before being applied.

Sample prompts include:
m  “Upgrade the firmware on <device>"

m  “Upgrade the firmware on <device> to <firmware_version>”

To upgrade firmware:

1. Upload firmware files to your AMF master device.
This feature requires the firmware files are on the AMF Master device for the area you're looking
to upgrade devices in.

2. Click on the Al Network Assistant icon from the top right of the screen.

€ manager ~

3. Ask the assistant to upgrade firmware on the network from the AMF master device.
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Upgrade the firmware on WLG_HR_4050-R30

Al Network Assistant
The available firmware files for the "AR4050S" model in
"Area-3" are as follows:

« AR4050S-5.5.1-1.3.rel
* AR40505-5.5.4-0.3a.rel
+ AR40505-5.5.5-0.4.rel
+ AR4050S-5.5.5-0.5.rel

Please let me know which firmware file you would like to

use for the upgrade.

Ask me anything

S

on't have an answer, I'll let you know. Your feedback
se. Check

I'm still learning
helps me improve.
important info

ponses may be inaccurate or

4. Review the files identified by the assistant and confirm that they are correct before proceeding.
5. If there are multiple files detected, select the file you would like to use.

6. Reply with the firmware file you’d like to upgrade to.

Al Network Assistant New Chat x

“Area-3" are as follows

« AR4050S-5.5.1-1.3.rel
« AR40505-5.5.4-0.3a.rel
= AR40508-5.5.5-0.4.rel
« AR40508-5.5.5-0.5.rel

Please let me know which firmware file you would like to
use for the upgrade.
1y &0
AR40505-5.5.5-0.5.rel
Al Network Assistant
Great choice! | will now proceed with upgrading the

firmware on the device "WLG_HR_4050-R30" to version
AR40505-5.5.5-0.5.rel. Please hold on for a moment.

Em o

lask me anything

4

I'm still learning. If | don't have an answer, I'll let you know. Your feedback
helps me improve. Responses may be inaccurate or false. Check
impertant info.
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7. Click Confirm to proceed with the upgrade.

Al Network Assistant

Great choice! | will now proceed with upgrading the
firmware on the device "WLG_HR_4050-R30" to version
AR40505-5.5.5-0.5.rel. Please hold on for a moment.

Action confirmed. Processing...

Ask me anything

Your feedback
se. Check

I'm still learning. If | don't have an answer, I'll let y«
helps me improve. Responses may be inaccurate or
important info

8. The assistant confirms when the task has been completed.

Al Network Assistant New Chat x

AR40508-5.5.5-0.5.rel

Al Network Assistant

Great choice! | will now proceed with upgrading the
firmware on the device "WLG_HR_4050-R30" fo version
AR40508-5.5.5-0.5.rel. Please hold on for a moment.

Action confirmed. Processing...

Al Network Assistant

The firmware upgrade on the device "WLG_HR_4050-R30"
to version AR4050S-5.5.5-0.5.rel was successful. The
pre-check confirmed the device was ready for the release,
and the distribution was completed. Please remember to
reboot the device for the upgrade to take full effect. If
you need further assistance, feel free to ask!

i 5P
Ask me anything
o~
I'm =till learning. If | don't have an answer, Il let you know. Your feedback
helps me improve. Responses may be inaccurate or false Check

important info.

9. Reboot the device outside of the Al Network Assistant from the CLI or Device GUI.
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Configuration Guidance

You can use the Al Network Assistant to get step-by-step configuration guidance and generate
ready-to-run commands for devices. This can help reduce the time spent searching through

documentation and simplify common configuration tasks.

Sample prompts include:

m  "What commands would | need to configure the firewall on <device>"

m  Give me a configuration for a guest vlan on a <device>"

What commands would | need to put in a configuration file to
enable a firewall on an AR40508?

Al Network Assistant

To enable a firewall on an AR4050S, you can use the following
configuration commands. These commands will set up a
basic firewall configuration:

configure terminal
firewall enable
firewall policy create name “MyFirewallPolicy"

firewall policy "MyFirewallPolicy™ rule create name
"AllowHTTP" action permit

firewall policy "MyFirewallPolicy™ rule “AllowHTTP"
match protocol tcp destination-port 88

firewall policy "MyFirewallPolicy™ rule create name
"AllowHTTPS" action permit
match protocol tcp destination-port 443

firewall policy "MyFirewallPolicy™ rule create
name "DenyAll” action deny

firewall policy "MyFirewallPolicy" apply

exit

This configuration enables the firewall, creates a policy named
"MyFirewallPolicy”, and adds rules to allow HTTP and HTTPS
traffic while denying all other traffic. Adjust the rules according
to your specific requirements.

Ask me anything

/r

I'm still learning. If | don't have an answer, I'll let you know. Your feedback
helps me improve. Responses may be inaccurate or false. Check

firewall policy "MyFirewallPolicy™ rule “AllowHTTPS™

What configuration would | need to add to a device for a guest
vlan?

Al Network Assistant

To configure a guest VLAN on a device, you can use the
following configuration commands. This example
assumes you want to create a VLAN with ID 100 for guest
access:

configure terminal

vlan database

vlan 122 name Guest_VLAN
exit

interface vlan 10@

ip address 192.168.180.1 255.255.255.0
exit

interface [interface_name]
switchport mode access
switchport access vlan 10
exit

Steps Explained:

1. Create VLAN: Enter VLAN configuration mode and
create VLAN 100 named "Guest_VLAN".

2. Assign IP Address: Assign an IP address to the VLAN
interface for routing purposes.

3. Configure Interface: Set the desired interface to access
maode and assign it to VLAN 100.

Replace [interface_name] with the actual interface you
want to configure. Adjust the IP address and subnet mask
according to your network requirements.

|ask me anything

Product Information

You can ask the Al Network Assistant questions about Allied Telesis products and features.

The assistant can provide product information and help users understand which products,

capabilities, or options are relevant to their needs. This can help users find product information more

quickly without manually reviewing documentation.
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Sample prompts include:
m  "Tell me about <product>"

m  "Can | provision devices with Vista Manager?"

Can | provision devices with Vista Manager?

Al Network Assistant

Yes, you can provision devices using Vista Manager. Vista
Manager provides a comprehensive set of tools to
manage and configure devices within your network. 1t
allows you to add, configure, and monitor devices
efficiently. If you need detailed steps or specific

configurations, please let me know!

Networking Knowledge

You can use the Al Network Assistant to ask questions about networking concepts. The assistant
can explain networking terminology, protocols, and features in a clear and practical way, helping
users understand concepts more quickly while they work. This can be useful when learning new
features or reviewing unfamiliar networking topics.

Sample prompts include:
® "Whatis L2TP?"

B "What does this command do - 'mac address-table thrash-limit 100'?"
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What is LT2P? What does this command do ‘mac address-table thrash-limit
1007

Al Network Assistant
L2TF, or Layer 2 Tunneling Protocol, is a protocol used to Al Network Assistant

support virtual private networks (VPNs) or as part of the The command mac address-table thrash-limit 188
delivery of services by ISPs. It allows for the tunneling of
PPP (Point-to-Paint Protocol) traffic over IP networks.
Specifically, the AR-Series firewalls from Allied Telesis
support L2TPv2, which can operate in two types of
tunnels: LAC-LNS tunnels and peer-to-peer tunnels.

is used to configure thrash limiting on a network switch.
Thrash limiting helps to detect and mitigate network loops
by monitering rapid changes in MAC address table
entries.

Specifically, this command sets the thrash limit to 100,
which means that if a MAC address moves between ports
more than 100 times within a certain period, the switch
will take a predefined action to address the potential loop.

LAC-LNS tunnels involve a LAC (L2TP Access
Concentrator) that tunnels PPP sessions from client
PPPoE connections to remote L2TP LNS (L2TP Network

Server) devices. Managed L2TPv2 peer-to-peer tunnels Possible actions include disabling MAC address learning,
can establish a Layer 3 VPN over an intermediate IP | blocking traffic, or taking down the link, depending on how
network. the thrash limiting profile is configured. This feature is

useful for maintaining network stability and preventing
For more detailed information, you can refer to the L2TP broadcast storms caused by loops.

Tunnel Feature Configuration Guide from Allied Telesis.
For more detailed configuration options, you can refer to
the Switching Feature Overview Guide.

i oGP

[ask me anything

Jask me anything

OsecT Support

From version 3.17.1 onwards, OsecT is supported with Vista Manager as a plugin.
OsecT is an Operational Technology (OT) intrusion detection system that monitors and protects

industrial control systems and OT networks, helping identify potential threats while ensuring normal
operations are not disrupted.
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Vista Manager supports connecting to OsecT through an IPv4 address or a hostname. As an admin
user, you can enable OsecT from the Optional Features page.

OsecT Enabled @I

show topolegy information from OsecT in Vista Manager.

1P Address *

API Key *

AP Key is required

Cancel

m Vista Manager 3.17.1 is compatible with OsecT version 4.2.0 or later.

m  When OsecT is enabled, devices will start appearing in Vista Manager shortly after. Vista Manager
requests updates from OsecT every hour.

m  OsecT-discovered devices do not report whether they are online or offline, so these devices will
always have a "Normal" status in Vista Manager.

m If OsecT is disabled, devices will be removed from Vista Manager.

m  However, if you enable offline device recording, a record of these removed devices will still remain
in the Offline Devices tab of the Asset Management page

Vista Labs

You can trial new or experimental features from the new Vista Labs menu.
A Terms of Service popup will appear when you click on the Vista Labs tab. Please read it prior to
agreeing to use Vista Labs features. You can view it again from the Terms of Service link on the info

card above the features.

You will then have access to the Vista Labs features, and you can toggle on features you would like
to use.

Currently, this includes feedback for Vista Manager.

Toggle feedback to allow all users to provide feedback on Vista Manager. After toggling this, you can
access the Feedback form.
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Troubleshooting

Ports used by Vista
Vista Manager EX makes use of the following ports. These ports may need to be configured on your

firewall:

VRT EJAPL Ports for all deployments of Vista Manager EX:
G WIN VA _
UDP port 514 (syslog), used by the AMF master/controller to send logs to Vista Manager EX.
m  TCP port 443 (HTTPS), used if the HTTPS mode of Vista Manager EX is enabled.
m  TCP ports 443 and 12943, used if you are not using certificates for device authentication.

m  TCP ports 12945 and 12946, used if you are using certificates for device authentication
(recommended).

B WIN Further ports:

m  TCP port 5000, which gives access to the Vista Manager web interface.

VRT EAPL Further ports:

G WIN

TCP port 5443, which gives access to the AWC plugin web interface. (This depends on which
port you configured the AWC plugin to run on during installation.)

m  TCP port 65437-65439, which the wireless APs use to communicate with the AWC plugin.
m  TCP port 6443, which gives access to the SNMP plugin web interface.

m  UDP port 162 (SNMP trap), used by SNMP devices to send traps to the SNMP plugin.

m  TCP port 443 gives Vista Manager access to the Forescout API.

B TCP port 11443 gives Forescout access to CounterACT devices.

£ vA [EWIN You may need to create Windows inbound firewall rules and Virus scanning exclusions.

Last update to Windows version of Vista Manager EX
From version 3.17.1 onwards, we will no longer support the Windows version of Vista Manager EX.

To get ongoing new features and enhancements, you need to update your Vista Manager installation
to the VST-VRT version.

Migration to VST-VRT is easy; for step-by-step instructions see the Windows to VST-VRT Vista
Manager Migration User Guide.

Periodic maintenance releases for version 3.16.x, along with select earlier versions, may be issued.
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Disable http check-api-content-type-header before
using Vista Manager

The http check-api-content-type-header command cannot be used on devices together with Vista
Manager as this command will cause the device to drop some Vista Manager requests. It is disabled by
default.

If you have enabled it, disable it using the no http check-api-content-type-header command. See your
device’'s command reference for more information.Upgrading versions earlier than 3.9.0

If you create a backup on a version earlier than 3.9.0, and you want to upgrade to a new version, you
must first install your backup on version 3.9.0 and export the backup again.

Then you can upload the new backup to a later version of Vista Manager (such as v3.17.1).
If you upgrade directly to 3.14.0 instead (for example, from 3.7.0 to 3.17.1 without upgrading to

3.9.0 first), you may encounter data corruption or incompatibility issues. Alternatively, you can
choose to perform a fresh install of the newer version and configure it from new.

Important Licensing changeover information

From version 3.14.0 onwards, we are preparing to migrate licensing systems. As of version 3.14.0,
we will support both old and new licenses to prepare for the migration change.

We recommend you contact Allied Telesis Customer Support from the Support Portal in preparation
to arrange new licenses for the licensed features before upgrading.

If you have not prepared licenses in advance and discover that this is an issue when upgrading,
Vista Manager 3.14.0 continues to support older licenses. You can arrange new licenses and apply
these before upgrading to a later version.

Vista Manager EX API

From version 3.14.0 onwards, you can access part of the APIs of Vista Manager to create custom
applications.

You can create a token for access to the API from the System Management > Configuration page.

For more information about the Vista Manager EX API, contact Allied Telesis support.

Vista Manager EX APl () Disabled ()
Access Vista Manager EX content in external applications

A Regenerating the token will invalidate the current token
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Live Migration collections taking a long time to load

From version 3.13.1 onwards, a banner system has been implemented for live migration of
collections that may take a long time. During a live migration, these collections may not display
correctly and may be inaccurate during migration.

Live Migration is triggered when a database restore is performed. This is either enacted by you as a
user from the System > Database screen, or automatically when AWC is upgrading the Vista
Manager version.

Large collections include Health Monitoring information and history metrics, SDWAN history
metrics, and pages with events, such as the Event page and Network Map.

Clear browser cache

Clear your browser’s cache after upgrading your Vista Manager EX installation. Incomplete dialog
boxes, incorrectly populated drop-down lists, and truncated forms are all symptoms of a caching
problem.

Allow Vista Manager EX to discover the AMF network

If, after installation, there are no devices on the AMF network/area map check that the following
command has been run on your AMF controller (if present) and all AMF masters.

configure terminal

atmf topology-gui enable

x930 Expansion Module

Caution: The x930 expansion module is not recognized by Vista Manager. This means that it cannot configure
VLANSs on those ports.

Vista Manager and RMON

When Vista Manager connects to an AlliedWare Plus network, it automatically enables the RMON
(Remote Network Monitoring) commands on each AMF interface port that it finds. This is done for
the purpose of collecting traffic statistics.

It does this by modifying the running config on all switchports that interconnect AMF devices
(including LAGSs). No notification is shown that these changes are being made.
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Caution:

VRT

A WIN

If the copy run start or wr commands are run on one of these devices, these config changes will be
made permanent.

Testing Windows server

If you cannot connect remotely on Windows, try connecting locally on the Windows server by using
localhost:

http://localhost:5000

You can test whether the plugin APIs are active using the following URLs:

B https://localhost:5443/wireless_plugin/api/plugin_registration

|
{"version":"100","baseUrl":"http:\"Vlocalhost: 8080\ wireless_plugin\/api”."product”:{"name":" AT-Vista Man:
plugin” "type":"awe","version”: { "major”:"1","minor":"2" "revision”:"0","build":"B06" }."capabilities”: [ "node:

B  https://localhost:6443/NetManager/api/plugin_registration
{"version”:"1.0.0","baseUrl":"http://10.33 24 38 NetManager/ap1", "product”: { "name":"SNMP Plugin", "tvpe":"anr

{"major":1,"minor":0,"revision":0,"build":"B04"}." capabilities”:["menu", "event"] } }

Note that these URLs can only be used locally on the Vista Manager server using “localhost”.

Reboot AMF master/controller after configuring
certificates

If you receive the following error message:

Error during polling - Error: Device did not accept a certificate request
and basic auth fallback is disabled. Details: Error: connect ECONNREFUSED
XXX . XXX .XXX.XxX:12946

Check that you have correctly configured your AMF master/controller for certificate authentication
and that you saved your configuration and rebooted your master/controller after running the atmf
trustpoint command (see "Configure certificate for device authentication" on page 17).

Problems adding plugins

If you are having difficulty adding the plugins in Vista Manager EX, make sure that you have done the
following:

EJAPL ®m Check that you have the correct URL for each plugin as described in "Registering/Installing

G WIN

plugins" on page 28, and click on Verify Connection.
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VRT EJAPL ®m Prior to Vista Manager 3.5.0, the Windows-based version of Vista Manager supported a
lowercase URL for registering the SNMP plugin. If you are upgrading from an earlier version, or
porting to a different platform, you should re-register the SNMP plugin using the mixed-case URL.

Server URL: https://<ip-address>:6443/NetManager

where <ip-address> is the IP address of the SNMP plugin.

EWIN = Make sure that you have imported the plugin server certificates as described in the “Initial Login”
section in the Vista Manager EX™ Installation Guide.

EwWIN = Add the Vista Manager EX server address to your trusted sites as described in the Vista Manager
EX™ Installation Guide.

EIWIN = Add an exception for the server to your web proxy as described in the Vista Manager EX™
Installation Guide.
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Updating plugins
If you are having issues with plugins, you can update a plugin without deleting it.

1. From the System Management menu, go to the Plugins tab. Select the plugin to update. Click

Edit.
Plugins AWC Plug-in Add Plugin
AWC Plug-in @ Plugin Certificate Fingerprints:
e LS Y S NS SV SR S

Delete Edit
2. Click Verify Connection.
Plugins AWC Plug-in
AWC Plug-in Server URL:
hitps. Jwireless_plugin
SNMP Plug-in e
Cancel Werify Connection
3. Click Save.
Plugins Register Plugin Add Plugin
AWC Plug-in Flease verify these certificate fingerprints match the ones the plugin is reporting. Please consult your
plugin’s documentation for how to view its certificate fingerprints.
SNMP Plug-in
N _ Plugin Certificate Fingerprints: _ PR
o o Y . i _r_.__.._.f A y i

Edit

o

gwin) SNMP plugin application pool settings

If you are having issues with the SNMP plugin, you can check the IIS settings are correct.
1. Launch Internet Information Services (IIS) Manager on the Vista Manager EX server.

2. Expand out the following items in the Connections pane tree on the left-hand side:
Computer name -> Sites -> NetManager Site -> NetManager
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3. Make sure that the api and web2 applications are available, and configured, as in the following
screenshots.

File View Help

Connections - x :
o EI5 18 03! Application Pools

i H;E‘ start Page This page lets you view and manage the list of application pools on the server. Application pools are associate
~ -85 WIN-TDAIC2SHLN (WIN-TE
2} Application Pools Filter:

- Go - 5% Show All | Group by: Mo Grouping =
w (@] Sites : : —
9 Default Web Site MName Status MET CLR V... Managed Pipel... Identity Applications
v.@ NetManager Site é,?DefauItAppPool Started vd.0 Integrated ApplicationPoolld... 1
v_‘_ NetManager QNetManagerAppPool Started vd0 Integrated ApplicationPoolld.. 5

-] pluginProxy

4. Select api in the Connections pane and then select Basic Settings in the Actions pane.

Edit Application

? X
Site name:  MetManager Site
Path: /MetManager
Application pool:
E | |NetManagerAppPooI Select...

Example: sales

Physical path:

|C:\InstaIITest\PIugins\AT-SNMP\NetManager\api

Pass-through authentication

Connect as... Test Settings...

[] Enable Preload
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5. Click the select button and check that the Select Application Pool settings have the following
properties:

m .Net CLR version: 4.0

m Pipeline mode: integration

Select Application Pool ? *
Application pool:
NetManagerAppPool ~
Properties:
Net CLR Version: 4.0
Pipeline mode: Integrated

6. Repeat for the web application.

7. If the NetManagerAppPool does not have the required properties, then select Application Pool
in the Connections pane.

8. Select NetManagerAppPool from the Application Pools screen and select Basic Settings from
the Edit Application Pool pane.

9. The application pool settings should look like the following:

Edit Application Pool ? *
|r\letManagerAppPO0I

.MET CLR version:

.MET CLR Version v4.0.30319 ~

Managed pipeline mode:

Integrated ~

Start application pool immediately

Note: The “xxxxx” portion of the .Net CLR Version v4.0.xxxxx version will vary depending on the
Windows OS installed.

De-register the AWC plugin on large wireless networks

B WIN Individual APs may disappear from the AWC plugin if the plugin is managing a large wireless
network (approximately 600 APs or more). If this occurs, de-register the AWC plugin from the Vista
Manager’s System Management -> Plugin Management page. Features such as licensing, auto-
recovery, and importing an AP from a guest device will still work, even if the plugin is not registered.
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Unexpected Communication Error during installation

When setting up your connection (Step 3: Set Up Your Network), you may receive the following error:

AVL Allied Telesis | Vista Manager™ EX

Unexpected Communication Error x

Enter AMF Network Master or Controller IPv4 or IPvb Address or Domain Name:

Enter AMF Network Master or Controller Username and Password:

Username manager
skip network setup upload backup file -

This is due to the atmf topology-gui enable command not having been run on the master. You can
resolve this by running the command on the master, then clicking the Next button.

For further information, refer to "Allow Vista Manager EX to discover the AMF network" on page 360.

Syslog generation for AMF guest devices

£ vA B APL When a guest device joins or leaves an AMF network, syslog messages will be generated containing
I WIN these fields:

m  Network name
B Area name

®  Port number
m  Model type

m  MAC address

m [P address

Information from these log messages are intended to help facilitate easy deployment and
replacement of APs.
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o Unable to enter Master/Controller IP address after
skipping license page

Vista Manager 3.7.0 does not require a license on the VST-APL. If you skip the license step when
installing the Vista Manager application, then at Step3: Set up Your Network, you may not be able
to enter your Master or Controller’s IP address.

AV Allied Telesis Vista Manager™ EX

Step 2: Optionally Use Trial Licenses
The trial license will provide full access to all Vista Manager EX plugins for
90 days.

Would you like to enable the 90 day trial license?

Use 90 day trial license [{EL{:RGIEESE) Upload backup file

To work-around this issue, perform the following steps:

1. Click Back:

AV Allied Telesis Vista Manager™ EX

Step 3: Set Up Your Network

Network Master or Controller

r If you are unable to enter IP address j

Enter AMF Network Master or Controller Username and Password:

2 Username:

& Password:

Click Back
< Back skip network setup Upload backup file m
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2. This takes you to Set Up Your Network, and you can then enter the IP address of your AMF
Master or Controller...

AVL Allied Telesis Vista Manager™ EX

Step 3: Set Up Your Network

Enter AMF Network Master or Controller IPv4 or IPvé Address or Domain Name:

OGO 00K

skip network setup Upload backup file

3. Click Next.
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Supported Device List

AlliedWare Plus devices

The following table lists the AlliedWare Plus devices for which the new features of Vista Manager EX
3.17.1 are available. To use all the new features, the devices must run AlliedWare Plus version 5.5.5-
2.x or later.

Vista Manager 3.17.1 will work with older AlliedWare Plus devices too, but newer features may not
be available. We recommend you use the most recent firmware for your device.

Table 3: Model names

Models Family

AMEF Plus Cloud

SBx81CFC960 SBx8100
SBx908 GEN3 SBx908 GEN3
SBx908 GEN2 SBx908 GEN2
x950-28XSQ X950 Series
x950-28XTQm

x950-52XSQ

x950-52XTQm

x930-28GTX x930 Series
x930-28GPX

x930-28GSTX

x930-52GTX

x930-52GPX

x560-28YSQ x560 Series
x550-185XQ x550 Series
x550-18XTQ

x550-18XSPQm

x540L-28XTm x540L Series
x540L-28XS

x530-10GHXm x530 and x530L Series

x530-18GHXm
x530-28GTXm
x530-28GPXm
x530-52GTXm
x530-52GPXm
x530DP-28GHXm
x530DP-52GHXm
x530L-10GHXm
x530L-18GHXm
x530L-28GTX
x530L-28GPX
x530L-52GTX
x530L-52GPX

x330-10GTX x330 Series
x330-20GTX
x330-28GTX
x330-52GTX

x320-10GH %320 Series
x320-11GPT
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Table 3: Model names (continued)

Models Family

x220-28GS
x220-52GT
x220-52GP

x230-10GP
x230-10GT
x230-18GP
x230-18GT
x230-28GP
x230-28GT
x230L-17GT
x230L-26GT

x240-10GTXm
x240-10GHXm
x240-26GHXm

x250-18XS
x250-28XTm
x250-28XS
x250-28XTm

IE560-12GSX

IE360-12GTX
IE360-12GHX

IE340-12GT
IE340-12GP
IE340-20GP
IE340L-18GP

IE220-6GHX
IE220-10GHX

IE210L-10GP
IE210L-18GP

SE540L-28XTm
SE540L-28XS

SE250-18XTm
SE250-28XTm
SE250-28XS

SE250-28XTm

SE240-10GTXm
SE240-10GHXm

XS916MXT
XS916MXS

GS980MX/10HSm
GS980MX/18HSm
GS980MX/28
GS980MX/28PSm
GS980MX/52
GS980MX/52PSm

GS980EM/10H
GS980EM/11PT

GS980M/52
GS980M/52PS

GS970EMX/10
GS970EMX/20
GS970EMX/28
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%220 Series

%230 and x230L Series

%240 Series

x250 Series

IE560 Series
IE360 Series

IE340 Series

IE220 Series

IE210L Series

SE540L Series

SE250 Series

SE240 Series

XS900MX Series

GS980MX Series

GS980EM Series

GS980M Series

GS970EMX Series
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Table 3: Model names (continued)

Models Family

GS970M/10PS GS970M Series
GS970M/10

GS970M/18PS

GS970M/18

GS970M/28PS

GS970M/28

ARX200S-GTX AR-Series UTM firewalls
10GbE UTM Firewall

AR4050S AR-series UTM firewalls
AR4050S-5G
AR3050S

AR1050V AR-series VPN routers

TQ6702 GEN2-R TQR Series
TQ7403-R
TQ3403-R

Allied Telesis Wireless APs

For details about AP support, see the “What is the AWC Plug-in” section of the Autonomous Wave
Control (AWC) Plug-in User Guide.
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